
DiversityCollection 
DiversityCollection (Version 3) is part of the database framework DiversityWorkbench. Within
this framework the application DiversityCollection is confined to the management of specimens
in scientific collections. In this context it is designed to document any action concerning the
collection, storage, exchange and treatment of specimens in a collection and is also
appropriate to store observation data. DiversityCollection is distinguished from other collection
management systems by its focus on biological relations between organisms collected
together as one or more specimens (e.g. host, parasite and hyperparasite, symbionts etc.).
Any module within the Diversity Workbench is focused on a specific data domain.
DiversityCollection keeps only data connected with the handling of collection specimens and
observations. Data of other realms like e.g. taxonomy are handled in separate modules. For an
overview of the available modules see DiversityWorkbench. DiversityCollection might also be
used as a stand-alone application.   

The image below gives you an overview of the main parts of DiversityCollection. The 4 grey
squares in the image indicate the possibility of a hierarchy. This means that for example one
organism can grow on another or a collection can be part of another collection. 

The image below gives an overview of some typical data depicted in DiversityCollection
together with the symbols used throughout the program. A typical specimen may have been
collected at a CollectionEvent during an expedition . The site of the CollectionEvent may
be localized and characterized and methods have been used. The collectors collected
twigs of the plant and fungi growing on the plants. These organisms were identified 
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several times and analysed where methods have been used. The collected samples are
stored as herbarium sheets and specimens in a collection . The manager sent some
of the samples for which he had a request from a requester to another collection. The
samples were collected as part of a project . Certain parts were cultivated and DNA 
extracted which was processed where methods have been used. Images were taken
for the EventSeries, the CollectionEvent, the CollectionSpecimen as well as organisms and
part of this specimen.

 

DiversityCollection 3.x is based on Microsoft SQL-Server 2008 or later and the .Net
Framework, Version 3.5. 

For licence and copyright see the licence section. 
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Installation
To run DiversityCollection you need the database and the client. All parts can be downloaded
for free from http://www.microsoft.com/downloads/ and
http://www.diversityworkbench.net/Portal/. 

The image below gives an overview of the installations and files needed. For an intoduction
see a short tutorial .

 

 

Client

The client is based on the .Net framework version 4.8 from Microsoft. If not already present,
the software will ask you for installation. Download the installer from

https://diversityworkbench.net/Portal/DiversityCollection
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and start it. In case you get as message as shown below

Please click on Weitere Informationen. A button as shown below will appear
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Please click on Trotzdem ausführen to install the software as shown below.
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If you need to change the location of the software, this can be done in the next step (see
below).

After the installation is done, the software will be included in the programm menu (see below)
and a shortcut on the desctop will be created. 
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The software will be placed in the programs directory as shown below. 

Page 7



After the installation make sure to get the latest updates from 
http://windowsupdate.microsoft.com/.

 

Database

For the installation of a local database see the section Installation of the database.

 

Display / Monitor settings

By default the program detects monitor resolution higher than 100% and will adapt to it. The
icons of the windows may become somewhat blurry. If for any reason the whole program
stays blurry it may help to let windows try to fix it (see image below).

Page 8

http://windowsupdate.microsoft.com/
http://windowsupdate.microsoft.com/


 

Page 9



Changes along with the migration from .Net
3.5 to .Net 4.8
Images, Labelprint, Maps 

The setting for the upper part showing maps, labels and event and specimen images has been

rearranged. The previous control containing 4 button has been replaced by a dropdown
menu providing access to all images and the printing section (see below). To hide the upper
part, select Hide. The indication of available images via a yellow backgroud has been

replaced by a button row where the presence of images is again indicated by a yellow
background. You may use a click on these buttons as a shortcut to select the corresponding
range. 

 

Images of the event series

The images of the event series has been moved from within the data area ... 

... into the upper part of the form along with the other images. 
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Exsiccatae

The display of the exsiccatal series moved from underneath the projects section ...

and together with the exsiccatal identification ...
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... to underneath the specimen section

 resp. above the unit section and is now marked with the  icon. 

 

References in table CollectionSpecimen moved to table
CollectionSpecimenReference

The content of the reference related columns in the table CollectionSpecimen have been
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removed ... 

... and are now replaced by entries in the table CollectionSpecimenReference. 

 

References in table Identification moved to table
CollectionSpecimenReference

The content of the reference related columns in the table Identification have been removed
... 

... and are now replaced by entries in the table CollectionSpecimenReference. 
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Description in table IdentificationUnitInPart moved to table
CollectionSpecimenPartDescription

The content of the desciption in table IdentificationUnitInPart moved ... 

... to the table CollectionSpecimenPartDescription. 

 

Logging information moved

The area containing the information about creation and last changes of the dataset moved
from unterneath the specimen data ...

... into the tree area underneath the unit tree. 
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Part tree only shown when parts are present 

The tree containing the parts that was allways displayed before ...

... is now only shown when parts are present. To insert parts with a hidden tree, click on the 
 button underneath the unit tree. The upcoming dialog will lead you through the creation of

a part. 

 

Scan for backlinks from DiversityDescriptions

The decision if backlinks from DiversityDescriptions should be searched has moved from
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underneath the specimen section ...

... into the customize settings. In the menu choose Administration - Customize display...
and there the page Defaults and miscellaneous and in ths page the Miscellaneous section (see
below). 
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Access to menu

The access to the menu depends upon the selected data. If certain parts of the menu are
disabled, choose a dataset you have access to.

 

 

Annotation 

Annotations former defined as reference will appear as annotation. A definition of an
annotation as reference is not possible any more. Use Reference instead. 

  

 

 

Installation 

The new version of the software is now included in an installer . To install
DiversityCollection, start DiversityCollectionSetup.msi and follow the instructions as shown
below.
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If you need to change the location of the software, this can be done in the next step (see
below).

After the installation is done, the software will be included in the programm menu (see below)
and a shortcut on the desctop will be created. 
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The software will be placed in the programs directory as shown below. 

Page 19



 

 

Resources 

If you use the installer, the software will be included in the programm menu and a shortcut on
the desctop will be created. The software will be placed in the programs directory as shown
above. 

All resources the user needs direct access to are now placed within the directory according to
the resources settings. For details see chapter Resources.
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Menu
Overview of the menu in DiversityCollection

Connection

  Database ... 
Choose one of the databases available on the server. Only
databases to which the user has access permission will be
listed.

  Module connections ...
Edit the connections to the other modules within the
DiversityWorkbench.

 Timeout for database ... Set the timeout for database queries.

  Transfer previous settings
Transfer the settings for IP-Address and port of the server,
name of the database, login etc. of a previous version of the
client to the current version.

  Quit
Quit the application and stop all processes started by the
application.

Grid 
  Specimen ... Change to the grid mode to edit the data set of the Specimen

in a list.

  Images ... Change to the grid mode to edit the data set of the Specimen
images in a list.

  Organisms ...
Change to the grid mode to edit the data set of the
Organisms in a list.

  Parts ... Change to the grid mode to edit the data set of the
SpecimenParts in a list.

  Collection events ... Change to the grid mode to edit the data set of the
CollectionEvents in a list.

  Event series ...
Change to the grid mode to edit the data set of the
CollectionEventSeries in a list.

  Table editors
Edit data as selected in the query data directly in the data
tables.

      Event series table... Edit data of the collection event series table.

      Event table... Edit data of the collection event table.

      Localisation table... Edit data of the collection event localisation table.

      Site table... Edit data of the collection site table.
      Specimen table... Edit data of the specimen table.
      Collector table... Edit data of the collector table.
      Relation table... Edit data of the specimen relation table.
      Image table... Edit data of the specimen image table.

      Organisms table... Edit data of the organism table.
      Identification table... Edit data of the identification table.
      Analysis table... Edit data of the organism analysis table.
      Analysis method table... Edit data of the organism analysis method table.

      Analysis parameter table... Edit data of the organism analysis parameter table.
      Part table... Edit data of the specimen part table.
      Processing table... Edit data of the specimen processing table.

      Transaction table... Edit data of the specimen transaction table.

      Annotation table Edit data of the annotation table.
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           Event annotations ... Edit collection event annotations.

           Specimen annotations ... Edit collection specimen annotations.

           Organism annotations ... Edit organism annotations.

           Part annotations ... Edit specimen part annotations.

      Identifier table Edit data of the identifier table.

           Event identifier ... Edit collection event identifier.

           Specimen identifier ... Edit collection specimen identifier.

           Organism identifier ... Edit organism identifier.

           Part identifier ... Edit specimen part identifier.

      Set timeout... Set the timeout for database queries.

  Spreadsheets Edit data in configurable tables.

      Event sheet... Edit event and dependent data with one line per event.

      TK25 sheet...
Edit organism and dependent data in relation to TK25
information and create distribution maps.

      Organism sheet... Edit organism and related data with one line per organism.
      Part sheet... Edit part and related data with one line per part.
      Image sheet... Edit image and related data with one line per image.

      Analysis sheet... Edit analysis and dependent data with one line per analysis.

Query
  Show query Show or hide the query list.
  Predefined queries All predefined queries will be listed.

  Scan mode
Change to scan mode to open the data set of a specimen by
scanning the barcode.

  Scan mode collection
Change to the collection scan mode to list all specimen within
a collection by scanning the barcode that identifies this
collection.

Data
  Import

         Import wizard Import data from tab-separated text files.

               import Series ... Import event series from tab-separated text files.

               import Events ... Import events from tab-separated text files.
               import Specimens ... Import specimen data from tab-separated text files.

               import Observations ... Import observation data from tab-separated text files.

               import Analysis ... Import analysis definitions from tab-separated text files.

               import Collections ... Import collections from tab-separated text files.

               import Methods ... Import method definitions from tab-separated text files.

               import Processings ... Import processing definitios from tab-separated text files.

               import Transactions ... Import Transactions from tab-separated text files.
         Specimen scans ... Import scans of specimen labels.
         Import list ... Import tab-separated lists.

         Reimport list ... Reimport tab-separated lists which have been exported
including the key columns.

  Export
         Wizard Export data via a wizard.
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                 Event series... Export event series.
                 Events... Export collection events.
                 Specimen... Export specimen.
                 Organisms... Export organisms.
                 Parts Export specimen parts.
                 Transactions Export transactions of specimen parts.
         Export list ... Export a tab-separated file with the data of the specimen.
         XML Export data as an XML-file.
              ABCD Export data as an XML-file according to the ABCD standard.

         GPI/JSTOR
Export data as an XML-file according to the GPI/JSTOR
standard.

         CSV (bcp) Export data of the entire database as csv files.

  Replication ... Synchronise the content of 2 databases.

         Add publisher ... Add a replication publisher for the replication.

         Replication publisher Database and server publishing data for replication.

                Download ... Download data from the data provider in your local database.

                Merge ...
Merge contents between your local database and the
replication provider.

                Upload ...
Upload data from your local database to the replication
provider.

                Remove Remove the replication provider.

         Clean database ... Clean your local database.

 Archive Archives of projects.

       Administrate archives...
Administrate the projects that should be included in a
schedule based archiving.

       Create archive... Create and archive of project data.

        Reset database... Reset the database, i.e. remove all user data.

        Restore archive... Restore project data from an archive.

  Cache DB Export data of selected projects into a cache database.

  Backup database ... Create a backup of the entire database.

  Transfer Transfer data sets.

         To collection ... Transfer all parts of the selected specimen into a collection.

         To project ... Transfer the selected specimen into an additional project.

         To transaction ... Transfer the selected specimen into an additional transaction.

  All annotations ... Edit all annotations in the selected dataset.

  All identifiers ... List all identifiers in the selected dataset.

  Remove specimen ... Remove the selected specimen from the database.

  Remove from project ... Remove the selected specimen from an additional project.

  Restore from log ... Restore data that had been deleted from the log tables.

  Save data set Save current data set.

Administration
  Change password ...

Changing the password of a user (only available for
SQL-Server accounts).

  Analysis ...
Administration of the analysis methods used for the
specimens.

  Collections ... Administration used for the collections.

  Customize display ... Customizing the display of the window e.g. the material
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categories and taxoniomc groups which should be visible when
creating a new entry.

  Database Administration of the database.

         Descritption ...
Administration of the descriptions and messages within the
application.

         Database tools ...
Tools for the administration of the objects in the database - 
for experts only!.

         Documentation ... Documentation of the structure of the database.

         Logins ...
Administration of the logins of the server and their permissions
in the databases.

         Maintenance ...
Maintenance of database entries, especially, if connected to
other modules.

         Queries ... Creating and editing predefined queries.
         Rename database Rename the current database.

         Set published address Setting the address published for links by other modules.

  External datasources ... Administration of the external data sources of data imported
into DiversityCollection.

 External identifier... Administration of the external identifier.

 Image description... Administration of the descriptions for images.

 Kiosk mode... Set the client into the Kiosk mode.

 Linked server... Administration of the linked server.
 Material categories... Administration of the material categories.

  Methods ... Administration of the methods used for CollectionEvents,
Analysis and Processing.

  Processing ... Administration of the processing procedures applied in the
collection.

  Projects ... Administration of the projects.

  Resources directory ... Setting the directory for the resources.
 Retrieval type... Administration of the retrieval types.
 Site properties... Administration of the properties of collection sites.
 Stable identifier... Administration of the stable identier.

 Taxonomic groups... Administration of the taxonomic groups.

  Tools ... Administration of the tools used for analysis and processing. 
Outdated - please use Methods instead

  Transaction management Management of transactions, managers, loans etc.

         Transactions ... Administration of the transactions e.g. loans, exchange etc.

         Expired loans ...
Administration of expired loans. This menu entry will appear
when there are expired loans in collections where the current
user is a curator.

         Loan requests ...

Administration of loan requests for the collections for which a
user is a collection manager. This menu entry will appear when
there are loan requests for the managed collections where the
current user is a collection manager.

         My requests ...
Administration of the loan requests of a user. This menu entry
will appear when a user placed requests for specimen.

         Loan requesters ... User having the right to place requests for specimen of a
collection.

         Collection managers ...
Administration of the users who manage collections and are
e.g. responsible for the administration of the transactions.

         Collection users ...
Administration of the access of users to data within
collections.

         Transfer to transaction ... Transfers data into a transaction.
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  Withhold data Edit the withholding reasons for the selected data.

Help
  Manual Opens the online manual.

  Feedback ... Opens a window for sending feedback.

  Feedback history ... Opens a window for browsing former feedback.

  Edit feedback ...
Opens a window for editing the feedbacks sent to the
administrator (for admins only).

  Statistics ... Overview of changes within the projects and edited specimen.

        Info Show the version of the program and corresponding
information.

  Websites Websites related to DiversityCollection.

         Download applications ... Download DiversityCollection from the website of the
DiveristyWorkbench project.

         Information model ... Inspect the information model on the website of the
DiveristyWorkbench project.

         Diversity mobile ...
Website of DiversityMobile, the mobile application for
collecting data stored in DiversityCollection.

     GitHub Resouces on GitHub.

          SNSB ...
Resources provided by the Staatliche Naturwissenschaftliche
Sammlungen Bayerns.

          ZFMK ... Resources provided by the Zoologische Forschungsmuseum
Alexander Koenig.

  ErrorLog ... Open the errorlog of the appliaction.

Update 
  Update database ... Update the database to the current version.

  Update client ... Download the current version of the client.

 

Shortcuts

Some of the menus are accessible via short cuts, e.g.:

 ALT + D = Data
 ALT + D + S = Save
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Manual
The online manual DiversityCollection.chm can be found in your application folder together
with the application DiversityCollection.exe and the library DiversityWorkbench.dll. To get
information on any topic in the application DiversityCollection and to open this manual simply
click on the field you require information on and press F1. To open the manual from the menu
choose Help -> Manual.
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Version
For information on the version of the client application choose Help, Info...

If the version of either your client or the database is outdated, this will be indicated in the
menu. For an outdated database the menu Update will contain the Update database
... menu and the Update client ... for outdated client software. For an update of database
or client see chapter Update of database and client.
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All videos delivered with DiversityCollection
 Common 

o Installation .
o Ordner und Dateien .
o Fehlerprotokoll .
o Druck, Bilder, Karten .
o Rückverweis aus DiversityDescriptions .

 Database 
o Anmelden .
o Timeout .
o Wiederherstellung geänderter Daten .
o Wiederherstellung gelöschter Daten .

 Query 
o Suchkriterien - allgemeine .
o Suchkriterien - spezielle .
o Abspeichern von Suchkritierien .
o Modul bezogene Suche .
o Suchen mit Prefix .

 Editing 
o Neuen Datensatz anlegen . 
o Beziehungen . 
o Methoden . 
o Literaturverweise . 
o Modules 
 Verbindung zu Modulen . 
 Webservices . 
o Images 
 Reihenfolge . 
o Event 
 Verbreitungskarten . 
o Organisms 
 Taxonomic Groups . 
 Taxonomische Gruppen . 
 Bestimmungen . 
o Parts 
 Einfügen von Teilen . 
 Reihenfolgen . 
 Bescheibung . 
o TableEditor 
 Allgemeines und Formatierung . 
 Daten verschieben . 
 Filtern . 
 Editieren . 
 Export . 
o Spreadsheet 
 Editoren im Vergleich . 
 Übersicht . 
 Tabellen und Spalten . 
 Ø Tabellenfilter . 
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 Spaltenfilter . 
 ↑↓Sortieren . 
 Schemata . 
 Spaltenbreite . 
 Bilder . 
 Editieren . 
 Editieren mehrerer Daten . 
 Verbindung zu Modulen . 
 +x Hinzufügen und Löschen . 
 Kontext Menü . 
 Projekte und ReadOnly . 
 Start . 
 Details . 
 Export . 
 Maps 

 Karten . 
 Farben . 
 Symbole . 
 Legende . 
     Transparenz . 
 Symbolgrösse aus Daten . 
 Auswählen in Karte . 
 Details in Karte . 

 Import 
o Wizard 
 Überblick . 
 Datei . 
 Anhängen . 
 Zusammenführen . 

 Export 
o Stable identifier .
o CacheDatabase 
 Overview . 
 Übersicht . 
 Datenbank anlegen . 
 Postgres Datenbank anlegen . 
 Datenquellen anlegen . 
 Projekt anlegen . 
 Automatisierung des Datentransfers . 
 Sperren . 
 Pakete . 
o Labelprint 
 Etikettendruck - Übersicht . 
 Etikettendruck - Codes . 
 Sortierung . 
o Wizard 
 Export mit Assistent . 
 Filter . 
 Transformation . 

 Collection 
o Sammlungsverwaltung .
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 Maintenance 
o Abgleich von Koordinaten mit den davon gecachten Werten .
o Koordinaten ausserhalb eines Gebiets .
o Entfernung verwaister Daten .
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Update of database and client
DiversityCollection is still in development. Therefore regular updates for the database and the
client will be provided. When you start the program and connect to a database, the program
will check, if it is compatible with the database or if the database needs an update. In any of
these cases an update entry in the menu will appear. If a new version of the client is
available, this menu will contain an update client ... entry. Click on it to open the webpage
where you may download the client as shown below. 

If you are the owner of the database (Database role = dbo) and the database needs to be
updated, the menu will contain an update database ... entry. Select this entry to open a
window as shown below to run the provided update scripts, delivered with the client software.
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These scripts need to run consecutively, so e.g. to update from version 2.5.1 to 2.5.4 you
either have to run the script DiversityCollectionUpdate_020501_To_020504 or the scripts
DiversityCollectionUpdate_020501_To_020502, DiversityCollectionUpdate_020502_To_020503
and DiversityCollectionUpdate_020503_To_020504. The program will guide you through these
steps and check for the scripts. Certain scripts may need a timeout set to a higher value than
the standard 30 seconds. If a certain script contains a hint for a prolonged timeout, please
click no the button and set the timeout to a value as suggested. All you need to do to
start the update is click the Start update button.  
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Resources
The resources directory may be set via the menu (Administration - Resources) or in the 
customize window. For an introduction see a short tutorial .

There are 3 possibilities for the resources directory: 

 Select the "Home directory" of the user (may  be definded via
%HOMEDRIVE%%HOMEPATH%)

   Select the "My Documents" directory of the user
 Select any directory you have read/write access (User defined)

With a click on button you can open the directory in the explorer.

The default is set to Home. This directory will contain all files the user need access to (see
image below).
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Certain directories are hidden (Query, Settings, Spreadsheet) and are handled by the software
i.e. the content should not be changed by the user. The other folders (Export, Import,
LabelPrinting, Transaction) are a copy of folders placed in the program directory (see below). 
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The users may place their own files and folders in these directories. The files and folders
created by the software will be restored if changed or missing. 
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License
This manual is copyrighted work licensed under a Creative Commons License.

All material in this manual is the property of the contributing authors and fully copyrighted. By
choosing this way of publication, the contributing authors have agreed to license the work
under a Creative Commons License permitting reproduction, distribution, and derivative works,
requiring attribution, notice, and share-alike, and prohibiting commercial use.

 

For information about the license of the client software choose Help, Info...

The client software is free software: you can redistribute it and/or modify it under the terms
of the GNU General Public License as published by the Free Software Foundation. 

The client software is distributed in the hope that it will be useful, but WITHOUT ANY
WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A
PARTICULAR PURPOSE. See the GNU General Public License (GPL) for more details. 
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Feedback
If you have suggestions for improvement, need any changes in the program or encounter an
error you can give a feedback to the administrator. Press the [ALT] and [PRINT] keys to get
a screen shot of your current window. After creating the screen shot choose Help -
Feedback from the menu to open the feedback window as shown below.

 

Click on the button to insert the screen shot and give a comment about your
problem. In the field Topic enter the topic of your feedback (will appear in response e-mail).
The Priority can either be empty or set to 3 levels: urgent, as soon as possible and nice to
have. If necessary, enter a date in the field ToDo until when you would like to have the task

described in you feedback be solved. Then click on the button to send your
feedback to the administrator. If you would like to receive a message when the problem you
described is solved, please enter you e-mail address in the field below the description. 

To inspect your former feedbacks choose Feedback history... from the menu. A window
will open where you can browse your past feedback together with the state of progress. 

In case you do not have access to the central database for the feedbacks the program will
open your mail client to send an e-mail. In case of bugs in the program it would be helpful, if
you attached the file DiversityCollectionError.log located in your application directory (see
image below). 

Error logging 
If any error messages show up while working with the application, you can find further
details concerning the part of the application where the error occurred and the parameters
involved in the file DiversityCollectionError.log located in your resources directory. 

To open the errorlog, choose Help - ErrorLog from the menu. A window will open showing
the content of the errolog. By default the errorlog will at program start. You can keep the
errorlog if needed by chossing Help - Errorlog - Keep error log from the menu. A button will
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appear that allows you to clear the error log manually: Help - Clear ErrorLog. 
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Tutorial - first steps
This tutorial will guide you through the first basic steps to enter a single data set in
DiversityCollection. After the installation, make sure you have access to the database. To
start the program double click on the DiversityCollection.exe in the directory where you
copied the files of DiversityCollection. The main window will open.

 

If you open this window for the first time, you need to connect to the database. Click on the 
button or choose Connection -> Database... from the menu. A window will open where

you may enter your account information and choose the database (see image below, for
further information see database access). See a short tutorial . 

 

After connecting to the server and choosing a database click on the OK button to return to
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the main form. As indicated by the symbol in the right upper corner, you are now connected
to the database. The tooltip of the button will show your current login information (see
below). 

 

This tutorial is continued in the sections listed below. 

 section New data set
 section CollectionEvent
 section Localisation
 section CollectionEventSeries
 section CollectionSpecimen
 section Collector
 section Collection specimen relations
 section Organisms and identifications
 section Specimen parts and storage
 section Searching the database
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Tutorial - Creation of a new data set 
For an introduction see a short tutorial . To enter a new data set click on the button in
the upper left panel (see point 1 in image below). In case of accession numbers being
available in the database, the software will ask whether you wish to take the next free
number (see accession for further information). If you click on the OK button, the program will
try to find the next free accession number starting with your current accession number. 

Finally you will find a new entry in the specimen list on the left and the trees for the specimen
(see point 2 in image below) and the storage as shown below.  

 

If you did not specify an accession number, the entries will look like in the image above.
Otherwise the accession number will be shown. To enter your data for the specimen click on
the entry in the upper tree as shown below (see point 3 in image below). This will open the
fields where you may enter the details for the specimen in the area on the right of the tree
(see point 4 in image below).
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In the panel in the middle of the form several buttons will appear where you may enter
additional information for this specimen. 

With these buttons you may enter information for the:
- CollectionEvent 
- CollectionSpecimen 
- Relation between specimen 
- Organisms and identifications 

This tutorial is continued in the sections listed below. 

 section CollectionEvent
 section Localisation
 section CollectionEventSeries
 section CollectionSpecimen
 section Collector
 section Collection specimen relations
 section Organisms and identifications
 section Specimen parts and storage
 section Searching the database
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Tutorial - CollectionEvent 
To enter information about the CollectionEvent (when and where the specimen was collected)
click on the button (see point 1 in image below). 

   

This will add an entry for the CollectionEvent in the upper tree as shown below. Select this
entry in the tree (see point 2 in image below) to open the fields for the CollectionEvent. To
see the projected contents of any data field simply place your mouse in the field. An
explanation will appear as for the field Description of the locality:

 

See the Event part for further details. 

Then enter the date (see point 3 in image below) of the CollectionEvent. If you click on the
drop-down button as shown in the image below, a calendar will open where you may select
the date. Then enter the description of the locality (see point 4 in image below). To store the
data entered so far click on the button (see point 5 in image below).
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Now you have the possibility to enter more details about the locality like coordinates, named
places, etc. by clicking on the button (see point 6 in image above).

This tutorial is continued in the sections listed below. 

 section Localisation
 section CollectionEventSeries
 section CollectionSpecimen
 section Collector
 section Collection specimen relations
 section Organisms and identifications
 section Specimen parts and storage
 section Searching the database
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Tutorial - Localisation 
To enter more information on the CollectionEvent like coordinates, named places, etc. click on
the button (see image below). 

 

Now you may select an option from the following list:

 

The three most important options are:
- New Coordinates WGS84
- New Named Area (Diversity Gazetteer)
- New Altitude (mNN)

 

New Coordinates WGS84

You may add the exact coordinates for the locality with the assistance of Google Maps. Click
on the button (see first image of this site) and choose New Coordinates WGS84 (Google
Maps uses WGS84). This will add a new entry in the overview. Select it (see point 1 in the
image below) to open the details for this entry. Here click on the button (see point 2 in
image below). 
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A window will open as shown below where you may set the coordinates simply by dragging the
map with your mouse. The coordinates correspond to the center of the map, symbolized with
the . Click on the OK button to store the coordinates.
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In the main window the coordinates will be stored at two positions - see image below. In the
upper area you may set the values and choose a different format for display as shown here -
the more familiar form with degrees, minutes and seconds. Change the values and click on
the button to change the original entry. At the same time the numeric values are stored in
fields which can not be edited by the user (see below).  

 

 

New Named Area (Diversity Gazetteer)

To enter a name of a place using the DiversityGazetteer choose New Named Area
(DiversityGazetteer) from the list. In the overview tree in the middle of the window an entry
will be inserted as shown below. Select it to open the detail fields for this entry (see point 1
in image below). 
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To open the connection to the DiversityGazetteer click on the button (see point 2 in image
above). A window will open as shown below. Enter a search string - for example the city you
wish to find (see point 3 in image below) - and start the query with a click on the button
(see point 4 in image below).

 

In the middle of the form the results of the query will be listed. Select one of these. To guide
you to the correct entry details to this place are listed in the area right of the list. The base
will show a map corresponding to the coordinates connected to this entry. After selecting the
correct entry (see point 5 in image above) click on the OK button to return to the main
window (see point 6 in image above). As shown below the data retrieved from the gazetteer
will be written in several areas. Next to the name of the place the DiversityGazetteer provides
the coordinates and the country as shown below.
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The area where you entered the name now changed to a locked state and will prevent you
from changing the entry (see image below). Next to the field with the place you find the link
to the external module. Double-click it for more details. 

 

If you wish to remove the connection to the external module click on the button. This will
keep all entries (country, place, coordinates) but remove the connection to
DiversityGazetteer. 

 

New Altitude (mNN)

As last information about the locality we enter the altitude. Click on the button (see first
image of this site) and choose New Altitude (mNN) (see point 1 in the image below). Select
the new entry in the overview to open the data fields (see point 2 in the image below). Let's
suppose you have only feet values available - change the display format to feet (see point 3
in the image below). Enter your values (see point 4 in the image below) and click on the 
button (see point 5 in the image below) to save your entries. Now your values are converted
to meter (the internal format of DiversityCollection) automatically. If you now change the
display format to meter, you can see the result. The program calculates an average value for
the altitude and accuracy in meter corresponding to the accuracy of your original values (see
below). The original values of your entry are saved in the Notes field. 
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This tutorial is continued in the sections listed below. 

 section CollectionEventSeries
 section CollectionSpecimen
 section Collector
 section Collection specimen relations
 section Organisms and identifications
 section Specimen parts and storage
 section Searching the database
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Tutorial - CollectionEventSeries
If you wish to organize your CollectionEvents, you may use the CollectionEventSeries. To
create a new EventSeries select the ColletionEvent (see point 1 in image below) and click on
the button (see point 2 in image below).  

 

In the tree the entry for the new EventSeries will appear (see point 3 in image below). Select
this entry in the tree to enter the details about the EventSeries (see point 4 in image below).

   

To build a hierarchy for your CollectionEvents and CollectionEventSeries choose the created
EventSeries in the tree (see point 1 in image below) and create a new secondary EventSeries
(see point 2 in image below). 

Then enter the date of the CollectionEventSeries. If you click on the drop-down button as
shown in the image below, a calendar will open where you may select the date. Then enter
the description of the locality. To store the data entered so far click on the button.

Page 52



Select the entry of the new EventSeries (see point 3 in image below) and enter the details of
the EventSeries (see point 4 in image below).

 

Finally drag the CollectionEvent to its position within the hierarchy of the
CollectionEventSeries entries (see point 5 in image below). 
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To include an existing event in a hierarchy of the CollectionEventSeries select the
CollectionEvent and click on the button. For more details see the section
CollectionEventSeries.

 

This tutorial is continued in the sections listed below. 

 section CollectionSpecimen
 section Collector
 section Collection specimen relations
 section Organisms and identifications
 section Specimen parts and storage
 section Searching the database
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Tutorial - CollectionSpecimen 
To set the accession number for the CollectionSpecimen select it in the overview (see point 1
in image below) and enter the accession number (see point 2 in image below).  

 

To search for the next free accession number click on the corresponding button as shown
above (see point 3 in image above). A window will open as shown below. Start the search for
a free accession number. If the query ended successful, click OK to include the new
accession number in your data set.

 

Project

To restrict the access to your data set add it to a project (click on the button - see point 4
in image above). A dialog will open where you may select a project from the projects defined
in DiversityCollection (see image below). The project will then be added to the list of the
projects for this specimen. 
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This tutorial is continued in the sections listed below. 

 section Collector
 section Collection specimen relations
 section Organisms and identifications
 section Specimen parts and storage
 section Searching the database
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Tutorial - Collector 
Collectors

Now we will add the collectors of the specimen. In the overview select the specimen and click
on the button to insert a new collector (see point 1 in image below). Select the collector in
the overview (see point 2 in image below). Now we use the module DiversityAgents to search
for a certain person. Click on the button to open the interface of the module (see point 3 in
image below).

 

In the interface for DiversityAgents enter search criteria (see point 1 in image below) and
click on the button to start the query (see point 2 in image below).

Select the correct entry from the query result (see point 3 in image above) and click on the
OK button (see point 4 in image above) to store the name in DiversityCollection. 

The next collector will have no connection to the module DiversityAgents. To insert this
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collector click on the button again (see point 1 in image below) and select it (see point 2 in
image below). Type the start of the name in the field for the name (in this example "Mei"

would be a good choice) and click on the drop-down button (see point 3 in image below)
to select a name from the list of collectors already stored in the database. Finally if the
collector has a field number, enter said number (see point 4 in image below). 

 

 

This tutorial is continued in the sections listed below. 

 section Collection specimen relations
 section Organisms and identifications
 section Specimen parts and storage
 section Searching the database
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Tutorial - Relations between specimens  
There are two types of relations possible:

1. relation to a specimen within DiversityCollection
2. relation to a specimen not administrated in the local database.  

 

1. Internal relations

To enter a relation to a specimen in DiverisityCollection select the specimen in the tree (see
point 1 in image below) and click on the button (see point 2 in image below). 

 

A window will open where you can search for the related specimen. In the window enter your
restrictions (see point 1 in image below) and start the query (see point 2 in image below).
Select the related specimen from the result list (see point 3 in image below) and click OK (see
point 4 in image below) to insert the relation.

 

In the window select the entry for the relation (see point 1 in image below) to display the
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fields for the details. Then enter the type of the relation (see point 2 in image below).  

 

 

2. External relations

To enter a relation to a specimen in a foreign collection insert a relation (see point 1 in image
below) and select it in the overview (see point 2 in image below). Enter the name of the
specimen (see point 3 in image below) and the type of the relation (see point 5 in image
below).

 

If there is a data set for the collection available you may select it from the list (see point 4 in
image above). Otherwise you first have to add this collection to the list. If you have
permission to edit the collections, choose Administration -> Collections from the menu to add
a collection. See the section Collection for details. 

For further information on relations turn to the section Relation.
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This tutorial is continued in the sections listed below. 

 section Organisms and identifications
 section Specimen parts and storage
 section Searching the database
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Tutorial - Organisms and identifications
To focus on the specimen and its organisms hide all other entries from the tree by clicking on
the corresponding buttons (see point 1 in image below). To enter the organism choose the
specimen entry in the tree (see point 2 in image below). Then select the organism from the 
list.

 

This will insert an entry for the organism underneath the entry of the specimen (see
image below). To enter details for this organism select the entry in the tree (see point 3 in
image below and image above). 

To enter an identification for this organism select it in the tree (see point 4 in image above)
and click on the button (see point 5 in image above). This will insert a data set for the
identification of the organism underneath the organism as shown above. Select this entry to
enter the details of the identification.

To enter more organisms living on the plant select the plant in the tree (see point 1 in
image below) and create new organisms as described above (see point 2 in image below). 
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Now let's enter the taxonomic name of the plant. Select the entry for the identification in
the tree (see point 1 in image below). As a simple method to enter a taxonomic name simply
type it in the field Tax. name (see point 2 in image below). To save the data set and display
the taxonomic name in the tree click on the button (see point 3 in image below). 

Now insert an identification for the fungus (see point 1 in image below).  
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Select the identification in the tree and click on the button (see point 2 in image above) to
open a remote query as shown below. Choose the database DiversityTaxonNames_Fungi (see
point 1 in image below), enter the conditions for the query, e.g. the beginning of the
taxonomic name (see point 2 in image below) and start the query (see point 3 in image
below). From the result list select the taxonomic name (see point 4 in image below) and click
OK (see point 5 in image below) to transfer the selected name to the main form.  

The name of the selected taxon together with the link to the datasource (see image below)
will be inserted in the field for the taxonomic name. The taxonomic name can not be directly
edited as long as the name is linked to a datasource (indicated by the yellow background). To
remove the link you need to use the button. To see the entire information on the linked
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name as stored in the datasource click on the button.

As an example for the last variant enter an identification for the insect (see below). Select
the identification in the tree (see point 1 in image below) and click on the button (see
point 2 in image below) to open a remote query. 

A window for the access to webservices and other modules will open as shown below. Here
select CatalogueOfLife (see point 1 in image below) as a datasource. This will query the
webservice of Catalogue of Life for a taxonomic name. Enter the beginning of the taxonomic
name (see point 2 in image below) and start the query (see point 3 in image below). From
the result list select the taxonomic name (see point 4 in image below) and click OK (see point
5 in image below) to transfer the selected name to the main form. 
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The name of the selected taxon together with the link (see image below) to the data source
will be inserted in the field for the taxonomic name. The taxonomic name can not be directly
edited as long as the name is linked to a data source (indicated by the yellow background).
To remove the link you need to use the button. To see the entire information on the linked
name as stored in the data source click on the button.

 

 

This tutorial is continued in the sections listed below. 
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 section Specimen parts and storage
 section Searching the database
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Tutorial - Specimen parts and storage 
To enter the data connected with the storage of the specimen click on the below the
specimen tree. A window will appear where you have to select the material category of the
part you want to insert (see below). In the list select "herbarium sheets". 

Another dialog will appear where you are required to enter the collection where your
specimens are stored (see below).

Select the collection from the list or the hierarchy and click OK to close the dialog. The
bottom tree will now contain the selected material with all organisms (see below).

Let's assume that the insect is not present in the specimen, but e.g. has only been observed
during the collection of the sample. To document this remove the entry for the insect from
the Show in label list to the Units not in part list: Select it (see point 1 in image above) and
remove it (see point 2 in image above) (click on the < button). The result is shown below.
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To see the exact position within the collection click on the button at the left side of the
tree. The tree will change as shown below where all the collections and subcollections
together with the parts of the specimen are listed (see below).

To print a label for a stored part of the specimen select it in the tree (see point 1 in image
below) and click on the button in the upper right corner to open the area for the label (see
point 2 in image below). Click on the button (see point 3 in image below) to select a
Schema file (e.g. Standard.xslt). Then click on the button to generate a label (see point 4
in image below). 
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Turn to the Section part for more details.

 

This tutorial is continued in the sections listed below. 

 section Searching the database
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Tutorial - Query
To search for data in the database use the query sector in the left part of the window. To
select the query conditions click on the button in the top panel. A window will open as
shown below.

 

With the Maximum number of results you may limit the package size which should be
retrieved from the server. For a slow connection to the database server choose a low value
(e.g. 100 as set by default). 

The Limit for drop-down lists restricts the maximum number of drop-down lists which should
be created. For a slow connection to the database server choose a low value. The default is
set to 0 which means no drop-down lists will be created.

Click on the Check none button to clear the previous selection. Then select the entries 

 Project -> Project
 Specimen -> Accession number of specimen
 Specimen -> The user who created the data set
 Specimen -> The date when the data set was created
 Event -> Collection date
 Organism -> Organism present
 Organism -> Only observed
 Storage -> Material category
 Image -> Type

Click OK to close the window. Your query conditions will be displayed as in the image below.

Page 71



Project -> Project: Here you may choose from a list of possible entries. Select your current
project.

Collection specimen -> Acc. Nr.: From the operator drop-down list choose "~" and enter
the first letters of your accession number. You may include wildcards. Other options are e.g.
"-" for a range or ">" for a lower limit. The conditions will be interpreted as text! So 2 will
appear after 10 etc.

Collection specimen -> Creat. by.: From the operator drop-down list choose "=" and
choose your user name from the list.

Collection specimen -> Cre. dat.: From the operator drop-down list choose "=" and choose
the current date with the help of the calendar.

Collection event -> Date: >From the operator drop-down list choose "=" and enter the
current year in the last field.

Organism -> Presence: From the operator drop-down list choose "•" which means that an
organism is present.

Organism -> Only obs: Uncheck the checkbox to find organisms which were not only
observed.

Part of a specimen -> Mat.cat.: Use the button on the right of the combobox to open the
hierarchy and select "herbarium sheet".

After all query conditions are set, click on the button to start the query. In the result list
you should find the specimen created in this tutorial. To save your current query click on the 

button on the right of the button. A window will open as shown below. For more details
see the section Save query. 
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Queries - overview
To search for specimens in the database you may choose from 3 options. For a short
introduction see the tutorial .

User defined query

With the user defined queries you may define any query condition - this is the default query
mode. You may save and load these queries. 

With the button the filter criteria will be remembered and in combination with the optimized
query with the data corresponding the filter criteria will be preselected in the main window.
These options are not available for saved or predefined queries and the scan mode. 

 

Predefined queries

The predefined queries are defined by the system administrator and are accessible via the
menu Query - Predefined queries. To return to the user-defined queries click on the Show
query conditions button.

 

Scan mode
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With the scan mode you may use a barcode scanner or the camera of your computer or tablet
using e.g. bcWebCam to search for a specimen. To work with the scan mode select the Scan
mode in the Query menu. The query part will be hidden and the field for the scanned
identifier will be accessible for the entry via the scanner. As possible identifiers you can
choose among the accession number of the specimen , the ID of the specimen ID, the
accession number of the part or the identifier of the organism . If the field for the entry

of the identifier is not activated, move the mouse to the field to activate
it. Once you scan the barcode the program will start the search for the specimen in the
database. To return to another query mode deselect the Scan mode. To set the timer interval
of the scanner, click on the button.

 

The second scan mode for collection codes (stable identifier for collections) or the name
of the collection will list all specimen within a collection. For the query of collection names
these must be unique within the database. 
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Result list
The result list displays the specimens found in a query.

The specimens may be displayed with their e.g. with their accession number. To change the
information of the specimen shown in the list, choose among the option provided in the order
by: combobox. Some possibilities are shown above: identifications, storage location or
collectors number. After you changed the selection of the displayed information, you have to
start the query to see it in the result list. To view further information on the chosen field
simply place the mouse in the field. A text box will appear with the description of the field (see
below). 

 

You may restrict the maximum number of specimens and query options (click on the 
button), if you have for example a slow connection to the database. As a default the
maximum number is set to 100. If the number of data sets according to your query is higher
than the maximum value set in the query options, it will be indicated in the header of the list. 

To ensure that restrictions set in the query conditions will be applied to the specimen list
make sure that you choose matching restrictions and order columns as shown below. In the
upper example corresponding fields were used for restricting the query and the display (Tax.
name). Here the query results will be restricted to said field. 
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In the second example a different field for the restriction was chosen (Last ident. <> Tax.
name). The query result in consequence will list all data sets with entries found in the field
Tax. name and entries which match the restriction (see below).

 

To search for specimens enter the restrictions in the fields for the search conditions and click
on the button. The specimens found in the database will be shown in the result list. To
add specimens with differing search conditions click on the button. If the list of items is
longer than your maximum number of returned items you may browse the next items with the 

button. If you wish to remove entries from the selected list, choose them in the list and

click on the button. This will not delete the data from the database but remove them
from your query result.

The result list will contain data with Read only access. For these data all controls and menus
for editing the data will be disabled except the button for adding annotations .

Here are some examples you may select for display in the result list:

AccessionNumber: One entry is shown for each specimen with its corresponding accession
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number.

Last identification: The last identification for every unit in a specimen is shown in the list. As
there can be several units in one specimen, several entries for one specimen may appear in
the list.

Storage location: The storage location of every part of a specimen stored in the collections is
shown in the list. As parts of a specimen can be stored in several collections under different
names, several entries for one specimen may appear in the list.

Collecting number: The collecting number given by the collector of every sample of a specimen
is shown in the list. A specimen may have several collectors each with a different number.
Therefore, several entries for one collection specimen may appear in the list.
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Query
To hide the area containing the search fields click on the button. If the search area is
hidden and you wish to start a new search, simply click on the button.

To change the displayed fields for searching specimens click on the button to change the
query options.

The options for a search are displayed in the main window beneath the list of the items. You

may change this arrangement using the / button to place the query options on the left
side of the item list.

To search for specimens enter the restrictions in the fields for the search conditions and click
on the button. The specimens found in the database will be shown in the specimen list. To
add specimens with differing search conditions click on the button. To clear all entries in the
query fields use the button. You may save and load the queries you define using the and

buttons. If the list of items is longer than your maximal number of returned items, you may
browse the next items with the button. To move back to the previous block of items click
on the button. If you wish to remove entries from the selected list, choose them and click
on the button. This will not delete the data from the database, but remove them from your
query result. 

The results are sorted according to the column shown in the result list. With the resp. 
button you may change the order of the results between ascending and descending. Results
are sorted according to their string values, e.g M1, M10, M2. For the column AccessionNumber
in the table CollectionSpecimen you have the option to sort the values according to the
numeric value after a prefix (only for optimized query ). Use the context menu of the order
column and add the prefix you want to remove for the sorting. In the above example, select 

Add Prefix in the context menu and add M as a prefix. Than choose M (AccessionNumber)
as sorting column. The results will then be sorted like M1, M2, M10 that means according to
the numeric value after the prefix. To remove a prefix select Remove Prefix from the
context menu. In the upcoming dialog select the prefix you want to remove and click OK.

To see the command generated by the program to retrieve the data right-click on the 
button to open the context menu (see below).
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A window will open containing the command used to retrieve the data (see below). 

To keep the values you entered for the query, you can click on the button. It will change to
and when restarting the program your query values will be remembered 

To speed up the query you may use the optimized version (Standard query: Optimized
query: ). The optimized query in combination with the remembering option includes the
functionality to preselect data depending on the query restrictions, e.g. if you search for an
identification and enter a taxonomic name the first identification matching the restrictions will
be preselected in the main window as shown below. 

Certain query fields provide the option to add up to 3 duplicates of themselves. Use the 
button to add and the button to remove duplicates. The restrictions can be combined with
AND (+) and OR (|). Just click on the + resp. | sign to change between the modes. 

Within the query options you have several possibilities to specify your search restriction. Use
the drop-down menu to switch between operators. The available operators are shown in the
tables below. 
Availability: t = text, n = numeric, d = date, h = hierarchy, x = XML, e = EXIF, g = geography,
a = annotation, m = module 
For an introduction see two short tutorials 

Op. Meaning Example Avail.

∼ search for an entry like... Pinus s[iy]lvestris % (you
may use wildcards) tn---e--

= search for an entry exactly equal to ... Pinus silvestris L. tndh----
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≠ search for an entry not like... Pinus s[iy]lvestris % (you
may use wildcards) tn------

∅ search for an entry where a value is missing ... tndhxeg-

• search for an entry where a value is present ... tndhxeg-
- search for an entry between ... and ... 2000 - 2003 tnd-----

|
search within a list of entries, separated by "|" or one line per
value. If wildcards ("%", "_") are included the query will
search for values like the given values

2000 | 2003 ...
2000
2003

tn------

∈ search within a list of entries with one value per line.
Wildcards will be ignored

2000
2003 tn-----m

∉ search with exclusion of a list of entries with one value per
line. Wildcards will be ignored

2000
2003 tn-----m

± search for an entry where only parts of the date are present... -.-.2006 --d-----
Δ search including children in a hierarchy ... M-Fungi ---h----

/ Search for entries containing a given XML node (not for
EXIF) settings ----x---

¬ Search for entries not containing a given XML node (not for
EXIF) settings ----x---

‡ Search for entries with a maximal distance of ... POINT(24.24 45.243) | 50
km ------g-

O Search for entries within an area POLYGON(34.5 ... ------g-
¤ Search for entries outside an area POLYGON(34.5 ... ------g-
+H Search for entry including lower hierarchy Picea | Picea abies -------m
+S Search for entry including synonyms Picea abies | Pinus abies -------m

+HS Search for entry including lower hierarchy and symonyms Picea | Picea abies | Pinus
abies -------m

Op
er
at
or

Meaning
Ex
am
ple

Text

∼ search for an entry like ...

Pin
us
s[i
y]l
ves
tris
%
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(yo
u
ma
y
use
wil
dc
ard
s)

= search for an entry exactly equal to ...

Pin
us
silv
est
ris
L.

≠ search for an entry not like ...

Pin
us
s[i
y]l
ves
tris
%
(yo
u
ma
y
use
wil
dc
ard
s)

∅ search for an entry where a value is missing ...

• search for an entry where a value is present ...

- search for an entry between ... and ...

20
00
-
20
03

|

search within a list of entries, separated by "|" or
one line per value. If wildcards ("%", "_") are
included the query will search for values like the
given values

20
00
|
20
03
...
20
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00
20
03

∈ search within a list of entries with one value per
line. Wildcards will be ignored

20
00
20
03

∉ search with exclusion of a list of entries with one
value per line. Wildcards will be ignored

20
00
20
03

Numeric

= search for an entry exactly equal to ... 20
06

< search for an entry lower than ... 20
06

> search for an entry higher than ... 20
06

- search for an entry between ... and ...

20
00
-
20
03

| search within a list of entries, separated by "|" or
one line per value

20
00
|
20
03

∈ search within a list of entries with one value per
line

20
00
20
03

∉ search with exclusion of a list of entries with one
value per line

20
00
20
03

∅ search for an entry where a value is missing ...

• search for an entry where a value is present ...
Date

= search for an entry exactly equal to ...

20.
3.2
00
6
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< search for an entry lower than ...

20.
3.2
00
6

> search for an entry higher than ...

20.
3.2
00
6

- search for an entry between two dates...

20.
3.2
00
6 -
29.
3.2
00
6

± search for an entry where only parts of the date
are present...

-.-.
20
06

∅ search for an entry where the date is missing ...

• search for an entry where the date is present and
complete ...

Hierachy

= search for an entry exactly equal to ...
M-
Fu
ngi

≠ search for an entry which is not equal to ...
M-
Fu
ngi

∅ search for missing entry ...

• search for present entry ...

Δ search including children in a hierarchy ...
M-
Fu
ngi

XML

~ Search for entries like a given text (for EXIF) R
DF

/ Search for entries containing a given XML node
(not for EXIF)

set
tin
gs

¬ Search for entries not containing a given XML set
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node (not for EXIF) tin
gs

∅ search for missing entry ...

• search for present entry ...
Geography
Use button to set geography

‡ Search for entries with a maximal distance of ...

P
OI
N
T(
24.
24
45.
24
3) |
50
km

O Search for entries within an area

P
O
LY
G
O
N(
34.
5
...

¤ Search for entries outside an area

P
O
LY
G
O
N(
34.
5
...

∅ search for missing entry...

• search for present entry ...

For yes/no fields exists a checkbox with 3 options: = yes, = no, = undefined
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For a search within a lists (using the |, ∈ or ∉ operator) you may double click in the text field

to open a window where you can enter your values. To separate the values either use the "|"
sign or a new line as shown in the image below. 

 

Query modules

In the query for values linked to another module click on the button to open a window
where you can search for values within the linked module. A click on the button will show a
list of the selected items. For some modules you can choose the cache database as source (if
you have the proper permissions). This option provides a faster query esp. if e.g. the data of
a related module are accessed via a linked server.

Module related restriction tutorial: 

∈ Search for entries with a list ... Rosa | Rosa caninia | ...

∉ Search for entries not within a list Rosa | Rosa caninia | ...

+H search for entry including lower
hierarchy Picea | Picea abies | ...

+S search for entry including
synonyms Picea abies | Pinus abies | ...

+HS search for entry including lower
hierarchy and synonyms

Picea | Picea abies | Pinus abies |
...

Change filter mode between link
and text

http://tnt.diversityworkbench.de/T
axonNames_Plants/4269
Picea abies L.

 

Query annotation
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The query for annotations deviates from the standard query (see below). Additionally, you
may specify a type of the annotation (Annotation , Problem , Reference ) and the
linked table (see Annotation). 

Query any fields

The query for any fields will search in several fields, e.g. withholding reasons in specimen,
images etc. There are two versions: The first version (e.g. Notes) will search in all tables but
not in collection event tables while the second version (e.g. Any notes) will search in any
table (see image below). 
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Save query
If you wish to save a current query, click on the button. A window will open as shown
below where you may specify the title and description of you query.

After you entered title and description of the query, click OK to specify the query group. A
window will open as shown below. Standard queries are symbolized with an icon while
optimized queries are symbolized with an icon and yellow background (see below).
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Choose a group from the tree or create a new one and click OK. The new query will be
included in the selected group. 

Finally, you may edit the titles and descriptions of the groups and queries. Click the button
to store the changes. To delete items from the tree select the item and click on the button.
Click OK to save the new query and close the window.

Load query
If you wish to load a query which has been stored previously, click on the button. A window
will open as shown below. Please note that if the optimizer is activated, only the queries
created with the optimizer are available (not optimized queries are disabled). 
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For not optimized queries, the optimized queries will be disabled as shown below.

Choose a query from the tree and click OK to close the form and filter the data sets according
to the selected query.
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Query options
The maximum number of items shown in a query result may be set in the window for the query
options. The default value is set to 100. If you have a fast connection to your database or
need to see a different number of results, you may change this value to any number.
To change the displayed search fields click on the button. This opens a form where you can
select and deselect the fields shown for searching specimens. You might also change the
maximum number of items which will be shown in the result list. 

The limit for the creation of drop-down lists is by default set to 0. This means no drop-down
lists will be created. If you set the limit to e.g. 1000 and connect to a database, the program
will create a drop-down list based on the entries in the database. For slow connections you
may set this to a lower value to speed up the start of the program. 

The minimal numbers of characters for a selection from the drop down list is by default set to
3.

To search for a field within the database use the search function which will check the names
and descriptions of the fields and mark them as shown below. 
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After having edited the query options click OK to store you selection. The new selection will
become active for the next query. To ease the selection and deselection of query options you
may use the buttons Check all, Check none, Expand and Collapse. 
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Wildcards in SQL
There are 4 different possibilities for wildcards in SQL:

%    any string consisting of no, one or many characters, e.g. Pinus % will find anything like
Pinus, Pinus sylvestris, Pinus strobus etc. 

*     same effect as % (see above)

_     a single character, e.g. Pinus s_lvestris will find Pinus sylvestris and Pinus silvestris etc. 

[]      any character out of a given range like [abcde] or [a-e], e.g. Pinus s[iy]lvestris will find
Pinus sylvestris and Pinus silvestris. 

[̂ ]   any character not in a given range like [̂ abcde] or [̂ a-e], e.g. Pinus s[̂ i]lvestris will
find Pinus sylvestris but not Pinus silvestris. 
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Predefined queries
Besides setting queries for specimens via the query options you may define separate
predefined user-specific queries. These are listed in the menu topic Query - Predefined
queries.  

If you choose one of these predefined queries, the query options will be hidden and the
command of the query will be shown at the base of the specimen list. The first line shows the
title of the query, the next lines contain the description followed by the part of the query
command which restricts the selection of the data sets (= WHERE-clause of the
SQL-statement).

 

To return to the user-defined query click on the Show query conditions button. 

If you are an administrator, you may create new queries for users. To create a predefined
query choose Administration - Queries... from the menu. A window will open as shown
below, where you may create, edit and test your queries.
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In the upper field you define the WHERE-clause of the SQL string of your query. Keep in mind
that the queries can refer to different tables, depending on the order column chosen by the
user. Thus, queries in DiversityCollection should start with the reference to the primary key of
the main table (CollectionSpecimenID in table CollectionSpecimen and depending tables). The
lower field contains the description for the query as shown in the user interface. To test a
query use the [Test count] and [Test query] buttons.
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Editing the data
The main window of the DiversityCollection client contains two main areas. On the left you
find the query and the results of this query. On the right the data of the data set selected in
the results list is shown. The upper part of the data area shows images, labels etc. In the
lower part you find two trees that give you an overview and access to the data. The data of
an entry selected in one of the trees is shown in the data editing section. 

Common comments

To see the descriptions of the fields, just move the mouse over the field you want to know
more about. A tip-text window will open, showing the description of the expected content of
this field (see image below). These descriptions are also available in the documentation for the
tables. 

 

The descriptions of some of the drop-down fields are too long to be shown in the drop-down
column. However, for a selected entry you can place your mouse over the hierarchy selector.
A tip-text window will appear (see image below) where the full text of the description is
shown. 
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Tabulation
Besides of the main form, DiversityCollection provides 3 editors of the data in tabular form: 

 Table editors : Provide single table based access to the data of the query results in
the main form 

 Grids : Provide predefined tabular access to the data of the query results in the main
form 

 Spreadsheets : Provide predefined tabular access including the possibility to query
and filter data and can be used as starting form 

See a short tutorial for an introduction . 

Comparison of tabular forms

Property Table editors Grids Spreadsheets 

Range One table Predefined selection of
tables 

Predefined selection of
tables 

Query Depending on main
from Depending on main from Own query 

Filter Restricted Restricted Direct query in database 
Column sequence Fixed Changeable Fixed 

Start form No No Yes 
Different versions No No Yes 

Read only
projects No access No access Read only mode 

Data in map No No In TK25 sheet 
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Grid mode
To edit the data in a data grid choose the Grid mode for the specimen , the organisms

, the parts , the images the collection events or the collection event series from
the menu. A window will open where every data set from the query result list is restricted to
one line for a specimen, an organism, a CollectionEvent or a CollectionEventSeries
respectively. Please keep in mind you can only see a limited part of the data while in this
view. For example only the last identification of an organism will be displayed. This is
demonstrated in the image below where two organisms, indicated with the red arrows, will not
appear in the grid. If you use the grid mode for the organisms, all organisms will appear with
their last identification. 

 

Customize column headers

The names of the columns may be changed using the description of the database. 

 

Customize visibility of fields

The selection of the visible fields can be adapted in the tree above the list. Change the
selection of the columns and click on the [Set columns] button. 

 

 

Customize column width and sequence

To adapt the width of the columns or the height of the rows either drag the border with the

Page 99



mouse or double click the border to get the optimal size for one column. You may also click on
the button for an optimal height of the rows or the button for an optimal width of the
columns. To change the width and sequence of the columns simply use your mouse to drag
the columns to the position of your choice or adapt the width to your preference. These
changes will be saved for this session as well as for the next time you use the grid mode. To
return to the original sequence of the columns click on the [Reset sequence] button. 

 

Sorting of the data

To sort the data in the grid simply click in the header of the column which you want to use as
sorting column. The sorting sequence will be kept even if you change values in this column.
This means if you change a value in the sorting column, the changed data set will be placed
at the new position according to its new value. The sorting of a column will be indicated by an
arrow for the direction of the sorting (up or down) and by a thicker right border of this column
(see image below).  

 

 

Find and replace

To use the find and replace functions you must either select a part of the field in this column
or click on the button to select the entire column. You may then choose the function you
wish to apply (remove, insert, append or replace). To replace a part of a text in the selected
fields enter the text which should be replaced and enter the replacement in the corresponding
fields. To start the replacement click the button. To insert a string to the beginning of
all entries in the selected fields click the button. To append a string to all entries in the
selected fields click the button. To remove all entries from the selected fields click the 
button. 

 

Transfer from spreadsheet

You can transfer data from a spreadsheet e.g. Excel or Calc. Copy the columns of this data
from the spreadsheet and then insert it in DiversityCollection. Click in the upmost left cell
where this data should be transferred to and use the context menu (click the right mouse
button) to insert the data. 
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Editing

Some columns can not be edited directly but are linked to external modules or services. These
columns appear as buttons. Simply click on the button to call the service. If a value is linked
to an entry in an external module, the background will change to yellow and you will not be
able to change the text. 

 

Together with the links (in the example above Link to DiversityAgents) you can select columns
that provide the possibility to release the links to the modules (e.g. Remove link for collector

in image above). These columns will appear as buttons . Simply click on the button related
to a link to release the link to the corresponding module. After that you can edit the text field
containing the linked value.

Some values are linked to a list of values. Use the drop-down list to change the value in one
of these columns. 

 

New dataset

If you click in the empty line at the base of the data grid, you will be asked if you wish to
create a new data set. The program will ask you for a new accession number and the project
of the new data set. Another way to create a new data set is the copy button . Simply
click in the line you wish to create a copy of and then click on the copy button . For details
see the Data section. A copy of the data set will be inserted at the base of the data grid. 

 

Saving the data

To save all changes click on the button. To undo all changes since the last time the data
sets were saved click on the button. To save the changes in the current data set use the

button. To undo the changes in the current data set click the button. If you click the
[OK] button, you will be asked whether you would like to save the changes before the window
will be closed. If you click the [Cancel] button or close the window your changes will not be
saved. To export the data shown in the grid as a text file with tabs as column separators click
on the button. 
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Grid mode for CollectionSpecimen
To edit the data of the specimens in a data grid choose the Grid mode for the specimen 
from the menu. A window will open where every data set for a specimen from the query result
list is restricted to one line. Please keep in mind you can only see a limited part of the data
while in this view. For example only the last identification of an organism will be displayed. This
is demonstrated in the image below where two organisms, indicated with the red arrows, will
not appear in the grid. If you use the grid mode for the organisms, all organisms will appear
with their last identification. 

 

Customize visibility of fields

The selection of the visible fields can be adapted in the tree above the list. Change the
selection of the columns and click on the [Set columns] button. 

 

 

Customize column width and sequence

To adapt the width of the columns or the height of the rows either drag the border with the
mouse or double click the border to get the optimal size for one column. You may also click on
the button for an optimal height of the rows or the button for an optimal width of the
columns. To change the width and sequence of the columns simply use your mouse to drag
the columns to the position of your choice or adapt the width to your preference. These
changes will be saved for this session as well as for the next time you use the grid mode. To
return to the original sequence of the columns click on the [Reset sequence] button. 
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Sorting of the data

To sort the data in the grid simply click in the header of the column which you want to use as
sorting column. The sorting sequence will be kept even if you change values in this column.
This means if you change a value in the sorting column, the changed data set will be placed
at the new position according to its new value. The sorting of a column will be indicated by an
arrow for the direction of the sorting (up or down) and by a thicker right border of this column
(see image below).  

 

 

Find and replace

To use the find and replace functions you must either select a part of the field in this column
or click on the button to select the entire column. You may then choose the function you
wish to apply (remove, insert, append or replace). To replace a part of a text in the selected
fields enter the text that should be replaced and enter the replacement in the corresponding
fields. To start the replacement click the button. To insert a string to the beginning of
all entries in the selected fields click the button. If the selected column is a link to a module
or webservice, a button will appear where you can search for a linked data set. The insert
will set the selected column and related columns according to the linked data set. Thus, if you
choose e.g. a value from the DiversityGazetteer, the coordinates and the country will be
changed as well. Click on the link to see all related information. To reset the link use the 
button. To append a string to all entries in the selected fields click the button. To remove
all entries from the selected fields click the button. 

 

Transfer from spreadsheet

You can transfer data from a spreadsheet e.g. Excel or Calc. Copy the columns of this data
from the spreadsheet and then insert it in DiversityCollection. Click in the upmost left cell
where this data should be transferred to and use the context menu (click the right mouse
button) to insert the data. 

 

Editing

Some columns can not be edited directly but are linked to external modules or services. These
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columns appear as buttons. Simply click on the button to call the service. If a value is linked
to an entry in an external module, the background will change to yellow and you will not be
able to change the text. 

 

Together with the links (in the example above Link to DiversityAgents) you can select columns
that provide the possibility to release the links to the modules (e.g. Remove link for collector

in image above). These columns will appear as buttons . Simply click on the button related
to a link to release the link to the corresponding module. After that you can edit the text field
containing the linked value.

Some values are linked to a list of values. Use the drop-down list to change the value in one
of these columns. 

If you click in the empty line at the base of the data grid, you will be asked if you wish to
create a new data set. The program will ask you for a new accession number and the project
of the new data set. Another way to create a new data set is the copy button . Simply
click in the line you wish to create a copy of and then click on the copy button . For details
see the Data section. A copy of the data set will be inserted at the base of the data grid. 

In the grid view for the organisms a part of the columns can not be edited. These columns
contain data which can be related to several organisms. This is indicated by a gray
background. 

The Relation has two states: 

either external   (the column Related
specimen URL will be shown in the interface)

or internal. 

  (the
column Related specimen display text will be shown in the interface)

Use the Relation is internal column to change the state and the Link to DiversityCollection for
relation column to set an internal relation.  

 

Saving the data

To save all changes click on the button. To undo all changes since the last time the data
sets were saved click on the button. To save the changes in the current data set use the

button. To undo the changes in the current data set click the button. If you click the
[OK] button, you will be asked whether you would like to save the changes before the window
will be closed. If you click the [Cancel] button or close the window your changes will not be
saved. To export the data shown in the grid as a text file with tabs as column separators click
on the button. 

 

Inserting new data

To insert a new data set simply click in the last empty line of the data grid. The program may
ask you to specify a project in which the new data should be placed. In the grid for the
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organisms a window will open as shown below. 

  

Here you have the option to insert the new data set of the organism in the last specimen in
the grid or to create a new specimen for the organism. In the second case you can specify
the accession number of the new specimen. Use the [Find Acc. Nr.] button to search for the
next free accession number in the database which matches your entry in the [Accession
number] field.

For new data sets you can specify certain project settings e.g. the material category of a
part of the specimen. The taxonomic group of a new organism will correspond to the first
organism in your last specimen unless you specify a certain taxonomic group in the project
settings for the project you are working in. To enter or change a setting you need the
module DiversityProjects. For further information please turn to the documentation provided
with this module. 

 

Copy data

To copy a data set select the line of the data grid you wish to create a copy of and click on
the button. For further details, see the chapter Copy specimen. 
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Grid mode for the organisms
To edit the data of the organisms in a data grid choose the Grid mode for the organisms 
from the menu. A window will open where every data set for an organism from the query result
list is restricted to one line. Please keep in mind that you can only see a limited part of the
data in this view. For example only the last identification of an organism will be displayed.  

In the grid view for the organisms a part of the columns can not be edited. These columns
contain data which can be related to several organisms. This is indicated by a gray
background. 

 

Customize the window

To change the width and sequence of the columns simply use your mouse to drag the columns
to the position of your choice or adapt the width to your preference. These changes will be
saved for this session as well as for the next time you use the grid mode. To return to the
original sequence of the columns click on the [Reset sequence] button. 

To adapt the width of the columns or the height of the rows either drag the border with the
mouse or double click the border to get the optimal size for one column. You may also click on
the button for an optimal height of the rows or the button for an optimal width of the
columns. 

The selection of the visible fields can be adapted in the tree above the list. Change the
selection of the columns and click on the [Set columns] button. 

 

Analysis

In this grid you can edit up to 10 different types of analysis, however, only the last analysis
will be shown for each type. By default the available analysis types will be generated
dynamically depending on the data. If you need an additional type in the grid, simply return to
the main form and enter the required type in one of the data sets. If you wish to specify
which analysis you want to see in the grid, you can set the list in the options. Click on the 
button to open a window as shown below. 
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Here you can restrict the range of the dates of the analysis and the types of the analysis
which should be displayed. To change the entries in the list use the and buttons to add
or delete entries. 

 

Sorting of the data

To sort the data in the grid simply click in the header of the column which you want to use as
sorting column. The sorting sequence will be kept even if you change values in this column.
This means if you change a value in the sorting column, the changed data set will be placed
at the new position according to its new value. The sorting of a column will be indicated by an
arrow for the direction of the sorting (up or down) and by a thicker right border of this column
(see image below).  

 

 

Handling the data

Some columns can not be edited directly but are linked to external modules or services. These
columns appear as buttons. Simply click on the button to call the service. If a value is linked
to an entry in an external module, the background will change to yellow and you will not be
able to change the text. 

 

Together with the links (in the example above Link to DiversityAgents) you can select columns
that provide the possibility to release the links to the modules (e.g. Remove link for collector

in image above). These columns will appear as buttons . Simply click on the button related
to a link to release the link to the corresponding module. After that you can edit the text field
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containing the linked value.

Some values are linked to a list of values. Use the drop-down list to change the value in one
of these columns. 

If you click in the empty line at the base of the data grid, you will be asked if you wish to
create a new data set. The program will ask you for a new accession number and the project
of the new data set. Another way to create a new data set is the copy button . Simply
click in the line you wish to create a copy of and then click on the copy button . For details
see the Data section. A copy of the data set will be inserted at the base of the data grid. 

In the grid view for the organisms a part of the columns can not be edited. These columns
contain data which can be related to several organisms. This is indicated by a gray
background. 

Find and replace

To use the find and replace functions you must either select a part of the field in this column
or click on the button to select the entire column. You may then choose the function you
wish to apply (remove, insert, append or replace). To replace a part of a text in the selected
fields enter the text which should be replaced and enter the replacement in the corresponding
fields. To start the replacement click the button. To insert a string to the beginning of
all entries in the selected fields click the button. To append a string to all entries in the
selected fields click the button. To remove all entries from the selected fields click the 
button. 

To save all changes click on the button. To undo all changes since the last time the data
sets were saved click on the button. To save the changes in the current data set use the

button. To undo the changes in the current data set click the button. If you click the
[OK] button, you will be asked whether you would like to save the changes before the window
will be closed. If you click the [Cancel] button or close the window your changes will not be
saved. To export the data shown in the grid as a text file with tabs as column separators click
on the button. 

To copy a dataset select the line of the data grid which you wish to create a copy of and
click on the button. A copy of the selected data set will be added at the base of the
spreadsheet.  
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Grid mode for the organisms of a specimen
To edit the data of the organisms of a specimen select the specimen entry in the tree and
click on the button in the panel on the right. A window as shown below will open with the
functionality of the grid for the organisms but restricted to the organisms of the current
specimen.
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Grid mode for the parts of the specimen
To edit the data of the parts in a data grid choose the Grid mode for the Parts...  from
the menu. A window will open where every data set for a part from the query result list is
restricted to one line. Please keep in mind you can only see a limited part of the data while in
this view. For example only the last processing or analysis of a certain type of a part will be
displayed. 

 

Customize the window

To change the width and sequence of the columns simply use your mouse to drag the columns
to the position of your choice or adapt the width to your preference. These changes will be
saved for this session as well as for the next time you use the grid mode. To return to the
original sequence of the columns click on the [Reset sequence] button. 

To adapt the width of the columns or the height of the rows either drag the border with the
mouse or double click the border to get the optimal size for one column. You may also click on
the button for an optimal height of the rows or the button for an optimal width of the
columns. 

The selection of the visible fields can be adapted in the tree above the list. Change the
selection of the columns and click on the [Set columns] button. 

 

Analysis

In this grid you can edit up to 10 different types of processing, however, only the last
analysis will be shown for each type. To specify which analysis you wish to see in the grid
click on the button to open a window as shown below. 

Here you can restrict the range of the dates of the analysis and the types of the analysis
which should be displayed. To change the entries in the list use the and buttons to add
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or delete entries. For taxonomic groups which miss certain types of analysis the columns will
be blocked. 

 

Processing

In this grid you can display up to 5 different processings, however, only the last processing
will be shown. You can define a time range for the processing that should be displayed and /
or restrict the processing to a certain type (see image below). For material categories which
miss certain types of processing the columns will be blocked. 

 

Sorting of the data

To sort the data in the grid simply click in the header of the column which you want to use as
sorting column. The sorting sequence will be kept even if you change values in this column.
This means if you change a value in the sorting column, the changed data set will be placed
at the new position according to its new value. The sorting of a column will be indicated by an
arrow for the direction of the sorting (up or down) and by a thicker right border of this column
(see image below).  

 

Selecting of the data

To restrict the data in the grid you can filter an entry. Select the entry for which you want to
filter and click on the button. To remove data from the grid select the rows which should be
removed and click on the   button.   

 

Handling the data

Some columns can not be edited directly but are linked to external modules or services. These
columns appear as buttons. Simply click on the button to call the service. If a value is linked
to an entry in an external module, the background will change to yellow and you will not be
able to change the text. 
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Together with the links (in the example above Link to DiversityAgents) you can select columns
that provide the possibility to release the links to the modules (e.g. Remove link for collector

in image above). These columns will appear as buttons . Simply click on the button related
to a link to release the link to the corresponding module. After that you can edit the text field
containing the linked value.

Some values are linked to a list of values. Use the drop-down list to change the value in one
of these columns. 

If you click in the empty line at the base of the data grid, you will be asked if you wish to
create a new data set. The program will ask you for a new accession number and the project
of the new data set. Another way to create a new data set is the copy button . Simply
click in the line you wish to create a copy of and then click on the copy button . For details
see the Data section. A copy of the data set will be inserted at the base of the data grid. 

In the grid view for the parts a part of the columns can not be edited. These columns contain
data which can be related to several parts. This is indicated by a gray background. 

 

Find and replace

To use the find and replace functions you must either select a part of the field in this column
or click on the button to select the entire column. You may then choose the function you
wish to apply (remove, insert, append or replace). To replace a part of a text in the selected
fields enter the text which should be replaced and enter the replacement in the corresponding
fields. To start the replacement click the button. To insert a string to the beginning of
all entries in the selected fields click the button. To append a string to all entries in the
selected fields click the button. To remove all entries from the selected fields click the 
button. 

To save all changes click on the button. To undo all changes since the last time the data
sets were saved click on the button. To save the changes in the current data set use the

button. To undo the changes in the current data set click the button. If you click the
[OK] button, you will be asked whether you would like to save the changes before the window
will be closed. If you click the [Cancel] button or close the window your changes will not be
saved. To export the data shown in the grid as a text file with tabs as column separators click
on the button. 

To copy a dataset select the line of the data grid which you wish to create a copy of and
click on the button. A copy of the selected data set will be added at the base of the
spreadsheet.  
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Grid mode for the CollectionEvents
To edit the data of the CollectionEvents in a data grid choose the Grid mode for the
event from the menu. A window will open where every data set for a CollectionEvent from
the query result list is restricted to one line. Please keep in mind you can only see a limited
part of the data while in this view. For example only a part of the localisation will be displayed
(see below). 

 

Customize the window

To change the width of a column simply use your mouse to adapt the width to your
preference. To hide or show parts of the window use the button for the setting of the
visible columns, the button for the hierarchy tree and the button for the images in the
upper right corner of the window. If the hierarchy tree is visible ( , see below), you have
access to the CollectionEventSeries which are linked to the CollectionEvents. Here you can
edit the hierarchy via drag & drop. Please keep in mind that ramifications within the hierarchy
can only be realized using EventSeries with CollectionEvents placed within and specimen

placed within the CollectionEvents. To insert a new EventSeries use the button below
the tree. 
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To change the width and sequence of the columns simply use your mouse to drag the columns
to the position of your choice or adapt the width to your preference. These changes will be
saved for this session as well as for the next time you use the grid mode. To return to the
original sequence of the columns click on the [Reset sequence] button. 

 

Customize visibility of fields

The selection of the visible fields can be adapted in the tree above the list. Change the
selection of the columns and click on the [Set columns] button. 

 

 

Sorting of the data
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To sort the data in the grid simply click in the header of the column which you want to use as
sorting column. The sorting sequence will be kept even if you change values in this column.
This means if you change a value in the sorting column, the changed data set will be placed
at the new position according to its new value. The sorting of a column will be indicated by an
arrow for the direction of the sorting (up or down) and by a thicker right border of this column
(see image below).  

 

Formatting the grid

To adapt the width of the columns or the height of the rows either drag the border with the
mouse or double click the border to get the optimal size for one column. You may also click on
the button for an optimal height of the rows or the button for an optimal width of the
columns. 

 

 

Handling the data

Find and replace

To use the find and replace functions you must either select a part of the field in this column
or click on the button to select the entire column. You may then choose the function you
wish to apply (remove, insert, append or replace). To replace a part of a text in the selected
fields enter the text which should be replaced and enter the replacement in the corresponding
fields. To start the replacement click the button. To insert a string to the beginning of
all entries in the selected fields click the button. To append a string to all entries in the
selected fields click the button. To remove all entries from the selected fields click the 
button. 

 

Editing

Some columns can not be edited directly but are linked to external modules or services. These
columns appear as buttons. Simply click on the button to call the service. If a value is linked
to an entry in an external module, the background will change to yellow and you will not be
able to change the text. 

 

Together with the links (in the example above Link to DiversityAgents) you can select columns
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that provide the possibility to release the links to the modules (e.g. Remove link for collector

in image above). These columns will appear as buttons . Simply click on the button related
to a link to release the link to the corresponding module. After that you can edit the text field
containing the linked value.

Some values are linked to a list of values. Use the drop-down list to change the value in one
of these columns. 

 

Saving the data

To save all changes click on the button. To undo the all changes since the last time the
data sets were saved click on the button. To save the changes in the current data set use
the button. To undo the changes in the current data set click the button. If you click
the [OK] button, you will be asked whether you would like to save the changes before the
window will be closed. If you click the [Cancel] button or close the window your changes will
not be saved. To export the data shown in the grid as a text file with tabs as column
separators click on the button. 
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Grid mode for the CollectionEventSeries
To edit the data in a data grid choose the Grid mode for the CollectionEventSeries from
the menu. A window will open where every data set for a CollectionEventSeries from the query
result list is restricted to one line (see below).  

 

Customize the window

To change the width of a column simply use your mouse to adapt the width to your
preference. To hide or show parts of the window use the button for the hierarchy tree and
the button for the images in the upper right corner of the window. If the parts are shown,
the icon will have red background e.g. .

History and feedback

To inspect the history of a data set click on the button. A window will open as described in
the History chapter. To send a feedback use the  button. Details are described in the
Feedback chapter. 

Sorting of the data

To sort the data in the grid simply click in the header of the column which you want to use as
sorting column. The sorting sequence will be kept even if you change values in this column.
This means if you change a value in the sorting column, the changed data set will be placed
at the new position according to its new value. The sorting of a column will be indicated by an
arrow for the direction of the sorting (up or down) and by a thicker right border of this column
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(see image below).  

 

 

Handling the data

To save the changes click on the button. To insert new data sets use the button for a
CollectionEventSeries and the button for a CollectionEvent. 
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Grid mode for the images of the specimen
To edit the data of the images in a data grid choose the Grid mode for the Images... 
from the menu. A window will open where every data set for an image from the query result
list is restricted to one line (see below).  

 

Sorting of the data

To sort the data in the grid simply click in the header of the column which you want to use as
sorting column. The sorting sequence will be kept even if you change values in this column.
This means if you change a value in the sorting column, the changed data set will be placed
at the new position according to its new value. The sorting of a column will be indicated by an
arrow for the direction of the sorting (up or down).  

 

Selecting the data

To restrict the data in the grid you can filter an entry. Select the entry for which you want to
filter and click on the button. To remove data from the grid select the rows which should be
removed and click on the   button.   

 

Handling the data

Some columns can not be edited directly because they are linked to external modules or
services. These columns appear as buttons. Simply click on the button to call the service. If a

Page 119



value is linked to an entry in an external module, the background will change to yellow and
you will not be able to change the text. 

Next to the links there are columns which allow you to remove a link to the corresponding

module . Simply click on the button to remove the link. After that you can edit the text
field containing the linked value.

Some values are linked to a list of values (e.g. Image type). Use the drop-down list to change
the value in one of these columns. 

 

Find and replace

To use the find and replace functions you must either select a part of the field in this column
or click on the button to select the entire column. You may then choose the function you
wish to apply (remove, insert, append or replace). To replace a part of a text in the selected
fields enter the text which should be replaced and enter the replacement in the corresponding
fields. To start the replacement click the button. To insert a string to the beginning of
all entries in the selected fields click the button. To append a string to all entries in the
selected fields click the button. To remove all entries from the selected fields click the 
button. 

To data are automatically saved when you close the window. To undo all changes click on
the button.  
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Table editors
For the data selected in the main window the table editors offer a direct access to the tables
of the database as shown in the image below. In the hierarchy tree of the main window every
entry corresponds to a table in the database, marked for the image below for the tables
CollectionEvent and IdentificationUnit. Underneath the menu Grid  select one of the Table
editors (see below). For an introduction see a short tutorial . 

A window with the content of the table will open. Columns with a gray background can not be
edited here. Columns with a light gray background are linked to the contents of lookup tables
where you can change according to the contents of these tables. If you are using the
optimzed query certain columns that are linked to lookup tables show the translated content
instead of the IDs. With the  ID  button you can change back to the original, not translated
content of the table. The tables below are examples for those that are included for direct
access via a table editor: 

 Collection events 
 Collection event localisations 
 Collection event site properties 
 Specimens 
 Collectors 
 Specimen images 
 Organisms 
 Identifications of the organisms 
 Analysis of the organisms 
 Specimen parts 
 Processings of the specimen parts 
 Transactions of the specimen 
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Select Set timeout ... from the menu to increase the default timeout from 5 seconds to a
higher value, e.g. for greater amounts of data.   

With the button you can set the widths of the columns according to the header and the
content. With the button the width is set to the content. After the column width is set,
this will be indicated with a yellow background . Click again on the button to release the
setting of the column width ./font>    

 

Editing 

You can either edit the contents of the table directly or perform changes to any number of
marked fields. For an introduction see a short tutorial . To mark a whole column use the 
button. Once you have selected the contents to change, select one of the modes of change
that appear in the upper left corner. The modes of change are: 

 Insert: Insert the given value at the beginning of the content 
 Append: Append the given value at the end of the content 
 Replace: Replace a string in the content with the given value 
 Clear: Remove the content of the field (for removal of the whole dataset see below

- Deleting ) 

After selecting the change mode, enter the text in the field where necessary and click on the
corresponding button to perform the changes 

 

Filtering 

To filter the content of the table, click in the column that should be used for filtering. Then
choose the mode of comparison:

 = : The content must be exactly like the given value 
 ~ : The content must contain the given value 
 ≠ : The content must be different to the given value 

If you want the filtering to be case sensitive, choose the a<>A option. After all parameters
are set, click on the button. To undo the filtering, click on the button. This will reset the
data to the last saved version. If you want your changes to be saved, click the button
before you reset the filtering. If you close the window all changes so far will be saved
automatically. So if you do not want to save your changes, click on the button before
closing the window. For an introduction see a tutorial . 

 

Deleting 

To delete the data from the database, mark them as shown in the image below and click on
the button.  
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Copy & Paste 

To move data within a table, you can select them and choose Copy from the context menu.
Then select the place where the data should be copied to and choose Paste from the
context menu. To remove selected data, choose Clear selected cells. This is demonstrated
in a short tutorial .   

 

Export 

For an introdution see a short tutorial .

To export the data as a tab separated text file, click on the button. The file will be
automatically saved in your application directory.. 

To export the data in a SQLite database click on the button. The data will be exported into
the SQLite database DiversityCollectionTables.sqlite in the folder Export in your application
directory. If you want to save previous exports, please rename the SQLite database or copy it
to a different directory.  

Log data 

To see the log data of the table, you can click on the button. The content of the log table
can not be changed, but is read only.   
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Spreadsheets 
The spreadsheets similar to the grids provide a tabular access to the data. In addition you
can search and filter data independent from the main form. For an introduction see two short
tutorials (overview), (tables and columns). To open a spreadsheet, choose Grid - 
Spreadsheets - and then one of the provided versions, e.g. Organisms from the menu. A
window as shown below will open where the data are marked and organized according to the 
database tables. If values in one of the tables are missing, this will be indicated with a  grey
background . The colors correspond to the overview for the database. 

Start 

To use any of the spreadsheets as a starting window, click on the  button. Now the
application will directly open the spreadsheet with the same parameters when you close it.  

 

Database 

To change to another database, click on the button and choose the database as described
here. Please keep in mind that the main form will connect to the new selected database.  

 

Project 

If a user has read only projects available, a button will appear in front of the project. Click
on this button to change to the list of projects with read only access. The window will change
into the Read only mode (see below). To return to the list of projects with write access, just
click no the button again. After changing the source for the project list, the project label will
blink with red to remind you, to select a project from the list.  

 

Getting the data 

The data are always restricted to one project, selected in the corresponding field (see image
above) and restricted to the first top lines as specified in the Max. res. field. To change to
the next or previous block of data, use the resp. button.  
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The program will organize the data in blocks indicated by the colors as shown above. In the
example above the first block contains 2  Organisms all belonging to the block starting with
 Hildesheim... for the Event and   M-0014196 for the Specimen. The next block then
starts with  Hildesheim... indicated by a change in the color containing 2  Organisms . As long
as you do not sort or filter the data (see below), these blocks will be consistent with the
data. As soon as you filter or sort the data, these blocks may be split and may not correspond
to the data blocks in the database any more. In the example below you see the effect of
sorting by the column Taxon on breaking up the blocks. E.g. the block for the specimen  
 M-0036950 is split into 2. 

 

SQL

The query used for the retrieval of the data can be accessed with a click on the SQL button.

 

Filtering 

To filter the content of a table you can apply a filter either on the whole table or on each of
the columns of the table.

Table filter 

Page 125

http://media.snsb.info/Tutorials/DiversityCollection/Editing/Spreadsheet/Tabellenfilter.wmv


This filter will apply on the whole table. Click in the black box next to the filter area and select
one of the filter options as shown below.

  ♦ : Filled (all visible columns) 
  ◊ : Empty (all visible columns) 
  • : Data in table do exist 
  Ø : Data in table do not exist 

Column filter 

This filter will apply on a single column of a table. To set a filter click in the field underneath
the column name. A window as shown below will open. With a click on the button you can
enter a value from the current content of the column as filter.

Here you set the sorting (see below), enter the search string and choose among several ways
of comparison with the contents in the database:

  = : The content must be exactly like the given value 
  ≠ : The content must be different to the given value 
  ~ : The content must be similar to the given value, use wildcards % for any string or _

for a single character 
  ¬ : The content must NOT be similar to the given value, use wildcards % for any

string or _ for a single character 
  < : The content must be smaller than the given value 
  > : The content must be bigger than the given value 
  | : The content must be in a given list of values 

  ∉ : The content must NOT be in a given list of values 

For columns linked to modules of the DiversityWorkbench there may be additional options. E.g.
for a column linked to DiversityTaxonNames you get 3 additional options: 

  +H : Include lower Hierarchy 
  +S : Include Synonyms 
  +H+S : Include lower Hierarchy and Synonyms 

After selecting one of these options, you will be asked for the database and the project where
the data should be taken from. In the next step the corresponding names as retrieved from
the selected source will be listed (see below). To change the filter click on the button and
on the button to remove it.

Sorting ↓↑ 
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The data can be sorted by each visible column. If you click into the field underneath the
column name a window will open as described above. To change between the modes of
sorting, just click on the current sorting. The modes are:

  - : Not sorted 
  ↑ : Sorted in ascending sequence 
  ↓ : Sorted in descending sequence

After all parameters are set, the sort mode and filter settings will be shown in the field
underneath the column name (see image below). The number indicates the sequence within
the sorting columns.

 

Timeout 

After all parameters are set, click on the button. If for any reason you get a timeout,
meaning the query for the data takes too long, either simplify your query or adapt the time for
the query after a click on the button. If you do not want to restrict the time for the
queries, set the value to 0. The default value is 30 seconds.  

 

Read only mode <> 

The formatting of the sheet including the color indication of tables and data blocks is rather
time consuming. If these are not needed, e.g. for exporting the data, you can switch to the 
Read only mode for higher performance. For projects with read only access (see above),
the mode is automatically set to Read only.  

 

Editing 

To edit the data, just change them. If data are missing, type or select a value in the
corresponding field. To remove data, click on the  x  field. This will remove all entries
dependent on this entry that means all data right from the entry in the same line resp. block
and any depending data. If there are any depending data, a window will open as shown below
listing these data. Click OK if you want to remove the selected data including all depending
data as shown in the window. 
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To change the content of several values in a column, either select the whole column with a
click on the  button or select the fields manually. To avoid the pop-up of data-entry
windows e.g. for columns with a lookup list, click no the button. Once you have selected
the contents to change, select the mode of change: 

 Prepend: Insert the given value at the beginning of the content 
 Append: Append the given value at the end of the content 
 Overwrite: Remove current content and insert given value
 Replace: Replace a string in the content with the given value 
 Clear: Remove the content 

After selecting the change mode, enter the text in the field where necessary and click on the
corresponding button to perform the changes.

With the context menu (mark area and right click) you can Remove data (for single data
fields with a list behind), Tranfer or Copy the content into the clipboard and Insert the
content of the clipboard into the selected cells. 

 

Fixed sources 

For columns that are linked to a remote module, you can fix the source for the query. If the
source is fixed, the query will directly contact the source as shown in the image below. To set
resp. change the source, click on the button. A window will open where you can select
either a webservice or a source database together with a project within the database. To
remove the source, click on the button (only visible if a source is present).

To see an overview for the fixed sources, click on the button. A window will open where all
sources are listed with the source for the current column marked with a yellow background.  
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A "right-click" on the button in the main form will show the settings as well and with a click
on the button you can set the connection for the selected column. If a column depends on
values from the data as for example the relations to the module DiversityTaxonNames with a
dependence on the taxonomic group, the relation will change with the selected row,
depending on the data retrieved from the selected row. If there is no connection to the
related module defined, the button will appear gray and if the column has no relation to a
module, the button will appear like . 

If the source is not fixed the query will start as described here. 

 

Settings 

To change the data shown in the query results, either click on the header of the tables, e.g. 
   Event     for that table. A window as shown below will open where you can select or
deselect columns, change their headers etc. Red columns need to be filled (either by the
database, the program or the user). In the Alias field you can rename the columns to your
preferences. The button will show a description of the columns. For columns linked to a
module, the current settings for the link will be shown in addition to the description. To display
a column in the sheet use the checkbox . If a column is needed, but should be hidden,
select the checkbox. Displayed columns are indicated by a yellow background while hidden
columns get a light yellow background. Certain columns are required (indicated by a purple
color) and can not be removed e.g. if they are involved in a link to a remote module like in the
example below the columns FamilyCache and OrderCache. Columns linked to a module are
indicated by a blue color. 
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The button allows you to include one of the tables missing in the sheet (see image below).
After selection of the table, select the column(s) you want to include in the sheet as shown
in the image above. 

To store resp. load settings, use the resp. button. If a setting file has been corrupted
click on the button to remove it and restart with factory settings. The spreadsheet will
always start with the previous settings. The location where the settings are stored are set
under Administration - Resources directory ... . For an introduction see a short tutorial .

 

Column width 

The width of the columns can be set manually (in the filter area) or automatically with a click
on the button. A window will open where you can choose and set the parameters for
setting the column width.

 

Adding 

To add new data, use the area underneath the data table. You can enter preset values that
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will be used for the new data. If the new data should be added to existing entries, select the
corresponding row. Then click on the  + field of the datarange that should be inserted. If
preset values are given, all corresponding tables will be filled together with the new inserted
data. Defaults for the responsibles can be set under Administration - Customize Display. If a
column is linked to a remote module, the corresponding columns will be filled together with the
selection of the link, so e.g. if you select a link for a taxonomic name to a
DiversityTaxonNames the columns for the taxon and if available the familiy etc. will be filled as
well. To remove a linked value, select it a choose Remove from the context menu (right
click).

 

Export 

To export the data as a tab separated text file (UTF8), click on the button. You will be
asked if you want to include the hidden columns. These are the primary keys you may need
for statistic evaluations etc. 

 

Feedback 

To send a feedback to the developer of the software, create a screenshot and click on the 
 button.  

 

Details 

To see all details of a dataset, select the dataset in the sheet and click on the button. A
window, corresponding to the main form will open, showing all data related to the selected
specimen.  

 

Image 

If an image is present a preview will be shown in the right upper area of the window. Click on
it to see the image in a separate form. The images are restricted to the first image of one
source, so e.g. in the organisms sheet only the first image of the specimen linked with this
organism will be shown while images of e.g. linked to none or another organism or the
collection event will not be addressed.  
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Spreadsheet - Maps 
For certain spreadsheets you can display the content in a map. The content will be displayed
with the GIS-Editor like in the example below. 

To set the symbols etc. representing the values, click on the button. A window as shown
below will open, where you can set the parameters for the map.  

Transparency      

For the creation of heat maps, the transparency of the symbols displayed in the map can be
set to a value below 255 (= no transparency).

  

Symbols 

The symbols can be linked to the value within the database. A typical example would be the
status of a plant, e.g. endagered, rare etc. stored as an analysis. Choose the Table where
the values should be taken from. Now you can choose the column within the table. The
different values will be listed and you can attribute a symbol together with the size to every
listed value. In the image below, the symbols are linked to the values of a column named Last
Nr for a certain analysis.  
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The tables in the drop down list (see above) correspond to the content and definitions in the
spreadsheets. Accordingly the values the symbols are linked to are restricted to the current
content of the spreadsheet. As an alternative and in preparation for data containing other
values to get the whole range of possible values you can select the source for the values
from the whole database. Click on the button to select the source table. The programm will
try to find the relevant data an make a proposal as shown in the image below. 

If the proposal does not fit, set the source manually: In the window that will open as shown
below, choose the source table for the values and click OK. (The table names in this list
correspond to those in the database)  

This will open the source table as shown below. Here choose the column for a filter, e.g.
AnalysisID, select the type of comparision and enter the restriction value. Now you can click
on the button to restrict the values. In the example below the values were restricted to the
analysis with the ID = 2. Finally select the column containing the values you need
(AnalysisResult in the example below) and click OK (see below).  
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Now all values from the source are listed, not only those contained in the data form the
spreadsheet (see below). The button will change to and will now remove the source, to
return to the values contained in the spreadsheet. If certain values should not appear in the
map, choose as symbol.  

If the list does not contain a missing value, a separate control will appear at the end of the
list, where you can set the symbol for missing values (see below). 
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The size of the symbols can be set either for every symbol or for all symbols with the button 
Set this size for all symbols. Another option is to link the size of the symbols to a numeric
value within the data (see below). Choose the table and the column within this table
containing the numeric value. 

 

Colors 

The colors can be linked to numeric values within the database. Select the table and the
column where the values should be taken from. Now click on the button to add colors and
the restrictions linked to the colors as shown below.  
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Legend 

With a click on the button, you can open a window listing all symbols and colors with their
attributed values (see below). In the spreadsheet window, click on the button underneath
the button to open the legend.  

 

Evaluation 
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There are 3 types of maps available: 

Map for WGS84 geography of organisms 

For this map type you have to set the table and the column containing the WGS84 geography,
i.e. a content like POINT(45 ... )  for the organism as shown below. Every entry will be shown
in the map with its exact geography. 

 

Map with WGS84 coordinates 

For this map type you have to set the table and the column containing the WGS84 geography,
i.e. a content like POINT(45 ... ) for the collection event as shown below. Every entry will be
shown in the map with the symbol placed in the center of its geography. 

 

Map for objects aggregated according to TK25 quadrants

Filter table / Column: For this map type all objects within a TK25 quadrant will be
aggregated to one value. For the filter according to which the aggreagation is performed, you
have to select the table and the column containing the combination of the TK25 identifier and
the quadrant (see below). 

Gazetteer for retrieval of TK25 coordinates. The coordinates for the symbols will be
obtained from a gazetteer module. Please select the source as shown in the example below. 

Sequence of the symbols as shown in the map: The sequence of the symbols resp. the
states linked to these symbols can be set here. Use the button to add an entry at the end
of the list and the button to clear the whole list. To remove a single entry from the list, just
click the entry you want to remove.   
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With the option Keep last valid symbol if later data are missing you can keep the last valid
symbol if in the later evaluated data the correspondig values are missing.   

 

Map 

To display your data in a predefined map you can set this map with a click on the button as
shown below. 
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With the option Show details in map the tooltip in the map will display the details of the
data as selected in the spreadsheet (see below). The widths in the tooltip roughly
corresponds to those set in the spreadsheet.  

Page 139

http://media.snsb.info/Tutorials/DiversityCollection/Editing/Spreadsheet/Maps/Details.wmv


 

Maps for organism geography , WGS84 coordinates of the collection event and
TK25 

After the parameters for the map are set you can choose among 3 types of maps:

Map with WGS84 geography of the organisms 

This map will show the geography of the organisms.

 

Map with WGS84 coordinates of the collection event 

This map will show all entries with a WGS84 geography.

 

Map for objects aggregated according to TK25 quadrants

This map will aggregate all entries according to the TK25 quadrants as shown below. 
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To select the data that should be edited either use the frame (as described in GIS: Save
samples  and  GIS: Settings ) or select resp. deselect single data with the mouse. Click OK to
close the map and return to the spreadsheet containing only the data selected in the map for
further editing. For the TK25 map the filter will be set for the TK25/Quadrant column while
for the WGS84 map the filter will be set for the column IdentificationUnitID corresponding to
organisms shown in the map. The column IdentificationUnitID will be shown in the spreadsheet
if you use the later filter. 

As only one symbol and color can  be shown for every quadrant, a certain routine is used for
the determination. 

Color: For the color sortable values must be provided, e.g. the year or a period. The sorting
will be according to the values were the highest value (e.g. the last year or period as
determined by the user, see above) is preferred. 

Symbol: For the symbol the sorting is determined by the user (see above). 

The default routine for the determination:

 Reduce the values for the quadrant to the first digit e.g. 2413 will be reduced to 2
 Test every data row in the table that corresponds to the filter value (e.g. TK25 +

Quadrant as determined by the user, see above). 
o The geography can not be determined - ignore this row. (The geography is

determided via a gazetteer, see above)
o The value for the color is missing - ignore this row.
o The value for the color found in the data row is higher than the value found so

far 
 Use this row to determine the color

o The value for the color in the data row is higher than the color value associated
with the symbol found so far 
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 Use this row to determine the symbol 
 The row contains NO value for the symbol and the option "Keep

last valid symbol if later data are missing" is NOT selected 
 Use the symbol for missing values (determined by the

user, see above)
o The value for the color in the data row is equal to the color value associated

with the symbol found so far 
 The value for the symbol in the row is above the value found so far 

 Use this row to determine the symbol
 No value for a symbol is found 

o Use the symbol for missing values (determined by the user, see above)
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CollectionEvent
Specimens stored in a collection are gathered during a CollectionEvent. This CollectionEvent
keeps for example information about the geographic locality, the habitat, the collection date.
During a CollectionEvent several specimens may have been collected. To create a new event
for a specimen click on the button. If a specimen has not been assigned to a
CollectionEvent, you can assign the specimens to an existing event with a click on the 
button. If you assign the specimen to an existing event, a window will open where you can
search for the events already included in the database as shown below. Choose an event and
click OK to assign the specimen to this event. If you click OK without selecting any
CollectionEvent, the current CollectionEvent will be removed from the CollectionSpecimen.

 

In the tree view the CollectionEvent is symbolized by an icon as shown below. 

 

The CollectionEvents can be organized in a hierarchy either by using CollectionEventSeries or
sampling plots. If your CollectionEvents belong e.g. to an expedition, you should preferably
use CollectionEventSeries for the organization. 

 

If your samples are taken e.g. on a regular basis from permanent sampling plots, you may
prefer to use the module DiversitySamplingPlots to document the geography and other details
of the sampling plots and use the CollectionEvents only to document the collection date. 

 

To edit the data of the CollectionEvent choose it in the tree view to open the detail fields as
shown below. If the collection date does not correspond to a certain day, you may use the 
Suppl. field to enter e.g. a range or a series of dates or the T.span field to document a
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certain time span.

 

The text shown in the tree view is composed of the date of the CollectionEvent and the
description of the locality. For each CollectionEvent you can enter several geographical
locations and properties. To see the locality according to the coordinates stored in the
database you can check the Maps. For each CollectionEvent you can enter images related to
this event.

If other specimens were collected during the same CollectionEvent, they will be displayed
once the entire hierarchy of the EventSeries is shown. To do this click on the button in the
panel on the left side of the tree. See EventSeries for further details. You can also move a
specimen to another event by drag and drop. 

Besides of a plain text description of the methods used during the CollectionEvent, you may
insert methods as defined in the chapter Methods. Use the and buttons to add or remove
methods from the list (see below)

If parameters are added to the methods after you added the method to the event, these new
parameters will not automatically be available in the event method. The new parameters must
be added via the Maintenance or with a click on the button. A window as shown below will
open where you can select the parameters that may be added.

Data is stored in the table CollectionEvent.
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CollectionEventSeries
If you need a hierarchical order of your CollectionEvents or to organise your CollectionEvents
(e.g. to document expeditions), you can do this with a CollectionEventSeries. For a better
differentiation between events and CollectionEventSeries there is blue text in the hierarchy as
well as the editing part and a different icon . A CollectionEventSeries can contain other
CollectionEventSeries and CollectionEvents. Information about the geographic locality,
properties of the collection site, date of collecting etc. is stored in the  CollectionEvent. To
show or hide the CollectionEventSeries you have two options. In the panel of the left of the
tree the button will show the superior EventSeries of the current CollectionEvent as shown
below. 

 

The button will show the entire hierarchy of the EventSeries as shown below.

 

To edit the data of an EventSeries select it in the tree to display the detail fields as shown
below.

New EventSeries

To insert a new CollectionEventSeries click on the button. If there are no
CollectionEventSeries so far, the CollectionEvent will be placed within the new
CollectionEventSeries. If there are CollectionEventSeries present, the new
CollectionEventSeries will be placed below the selected CollectionEventSeries. To assign a
CollectionEvent to an existing CollectionEventSeries already available in the database click on
the icon.
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To move an item within the hierarchy just drag it with the mouse to whatever position it
should be placed in. Keep in mind that specimens can only be placed in CollectionEvents and
CollectionEvents only in CollectionEventSeries.

Removing EventSeries

If you want to delete a CollectionEventSeries or a CollectionEvent, remove all depending
CollectionEventSeries, CollectionEvents and specimens and click on the  button. A specimen
can not be deleted here. 

If you want to remove a CollectionEvent from a CollectionEventSeries, click on the 
button to open the window for selecting a CollectionEventSeries. Then select nothing but
simply click OK to remove the link to the CollectionEventSeries. 

Images

To display the images, choose Series images in the header menu. To add images to a
CollectionEventSeries click on the button, to remove an image use the button. The
presence of images of the eventseries is indicated by a yellow backgroud of the lower button
of the buttons in the right upper corner. These buttons may be used as a shortcut for the

display of the images .

To zoom a sector of the image simply move the mouse over the image. A red square will
indicate the zoomed area. To set the size of the image to the original resolution click on the 

button. To adapt the size of the image to the available space in the form click on the 
button. To change the orientation of the image use the appropriate buttons ( flip
horizontally, flip vertically, rotate right, rotate left). To view the image in a separate
form click on the button. If the image should not be published e.g. on the internet, enter
any reason in the Withhold reason field. Besides images you can also store other media. 

Hierarchy

If you want to change to another specimen listed in the CollectionEventSeries, select it in the
hierarchy and click on the  button. 

The current specimen together with the event and all superior CollectionEventSeries will be 
highlighted. 

Geography
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The CollectionEventSeries can contain a geographical object (using WGS84) such as a point, a
line, an area etc. To edit or show the geographical object related to the CollectionEventSeries
either click on the Geography button in the details next to the notes field select the Map
in the header to show the maps and use the GIS editor .

Storage

The data of the CollectionEventSeries is stored in the table CollectionEventSeries. 
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Event images 
The specimens stored in a collection are gathered during a CollectionEvent. To insert an image
related to a CollectionEvent, select the event image in the header menu to display the
images of the collection event. In case the event images are not displayed, a yellow (image(s)
present) resp. gray (no image) backgroud of the tiny buttons at the upper right corner

indicates the presence of images . 

In the list (see below) click on the  button. If you want to delete an image, click on the 
button.  For more details see the section Images.

If for any reason an image should not be published i.e. shown on a website, enter the reason
in the field Withholding reason. Only images where this field is empty will be shown e.g.
on websites. The EXIF data are extracted from the image during the import, e.g. via 
DiversityMobile. 

Data is stored in the table CollectionEventImage .
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Geography
As additional information to the description of the locality you can use several localisation
systems, e.g. georeferencing. These entries are marked with an icon in the tree as shown
below.

 

To add a new entry choose the localisation system from the drop-down list as shown below.
Only items which are not already set for a CollectionEvent will be shown. The items visible in
the drop-down list can be customized. 

If a localisation should be removed, select it from the list and click on the  button.

 

GIS editor

To define an area for the locality you can use the GIS editor. For further details please see
the help sections for the corresponding pages.

 

Coordinates (WGS84)

If you use geo-coordinates as georeferencing system (coordinates WGS84), a button  will
appear which will provide you with the possibility to set or correct the coordinates via Google
Maps. Just click on the  button and a window will open with a map provided by Google Maps
as shown below. If there are already coordinates provided by a different localisation e.g. by
the DiversityGazetteer, these will be taken as a starting position. Thus, you may use an entry
for a named area (DiversityGazetteer) as an approximate localisation and use additional
coordinates for a more accurate localisation. 
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If you start with existing geographic coordinates (WGS84) in your data, the system will use
these as starting point. You can zoom the map, drag it to another position and change from
map to satellite mode. The actual position is symbolized by the  symbol in the middle of
the map. The current coordinates are shown in the field at the bottom of the map. To include
these coordinates in your data simply click OK.

With the Set start coordinates button you can set the coordinates which GoogleMaps
should use as a starting position.

Please keep in mind that Google Maps coordinates are based on WGS84. 

If there are no entries for the altitude and the named area, this data will be retrieved from the
webservice ws.geonames.org and entered into the database. The source will be documented
in the Notes field. Subsequent changes in the coordinates using the GoogleMaps function will
update the altitude and named area entries provided they are derived from a webservice
(ws.geonames.org) as documented in the Notes field. 

Please keep in mind that the place names provided by ws.geonames.org may differ from
those depicted in GoogleMaps.

 

To enter the localisations listed above simply enter the Coordinates WGS84. If an
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appropriate webservice is available (e.g. geonames) the Altitude and Named area will be
added automatically.

 

 

Named areas - DiversityGazetter

The localisation system DiversityGazetteer is linked to the module DiversityGazetteer within
the DiversityWorkbench and providing information on geographical names as shown below. The
module DiversityGazetteer may contain several independent lists of geographical names, e.g.
political and biogeographical regions. You therefore may add up to 5 links to the module
DiversityGazetteer. 

 

 

TK25 (MTB) 

The source data for TK maps are stored in the module DiversityGazetteer. You need an access
to a database of this module containing these data. If you choose MTB or TK25, the button

will open a window where you can set the TK25 as well as the quadrant (see image below).
Choose the quadrant depending on your preferred resolution. The thick line shows the current
quadrant, the thin line the entire TK25. The needle in the center is placed at your current
position. If you click on it, a message box will display the TK25 information as shown below. 

Page 151

http://www.geonames.org/


If you click [OK], the TK25 values together with the coordinates of the center of the selected
quadrant will be entered into the database.

 

Conversion of values 

The values for any localisation system are stored in two text fields. You can enter your values
as simple text. This may, however, prevent any calculations with said values. Thus, you
should preferably enter your values according to the measurement units available. Whatever
obsolete measurement units like feet or Fahrenheit may exist, within the DiversityWorkbench
measurement data is stored in units according to the Système International d'Unités (SI). For
those who still need to use these obsolete units DiversityCollection provides a possibility to
convert them into their modern counterparts. To enter a numeric value choose the unit you
prefer from the list. The form will change as shown below.

 

You can then edit the values and click on the  button to incorporate the changed values
into your data. The system will calculate the corresponding value for storage in the database
together with the default accuracy. You may correct this accuracy if you have more exact
values. To indicate that the shown values are calculated from the values in the database the
fields have a green background. When you save the data DiversityCollection will store
geographic coordinates and the average altitude, if available, in separate fields.

The altitude, the exposition or the slope may be entered as one value or as a range of two
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values. If you use the conversion function and have only one value, make sure that the
second field is empty.

Available units: meter and feet. 

Available units: Orientation (N, NE,
... ) and degree rel. to North. 

Available units: degree and
percent. 

The accuracy and uncertainty respectively will be calculated as an approximation in parts
derived from Wieczorek, J. 2001 (MaNIS/HerpNet/ORNIS Georeferencing Guidelines. University
of California, Berkeley: Museum of Vertebrate Zoology) and in parts according to Wieczorek,
J., Q. Guo, and R. Hijmans 2004 (The point-radius method for georeferencing locality
descriptions and calculating associated uncertainty. International Journal of Geographical
Information Science 18: 745-767). The unit of the accuracy will always be the unit stored in
the database according to the Système International d'Unités (SI) and degrees for angles
respectively.

The data for the geography is stored in the table CollectionEventLocalisation. 
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Maps of samples in the database
If there are WGS84 coordinates available for your collection site, an event series or single
organisms, you can use GoogleMaps to display these locations.

To use this service you need access to the internet. Select the Map for display in the
header area to show the maps. Here you can display maps of CollectionEventSeries, 
CollectionEvent, Organism as well as Distribution maps. To display the maps you can
either use the browser, the GIS viewer or the GIS editor. By default the map will show
the location of the CollectionEvent using the browser as shown below. 

For the CollectionEventSeries, the CollectionEvent or the Organism you can use any
geographical object like points, lines, areas, etc. to describe the location. The browser will
always display these objects as points (see left image below) whereas with the GIS editor you
can see and edit the real objects (see right image below). 
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The data of the geographical objects is stored in the table CollectionEventSeries for the
collection event series, the table CollectionEventLocalisation for the collection event and the
table IdentificationUnitGeoAnalysis for the organisms.
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Sampling plots
If your samples are collected at constant sampling plots, you may use the module
DiversitySamplingPots to describe said SamplingPlots. For a better differentiation between
events and the SamplingPlots there is a brown text in the hierarchy as well as a different icon

. A SamplingPlot can contain other SamplingPlots and CollectionEvents. Information about
the geographic locality and properties of the collection site can be stored in the SamplingPlot,
while the collecting date must be stored in the CollectionEvent. To show or hide the
SamplingPlots you have two options. In the panel on the left of the tree the button will
show the superior SamplingPlots of the current CollectionEvent as shown below. 

 

The button will show the entire hierarchy of the SamplingPlots as shown below.

 

If you select a SamplingPlot in the hierarchy, two buttons will appear in the bar to the left of
the tree. With the button you can retrieve a taxon list for the SamplingPlot. With the 
button you can retrieve a summary of the information on a SamplingPlot (see image below). 
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To edit the data of a SamplingPlot please use the module DiversitySamplingPlots.

The link to the module DiversitySamplingPlots is stored in the table CollectionEventLocalisation
. 
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Distribution maps
If WGS84 coordinates are available for your collection sites, you can create distribution maps
of your samples in the database. To use this service you need access to the internet.
Choose Map in the header to show the maps. To display distribution maps choose the
appropriate option from the first drop down list in the maps control. 

To add data sets to the distribution search for the data sets you want to see in the map,
mark them in the list (either use the button to mark all data sets, mark a list/single data
sets or check the option for the distribution map) and click the button. To display the
map click on the button. The displayed localities in the map will not change until you add

new localities or click the button to start with a new distribution map. If you want to set
different icons for the positions of different series of your samples, set the style of the icon
(symbol, color, size etc.) in the menu before you add them to the distribution list.

To show a distribution map of all the specimens found in your query as shown below, select
the option Distribution from the drop down menu. For the display in the map you can
choose either the Browser (see below) or the GIS-Editor. In the browser all objects will
be shown with their center coordinates and the number of specimens that can be depicted is
limited, thus, it may be necessary to restrict your query. With the GIS editor all objects will be
shown with their whole geography (e.g. an area will not be reduced to its central coordinates)
and there is no limit to the number. Furthermore you can vary the symbols for different
groups.

 

The upper distribution map is restricted to coordinates of the collection event . If you
want to include coordinates from the organisms , choose the distribution map including
organisms . For the positions of the organisms in this map, the ID of the organism ( =
IdentificationUnitID, 528577 in example below) is shown as identifier and the last identification
( = LastIdentificationCache) as display text (Ajuga reptans L. in example below). 
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If you want to restrict the display to the organisms, click on the  button to open the
window for custimizing the display (see below) and deselect all localisation systems for the
collection event.
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While in the GIS tool the objects are represented with their real geography (see above), in the
browser every object is reduced to a single point. For an introduction see a short tutorial .
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Habitats and properties of the collection site
For the description of the habitat select the CollectionEvent or an existing collection site
property . The description is entered in the field Habitat (see below).

To enter a new property of the collection site select the CollectionEvent or an existing
collection site property . Then choose the type of the property you wish to enter from the
drop-down menu as shown below. Only items which are not already set for a CollectionEvent
will appear in the list. You can customize the selection of visible items. 

 

The list is dependent on the availability of terminologies for site descriptions. Details for the
property can be entered if you choose the item in the hierarchy. The person responsible for
the entry as well as notes can be entered in the corresponding fields as shown below.

 

To delete entries use the  button. You can enter a value by either typing the name of the
collection site property or by selection from the module DiversityScientificTerms. To search for
properties from this module click on the  button. The current user's name will be inserted as
the responsible user. You may change this by either typing or through selection from the
module DiversityAgents.

The data concerning the habitats is stored in the table CollectionEventProperty.

 

Administration of properties (resp. terminologies)

To administrate the available properties of collection sites, choose Administration - Site
properties... from the menu. A window as shown below will open, where you can delete
existing site properties and add new site properties. 
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To add new properties, click on the button, select the new entry in the list and choose the
appropriate parsing method. 

Properties should be linked to the module DiversityScientificTerms. To link the property to
the module, click on the  button. A window as shown below will open, where you can
search for the terminology provided by the module. Please keep in mind, that the ID of the
terminology will be used for the new entry and that this ID must be unique. Turn to your
administrator if any difficulties occur. 
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After choosing the terminology from DiversityScientificTerms, the new property will be
displayed as shown below.. 
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Specimens
Specimens are the entities stored in a collection. For handling the data use the appropriate
buttons (new specimen , copy , delete ). See the Data section for further details.
Directly attached to the specimen is the data about accession, label, exsiccatae, notes,
reference and the availability. A specimen may be composed of several units. Any problems
concerning the specimen should be entered into the problems field. 

The header of the main window shows some important parameters for the selected specimen.
On the left side the accession number is shown. In the center you find the last identification
of the main IdentificationUnit according to the display order. The http:/ link shows the public
address of the selected item. Click on it to see the public available values. The next field
shows the internal IDs (field CollectionSpecimenID in table CollectionSpecimen and
CollectionEventID in table CollectionEvent) and the Versions for the specimen and the
CollectionEvent. For details about the version of a data set see the Version topic. The
availability of a specimen can be changed by entering an appropriate reason in the field
Withholding reason. 

If the specimen is a type, the header will show the type state and the identification
connected with the type (see below).

To inspect the history of a specimen click on the button. For further details see the History
section.

In the header menu you can determine what is shown in the upper part of the window.
Choose on of the options: will show the printing area, images for the specimen, the
images for the  collection event and the images of the collection event series. will show the
maps. To hide the upper part, select Hide.

The tiny buttons in the upper right corner provide a shortcut to the image displays and

indicate the existence of images by a yellow background . 

The data is stored in the table CollectionSpecimen . 
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Data
The controls for handling data sets in the database are located in the left upper part of the
window as shown in the image below. A step-by-step introduction for the creation of new
data sets is provided in the Tutorial.

- To SAVE the changes in a data set click on the button. If you select another data set
from the list of results, the current changes will be saved automatically.

- To UNDO the changes in a data set, click on the button. This will recover the original
data unless the changes have been saved or changes were done in certain tables or
hierarchies were the data must be stored to display the hierarchy.

- To create a NEW entry in the database click on the button. This will create a new
record of a specimen and show it in the list of results.

- To COPY the data of a specimen record choose it from the list and click on the button.
For further details, see the chapter Copy specimen. 

 

- To DELETE a data set you must have the proper rights (e.g. be a member of the group
Administator). Select the dataset you want to delete it in the list and click on the button. 

To delete all selected specimen choose Data - Remove specimen... from the menu. A
window as shown below will open where you can choose if the data from the log and the
collection events should be included in the removal.

Page 165



Tree for the specimen
The upper tree in the window provides an overview for all the data linked with the specimen.
With the buttons in the left panel you may hide or show certain nodes in the tree. If for
example you do not wish to see the collectors, simply click on the button and they will be
hidden in the tree. The button will change to a grey version and the background will turn
yellow to show that there is hidden data of the collectors. 

If the CollectionEvent is part of a CollectionEventSeries, a drop-down button will appear
where you may select between 3 states: 

 = show the parent EventSeries
 = show the entire hierarchy of the EventSeries
 = hide the EventSeries

If the CollectionEvent is linked to a SamplingPlot, a drop-down button will appear where you
may select between 3 states: 

 = show the parent SamplingPlots
 = show the entire hierarchy of the SamplingPlots
 = hide the SamplingPlots

If both options are available, you may choose between the CollectionEventSeries or the
SamplingPlot hierarchy. If the entire hierarchy for the EventSeries or the SamplingPlots is
displayed, the items not included in the current data set will be displayed with gray icons,
e.g. . To change to one of these use the button. For the Events, the EventSeries, the
Plots and the Specimen a button will appear which will give you access to a taxon list of
the selected item. 

The panel on the right side of the tree is used for editing the data, for example the button
will insert a new collector. For further details see the special sections. For data with Read
only access these panels are disabled except the button for adding annotations .  
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Display order 
The display order defines the sequence in which the units within this specimen will appear on
e.g. a label. The first unit will be printed in the header of the label, others are included in the
text below. You can change the display order by using the   buttons. If a unit should not
appear on the label, transfer it to the hide list using the  button. The  button returns it to
the list to be shown on a label. The first unit can not be transferred to the hide list. 

The upper section shows the display orders of the units within the whole specimen. The lower
section shows the display orders in a specimen part. If you print a label without reference to a
part, the display order for the entire specimen as in the upper section will be used. This part is
also accessible if you click on the button in the right panel of the upper tree, which will
appear if you e.g. select the specimen.     

If you print a label with reference to a part, the display order for the part as in the lower
section will be used. This area will be shown when you select a specimen part in the lower
tree. In addition to the display order you can specify whether an organism is present in a
selected part of a specimen. With the button you can transfer all organisms into the part.

To change the sequence of the parts according to e.g. the name instead of setting all entries
one by one, you may choose among the options shown in the image below (Name, Identifier,
ID).
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Accession
The accession of a specimen in a collection is documented with its accession number and the
date of the accession if available.

If the specimen was received from another collection, this may be documented with the name
of the depositor and the number in the original collection (Dep.Nr). 

If the current project (= as selected in the query list) contains a duplicate of the accession
number, a button will appear. This gives you the opportunity to switch to the specimen with
the duplicate accession number.

If a new specimen is entered you can use the button to search for the next free
accession number. A window will open as shown below, where you can begin the search. The
search will start with the number you provide as a starting point. 

 

The system will try to find the next free number based on the accession numbers available in
the database. As accession numbers can be assigned to a specimen as well as a part of a
specimen, you have the option to include accession numbers in both places in the query. Click
OK to use the recommended number for the specimen.

Data concerning the accession and deposition are stored in the table CollectionSpecimen.
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Specimen images
To see the specimen images select the specimen image in the header menu. Each specimen
may be documented with several images. The images are stored as their path, either locally or
provided by a server. To enter a new image click on the button. For more details see the
section Images.

To delete an image select it from the list and click on the button (see below).

To change the sequence of the images, use the resp. buttons to change the position of
the selected image. To adapt the sequence of the whole list, you can select one of the
options offered when you click on the button: Ordering ascending resp. descending by the
name (= URI) or the creation date of the images. For a short introduction see the tutorial . 

To change the image sequence for a whole project, use the functionality within maintenance 
maintenance. 

To document the relation of an image to an organism or a part of the specimen choose the
corresponding entries from the drop-down lists Organisms: and/or Part:. 

To restrict the displayed images to either images which are related to a certain part or a
certain organism within the specimen, choose e.g. the organism in the tree. If the selected
organism is related to any image the button (see below) will change to .   

Click on the button to restrict the images displayed in the list to those, which are related to
e.g. the selected organism. The button will receive a red background    to remind you of the
restriction. Next to the image list a button will appear which enables you to show all images
again. 

To enter a description for an image click on the button (see the chapter Image description
for further details).

The data is stored in the table CollectionSpecimenImage.
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Projects
Every CollectionSpecimen may be assigned to any number of projects. To assign a specimen
to a project click on the button. To add a project where you have no access to, use the 
button. To remove a specimen from a project select the project from the list and click on the 

button.

 

If there are projects, to which you have no access to, these will be listed in a separate list
at the top as shown below.

 

Projects, to which you have Read only access will be listed in a separate list at the top as
shown below.

Data from Read only projects can be seen but not edited. Only Annotations can be added
(see image below).
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To transfer all selected specimen into an additional project choose Data -> Transfer -> 
To project... from the menu. A window will open where you can select the project to which
the specimen should be added.

To remove all selected specimen from an additional project choose Data -> Remove from
project... from the menu. A window will open where you can select the project from which
the specimen should be removed. The last project in which a specimen is placed can not be
removed.

 

The data are stored in the table CollectionProject.

Details of the projects within the DiversityWorkbench are stored in the database
DiversityProjects. To access further information on a project click on the button. To edit
details in projects you require the application DiversityProjects.exe in your application
directory and access to the database DiversityProjects. To synchronize the projects listed in
DiversityProjects you may use the synchronize function in the user administration window as
shown below. If DiversityProjects is not available, you may create a new project by clicking
the button. If DiversityProjects is available, use the synchronize function

.

 

The diagram below shows all tables with direct relations to the project tables. For more details
see the sections Analysis, Processing and Image description.
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Notes and problems
To enter notes or problems connected with the specimen select it in the hierarchy. The data
form will open the corresponding fields. The Original notes are the notes found on the label of
the specimen, made by the original collector or from a later revision. Additional notes are
those made by the editor of the specimen record, e. g. doubtful identification or locality. 

In the Problems area enter the description of a problem which occurred during data editing.
Typically these entries should be deleted after help has been obtained. Do not enter scientific
problems here. Use Additional notes for such permanent problems! 

The data is stored in the table CollectionSpecimen.

For notes on data created by users with no permission for editing see the chapter Annotation
.  
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Organisms and identifications
Each specimen can contain several organisms and each organism may have been identified
several times as shown in the image below.

 

To see the list of organisms within a Specimen, CollectionEvent, EventSeries or SamplingPlot
use the taxon list function.
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Organisms (= Identification Units)
The items or organisms in one CollectionSpecimen are regarded as IdentificationUnits. One
specimen can contain several IdentificationUnits e.g. an insect (1) feeding on a fungus
(2) growing as a parasite on a plant (3). To add a new organism use the drop-down menu as
shown below to select the taxonomic group to which the new organism belongs to.

 

To specify the taxonomic groups that are shown in the drop-down menu select Administration
- Customize display ... from the menu. 

The organisms of the specimen are shown in the tree. To edit the relations between the
organisms simply drag and drop. The name of the organism under which the specimen is stored
in the collection is underlined. To delete an organism select it in the tree and click on the 
button.

To enter details about one of the organisms like e.g. gender or life stage, select it in the tree.
The fields for the details of this organism will be displayed in the right area of the window as
shown below. 

If the Identification unit is e.g. not a complete organism you can enter a description for this
IdentificationUnit. Either type you description or choose one of the predefined descriptions via
combobox or hierarchy: Use the combobox to select a description as found for the same
taxonomic group in the database or use the hierarchy-selector to select a predefined
description. An additional description can be entered for an IdentificationUnit within part of a
CollectionSpecimen.

Taxonomic hierarchy - family and order

The entries for the family and the order of the taxon are either set when linking to a
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taxonomic database or set manually when no link to a taxonomic database exists.

 

If no link to a taxonomic database exists you may enter the family and the order after clicking
on the button. To transfer these entries to other specimens with the same genus use the
maintenance functions as described under Maintenance - family and order.

Parts of units

If a unit contains parts which have to be documented, you can do this by setting the relation
to the substrate to "Part of". 

 

In the tree the background of a part will be grey as shown below for the unit-tree und the
tree depicting the storage of a sample. The name of the part will correspond to the identifier
set for this part. The icon will correspond to the description of the part provided you choose
one of the preset options contained in the drop-down list. You may of course enter any
description for the unit. A unit that is part of another unit can not get an identification.
Identifications are restricted to the main unit.

  

 

Parent-child relations

If a unit is a genetic child of a parent, choose "Child of" as type of the relation. If there are 2
parents like mother and father that you want to document, click on the button next to the
relation type. A window will open where you can choose among the organisms (= units) in
your sample. The second parent will be indicated with the symbol in the tree (see below). 

For details about exsiccatal series and analysis see the related topics. You can sort your
IdentificationUnits e.g. for display on a label with the display order button. Each
IdentificationUnit can have several identifications.

With the template you can define and copy predefined values into the data (see chapter
Template).   
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If there are images which are related to the current organism, the button for the restriction of
the images will be enabled ( → ). Click on it to restrict the images to this organism. The
button will get a red background   to remind you about the restriction and in the image list
a button will appear that enables you to show all images.

Non biological units
Non biological units like soil, rock or mineral do not have biology related characters like
family or sex. These are therefore not displayed for these groups.  

 

The data for the organisms and non biological units are stored in the table IdentificationUnit.
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Taxonomic groups
The organisms and corresponding objects stored in the database are organized in taxonomic
groups to facilitate the recognition in multi organism samples and to enable a specific design
for the analysis where e.g. plants differ in recorded measurements from mammals. The
taxonomic groups are roughly orientated on the taxonomy but are not meant to replace the 
taxonomy for which there are other possibilities for entry. The list of taxonomic groups visible
for the creation of new entries may be restricted as described in the chapter about the 
customization. 

To administrate the taxonomic groups, choose Administration - Taxonomic groups... from
the menu. A window as shown below will open.  

To add resp. remove a taxonomic group use the resp. button. To set the superior
taxonomic group use the button. With the button you can set a symbol for the
taxonomic group. Please keep in mind, that this will be converted into a 16 x 16 size icon. In
the lower part of the window, you can add and edit translations for display texts,
abbreviations etc. for all contexts available. The non-biological taxonomic groups like soil,

rock or mineral will for an identification not be linked to DiversityTaxonNames but to
DiversityScientificTerms (see image below and the short tutorial ). If you add a new
taxonomic group anything outside the predefined groups animal, alga, bacterium, bryophyte,
fungus, gall, lichen, myxomycete, plant or virus will be regarded as non-biological. The sources
for direct access using the buttons are linked to the taxonomic groups (see Settings). 
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Retrieval type
The ways the data about organisms and corresponding objects stored in the database are
retrieved are documented as retrieval type. 

To administrate the retrieval types, choose Administration - Retrieval types... from the
menu. A window as shown below will open.  

To add resp. remove a retrieval type use the resp. button. To set the superior type use
the button.  
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Analysis
The organisms in a specimen can be analysed by analysis types defined in the database. In
the tree the analysis entries are symbolized with an icon. Only the types of analysis that
were assigned to the group of the organism can be selected. An analysis always refers to an
organism and may also refer to a part of a specimen. An analysis that refers to a part of a
specimen will be shown in the tree for the parts as shown in the examples below. 

To show or hide the analysis items in the tree use the button in the left panel. This button
has 3 states. In the default state the analysis entries will be shown as above. If you click

a second time it will change to the hierarchy mode and the entries will appear as shown
in the tree below. The last state will hide the entries.

To insert a new analysis to an organism select the organism in the upper tree. Then select the
type of the analysis from the drop down list as shown below. 

To delete an analysis, select it in the tree and use the button in the panel on the left. To
edit the details of an analysis, select it in the tree and enter data into the fields as shown
below. To enter or inspect an URI given for a single analysis, click on the button. 

If an analysis refers to a part of the specimen, you can document this by choosing the
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respective part from the list (see field Part above). The analysis will then be shown in the
tree for the parts of the specimen as well. Alternatively you may directly choose the organism
in the part tree and create the analysis for this part of the organism in the part tree. If you
used any tools defined in the tool section, you can include the usage of these tools.

 

Administration

If you require further information about an analysis click on the button. A window for the
analysis administration will open. If you have the proper rights you can edit the analysis types
used in your collection as shown below. This window is also accessible via the menu entry 
Administration - Analysis... 

For the import and export of data it is sometimes necessary to know the IDs of the analysis
types. To see the IDs, click on the ID button to display them as shown in the image below.
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The types of an analysis are restricted by the taxonomic group of the organism or object to
be analysed and from the projects. You may edit the list of taxonomic groups resp. projects,
which can use a certain analysis, using the and button. To add all used taxonomic groups
resp. projects, you can use the buttons. For details about handling data see the data
section. If you add a taxonomic group or a project to an analysis, all children of this analysis
will be available for these taxonomic groups resp. projects as well (see image below). Thus, in
the example above it is sufficient to enter the taxonomic group and the project in the analysis
Mammals to have access to all analysis within this superior analysis as shown in the tree. The
different types of analysis are organized in a hierarchy. To organize. Some of the entries may
only serve for structuring purposes (e.g. Mammals as shown above) and should not be used to
document the analysis of the specimen. To ensure this, check the checkbox [Only hierarchy]
. 

There are 3 states for result lists in the main form. (1) No result list will be generated if a
measurement unit is defined, for example if you specify "mm" as the measurement unit. (2) If
no measurement unit is defined, the program will collect all values given so far and present
these values as a list. (3) Some types of analysis need categorized values. Enter these values
together with their description in the Result list as shown below using the and buttons
respectively. To show values different from the entries in the Result column change the
entries in the Display text column.
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If you want to access or inspect an URI given for an analysis type, click on the button. The
URI related to the analysis will then be displayed in the window below. 

Besides of a plain text description of the analysis, you may insert methods as defined in the
chapter Methods. Use the and buttons to add or remove methods from the list (see
below). The added methods will be marked with sequential number (see Mark.: ... ) to allow
several methods of the same type. 

Every method may have several parameters that will automatically be available to take your
values. If the definitions of the parameters have been changed, you may add missing
parameters with the button. A window as shown below will open where you can select the
missing parameters you want to add.
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To view the history of a dataset, click on the button. A window with the history will open.
For more details see the section History.
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Geography of organisms
The geographical position (using WGS84) of organisms can be captured related to the date to
e.g. document a migration or the distribution of an organism. In the tree the geographical
entries are symbolized with an icon as shown below. 

To display the corresponding map activate Maps and click on the button. To edit an already
existing geography use the GIS editor. If you add a new geographical position and there are
already geographical positions available, these will be shown in the map. Remove them from
the map and insert the new geography. 
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Identification
Each organism or unit may have been identified several times. The identifications are listed in
the tree under the organism as shown in the image below. To create a new identification
choose the organism from the tree and click on the icon. The last identification will always
be taken as the valid one and set at the top of the list. To insert an older identification at the
base of the list click on the icon.

 

To hide / show the identifications in the tree click on the icon on the right panel next to the
tree. To enter a confirmation of an identification choose it in the tree and then click on the 
button. To move an identification to the end or the start of the list use the or button
respectively. To delete an identification select it in the tree and click the  button. To enter
details for an identification choose it in the tree. You can then enter the details in the form
opening on the right side of the tree as shown below.

 

The taxonomic name of an organism can be selected from either the names already available
in DiversityCollection or from the module DiversityTaxonNames. To choose from the local

names type the beginning of the name and click on the drop-down button  to get a list of
available names. You can use wildcards according to SQL. 

To select a taxonomic name from an external database click on the button. A window will
open where you can search for a taxonomic name. For taxonomic names provided by the
module DiversityTaxonNames you can use a shortcut. Click on the button to set the source
in the window that will open. After the source is set, the pin and drop-down box will change
their colors as shown below to indicate that the taxonomic names are not longer derived from
the content in DiversityCollection but from the selected DiversityTaxonNames database. 

Page 187



The links will be set separate for every taxonomic group and may be changed at any time with
a click on the button. To release the link to the remote database, click on the  button and
than select Cancel in the window where you select the database. The pin will change to 
and the data will again be derived from the local values in DiversityCollection.

For identifications linked to a DiversityTaxonNames database you may activate the Show
accepted names option. Accepted names will then be shown with a green color while for
synonyms the accepted name will be displayed above the current name (see below). 

 

Non biological units

Non biological units like soil, rock or mineral do not have biology related information like
a qualifier or a type status. These are therefore not displayed for these groups. Furthermore
the source for the names is not DiversityTaxonNames but DiversityScientificTerms (see a short
tutorial ). 

 

In the database the data for the identification is stored in the table Identification.
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Taxon lists
To see the list of organisms within a Specimen , CollectionEvent , EventSeries or
SamplingPlot click on the button which will appear, if you select one of the corresponding
items in the tree (see below). 

A window will open as shown below where you can gather additional information stored in the
module DiversityTaxonNames.

To retrieve information stored in the module DiversityTaxonNames for names which are linked
to this module select the taxonomic group of the organism. Then select the option [Include
information from taxonomic lists]. A combobox will appear where you may select the taxonomic
database. Next, select the project in the combobox and finally the analysis. After all options
are selected, click the button to refresh the data. To export the results in a tab-separated
list use the button.
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Storage and trees for the parts of the
specimen
In the tree at the base of the window the parts of the specimen with their related data are
shown. This tree is only shown when parts are present. To insert parts when the tree is
hidden use the button and follow the upcoming dialogs. This tree depicts the parts either in
accordance to their relation to each other in the specimen tree (click on the icon in the
panel on the left) ...

 

... or depending on the collections where the parts are stored (click on the icon in the panel
on the left). 

 

With the buttons in the left panel you may hide or show certain nodes in the tree. If e.g. you
do not wish to see the processings, simply click on the button and they will be hidden in the
tree. The button will change to a grey version and the background will turn yellow, to show
you that there is hidden data of the processings.

The panel on the right of the tree is for editing the data, for example the button will insert
a new transaction. For data with Read only access these panels are disabled except the
button for adding annotations . For further details see the sections Transaction and
Processing.
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Parts of the specimen
A specimen can contain several parts which may be stored in several collections. These parts
may represent different material categories, e.g. herbarium sheets, microscopic slides etc. The
parts are shown in the part tree under the main tree. This tree depicts the parts either in
accordance to their relation to each other in the specimen tree (click on the icon in the
panel on the left) - see first image below - or in relation to the collections where the parts are
stored (click on the icon in the panel on the left) - see second image below. Here the two
parts of the specimen are located in two collections. To add a new part use the drop-down
field in the panel on the right of the tree and choose the material category of the new part.
The material categories which appear in this list can be customized. You can set the a default
collection for new parts. If the default collection is not set, you will be asked to name the
collection of the new part. If the part is derived from another part, select this in the tree
before creating the new part. The new part will then be added as a child of the old part. You
can later edit these relations by drag & drop. If you wish to create a copy of a part, use the 

button in the panel on the right side of the tree. To insert parts when the tree is hidden
use the button and follow the upcoming dialogs. As another option you can transfer all
specimens in the result list of a query via the menu Data - Transfer - To collection ...
into a collection. Please keep in mind that next to adding part existing part will be transferred
to the selected collection as well. 

To see the whole content of a collection, click on the button. All specimens within the
collections will be listed as shown below with e.g. their accession number, accession number
of the part, storage location, collection date and/or locality as set in Customize.  
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If an organism is present in a part of the specimen, it will be shown in the tree. To edit its
presence select the specimen part in the tree and edit the Display order as shown below. 

In the example above, all organisms are present in the specimen. However, the fungus 
Cystotheca lanestris was chosen not to appear on the label and was transferred to the Hide
list. This is symbolized by a grey icon in the tree. You may enter a description for an
organism as a whole or for the organism within a certain part. The slide, symbolized by the 
icon, was created from the sample. Thus, in the specimen tree it is shown as a child of the
specimen symbolized by the icon. Concerning the organisms only the fungus Arthrocladiella
is found on the slide. Thus, in the tree it is the only organism shown as child of the slide. In
the display order the two other organisms appear in the Units not in part list (see below).

To move the organisms between the lists use the > and < buttons. In the list Show in label
you may change the sequence of the organisms with the and buttons in the panel at the
base of the list. The organism at the top will be the one taken as the main organism, e.g. for
printing a label. 

To see changes of the stock of the part click on the button . A window will open listing all
previous volumns together unit, the date and the responsible user.

To change the sequence of the parts according to e.g. the name instead of setting all entries
one by one, you may choose among the options shown in the image below (Name, Identifier,
ID).
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To edit the details of a part select it in the tree to open the fields as shown below.

The identifier, e.g. the taxonomic name under which the specimen can be found in the
collection is entered in the field Storage location. You can search for this entry in the query.

With the template you can define and copy predefined values into the data (see chapter
Template).   

To search for a free accession number use the button (see chapter Accession). To enter

the storage location you may use the drop-down button to select from e.g. the
identifications within the specimen. The source for the list can be specified under 
Administration - Customize display ... (see below).  

 The drop-down button for the Notes will provide you with a list of all entries in this field,
filtered with your entry in the text field. You may use wildcards like "%" or "_" (see Wildcards).

In the collection tree, the specimens are shown with their dependence upon each other based
on their location in Collections. To get information about a collection simply select it in the
tree. If you have the required rights, you may use the button to open the administration of
the collections. This form is accessible under the menu entry Administration - Collections...
as well.

The material category of a specimen part is indicated by the icon in the hierarchy. 

Here some examples:
bones: bones or skeleton from vertebrates
cultures: living cultures of organisms
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drawing: original line or color drawing
herbarium sheets: capsules or sheets as stored in a botanical collection
icons: icons, images etc. stored in a botanical collection
micr. slide: glass plate with sections of specimen for microscopic studies
specimen: specimen stored in a collection

Specimens can be included in a transaction. Every stored part of a specimen may be treated
with several processings.

If there are images which are related to the current part, the button for the restriction of the
images will be enabled ( → ). Click on it to restrict the images to this part. The button
will receive a red background    to remind you of the restriction and in the image list a
button will appear which enables you to show all images.

To edit the parts of the specimens in a table see the chapter Grid for parts, use the Table
editor for the Part table or the Part sheet from the Spreadsheets .

The data is stored in the table CollectionSpecimenPart.
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Material categories
The objects stored in a collection is organized in material categories to facilitate the
recognition of specimen containing diverse materials and to enable a specific design for the 
processing where e.g. bones differ in treatment from DNA samples. The list of material
categories visible for the creation of new entries may be restricted as described in the
chapter about the customization. 

To administrate the material categories, choose Administration - Material categories...
from the menu. A window as shown below will open.  

To add resp. remove a material category use the resp. button. To set the superior
material category use the button. With the button you can set a symbol for the material
category. Please keep in mind, that this will be converted into a 16 x 16 size icon. For the
translations for display texts, abbreviations etc. please see the chapter about database
description. 
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Processing
Every specimen can be processed, e.g. for preparation or preservation. Processings can be
applied to a specimen or a part of a specimen. In the hierarchy for the parts the processings
are indicated by the icon and a blue text. If there are any processings available, they will
be indicated by the icon in the tool bar. Please keep in mind that the availability of the
processings depend upon the material category and the current project as described below.
You can hide or show the processings in the hierarchy with a click on the icon. The
images below show a processing in the collection and the specimen tree for the parts
respectively.

You can enter a new processing for either the entire specimen or a part of the specimen. To
do this select the specimen or part in the hierarchy and choose a processing from the list as
shown below.

To delete a processing select it and click on the button. To edit the data for a processing
select it in the hierarchy. The window will show you the fields related to the processing as
shown below. If you used any tools defined in the tool section, you may include the usage of
these tools. 

In the window select the type of your processing from the list.
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If you have the required rights you may edit the processing types in the menu entry 
Administration - Processing...

In this window you can define the processings used in your collection. To add a new
processing click on the button, to delete a processing select it and click on the button.
The processings are related to material categories within the database. To add a new material
category or projects, which should be connected to the selected processing, click on the 
button in the panel right of the material categories or the projects. A window will open where
you need to select the desired material category or project respectively (see below).

The processing types are organized in a hierarchy. Some of the entries may only serve for
structuring as Maceration in the example below and should not be used to document the
processing of specimen parts. To ensure this check the checkbox [Only hierarchy]. For the
import and export of data it is sometimes necessary to know the ID's of the analysis types. To
see the ID's of the data sets click on the ID button. The ID's will then be displayed as in the
image shown below.

Besides of a plain text description of the processing, you may insert methods as defined in the
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chapter Methods. Use the and buttons to add or remove methods from the list (see
below). The added methods will be marked with sequential number to allow several methods of
the same type. Every method may have several parameters that will automatically be
available to take your values. If the definitions of the parameters have been changed, you
may add missing parameters with the button. A window will open where you can select the
missing parameters you want to add. 

To view the history of a data set, click on the button. A window with the history will open.
For more details see the section History.

The data of the processing is stored in the table CollectionSpecimenProcessing. 
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Description of the parts of the specimen 
A part of a specimen may be characterized with links to a standardized vocabulary from 
DiversityScientificTerms. Use the button to add and the button to delete descriptions
(see below). If the description refers to a certain unit, you may select it in the list as shown
below.  

The data is stored in the table CollectionSpecimenPartDescription .
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Collector
The people or groups responsible for the gathering of the specimen are stored in the table 
CollectionAgent. There may be several collectors for one specimen. In the tree the collectors
are symbolized by the icon as shown below.

 

To hide or show the collectors in the tree use the icon in the left panel (it will change to a
grey version with a yellow background when the collectors are hidden). To insert a collector
choose either the specimen or an existing collector in the tree and then click on the icon in
the right panel. Select a collector in the tree to enter details. In the right part of the window
the detail fields will appear as shown below.

 

If a collector should refer to a dataset in the module DiversityAgents (where more details like
addresses may be stored) click on the  button. If in the module DiversityAgents a synonym
is choosen, you will get the data of the correct name instead. The sequence of the collectors
(e.g. for print on a label) as shown in the tree can be changed by with the   and  buttons
in the panel on the right side of the tree.

With the template you can define and copy predefined values into the data (see chapter
Template).   

To remove a collector select the entry in the tree and click on the  button.

You can search for the gathering numbers of the collectors in the query.

Data of the collectors is stored in the table CollectionAgent. 
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Reference 
To each specimen, organism or part you can add references. To add a reference select the
specimen (symbolized by the barcode ), organism (e.g. , , ), identification or part
(e.g. , , ) in the tree and click on the button in the panel right of the tree. This adds
a reference to the selected item as shown in the image below.

 

The entries may be linked to the module DiversityReferences .  

The data is stored in the table CollectionSpecimenReference.
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Relation
Each specimen may have relations to other specimens. For example a duplicate, a specimen
isolated from the same material or a part of a specimen may be located in another collection.
Another example is link to e.g. GenBank where information connected to the specimen can be
found. This can be documented by adding relations to these specimens. To add a relation
select the specimen (symbolized by the barcode ), organisms (e.g. , , ) or part (e.g.

, , ) in the tree. You may then either add a relation to a local specimen using the 
button or add a relation to a remote specimen using the button in the button panel on the
right side. To show or hide the relations in the tree use the and buttons. For an overview
see a short tutorial .

 

Internal relation 

To add an internal relation to a local specimen use the button. A window will open where
you may search for the related specimen. 

 

Select the related specimen from the query result list and click OK to close the window and
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establish the relation. In the left image below you can see an internal relation while the
image on the right shows a reverse relation from another specimen.  

 

In the case of internal relations you can navigate to the related specimens using the 
button.

 

External relation   

To add an external relation to a specimen which is not administrated in the database
DiversityCollection use the button. In the image below you can see a relation to a specimen
in an external collection.

  

Deleting relations   

To delete a relation select it in the tree and click on the  button. 

Relations to units and parts   

If the relation should be If the relation should be referred to an organism, part or organism in a
part either select the organism or part in the tree and add the relation or use the mouse to
drag the relation into the correct position (see examples below). 
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Specimen: 

Organism: 

Part: 

Organism in Part: 

 

Details of the relations 

Together with the relation the details of the dataset is shown in the overview tree. To hide
these details click on the button (see example below). 
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Editing the data

To edit the data for a relation click on the entry in the tree. In the right part of the window
the details of the data set will be shown (see below).

 

The data is stored in the table CollectionSpecimenRelation.
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Exsiccatae 
A Specimen may be part of an exsiccatal series. These series are administrated in the
DiversityWorkbench module DiversityExsiccatae. To enter the exsiccatal series select the
Specimen, the Organism or IdentificationUnit in the tree. With the Specimen the exsiccatal
series is shown at the base of the data form as shown below.

 

As there may be several Organisms with separate exsiccatal numbers in one Specimen the
numbers are handled together with the IdentificationUnits. Select the concerned Organism to
enter data in the form as shown below. 

You can either type the name of the exsiccatal series or choose one from the module

DiversityExsiccatae. If you click on the , a window will open showing the link to the entry
as derived from the module.

 

The data on the exsiccatal series is stored in the table CollectionSpecimen, the data on the
number and the taxon is stored in the table IdentificationUnit. 
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Images
To insert a new image click on the  button. A window will open where you can enter the
path and file name of the image. Click on the button to search for a web address of an
image as shown below.

To use an image available as a local file click on the button to search in your local
directories. You can upload this file via a webservice to the server of an institution providing
the DiversityMediaService. To use this service you may rename your image either using a GUID
or according to the accession number including date and time. Use the upload button to
upload your image to the server.
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To delete an image select it from the list and click on the  button.

To zoom a specific sector of an image simply drag the mouse over the preferred area of the
image. A red square will indicate the zoomed area. To set the size of the image to its original
resolution click on the  button. To adapt the size of the image to the available space in the
form click on the  button. To change the orientation of the image use the appropriate
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buttons (  flip horizontal,  flip vertical,  rotate right,  rotate left). To view the
image in a separate form click on the button. For images with a path containing escape
signs (e.g. %2F) the translation of these sign can be suppressed using the %2F resp. /
button. If the image should not be published e.g. on the internet, enter any reason in the 
Withhold. reason - field. Next to images you can store other media. 

For images where a high resolution version is available, a zoom button will appear as shown
below. 

Click on the zoom button to open a window to see details of the image as shown below
(using krpano/ software). 
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For the description of a medium see the chapter Image description.

Data is stored in the tables CollectionSpecimenImage, CollectionEventImage ,
CollectionEventSeriesImage and CollectionImage.
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Tools
Tools are a previous option replaced by methods. If you used tools, you
have to turn to a version older than 4.0.0.0 (e.g. 3.0.9.8). 
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Methods
The methods used for collection events, the analysis of the organisms or the processing of
the material. To administrate these methods, choose Administration -> Methods ... from
the menu (only for Administrator). A window as shown below will open. For an introduction see
a short tutorial . 

There are 2 lists where you can define for which analysis resp. processing the selected
method may be used. If the checkbox For collection event is checked, this method may be
used for collecting events. To organize your methods you can add methods with the
checkbox Only for hierarchy set to true . For these methods the sections for entering
details are disabled. The methods may contain several parameters as shown above. To insert
a parameter click on the  button. If a parameter should only allow predefined values, check
the Use dedicated values for a parameter checkbox and add values using the  button.
With the buttons you can remove parameters or predefined values. 

To view the history of a dataset, click on the button. A window with the history will open.
For more details see the section History. For any comments to this part of the application, use
the feedback function.

In the main form you can add a method to a collection event, an analysis or a processing.
Choose the respective item in the tree and click on the button to add a method (see
below). Depending on the selected method, you get a list of parameters for which the values
can be set. For the parameters where default values are available, these will be inserted when
adding the method. 
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You may add several methods for one analysis resp. processing or collection event as shown
above.
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Image description
To enter a description for an image or a medium you have the possibility to add properties to
the image.

Properties of images
To add properties to an image, select the tab page for the properties and click on the 
button. A window as shown below will open. Select a property from a list of present
properties. If you are an administrator you can enter new property types here.  

After adding a new property, click on the button that will show up to save it before adding
descriptions or area information. To enter the description resp. value of a property, select it in
the list and the description in the field below the list. If a property should refer to a certain
area in the image, you may mark this area. Click on the button. The image will zoom in to
show the whole image as shown below. With the mouse mark the area for the property
(corresponding to Area Mode described in the GIS-Manual). If the geometry consists of
several areas click on the button underneath the image to start a new area. After the area
is drawn, use the button underneath the image to save your changes. With the button
underneath the image you can remove the geometry.

To filter for images with a certain property, enter a filter text in the field above the property
list and click on the button. You may use wildcards like % or _ for the filter text. As long as
the filter is set, only images containing a property according to the filter will be displayed. To
remove the filter, clear the text field or click on the button next to the image list.

To remove a property, select it in the list and click on the button.
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Description / EXIF
The EXIF content is derived from the original image (see below). This will be automatically
extracted from the image.

To extract the EXIF content of an image, the image must be accessible from a local directory
and the exiftool.exe (see below) must be available in the application directory.
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Media

Next to images you can store audio and video files. Click on the [>>>] button
(see below)

 

To open Windows Media Player and play the content of the media. You must have Windows
Media Player installed to use this function. For the description of a medium see the chapter
Image description. 
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DiversityMediaService
The webservice DiversityMediaService provides the possibility to upload media files like images,
audio recordings, etc. to a server. The usage of this webservice includes several preconditions
(please turn to your administrator):

 You need an account in the DiversityWorkbench module DiversityAgents with your login
in DiversityCollection linked to this account

 Your project has to be registered on the server
 You have to rename your media file according to the settings of the server e.g. using a

GUID (see image below) 

Use the upload button to upload your image to the server.
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Annotation 
If you are a user, having no rights to edit any data in the database, you can still add
annotations for a collection event, a collection specimen, a part of a collection
specimen or an organism (= identification unit). With annotations you can start a discussion
about items in the database where annotations refer to previous annotations on the same
subject.  

For data where you have Read Only access, you can still add annotations.

The available types are annotation and problem. To add an annotation, select the
corresponding data in the tree view. In the tool panel on the right of the tree view a button
will appear: if no annotations have been added so far or if there are annotations for this
entry. A window will open as shown below.

To add an annotation, click on the button and select the type of the annotation. If you
want to add an annotation depending on an existing annotation, select the superior
annotation in the tree and click on the button. The annotation will be shown in the tree
with the details listed below (see image below). 

Enter your annotation in the text box as shown above. You can enter a title or subject for
your annotation or select one from the list. You may enter a link and a source as shown
above. The source may be related to the module DiversityAgents. 
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To delete an annotation you have to be either an administrator or a data manager. Select the
annotation and click on the button. 

If you want to see all annotations of the current specimen choose Data - All annotations...
from the menu. All annotations will be listed as shown below.

Data for the annotations are stored in the table Annotation.
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External Identifier 
External identifier may be added for a collection event, a collection specimen, a part
of a collection specimen, an organism (= identification unit), a reference or a 
transaction. To add an external identifier, select the entry it should be attached to and click
on the button. A window as shown below will open.  

Select the type of the identifier, enter the identifier itself and close the form to save the
identifier. To remove an identifier use the button. 

To administrate the types of external identifiers choose Administration - External
identifier ... from the menu. A window as shown below will open listing the available types. 

To add or remove a certain type, use the and buttons. To edit the relations between the
identifiers use the resp. button.

Data for the external identifiers are stored in the table ExternalIdentifier. In an upcoming
version these data will be transferred into new tables (Identifier, IdentifierForEvent etc.).
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Regulations 
Regulations may be added for a part of a collection specimen. 

For surveillance of correct entries the regulations resp. their title must have been added for
the collection events before a insert for a part will be successful. 

To add a regulation to a specimen part, choose the part to which the regulation should be
added and click on the button. Depending on your permissions either a window as below will
open, listing all available regulations (see below) ... 

... or a textbox as shown below where you have to enter the title of the regulation. 

Choose or type the regulation you want to insert and click OK. The regulation will be inserted
as shown below.

If you do not have the proper permissions the regulation will be displaced without the title as
shown below.

To remove any regulation use the button. 

To administrate the regulations choose Administration - Transaction management - 
Transaction  ... from the menu. A window as shown below will open where the you can
administrate and create regulations (see below). See chapter Transaction or further details. 
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Templates for data
For several ranges in the data, you can define templates which can than be copied into the
data. To define the template, click on the button. A window as shown below will open,
where you can enter the data for the template. 

Use the button to save changes in the template, the button to clear all entries and the
copy options to take values from the data into the template. With the filling option you

can decide in which way values from the template are written into the data. This option can
be set as well under the menu Administration - Customize display and then Defaults and
miscellaneous - Template (see below).  

 

There are 3 possibilities: 

 Copy values from the template only if there are no entries in the data
 Ask the user if there are differing contents in data and template whether the template

values should be copied into the data
 Copy the values from the template irrespective of any content in the data

 

To copy the values defined in the template into your data just click on the button. 

In case you select that the program should ask (see above), a window as shown below will
open where you have to select those entries from the template that should be copies into the
data. Use the buttons all resp. none to select resp. deselect all columns. 
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GIS editor
Choose the Map for display in the header and choose the appropriate option ( GIS- edit)
from the first drop-down list in the maps control. With this editor you can document locations
with any geographical object (lines, areas, ...) different from a simple point. If coordinates are
available for your data set, the GIS editor will load a map (Google Maps) as background. To
insert the geographical object defined for e.g. the locality click on the button. To set the
format for point symbols use the controls for the symbol, color, size and line thickness above
the GIS editor. To redraw the maps with new settings click on the button. 

With the GIS editor you can edit the geographical information for the CollectionEventSeries 
, the CollectionEvent and an Organism or all coordinates related to the current specimen

. With the latest option the colors for the objects by default will be blue for coordinates of
event series, red for events localisations and green for coordinates of organisms. Furthermore
you can create distribution maps for any sample selection. 

The GIS editor has several states which are needed to handle geographical objects. For a
detailed description see the GIS tutorial. 
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GIS Editor
Introduction
The Diversity GIS Editor is a tool to create, visualize, edit and archive samples within a
geographical environment. It may be used as a stand-alone application or as a component of
the Diversity Workbench by other applications, e.g. DiversityCollection or
DiversitySamplingPlots.

In combination with a background map, equipped with world coordinates, collections of
Microsoft SQL Geometry Objects (points, lines and areas) may be displayed and edited in their
geographical context. The screen and world coordinates of the objects will be calculated and
shown in the status line. Color, thickness and transparency of the elements can be adjusted.
The working area which keeps the maps and objects may be shifted or zoomed.

The background map could either be loaded from a storage device or created with an online
map server tool provided by the editor. Other maps without world coordinates may be
adjusted to the background map easily by setting 3 pairs of reference points on the
background and the new map. The calculated world coordinates will be assigned and stored
when the new map is saved.

A GPS functionality has been integrated. If a GPS device is connected, the current position
will be displayed and - if an applicable background map is loaded - marked on the map.

The data transfer between application and GIS editor is made by interface function calls. In
that way geometry objects of a Diversity database may be loaded to the editor, modified or
extended and sent back to the application, which then updates the data base.
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Chapter 1: GIS Editor Layout
The layout of the Diversity GIS Editor could be divided into 3 regions:

 Control Panel
 Sample List
 Working Area

Control Panel

The Control Panel consists of the following elements:

 8 buttons to load , save , delete , print or add samples, switch GPS , detect samples
and to open the Settings window 

 2 text boxes for sample Identifier (ID) and Description (Text)
 7 radio buttons to select the operation mode (Map, Shift, Adapt, Edit, Point, Line,

Area)
 1 button to switch to a new object, if the current sample is composed of multiple lines

or areas
 4 controls to adjust color and transparency of the samples (for stroke and fill) or to

zoom the working area
 Status lines with screen and world coordinates (if any) and an appropriate symbol , ,

or 
 A hint about the user interaction, which is possible or expected

Sample List

The Sample List is the container for added maps or objects. Each entry is composed of the
following elements:

 Identifier of the sample
 Delete button to remove the sample
 Toggle button to hide or show the sample

The toggle button is illustrated with a small picture of the associated sample. Switching these
controls using the left mouse button will hide or show the corresponding sample. Using the
right mouse button will effect all samples except the corresponding one and the background
map: 

 When right clicking on an active toggle button, all other samples will be switched off.
 When right clicking on an inactive toggle button, all other samples will be switched on.

If the number of samples in the list do not fit into the window area, a scroll bar will be
displayed.

Working Area

This is the drawing space containing loaded maps and objects. In Shift mode the area could
be moved or zoomed.
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Chapter 2: GIS Editor Usage
The GIS Editor has 7 operation modes which are described in the following chapters:

 Map: Create an online map from the map server
 Shift: Move the working area with the mouse or zoom it with the slider
 Adapt: Calculate world coordinates for a new image using reference points of the

background map
 Edit: Modify the current object and all visible samples of the Sample List
 Point: Create a number of object markers on the background map
 Line: Create a line string or a collection of line strings on the background map
 Area: Create an area or a collection of areas on the background map

When starting the GIS Editor as a stand-alone application the start-up operating mode usually
is the Map mode. This is to remind the user that a background map with world coordinates is
necessary to work with geographic objects.
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Chapter 2.1: Map Mode

In Map mode the editor connects via Internet to the SNSB Google Maps service or
alternatively to the Open Street Maps service, regarding on the GIS-Editor Settings, and
displays an online map which can be moved, zoomed and switched as usual. The status area
shows the or respectively the symbol. The size of the map area adapts to the size of the
working area, even when resizing the window.

In case of Google the controls for moving, zooming and map type are displayed by default.
The overview window in the bottom right corner can be switched manually. The map can be
adjusted to the user's needs as follows: 

 Select map area: Press and hold left mouse button and move the mouse
 Zoom map: Turn the mouse wheel (if any), double click (left or right mouse button) on

a location
 Switch map type: Use Google map type control
 Hide Google controls: Click right mouse button to hide, left mouse button to show them

again

In case of Open Street Maps the pan and zoom control is displayed by default. It can be
switched off or on by clicking the left mouse button anywhere within the map area. The layer
switch control is hidden and can be opened by pressing the or closed again by pressing the
button on the right side. The map can be adjusted to the user's needs as follows: 

 Select map area: Press and hold left mouse button and move the mouse, or use the
OSM pan control

 Zoom map: Turn the mouse wheel (if any), double click (left mouse button) on a
location or use the OSM zoom control

 Switch map type: Open the layer switch and select a layer
 Hide or show pan and zoom control: Click left mouse button to toggle the control

If an appropriate area has been selected, just press the Add button , then the area will be
scanned and added to the Sample List as a reference map. A little image of the map will
appear on the toggle button in the Sample List. The controls should be switched off before
adding to get a neat map image.

Then the mode will be switched to Shift mode automatically and the status symbol will change
to indicating that world coordinates are present. The screen and world coordinates will be
shown in the status lines if the mouse is moved over the map surface.

The maps are subject to the Mercator projection, which is the GIS Editor's precondition for
every bitmap used as a reference map. While the screen coordinates are linear in horizontal
and vertical direction, the world coordinates are non linear in vertical direction.
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Chapter 2.2: Shift Mode

This is the quasi default mode of the GIS Editor. The cursor changes to a move shape when
touching the background map. The map is "frozen" and exists as an image sample on the
sample list. Changing the map region or resolution is no longer possible. But the Shift Mode
provides 2 features:

 Move the working area
 Zoom the working area

Moving the working area

Press and hold the left mouse button and move the mouse to shift the working area within the
display window. This is useful when having loaded a map from a storage unit which is larger
than the GIS Editor's window, or in combination with zooming the working area.

Zooming the working area

Place the mouse cursor at the slider control, press and hold the left mouse button and move
the control left to zoom out or right to zoom in the working area. The range of the zoom is
from factor 0.6 to 3.0. The current value is displayed beneath the zoom control. Double click
the slider control to reset the zoom to default value 1.0.

Enlarging the working area makes it more easy to place objects precisely. The relevant area
then could be selected by moving the zoomed working area. Downsizing the working area
gives an overview of large map regions.

Note that the resolution of the map itself does not change any more when zooming in. But
objects on the map are created in vector graphics, so the markers, lines or areas will remain
sharp and clear while zooming. And they will adapt there thickness smoothly to the size.
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Chapter 2.3: Area Mode

This mode is used to create areas (polygons) on the background map. The cursor changes to
a cross line when touching the background map. Each click on the left mouse button sets a
new point of the polygon. Every click on the right mouse button clears the last point set. The
closed polygon defined by the points is displayed completely at any time. When holding the
left mouse button the point can be placed while the lines of the polygon are shown as a
"rubber band" display.

To create more than one area for a sample, just click the button. This will finish the current
polygon and start another one. It could be repeated without limitation of the number of
polygons.

Setting the color

The areas are created as filled polygons, this means they have a border line (stroke) and a
filling. The color of stroke and filling can be set independently or simultaneously by clicking the
appropriate check boxes beneath the Color list box. Clicking on the list box will open a drop
down menu with the complete set of 141 predefined brushes. Use the scroll bar to navigate to
the preferred color and select it with the left mouse button.

Setting the transparency

Besides the color the transparency of the area could also be set for stroke and filling. In each
edit mode the slider control is used for that. The area stroke or filling changes smoothly from
invisible at the left till completely opaque on the right slider position. The value beneath the
slider control indicates the opaqueness in a range from 0% to 100%. The default settings are
100% for stroke and 25% for filling.

Before adding the polygon to the Sample List an Identifier (ID) and a Description (Text) should
be written to the text boxes in the control panel.

Clicking the Add button will put the current area(s) as one sample into the Sample List. The
toggle button will show a small picture of the first area of the sample. The ID will be displayed
above the button. Furthermore a tool tip will be created for the sample holding the ID and
Description, which will pop up when moving the mouse over the toggle button or over the
polygon in the working area.
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Chapter 2.4: Line Mode

This mode is used to create line strings on the background map. The usage is adequate to
the Area Mode. The cursor changes to a cross line when touching the background map. The
points of the line strings can be set or cleared by clicking the mouse buttons. Clicking the
button will switch to the next line string for the sample. The distance of the last drawn line
string section is displayed beneath the status area.

Color and transparency can be set for the line strings using the appropriate controls, but only
for stroke, because the line strings do not have a filling. Thus checking the Fill box will have
no effect. After adding the lines to the sample list a small picture of the first line string will
appear on the toggle button.
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Chapter 2.5: Point Mode

This mode is used to create Points (object markers) on the background map. The usage is
similar to the Area Mode. The cursor changes to a cross line when touching the background
map. The object markers can be set by clicking the left mouse button, clicking the right
mouse button will clear the last markers one by one again. The button has no impact, because
each Point represents a complete object and needs not to be finished before creating the
next one.

The shape of the object markers can be selected from a number of predefined Point symbols
and icons within the Settings window, e.g.:

Pin: Assel: Fish: Mollusc:

Cross: Bird: Fungus: Myxomy
cete:

X: Bryophy
t:

Insect: Plant:

Circle: Echinoder
m:

Lichen: Reptile:

Square: Evertebra
te:

Mammal: Vertebrat
e:

Diamond: Needle:

Color can be set for the symbol markers using the appropriate controls. It depends on the
selected point symbol, whether it just has a stroke (e.g. "Cross") or also a filling (e.g. "Pin").
Transparency can be set for both, the symbol and icon markers. The stroke thickness and the
size of the markers can be set in the Settings menu. After adding the object markers to the
sample list a small picture of the collection will appear on the toggle button.

Page 233



Chapter 2.6: Edit Mode

This mode is used to modify all samples (objects and images) which are currently visible on
the working area. It applies to the elements of the Sample List as well as to the current
sample.

Changing the position or shape of objects (points, line strings, areas)

To change an object one has to move the vertices ("corner points") which are defining it. To
do so just move the mouse close to a vertex to localize it. As soon as the corner has been
grabbed the cursor changes its shape to a hand symbol .

Now press the left mouse button and hold it, then move the mouse to change the position of
the vertex accordingly. The shape of the object or the marker will change in the same
manner. Release the mouse button when the preferred position has been set.

Note that areas and line strings cannot be moved in total while keeping their shapes!

Changing the position or shape of images (maps)

Images (e.g. maps) can be moved completely (keeping their aspect ratio), scaled in horizontal
and vertical direction and skewed within an affine transformation. Editing an image can be
divided into 4 stages by grabbing and moving the following corners:

1. Top-left: Moving the total image by keeping its aspect ratio 
2. Bottom-right: Squeezing or stretching the image horizontally and vertically
3. Bottom-left, top-right: Skewing the image in an affine way by keeping the corner

points top-left and bottom-right at its positions
4. Bottom-right again: Skewing the image in an affine way by keeping the corner points

top-left and bottom-left at its positions

Stages 1 to 4: 

Changing color and transparency

Color and transparency can be set independently (or simultaneously) for the objects using the
appropriate controls and check boxes for Stroke or Fill. The setting will affect all visible
objects, so objects which should not be changed have to be switched off before with their
toggle buttons. The color of images could not be changed, of course, but the transparency
can be set if the Fill box is checked. The transparency of the background map cannot be
changed. 
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Chapter 2.7: Adapt Mode

Essential for visualizing Geographical Objects is a background map with world coordinates. The
GIS Editor's Map mode offers a convenient way to create such a map, but it is restricted for
the use of Google or OSM maps which are present in the web and are providing world
coordinates. It would be nice to load scans of e.g. topographical or even historical maps into
the working area and use them as background maps, but the problem is how to assign world
coordinates to them.

The Adapt mode solves this in an easy way by executing the following steps. As a
precondition a background map having world coordinates (e.g. a Google map) must be present
which covers the area of interest of the new map to be referenced.

1. Load the new map image using the Load button . The image will be placed top left
inside the working area.

2. Select Adapt mode by checking the Adapt radio button. The cursor changes to a
pointer symbol having a green border when touching the new image and having a red
one when touching the background map.

3. Now 3 reference points must be set alternately on background and new map to assign
the appropriate locations (e.g. distinctive landmarks like road crossings). The last point
can be modified as long as the map is not changed. The cursor always tells you what
reference point will be set, according to its color and the number of dots in the
middle: 
Note: It is reasonable to select distant points close to the edges of the new map,
because this will give more accurate results. 

4. When all reference points have been set and the cursor touches the alternate map, it
changes to the finished shape . The next click will place the new map into the
appropriate background map area. 

The adapted image has been transformed to fit into the current world coordinates of the
background map. Now the new map can be added to the sample list by pressing the Add
button . When it is finally saved to disk by pressing the Save button , the new assigned world
coordinates will be saved, too, in an XML file with the same name (see Save Samples).

Sometimes it is difficult to place the new map and the reference map side by side, because
the window is too small, and zooming out would blur the details needed for setting the
reference points. If the new map covers the background map, the reference points can be set
anyway 

 for the new map by making it opaque with the transparency slider
 for the background map by making the new map transparent (less than 10% opacity)

with the slider 

Note: The Fill box must be checked to change the transparency of the new map. The
background map's transparency cannot be changed.
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Chapter 2.8: Load Samples

A background map is required before objects (areas, line strings, points) can be loaded. If no
background map is available, the GIS Editor will extract the appropriate area from the sample
file data and automatically adjust the map viewer to cover the region. The user is prompted to
wait until the map has been established completely and then press . If no map is displayed
(e.g. because there is no internet connection), the user may press and load a local map
instead, or to cancel the loading of the shapes.

When loading a shape file, the objects will be displayed at the background map according to
their coordinates and added to the Sample List automatically. The GIS Editor is able to read
MS-SQL Geo Object files (.shp1), TAB separated text files (.shp2), GPS Exchange Format files
(.gpx) as well as ArcView Shape Files (.shp). 

The assumption of the type of input file is made according to the extension of the file, so e.
g. a TAB separated input file of an external source might have to be renamed to .shp2 before
it is loaded by the GIS Editor. The input parameters of the first text line are determined, a
dialog window will open and show them on the left. 

Then you have to assign certain input values to the GIS Editor attributes, wich are displayed
in the middle of the window. Select an input parameter using the radio button on the left,
then assign it to one or more sample attributes by clicking the appropriate checkbox in the
middle. The assigned values are shown on the right side of the window. Values in gray are
default parameters, which are used if the attribute has not been assigned. There is just one
mandatory attribute which has to be set, the Geography Data (SQL Geo Object). If there is no
SQL Geo Object available in the input file, a point object will be created automatically when
assigning longitude and latitude parameters. 

To assign up to 10 input parameters simultaneously to the adjacent 10 sample attributes, just
click on the button. This is helpful if the input file has been created with the GIS Editor itself,
so the input values are already in the right order. 
To remove all assigned values, click on the button. 
If the assignment is done, click on the button to show all geographic objects of the input file
according to the assigned parameters. Each object will be added to the list as a separate
sample. To put all objects together as one single sample, check the "Save as one object"
box. 
Click on the button to cancel the load operation. 
The last assignment is saved by the GIS Editor and can be used for the next input file, if it
has the same structure as the previous one. Just click on the button to assign the same input
parameters as before. 

The GIS Editor supports ArcView Shape Files (.shp) using geographical, UTM or Gauß-Krüger
coordinates. The type of the coordinates (Geographic/Gauß-Krüger or UTM) has to be
selected first in the GIS-Editor Settings, in case of UTM also the zone and the hemisphere. If
an ArcView attribute file (.dbf) is available, a window will open and show the attributes of the
first shape. The user may select the attributes which should be used to create the sample ID
and description. Check one or more appropriate boxes and assign them by clicking the "ID" or
"Text" button. A separator string may be defined to combine the selected attributes to the
final text string. If no attribute is selected, the name of the ArcView file is assigned to the
sample description. 

To access the dBase attributes file for reading or writing, the Microsoft ACE OLEDB 12.0 driver
must be installed on the computer. If it is missing, the attributes cannot be evaluated and a
warning will be displayed. The shapes will be loaded properly, anyway, but no description will
be added.
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When loading an image without world coordinates, it will be displayed top left in the working
area. If no background map is loaded yet, the Screen symbol is shown in the status line,
followed by the screen coordinates of the current cursor position.

When loading an image with world coordinates and no background reference map exists, it will
be displayed top left in the working area. The World symbol is shown in the status line,
followed by the screen coordinates and the world coordinates of the current cursor position.

When loading an image with world coordinates having an existing reference map, it will be
embedded in the background map according to its coordinates. If the new image does not
overlap with the reference map, the image exists virtually in the coordinate system, but
possibly could not be seen because it is too far away from the reference map. 

Loaded images with world coordinates are immediately added to the Sample List. When loading
an image without world coordinates it is displayed, but not yet added to the Sample List. The
user has to add it manually by pressing the Add button . This is because the user should have
the opportunity to adapt the image to the background map to be stored later on with
applicable coordinates.
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Chapter 2.9: Save Samples

To save a background map which is currently displayed in Map mode just press the Save
button instead of the Add button . A save file dialog will pop up to name the file, the map and
its coordinates will be saved and added to the sample list.

A background map is required before objects and images can be saved. Saving samples means
saving their type, attributes and world coordinates in files. When pressing the Save button , it
applies to all visible samples on the working area, except the background map. A current
sample will be added to the sample list before it is saved.

If objects are visible, a save file dialog will open and a name for the target file(s) must be set.
Objects (areas, line strings, points) will be saved in respect to the selected formats of the 
GIS-Editor Settings:

 If MS-SQL is enabled, all visible objects will be collected and stored in one GIS Editor
shape file in text format (extension .shp1). The file contains the objects' attributes and
MS-SQL Geo Object definition strings. If altitude calculation is enabled in the 
GIS-Editor Settings, these values are stored, too.

 If ArcView is enabled, for each object 3 ArcView compatible shape definition files in
binary format will be created: A shape file, an index file and a dBase file holding the
description (extensions .shp, .shx, .dbf).

If images are in the Sample List, they are already present on disk and will not be saved twice.
Instead for each image an XML file will be created with the calculated world coordinates of
the image and will be stored under the same location and name as the image. This does not
apply to the current background map.

If Save Working Area is enabled in the GIS-Editor Settings, a scan of the complete working
area including its objects is made and stored in an image file, which name has been set in the
save file dialog. 
To save only a part of the working area the Frame box must be checked in the GIS-Editor
Settings, too. Then a rectangular frame of the given dimensions is displayed, which defines
the part of the working area that will be saved. It can be dragged to the right position using
the left mouse button (click, hold and shift), and it can be resized by grabbing and moving the
corners of the frame.
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Chapter 2.10: Delete Samples

To delete a single object of the Sample List just press the small Delete button left of the
Toggle button. The sample will be removed from the list and the working area, the other
sample entries will be rearranged. 

Pressing the large Delete button in the Control Panel will remove all samples of the Sample
List, except the reference map. A warning is shown before: 
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Chapter 2.11: Print Samples

Pressing the Print button in the Control Panel will open a print dialog to select a printer and
adjust the settings. Then it will print the complete working area including all visible objects.
This feature is useful e.g. for documentations.
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Chapter 2.12: GPS Tracking

When pressing the GPS button in the Control Panel the hardware will be scanned for a GPS
device. All available serial ports are opened and checked if they are delivering valid GPS data.
This takes 2 seconds. Be sure that the correct baudrate for the GPS device has been set in
the Settings menu (standard rate: 9600). 

If no device is detected the button will be released. If a device has been found the button
changes the color according to the numbers of satellites which have been fixed by the device:
Red up to 3 satellites, yellow up to 5 and green if 6 satellites or more are available. The
number of satellites, longitude, latitude and altitude delivered from the GPS device are
displayed in the info line of the Control Panel beneath the status.

The current position will be shown by a GPS marker if an appropriate background map has
been loaded. If GPS Track in the Settings window is checked, the movement of the position
will be drawn as a line string on the background map. The color and stroke thickness are
similar to the last adjustment for lines. When switching off the GPS button again, the track will
be added to the sample list automatically and could be saved for future documentation
purposes.
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Chapter 2.13: Settings

Pressing the Settings button in the Control Panel will open a dialog to adjust these GIS Editor
settings which are not frequently changed:

Setting the file formats for reading ArcView shape files

ArcView is a common Desktop GIS tool and stores its data in binary files. The GIS Editor is
able to read these files and display the included geography objects. But because ArcView
does not necessarily provide a dedicated information about the GIS format of the contained
data, the user has to know and select it in advance. 
The GIS Editor currently supports WGS84 geographic coordinates, Gauß-Krüger coordinates
(Potsdam datum) und WGS84 UTM coordinates. If "Geographic / GK" is selected, the program
will choose the right format by checking the binary values. In case of UTM the user must
select the hemisphere (N/S) and the UTM zone (1-60) to ensure that the objects will be
displayed at the correct location. 

The ArcView data files may contain complex geographic shapes (e.g. polygons or line strings)
which are combined by the GIS editor to one multi object (e.g. multipolygon) by default. To
split up the shapes into single objects the option "Split shapes into single samples" has to be
selected. Then they are placed into the sample list separately. This could be helpful to avoid
out-of-memory errors if very large shapes should be converted to SQL geography strings. 

Setting the file formats for saving objects

At the moment 3 formats for object files are supported: 

 MS-SQL Geo Objects (.shp1)
 TAB separated text files (.shp2)
 ArcView shape files (.shp, .shx, .dbf)

Microsoft SQL Geo Objects are part of a standard for storing geometry and geography data in
an SQL database, as used by the DiversityWorkbench modules. They are a well defined text
string containing the geometrical type (e.g. Polygon, Line, Point) and the geographical
coordinates (longitude, latitude, optional altitude) of an object. 
Together with the GIS Editor attributes (e.g. color, transparency) they are stored in a
proprietary GIS Editor shape file in ASCII text format. This file can easily be read and changed
using a text editor. 

TAB separated text files are widely used as an interchange data file format. The content of a
file is more or less the same as above, but the parameters of each object are placed in a
single text line, separated by tabulator characters. Additionally to the SQL Geo Object the
"envelope center point" (longitude and latitude) of it is saved separately in the file. 

The GIS Editor can also create ArcView compatible files to store the samples, which then may
be read from ArcView GIS tools. 3 files are required for each type of shape: A data file with
extension ".shp", an index file with extension ".shx" and a description file in dBase format with
extension ".dbf". 

The advantage of the first format is the transparency and readability of the data file, which is
just one single text file. But storing huge samples is time consuming, because they have to be
converted to SQL geography strings. If the samples consist of more than 100,000 points, an
warning message is shown and the user may decide whether to continue or not: 

While saving the shapes, a progress bar will be displayed to indicate the status of the task: 

Using the ArcView format makes the data files compatible with many applications. Huge
samples can be stored much faster. But each type of sample requires a separate set of output
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files, because different types of objects within one file are not supported so far. So a sample
list containing 10 objects will produce 30 data files (file name with an appended index, which
is incremented for each sample). Furthermore the attributes like color, transparency and
stroke thickness will not be saved. 

Currently there is just one format supported for storing image coordinates. They are written
into an XML file which is also used in DiversityMobile modules. Saving the coordinates in this
format is required for the GIS Editor, so it cannot be disabled.

Saving the working area

Selecting this check box and later on pressing the Save button will additionally scan the
working area including all visible objects and save it as an image file under the name provided
in the save file dialog, see Save Samples. This is useful for documentations. 
Note: There are copyright restrictions on maps or aerial images which are created with the
Google maps viewer. Please contact Google before using them for publications to grant a
license, or use Open Street Maps captures, which could be used freely under the Creative
Commons Attribution Share Alike license conditions.

When checking the "Frame" box just a rectangular part of the working area is saved. The size
(in pixels) of the frame has to be defined in the adjacent "Width" and "Height" fields. This is
convenient if the resulting image should have well defined dimensions, e.g. fit the resolution of
a smartphone display. This feature is only active when the Save Working Area box is checked.
After closing the Settings window a rectangular frame of these dimensions is displayed on the
working area which defines the part to be saved.

GPS Track

When checking this box the movement of the GPS marker on the background map will be
tracked by a line string. After switching off the GPS button the line string will be added to the
sample list automatically.

Altitude for geo objects

This box applies to MS-SQL Geo Objects only. If checked, the appropriate altitude of the
object points (longitude, latitude) will be stored in the file, too. This is not recommended for
sample objects with a lot of points or vertices, because for every point the Geonames server
has to be contacted to request the associated altitude value. This could slow down the
saving procedure immensely.

Setting the stroke thickness

The stroke thickness for area, line strings and point symbols can be set by using the
appropriate slider. The value of the thickness is shown in the label box left of the slider.
Double clicking the slider will reset the thickness to its default value 1.

Setting the Point symbol

The symbol for the points can be selected from the drop down menu. The symbol size can be
set using the slider below the menu. The point symbol display will change accordingly.

Setting the GPS baudrate

It is essential to set a suitable baudrate for a connected GPS device according to its
specification. The rate can be selected from the list of the drop down menu. If no GPS device
is available, Demo mode could be chosen to see the behaviour of the functionality.

Setting the Map Mode viewer

The radio buttons offer the choice of the viewer for creating a background map. Currently
Google Maps and Open Street Maps are provided.
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GIS Editor Info

Clicking the Info button will display a window containing GIS Editor version and license
information.

Saving the settings

Finally pressing the OK Button will save the settings, pressing the Cancel button will discard
them.
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Chapter 2.14: Sample Detection

Since GIS Editor version 2.2.3.0 the Sample Detection offers a new convenient tool to digitize
sample markers e. g. of a scanned and georeferenced analog paper sheet.

The tool will try to detect "points" on an image according to the detection parameters which
can be adjusted in the Sample Detection Parameters window, which will open when clicking
the button. 

The decision what belongs to a sample and what is just background on the loaded image is
made by defining a color range of the object to be found. Looking at the example picture
above, we can see that the collector has marked samples using a "black" pen on a reddish
scale paper. The points appear as dark grey scatterplots. To detect these points we must
define the color range of interest from "mid grey" to "black". 

The grey range can be easily set by moving the "Grey" sliders for minimum and maximum
values. The sliders for the 3 color channels will move simultaneously, adjusting the channel
values in parallel. In the example above we found a range from 0 (black) to 150 (mid grey)
which covers the colors of the samples and excludes the background colors. It is visualized in
the color boxes for min and max values and as a linear gradient color brush. 

If we'd look with a magnifying glass on a single point, we would discover that in fact it is an
array of pixels (picture elements) in various shades of grey. To reduce this "cloud" to a single
point coordinate the program uses several algorithms. The result can be improved by setting
the parameter for the minimum point distance in pixels to an appropriate value (e. g. 4). 

The resulting sample points would be displayed as a point collection to be (potentially) edited
and added as one sample to the GIS Editor sample list. In contrast, clicking the check box
beneath will split up the found sample points into single samples and add them immediately to
the sample list including an enumeration. The sample names will then be composed by
Identifier and Enumeration (start value, will be incremented) as defined in the text boxes
under it. Pressing the OK button will start the detection and deliver the detected points as
object markers. 

Not only grey points may be detected, but markers of any color tone. The ranges for the red,
green and blue color channels can be adjusted individually by moving the sliders for min and
max values. The gradient color brush gives you a hint about the resulting color range, but it
needs much experience to define a color range properly to get the expected results. 
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Access to the data
To get access to the data, you have to fulfill several requirements. In DiversityCollection, you
must be a member of one of the user groups. You can only access data, which is listed in the
projects you have access to. For external users data may be blocked by entries in the data
withholding reasons or due to a data embargo.
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Availability of data sets
The data of certain parts of the database can be blocked for remote access. If you want to
prevent access for the whole dataset, enter your reason in the field Withholding reason in
the header (see below). 

If you want to block only the access to the data of the collection event or the collector,
choose them in the tree and enter your reason for withholding the data in the corresponding
fields. The data will only be published, if these fields are empty. 

Within the database a user has only access to the data of those projects for which he has
permission. If a data set belongs to a certain project, it is stored in the table
CollectionProject. 

To prevent publication of the data it can be blocked for the whole data set (table
CollectionSpecimen), for the locality as a whole and for the collection date (table
CollectionEvent), for the collectors (table CollectionAgent) (for the collectors an
anonymisation is available), the organisms (table IdentificationUnit) and the parts (table
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CollectionSpecimenPart) - see overview below - and for all image tables:
CollectionSpecimenImage, CollectionEventImage, CollectionEventSeriesImage and
CollectionImage. The transaction provide the possiblity of an embargo (see below).

 

To edit the withholding reasons for all specimen selected in the main window choose 
Administration  - Withhold data... from the menu. As an alternative choose Data - 
Cache database... from the menu. There in the projects part click on the button to edit
the withholding reasons for a single project. A window will open as shown below, giving a
summary of all withholding reasons set for the selected specimen and related data.  
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To edit the withholding reasons for certain entries choose the corresponding page where the
details are listed as shown below. 

To block all data enter a new reason for withholding the data and click on the Add
withholding reason to all ...  button or the ... only to selected button, if only the
selected entries should be blocked. To remove the withholding reason from all data sets click
on the Remove withholding reasons for all ... button or the ... only from selected
button, if only the selected entry should be published. 

 

Data embargo

To mark data to be not published for a certain period you can define a data embargo and
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include the data in this data embargo. 

 

Permissions for projects

The user's access to the data within the database is stored in the tables shown below. The
tables UserProxy and ProjectProxy are related to the Diversity Workbench modules
DiversityUsers and DiversityProjects respectively. See User administration for further details.
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Projects
Every CollectionSpecimen may be assigned to any number of projects. To assign a specimen
to a project click on the button. To add a project where you have no access to, use the 
button. To remove a specimen from a project select the project from the list and click on the 

button.

 

If there are projects, to which you have no access to, these will be listed in a separate list
at the top as shown below.

 

Projects, to which you have Read only access will be listed in a separate list at the top as
shown below.

Data from Read only projects can be seen but not edited. Only Annotations can be added
(see image below).
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To transfer all selected specimen into an additional project choose Data -> Transfer -> 
To project... from the menu. A window will open where you can select the project to which
the specimen should be added.

To remove all selected specimen from an additional project choose Data -> Remove from
project... from the menu. A window will open where you can select the project from which
the specimen should be removed. The last project in which a specimen is placed can not be
removed.

 

The data are stored in the table CollectionProject.

Details of the projects within the DiversityWorkbench are stored in the database
DiversityProjects. To access further information on a project click on the button. To edit
details in projects you require the application DiversityProjects.exe in your application
directory and access to the database DiversityProjects. To synchronize the projects listed in
DiversityProjects you may use the synchronize function in the user administration window as
shown below. If DiversityProjects is not available, you may create a new project by clicking
the button. If DiversityProjects is available, use the synchronize function

.

 

The diagram below shows all tables with direct relations to the project tables. For more details
see the sections Analysis, Processing and Image description.
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Login administration
To administrate the logins on the database server, their permissions and roles respectively as
well as access to projects choose Administration - Database - Logins ... from the menu. A
window will open as shown below. 

To set the website where information about details concerning the General Data Protection
Regulation are shown, click on the button.   

To see the current activity on the server click on the button. A window as shown below will
open listing all user related processes on the server.

To administrate the  linked servers, click on the button.   

To send a feedback click on the button.   
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Statistics

To see the activity of a login click on the button. A window will open as shown below listing
all databases and tables together with the time span (From - To) and the number of data sets
where any activity of the current login has been found.

 

Creation of login

To create a new login click on the button. A window will open as shown below. A login that
should be able to create new logins must to be a System administrator.
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Here you can enter the name of the new login, the password and the information about the
user which will be stored in a DiversityAgents database. You may either create a new entry in
this database or select an existing one: Click on the button to search for a name in the
database (see below).

 

Copy a login

To copy a login including all permissions etc. into a new login, select the original login in the
list and click on the button. 

 

Edit a login

To edit the access for a login on the server select the login in the list. If a login should be
disabled , uncheck the enabled checkbox (see below).

All databases on the server will be listed with the current database showing a yellow
background. The databases where the login has no access will be listed in gray while the
databases accessible for a login are black. 
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Access of a login to a database

To allow the access to a database select the database from the list and choose database as
shown below. 

The state and date of the privacy consent according to the General Data Protection
Regulation is shown in dependence of the selected database. 

Roles of a login in a database

Use the > and < buttons to add or remove roles for the login in the database (see below). 

To see the detailed permissions of a role, select it in the list of Available roles and click on
the button. A window as shown below will open listing all objects in the database the role
has permissions for (see below). 

As a database owner you can edit the permissions and role memberships with the and 
buttons. Please keep in mind that any change of the permissions may cause serious troubles
and should only be used for testing and bug fixing. The final setting of the permissions should
be performed by a proper update script of the database. For every action you will get the
code that is to be included in an update script (see below). 
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Projects for a login in a database

Depending on the database you can edit the list of projects accessible for a login (see below).
Projects are related to the module DiversityProjects. To get additional information about a
project select it in the list and click on the button.  

Starting with database version 02.05.35 next to the projects with full access, a second list
provides projects with Read Only access (see image below). Use the and buttons to
move projects between Accessible and Read Only. If a project is set on Read Only a user
can still add annotations. 
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To load additional projects click on the Load projects button. A window will open as shown
below. Projects already in the database will be listed in green, missing projects in red (see
below). Check all projects you need in your database and click the Start download button.

To see an overview of the users within a project select one of the project in either list and
click on the corresponding button . A window as shown below will open listing all users and
their roles with access to the selected project.

To add or remove a role for a login, select the corresponding field and choose or from the
context menu (see below).
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Settings of a login in a database

Depending on the database you can edit the settings of a login as shown below.

If you wish to use settings already defined for another login, click on the Search template
button. A window (see below) will open where you can choose among the settings defined for
logins in the database. 

 

Overview for a login

If you want to see an overview of all permissions and project for a login, click on the 
button. A window as shown below will open. It lists all modules and their databases, the

roles, accessible projects and read only projects for a login.  
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To copy the permissions and projects of the current login to another login, select the login
where the settings should be copied to from the list at the base of the window and click on
the button to copy the settings for all databases or the button to copy the settings of
the selected database into this login.  

 

Overview for a database 

If you see an overview of all user and roles in a database, click on the button. A window a
shown below will open. It lists all user, roles and projects in the database.  
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To remove a user, select it in the list and click on the button.  

 

Correction of logins

If you select one of the databases, at the base a button may appear. This indicates that
there are windows logins listed where the name of the login does not match the logins of the
server. This may happen if e.g. a database was moved from one server to another. To correct
this, click on the button. A list of deviating logins will be shown, that can be corrected
automatically. 

If logins with the same name but different server are found, one of them has to be deleted to
make the correction possible. You will get a list where you can select those that should be
removed. 
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Select the duplicate logins that should be removed and click OK. 

To find users within the database that have no valid login, click on the button. A window as
shown below will open, listing the users without a login. Select those that should be removed
and click OK. This will include a removal from the collection managers. 
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Security
A user may be in several groups with diverse rights in the database. Here certain higher
groups have all rights of lower groups in addition to special rights for the higher group, e.g.
the group User may only read data of certain tables while Typist has the rights of User and
additionally may edit the data in certain tables - see overview below.

Summarized overview of some of the groups and their permissions

Role Permissions in addition to lower role and user group respectively Included rights
Administrat
or Delete data, edit user permissions DataManager

CollectionM
anager Administration of collections, handling loans etc. StorageManager

DataManag
er Delete data, edit image descripton templates Editor

Editor Create new entries and delete details (not entire data sets) Typist
Requester Has the right to place requests for specimen  
StorageMa
nager Administration of stored parts, handling loans etc. User

Typist Edit data User
User See the data of the data tables, add annotations

To place a user in one of the groups, select Administration - Database - Logins... from the
menu. In the window that will open select a login and a database. The roles available in the
selected database will be listed as shown below. Use the > and < buttons to add or remove
roles for the login in the database (see below). 

To see the detailed permissions of a role, select it in the list of Available roles and click on
the button. A window as shown below will open listing all objects in the database the role
has permissions for (see below). 
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If you are an Administrator you may add a user to one of these groups.

Any user may have access to several projects.
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Collection management
Collections are managed by collection managers (see Administration -> Transaction
management -> Collection managers ... in the menu), who organize the transfer of
specimen between collections and track the exchange balances . Any transfer of
specimen is organized via transactions (see Administration -> Transaction management
-> Transaction ... in the menu). To be able to place a request for specimen from a
collection you must be in the group of requesters (see Administration -> Transaction
management -> Loan requesters ... in the menu) for the requested collection and a
collection manager for the requesting collection. An overview is given in the image below.
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Collection
The parts of a specimen can be stored in several collections. To see the place where a
specimen or parts of it are stored use the lower tree and click on the icon to select the
display according to the collections as shown below and in a short tutorial .

In the tree shown above select the collection to display the data fields as shown below. 

To be able to edit the details of a collection, you must be a collection manager of this
collection. The restrictions for the access for editing the collections are defined in the 
CollectionManager section. 

At the base of the fields you find the default collection, used for the creation of new
specimen parts. Specimen parts that are not created as a part of another part will be placed
in this collection. Use the button to edit this entry (see below) For another possiblity to edit
this value choose Administration - Customize display from the menu. 

Administration of the collections

If you need further information about a collection click on the button or choose
Administration - Collections... from the menu to open the window for the collection
administration (this menu entry is only available for collection managers). This will open a
window (see below) where you can edit the collections used in your database for which you
are a collection manager. 
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Specimen placed in the collections

The specimens stored in a selected collection are listed in the specimen list. You can hide /
show this list using the   /  button. The specimen list will appear as shown below. Click on
the collection in the tree view to fill the list and see the specimens that contain parts which
are placed in the current collection. To transfer the parts of certain specimen from the
current collection to another collection, choose them in the list and click on the button. To
change to a specimen from this list click on the button. 

As an alternative you may select the specimen in the main form a choose Data - Transfer
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- To Collection ... from the menu. A window will open where you can select the collection
in which you want to transfer the specimen. With this option ALL parts of the selected
specimen will be transferred into the selected collection. 

 

Creating new collections

To create a new collection use the button either above the Query results or the button
right of the hierarchy, where the new collection will be placed underneath the collection
selected in the hierarchy. To copy a collection either use the button or the button. The
latter will copy the collection including all child collections. To set the superior collection, use
the button. The user creating the new collection will automatically be inserted as a
collection manager for this collection. To remove a collection, any collection manager must
be removed from this collection first. Click on the button to open a window for the
administration of the collection managers. For new versions of the database the removal of
the link of collection managers to deleted collection will be done automatically. 

 

Administration of collection types

To administrate the types for the collections, click on the button. A window will open where
you can create new types and add icons representing a type (see below). 

 

Images 

If there are images depicting the collection a yellow background    will indicate the
availability of these images. To show the images, click on the button. This will open the
area for the images as shown below. Use the and buttons to add or delete images of your
collection. For further details about handling images see chapter Images.
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Label 

To print labels for e.g. drawers, click on the button. The area for printing the labels will be
shown (see below). Further details about printing labels are described in the chapter Label.

 

To view the history of a dataset, click on the button. A window with the history will open.
For more details see chapter History.

For details about handling data see the Data section. Data of the collections is stored in the
table Collection. 
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Collection manager 
Collection managers are users with the right to edit the transactions for a collection, including
loan, purchase, inventory etc. To administrate the collection managers you must be in the
administrator group. Either choose - Administration - Transaction management -
Collection managers from the menu or Administration - Collection and there the 
button to open the editing window for the collection managers as shown below. 

Use the < and > buttons to edit the list of the collections for which the selected collection
manager can create and edit transactions. 

The collection managers can be listed with their names or their logins. Change this with the
list by option at the base of the list. If after e.g. a database have been moved to another
server, the may exist logins with names not matching those on the server. Click on the 
button to correct this. In case of duplicate permissions you might get a list with these
duplicates where you have to remove the duplicate permissions. 

For details about handling the collections see the Transaction section. Data of the collection
managers is stored in the table CollectionManager. 
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Collection user 
The access of users to collections can be restricted. To edit the collection list for a user
choose - Administration - Transaction management - Collection users ... from the
menu. A window will open, where you can add or remove collections a user has access to as
shown below. The access includes all subordinate collections. This means adding a collection
to the list a user has access to also grants the user access to the subcollections as defined in
the hierarchy of the collection. In the example shown below the second entry is not
necessary as it is already included in the first entry.

Use the < and > buttons to edit the list of the collections for which the selected user has
access to. 

If a user has no collections in the list, all collections are available for this user. 

A collection manager has access to the collections he is allowed to manage as well as those in
the list as a collection user. 

Data of the collections is stored in the table CollectionUser. 
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Transactions
Prerequisites 

The transfer of a specimen between collections is handled with transactions. There are two
prerequisites to use transactions in DiversityCollection. You are required to be in the user
group CollectionManager (see UserAdministration) and the collections in which you have the
right to handle transactions must have been assigned to you is shown in the 
CollectionManagers section.

Visibility of transactions

A specimen may be involved in diverse transactions between collections like loan, purchase,
gift or exchange. The transactions are shown in the tree for the parts of a specimen and
symbolized with e.g. an icon. For specimens which are still on loan an icon is shown while
a returned loan is symbolized with an icon (see image below). A data embargo will be
symbolized with an icon. If there are older accession numbers linked to a specimen involved
in a transaction, these numbers can be documented together with the entry of the
transaction of the respective part of the specimen. 

           

To customize the sequence and format of the transactions shown in the tree, choose 
Administration -> Customize display ... from the menu and see the chapter customize for
further details.

As an administrator you can add entries to the Standard comments for transactions (see
chapter customize). 

If you are a CollectionManager, you may take a look at the details of a transaction. Select the
specimen part in the tree and click on the button which will be shown in the details next to
the name of the transaction. This will open the window for the transactions as described
below. 

 

To edit the transactions choose Administration - Transactions from the menu. A window
will open as shown below. In the tree at the top the relations between the transactions are
shown. To create a transaction dependent on another transaction choose the superior
transaction in the tree and click on the button in the panel right of the tree. With the 
button you may create a copy of a transaction. To delete a specimen from the list click on
the button. To transfer all selected specimen in an existing transaction choose Data -> 
Transfer -> To transaction... from the menu and choose the transaction where the
specimen with all their parts should be included. In two following dialogs you may restrict the
transferred parts to a certain collection or material category. The data for the transactions is
stored in the tables Transaction and CollectionSpecimenTransaction. 
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The ID of the transaction is shown in the header. Behind the ID the button may appear in
case of missing units in parts which e.g. for the creation of sending letters may cause
unexpected results. Click on the button to open the maintenance for fixing this problem.
With the button you can send a feedback to the software developer. To view the history of
a data set click on the button. A window with the history will open. For more details see
the section History. The  button will open the settings for the transaction. The button
opens a table editor for the selected transactions. For large hierarchies the retrieval from the
database may be time consuming. To hide the hierarchy use the botton resp. to show
the hierarchy. The list for the specimen may be shown or hidden   .

Data entry 

On this page you may edit the data of a transaction. Every transaction is linked to an
administrating collection (symbolized by the key ) and can be edited exclusively by
CollectionManagers of this collection. To appoint managers choose Administration -
Managers from the menu.

 

The transactions can be organized in a hierarchy as shown in the image above, if e.g. you
wish to keep together all loans to a certain institution. To create a transaction of an inferior
transaction choose the superior transaction in the tree and click on the button in the panel
at the right side of the tree. To create of copy of a transaction, use the button and the 
button to delete it. Depending on the type of transaction you have up to 3 dates, e.g. for a
loan you have a begin date, an end date and in case of a prolongation an end date of the
prolongation. 

There are the following types of transaction:

Transaction type  Description

embargo 
Temporary data embargo for specimen that should not be published
within the specified period

exchange the exchange of specimens between institutions

gift the gift of specimens to an institution
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inventory the inventory of specimens within an institution

loan the loan of specimens of an institution to an external loan taker

permanent loan permanent loan of specimens of an institution to an external loan taker

permit permit or certificate for the collection of specimen

purchase the purchase of specimen by an institution

removal a removal of a specimen from a collection 

return a complete or partial return of a loan 
transaction group an entry to organize your transactions 

The fields display in the Details tab will vary with the type of the transaction as e.g. an
embargo does not need any address information. For the addresses use the links to the
module DiversityAgents as shown in the image above. You may optionally enter a collection
and the program will then use the corresponding address as described below. As the recipient
of e.g. a loan may not be entered in DiversityAgents, you can enter the name of the person
directly in the To-address. The use of the collection as a reference in the From and To
section is deprecated. Please use a link to the module DiversityAgents instead. If you need
these controls please open the settings and select the Show all address fields option. 

 

Common notes

On the tab pages for generating documents you need to specify a xml-schema for your
document. Click on the button to choose one of the predefined schemas or create your
own. To edit the schema files (*.xslt) you may use a text editor or software like e.g. EditiX. If
you do not specify a schema for your form (i.e. the field for the path of the schema is empty
- see below), you will see the XML output created by the database as shown below.

 

To choose a schema click on the button and select a schema from the list.
DiversityCollection contains several ready to use schemas in the folder Transaction -
Schemas - Sending. 
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Feel free to change these schemas according to your own needs (editors are available e.g.
from http://www.altova.com/). Choose the schema you need and click on the button to
create a document. To print the document use the button. To store the current document
for later reference in Documents click on the button. An example for a document is shown
below.

Sending list
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The specimens will be listed with their accession number, an optional label of the part, the
material category and if available the country and the collection year to ensure
discrimination in case a specimen contains more than one part. If available a permit will be
shown at the last position (see image below).

In the sending list - to see the details of a permit - click on the line containing the permit.
The details will for the permit will be shown as in the example below.

 

Finding addresses

The addresses used for the documents are taken from the module DiversityAgents, where
addresses are stored. Therefore the entries must at some point be linked to an entry in this
module. The program will try to find an address as shown below: First the transaction partners
(from ... and to ...) will be checked. If no address is available (e.g. if the transaction partner
is not linked to an entry in DiversityAgents), the program will try to find an address in one of
the superior transactions from the transaction partners found there. If no address exists in
these transactions, the program will try to get an address from the collections. Therefore, a
transaction partner linked to DiversityAgents is only necessary if either there are no addresses
for the collections or you wish to use a different address. The search path as described is
summarized in the image below.   
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No Access

If the data contain datasets, where you have no access to, this will be indicated as shown
below.    
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The access to the data rely on the result of the view TransactionList, combining the
transactions with missing administrating collection and those where the current user is a
member of the group CollectionManager with allowance for the collection where the
transaction is administrated. Transactions within a hierarchy to which the user has no access
will be displayed with gray titles .     
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Transactions - Sending  
In the sending tab page of the transaction window you can create the covering note for a
sent sample. To choose a schema click on the button and select a schema from the list.
DiversityCollection contains several ready to use schemas in the folder Transaction -
Schemas. 

To add a specimen to the list, you can use a barcode scanner. The code detected by the
scanner will be displayed in the field behind the symbol and entered in the list below. If no
scanner or barcode is available, use the combobox underneath, enter the first letters of the
accession number of the specimen and select your specimen from the drop down list. In case
your scanner is reading only parts of the barcode try to adjust the timer interval - click on
the button to open a window as shown below.

 

To restrict the selection of the specimens and parts of the specimens, you can check the 
Restrict to collection ... and Restrict to material ... options. To remove a specimen from
the list, use the button under the specimen list. If you want to see the details of a
specimen, choose it in the list and click on the button. Click on the button to create the
document as shown below. The upper list shows the parts on loan while the parts in lower list
are returned to another institution. For more details about the upper list see chapter
transaction.
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Transactions - Confirmation  
On this page you may create an inquiry letter for a package sent, e.g. if a parcel was sent to
a loan taker and no confirmation that the parcel reached its destination was returned so far.

With the button choose the schema you need. Click on the button to create a document.
To print the document use the button. To store the current document for later reference in
Documents click on the button.
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Transactions - Reminder  
If a loan or forwarding is due to return or a loan taker did not meet the deadline, you may
create a prompt note here. 

With the button choose the schema you need. Click on the button to create a document.
To print the document use the button. To store the current document for later reference in
Documents click on the button. 

In the upper right list the missing specimen and at the lower right list the returned specimen
are listed.
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Transactions - Printing / Inventory  
In addition to special pages for creating letters along with a loan, this page provides the
possibility to print cover letters, inventories etc. You may restrict the selected specimen to
the current collection, include subcollections or all related collections - simply activate the
corresponding checkboxes. 

To add a specimen to the list you may either use the combobox or a barcode scanner. To use
the barcode scanner move your mouse cursor into the pink field on the right of the scanner.
In case your scanner is reading only parts of the barcode, try to adjust the timer interval.
Click on the button to open a window where you may set the timer interval to a different
value. To remove a specimen from the list select it and click on the button.

With the button choose the schema you need. Click on the button to create a preview of
the document. To print the document use the button. To store the current document for
later reference in Documents click on the button. 
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Transactions - Documents  
The page Saved documents stores all the documents created or received along with a
transaction. A display text is automatically generated containing the type of the transaction
and the date. You may change this if you prefer a different text.

 

To add a document either use the button after creating a preview of a letter e.g. for
Sending . 

Next to the internal documents created within the program, you can include external
documents. You may scan an external document and create a screenshot of it. Then create a
new entry (click on the  button) and use one of these options: Add URI of document or 

Add image of document. The first option uses public available sources from a webserver
while with the second option later screenshots will be stored directly in the database and are
not accessible outside the database. If you want to print the document, double click on the
image to open a window enabling the printing of the document . For the first option you
may use the button to search for an URL in your default browser instead of the inbuilt
browser of the software which may not provide the whole functionality of a modern browser. 

In the lower part you may enter the text that should be shown in the interface (Display text),
the type and notes related to the document. With the type you may organize your documents
as needed. 
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Transactions - Balance  
This is the balance for the exchange between two collections. 

With the button choose the schema you need. Click on the button to create a document.
To print the document use the button. To store the current document for later reference in
Documents click on the button. To include either the subcollections of any related
collection or the collections of the current transaction select the corresponding checkboxes. 
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Transactions - Loan  
Loans of specimen from a collecting are documented with the transaction type loan (see
below).

 

For a loan granted to a loan taker, create a new transaction and set its type to loan. The
loan needs an administrating collection, which is the collection in which the specimen included
in the loan are located and for which the current user is registrated as collection manager .
The addresses are entered as links to DiversityAgents in the From and To areas. The To area
provides a recipient for inclusion in the address. The collections in the From and To area may
be used optionally as source of the address. The Begin and End fields mark the time span for
the loan. If the time of the loan should be prolonged, use the Prol.: field to enter the new end
date. Standard comments can be edited (Admin only) in the Customize section. In the 
Sending, Confirmation and Reminder sections you can create documents for the
communication with the loan taker. Documents as sent to or received from the loan taker are
available in the Saved documents section. If after the end of the loan all or a part of the
specimen are returned, create a Return transaction as child of the loan (see image above) and
include all returned specimen in this return transaction. 
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Transactions - Return  
If a loan is returned, a child transaction of the type return is created, containing the
returned items of the superior transaction. To do this, choose the loan in the tree and add
a new transaction as child as shown below. Then set the type of this new transaction to 
return. 

The state of the specimen will always be kept with the loan and you can add return incidents
as long as there are specimens on loan. A return incident can only be part of a loan
transaction. To transfer items into the return transaction, you have two options: can mark
the items in the loan list that should be transferred and click on the button or click into the
text field right of the icon and use a barcode scanner. To remove an item of the return list,
mark it in the list of returned items and click on the button.  

To you may create a notice of arrival here. With the button choose the schema you need.
Click on the button to create a document. To print the document use the button. To
store the current document for later reference in Documents click on the button.
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Transactions - Permit  
Permits for collecting specimen parts are documented with the transaction type permit (see
below).

 

Documents as received by the permitting institution can be entered under Saved
documents (see below). 

To add a permit to a specimen part, choose the part to which the regulation should be
added and click on the button. A window will open as shown below where you can select
the permit you want to insert. 
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In the main window, click on the permit to see the details as shown below. The details of a
permit will as well be shown for datasets in a sending list for a loan (see chapter Transaction
). 
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Regulations 
Regulations may be added for a part of a collection specimen. 

For surveillance of correct entries the regulations resp. their title must have been added for
the collection events before a insert for a part will be successful. 

To add a regulation to a specimen part, choose the part to which the regulation should be
added and click on the button. Depending on your permissions either a window as below will
open, listing all available regulations (see below) ... 

... or a textbox as shown below where you have to enter the title of the regulation. 

Choose or type the regulation you want to insert and click OK. The regulation will be inserted
as shown below.

If you do not have the proper permissions the regulation will be displaced without the title as
shown below.

To remove any regulation use the button. 

To administrate the regulations choose Administration - Transaction management - 
Transaction  ... from the menu. A window as shown below will open where the you can
administrate and create regulations (see below). See chapter Transaction or further details. 
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Transactions - Removal  
If specimens were removed from a collection e.g. by destruction or loss, you can create a
transaction of the type removal and add parts of the specimen in question to this removal. If
a specimen is part of a removal, it is shown as in the image below. 

To create a removal choose Administration -> Transaction management -> Transaction
from the menu, create a new transaction and choose the type removal for the new
transaction (see below). 

Page 292



Transactions - Embargo  
If specimens should not be published for a certain period, you are able to create a transaction
of the type embargo and add parts of the specimen in question to this embargo. If a specimen
is part of an embargo, it is shown as in the image below for current and past or future
embargos . 

To create an embargo choose Administration -> Transaction management ->
Transaction from the menu, create a new transaction and choose the type embargo for the
new transaction. The period of the embargo is defined by its Beginning and End (see below). 

To see the parts of a specimen that where selected and are included in an embargo choose 
Administration -> Withhold data...  from the menu. 
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Transactions - Payments  
The page Payments stores any payment within the transaction. To set the default
currency (only dbo), choose Administration - Customize display from the menu. In the
Transaction area use the Currency button to set the default currency for all payments.
This is done with the setup of the database and can not be changed after any payment has
been entered.

 

To add or remove payments use the and buttons. To set default currency for all
payments in the database choose Administration - Customize display... from the menu and
in the opening window the section Transaction (see chapter Customize). 
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Transactions - Identifier  
The page Identifier stores any additional identifier related to the transaction (see
below).  

 

For the administration of the types of identifiers see chapter External identifier. 
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Transactions - Agents  
The page Agents stores additional agents involved in the transaction (see image below)
that are not recorded otherwise. 
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Maintenance
To open the maintenance form choose Administration -> Maintenance ... from the menu.
With the maintenance functions you can update values cached from other modules or external
webservices. DiversityCollection can be linked with several other modules of the
DiversityWorkbench. If you link a data source to another module, the URI of the data set in
the other module together with one or several cached values will be stored in
DiversityCollection. Due to changes in the source modules these cached values may differ
from the original values. To get the actual values you can use the synchronize functions
for taxonomic names, family and orders, people, exsiccatal series, geographical names and

references. Further functions provided by maintenance are a search for duplicate
accession numbers, the insert of updated taxonomic names, the removal of orphaned
CollectionEventSeries and CollectionEvents, the search for additional geographical
information based on WGS84 coordinates and the conversion of coordinate systems.

With the button   you can set the timeout for critical queries used within maintenance and
feedbacks can be sent with the button .
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Maintenance - Taxonomic names
Taxonomic names may be linked to an external source. To synchronize the entries for the
taxonomic names derived from the module DiversityTaxonNames choose Administration ->
Maintenance... from the menu. A window will open as shown below. Choose the tab
TaxonNames. There are two ways to synchronize taxonomic names. You may either
Synchronize taxonomic names based on the link via an URI for entries where the link to a
taxonomic database is already established or you may Synchronize taxonomic names
missing a connection where no link is established and you can query for identical names in
one of the databases. 

Synchronize taxonomic names based on the link via an URI

The taxonomic names are stored in the field TaxonomicName in the table Identification. Select
a taxonomic database and a project and taxonomic group which should be synchronized. Start
the query with a click on the Check for differences button. 

 

If the taxonomic information has been imported into the cache database, you may use the
data from there to speed up the synchronization. 

The form will list all differences found. With the Select same genus and species button
you can restrict the selected entries to those where the genus and species are identical in
the source and the entry in collection. The other buttons will either select all or no entry 
. 

To update the database click on the Start update button. If you wish to have a more
detailed look on your data, you need to check the Include accession number checkbox
before starting the query. A button Close form and check dataset in database will
appear which will take you back to a single data set in the database.
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Synchronize taxonomic names missing a connection

Select a taxonomic database and a project within this database, a project in the collection
database and a taxonomic group to search for identical names. Start the query with a click on
the Check for identical names button. You have several options to search for fitting names:

Compare whole name 

Search for an exact match. With the option Excl. auth. you can extend the search for
names where the authors are missing in the identifications. 

Compare first parts 

Search for names fitting in first parts of the name as shown below. If the names do not match
exactly, you may either update the name ( Update similar name) in the collection
database or import the name from the DiversityTaxonNames as a new identification ( Insert
as new name - see options in the window depicted below). 

If you choose the option Restrict to last identification, the former identifications of an
organism will be ignored. 

If you choose the option Include fuzzy search, the program will try to find names with up
to 3 differences. The search with this option is rather time consuming and should only be used
for a small number of datasets. 

In the result list only matching names will be checked (column OK). The other results will be
marked indicating the difference.

If several similar names were found, these lines will be marked with a blue background. To
select one of the similar names click on the Select valid name button. A window will open
as shown below listing all similar names found in Index Fungorum. Select one name and click
OK to use it. 
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Search for broken links 

If for any reason links to webservices or modules are broken, e.g. when a webservice changes
its address, you can search for these (see below). Please make sure, that you are connected
with all source databases used for the taxa. Otherwise connections to these sources would be
assumed as broken. Choose the Project, for which you want to search for broken links and
optional restrict the search on a Source and a Taxonomic group. Click on the button to
start the search.

The broken links will be listed as shown below. With the Check dataset in database you
can inspect a single dataset. With the Select all and Select none buttons you can
select resp. deselect all datasets and show the selected datasets with the Close form and
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check whole list in the database button in the main window.

 

 

Update the display text for organisms according to last identification

If for any reason the displayed text for an organism does not correspond to the last
identification, this can be fixed under the Synchronize last identification tab. Just click on
the Search for organisms where the displayed text does not correspond to the last
identification   button to list the deviating display text and then on the Update the
displayed text for organisms according to the last identification button to synchronize
the displayed text with the last identification.
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Maintenance - Hierarchy
To synchronize the entries for the family, order and hierarchy of taxa derived from the module
DiversityTaxonNames choose Administration -> Maintenance from the menu. A window will
open as shown below. To synchronize the higher taxonomic entries for entries linked to the
module DiversityTaxonNames choose the tab Hierarchy. These entries are stored in the
fields FamilyCache, OrderCache and HierarchyCache in the table IdentificationUnit.

Select a taxonomic database, a project and a taxonomic group and then choose whether you
wish to synchronize the family, order or hierarchy. If you wish to inspect single data sets you
need to check the Include accession number checkbox. Then click on the Check for
differences   button to start the query. 

The form will list all differences found as shown above. To update the database click on the 
Start update button. 
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Maintenance - renaming identifications
If you wish to add updated taxonomic names for specimen in the database, you can use the
bulk insert function. Choose the project, the taxonomic group and the taxonomic name for
which the new identification should be added. As shown in the window below you may enter
additional information about this identification. By default the [Only last identification]
option is checked to prevent you from searching in older identifications. If you uncheck this
option, the program will search for any identification, irrespective whether it is the last or an
older identification. 

If you wish to check single data sets check the [Include accession numbers] option. A new

button will appear which will enable you to close the window and turn to
a specimen selected in the table. 

To search for names click on the [Test] button. The found names will be listed in the table as
shown below. To insert the new identification click the [Start insert] button.
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Maintenance - adding accpeted names 
If you wish to add accepted taxonomic names for specimen in the database were the
synonyms are used, you can use the insert function for accepted names. Choose the project,
the taxonomic group for which the new identification should be added as well as the source
for the taxonomic names and the projects within the taxonomic source from which the new
identifications should be taken. As shown in the window below you may enter additional
information in the notes field. 

Click on the Search for accepted names button to find the accepted names that may be
inserted. If you wish to check single data set, select this dataset in the grid and click on the
Close form and check dataset in database button.  

If some of the names should not be added, deselect them as shown for the 3. name in the
example below. To select or deselect all names you can use the All resp. None buttons.
To insert the selected names, click on the Start insert button. 
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Maintenance - Accession number duplicates
The database will warn but not prevent you from entering an accession number several times
e.g. via an import. In the main form a duplicate accession number is indicated with a red
background. To check for duplicate accession numbers choose Administration ->
Maintenance from the menu. In the window that will open, choose the tab page 
Specimen as shown below. You can restrict the query to a project or leave the project
empty in order to compare with all the available projects. For a restriction to certain numbers
you may enter a filter (using wildcards, see below). To start the query click on the Check for
duplicates button. 

The form will list all duplicates found as shown above. To switch to a data set in the database
select it in the table and click on the Close form and check dataset in database button.
To see only the selected rows, click on the Close form and check selected rows . To list all
duplicates in the main form click on the Close form and check whole list in database . To
compare the contents of duplicates, select the duplicate in the list and click on the button.
A window as shown below will open. All tables containing the data of the duplicates will be
shown. 

Use the button to optimize the width of the columns. The columns in the tables are marked
with different colors as shown in the image above. For the comparison of the data key
columns will be ignored unless you choose the option Compare text key columns. To
restrict the displayed tables and columns to those with differences, choose the Restrict to
differences option (see below). In the window for comparing the data, editing is not possible,
but you can open another client and edit the duplicated data. To show changes in the data
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performed e.g. in a second client, click on the button. 
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Maintenance - Exsiccatae
To synchronize the abbreviations of the exsiccatal series titles which are linked to the module
DiversityExsiccatae choose Administration -> Maintenance... from the menu. A window will
open as shown below. On the tab page Collection <-> Exsiccatae select the project for
which the titles should be synchronized. The title is stored in the field ExsiccataAbbreviation in
the table CollectionSpecimen. Select the project which should be synchronized and start the

query by clicking on the  button. 

The form will list all differences found. To update the database click on the 

button. If you wish to have a more detailed look at your data, you need
to check the "Include accession number" checkbox before starting the query. A button 

will appear which will take you back to a single data set in the database.
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Maintenance - Agents
To synchronize the names of collectors, determinators etc. which are linked to the module
DiversityAgents choose Administration -> Maintenance from the menu. A window will open
as shown below. On the tab page Collection <-> Agents select the project for which the
agents should be synchronized. There are 9 tables which may contain links to
DiversityAgents: Collection, CollectionAgent, CollectionEventLocalisation,
CollectionEventProperty, CollectionSpecimen, CollectionSpecimenProcessing, Identification,
IdentificationUnitAnalysis and Transaction. Choose one of these tables for the

synchronization. Then start the query with a click on the  button. The
type name is written as defined by the default display type in the module DiversityAgents - for
more information please see the documentation on DiversityAgents. 

The form will list all differences found. To update the database click on the 

button. If you wish to have a more detailed look on one of the data sets
in the list, you need to check the "Include accession number" checkbox before starting the

query. A button will appear which will take you back to a single data set
in the database. 

 

Search for possible links

You can either update the cached names for entries which are linked to DiversityAgents as
described above or you can search for possible links based on the names as shown below. In
addition to the options described above you may choose the display type for the query to find
any possible match as names may be written like "Hertel, H.", "H. Hertel" etc.
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Splitting collectors

If the collectors had been written in one field with separators like & you can split these to
create a separate entry for every collector (see below). Choose the project, enter the
separator or select one of the predefined separators and click on the Search for names to
split button. The result will be shown as in the example below. Click on the Start update
button to split the collectors. If several separators had been used you have to do the splitting
for every single separator.
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Maintenance - References
To synchronize the titles of the references which are linked to the module DiversityReferences
choose Administration -> Maintenance from the menu. A window will open as shown below.
On the tab page Collection <-> References select the project for which the reference titles
should be synchronized. With the first option you can Search for differences in the
reference. There are 3 tables which may contain links to DiversityReferences: CollectionEvent
, CollectionSpecimen and Identification. Choose one of these tables for synchronization. Start
the query with a click on the Check for differences button. 

The form will list all differences found. To update the data click on the Start update 
button. 

As a second option you can Search for references with the same title as found in the
module DiversityReferences (see below).

If there is more than 1 reference matching the entry in DiversityCollection, select the line and
click on the Select valid button to choose the correct reference. 
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Next to the references in the tables mentioned above, you can perform the same checks for
references stored in the table Annotation related to the tables  CollectionEvent,
CollectionSpecimen, CollectionSpecimenPart and IdentificationUnit. To use this option, check

Annotations for this table and select the table that should be checked (see below)  
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Maintenance - Retrieval type
To find observations (= organisms without a part in a collection) with missing retrieval type
choose Organisms - Retrieval type in the maintenance form as shown below. After
selection of the project, click on the Find missing retrieval types button. The organisms
missing a retrieval type will be listed as shown below. To inspect a single dataset, select it in
the list and click on the Show selected dataset button. To edit the data in the main form,
choose those you want to edit as shown in the image below and click on the Edit data in
main form button. If nothing is selected all data will be listed. If you want to insert the
missing retrieval type, selected the proper type from the list and click on the Insert retrieval
type button 
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Maintenance - Orphaned data
The removal of certain data may leave orphaned data as shown in the image below. The
removal of a specimen may leave event data without any relation to a specimen. As the
access to the data is organized via projects this relation is removed as well. So orphaned data
are accessible by anyone. Orphaned data may on the other hand exist due to the preparation
of events for upcoming expeditions and the like. Therefore care should be taken when
removing orphaned data to not remove preparations of other users. For an overview see a
short tutorial .

CollectionEvents & CollectionEventSeries 

The removal of orphaned event data is described in the Maintenance capters 
CollectionEventSeries and CollectionEvent.

 

Annotations 

Provided you have the proper rights you may remove orphaned data sets in the table
Annotation. To delete annotations which are not linked to any data in the database use the
tab page Annotations. These orphaned data sets may e.g. be derived from specimens which
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were deleted. Click on the List orphaned annotations button to list all annotations and their
related tables which are orphaned. The found annotations will be listed in the form. Click on
the remove orphaned annotations button to remove the data.

 

 

External Identifier 

As described for the annoations above you can delete orphaned external identifier in the tab 
Identifier (see below). 
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Maintenance - CollectionEventSeries
To delete CollectionEventSeries with no relation to CollectionEvents or other event series
choose the tab page Event series. Click the List orphaned event series button to list
these series. The detected data will be listed as shown below. In case there are orphaned
images these must be deleted first (see below). Click on the Delete orphaned event images 
and and the Delete orphaned event series button to delete the data. 
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Maintenance - CollectionEvent
CollectionEvents - orphaned events

Provided you have the proper rights you can remove orphaned data sets in the tables
CollectionEvent and CollectionEventSeries. To delete events which are not linked to any data
in the database use the tab page CollectionEvents - Remove orphaned data. These
unrelated data sets may e.g. be derived from specimens that were transferred to another
CollectionEvent. Click on the Find orphaned data button to list all events which are not
related to a specimen. The found CollectionEvents and their dependend data will be listed as
shown below. Click on the Start removal button to delete the data.

 

 

Country, Place and Altitude via GeoNames

If your data sets contain WGS84 Coordinates, you can use the webservice 
www.geonames.org to insert or update the country, the place or the altitude of your
collection sites. Choose the tab Set place and country, the project you wish to update
and an optional upper limit of the data sets (recommended for slow connections). Click the 
Query GeoNames button to start the query. According to the selected option (only if missing
/ when different / for all entries) the retrieved data will be marked with colors as shown in the
images below. 

Whit
e

The data set will be inserted or changed

Red An error occured
Grey According to the selected option this data set will not be inserted or changed
Yello
w

The data set has been deselected and will not be inserted or changed

Gree
n

The data set has been inserted or changed
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In the first column you can deselect a data set for the update. To inspect a single data set
from the list select it and click on the Close window and check data set button. To
update the data set click on the Set countries button. 

As for countries, the places will be listed as shown below. 

To insert or update the selected data sets click the Insert places button. 
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The image above shows the data for the altitude. After the update all updated data sets will
be marked green (see below). 

 

Sampling plots

If your data contains references to sampling plot coordinates, you can update the locality
description according to the name of the sampling plot (see image below). Click on the Start
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search button to find links to SamplingPlots where the locality description does not
correspond to the name of the sampling plot. You can restrict the search to missing locality
descriptions and attach the name of the sampling plot to the existing entry in the locality
description. Use the Start update button to set the locality description according to your
settings and the differences found. 

 

Method parameters

If your events contain methods where parameters for these methods had been added
afterwards, you can add these missing parameters. You may restrict the search for missing
parameters to certain methods and projects (see image below). Click on the Find differences 

button to search for missing parameters and on the Start update button to add them to
the methods used in the events. 

If your data contain or needs coordinates, please see the corresponding chapter on adding
and calculating coordinates.
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Collection date 

If your events contain missing or invalid collection dates you may search for these in the 
Collection date section (see below). Use the button to search for these datasets. In the
upper part of the window datasets with complete parts for a valid date but missing dates are
listed. These can be updated with a click on the button. In the lower part of the window
you find data with date parts that would result in an invalid date. Click in one of the lines and
then on the button to close the window and inspect and fix the listed data. 
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Maintenance - Collection event coordinates
Add Coordinates

If your data contain coordinates you can add additional coordinates in a different system for
those dataset, where entries of the additional coordinate system are missing. E.g. you can
add WGS84 coordinates on the basis of Gauss Krueger coordinates. In the Add coordinates
tab choose the project you want to update and an optional upper limit of the datasets. Then
select the source coordinates and the coordinate system these should be converted into.
Click on the Start conversion button to start the conversion. If a conversion is not
possible, the fields for the target system will be empty as shown below. The option Keep
accuracy ensures that the accuracy if present in the original data will be copied into the new
generated coordinates. Click the Insert coordinates button to insert the new coordinates
into you datasets.  

 

Calculate Coordinates

If your data contain coordinates e.g. written as non numeric entries like 59°21'W 10°12'S you
can try to calculate numeric values from these entries (see below). Select the project, the
maximal number that should be parsed and the type (currently only WGS84). Then start the
conversion with a click on the start calculation button. Click the Insert coordinates button
to insert the new coordinates into your datasets.  
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Check Coordinates

If your data contain coordinates these may be inconsistent between the 3 places the
coordinates are stored. To fix these inconsistencies use the functions showed in the image
below and a short tutorial .  

 

Add Coordinates for TK25 entries
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If your data contain TK25 (= MTB) entries you can try to retrieve the coordinates and
geography for these entries from data in the module DiversityGazetteer (see below). If the
source database is located on a different server, select the source from the list (for adding
source databases see chapter Connections). As the retrieval of the geographical data is
rather time consuming, you may restrict the number datasets tested. Choose a project and
click on the Find differences button to search for coordinates. Click the Start update 
button to update the TK25 entries with the found coordinates.  

 

Add TK25 entries for WGS84 coordinates

If your data contain WGS84 coordinates you can try to retrieve TK25 (= MTB) entries for
these entries from data in the module DiversityGazetteer (see below). Select the source for
the geographical information. If the source database is located on a different server and not
connected via a linked server, select the source from the list (for adding source databases
see chapter Connections). As the retrieval of the geographical data is rather time consuming,
you may restrict the number datasets tested. By default the range for the search is restricted
(Lat.: 47.1 - 55.2 and Long.: 6.0 - 15.2) to avoid the inclusion of coordinates where no TK25
information is expected. Choose a project and click on the Find missing TK25 button to
search for coordinates. If you want to check a single dataset in the main form, mark this
dataset and click on the button Close form and check dataset in database . Click the
Start insert button to insert the TK25 entries for the found coordinates.  

Page 324



A precondition for the above described handling of the TK25 datasets is the availablity of the
corresponding data in the Gazetteer database. The current range is shown in the image
below.  
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Coordinates outside TK25

If your data contain WGS84 coordinates outside TK25 (= MTB) entries these can be detected
in the Coordinates ouside TK25 part. Choose the project and click on the Find differences 
button. All entries with coordinates outside a TK25 entry for the same event will be listed (see
below). Click on the Close form and check all detected datasets in main form  button
to close the form and list the detected datasets in the main form.   
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Find coordinates outside an area 

If your data contain coordinates these may be positioned outside an area e.g. due to
swapping latitude and longitude. You can detect these errors by comparing all coordinates
within a project with an area as provided by DiversityGazetteer. In the maintenance form
choose Events - Coordinates - Coordinates outside area. You may restrict the search
with the country , the localisation sytem and the description of the locality (please use
wildcards like %). The areas for comparison are provided by DiversityGazetteer. Choose one of
the sources for areas. With the and buttons you can edit the list of area types from
which the area is selected. Click on the Choose area for comparison button to select the
area the coordinates should be compared with. A window will open where you can select
among the areas provided by the DiversityGazetteer database you selected as a source.
Finally click on the Find coordinates outside the area button. All corresponding
localisations will be listed as shown in the image below. To inspect a single dataset, select it
in the list and click on the Check selected dataset button. To edit the data in the main
form, click on the Edit datasets in main form button. If you mark some datasets in the
list, the selection in the main form will be restricted to these. Otherwise all datasets from the
list will be shown. For an introduction see a short tutorial .  
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Maintenance - Gazetteer
To synchronize the entries derived from the module DiversityGazetteer choose 
Administration -> Maintenance from the menu. A window will open as shown below. On the
tab page Gazetteer select the database containing the gazetteer data and the project for
which the entries should be synchronized. There are 2 parts for the synchronization: The 
Place and the Coordinates. Select one of these parts for synchronization. To start the
query click on the Check for differences   button. 

The form will list all detected differences. To update the database click on the Start update 
 button. 

Maintenance - Gazetteer: Adding links
To set links to the DiversityGazetteer for places which are not linked so far choose the second
tab under Collection <-> Gazetteer for synchronization of places missing a connection to
the DiversityGazetteer. Choose the database and the project and click on the Start query
button. The results will be listed as shown below.
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Many places have identical names in different regions. Names where several results were
found are marked in blue. To choose the correct name among the list of results, click on the 

 Select valid place button and select the correct name from the list as shown below. 

Finally, click on the Start update button to enter the results in the database. 
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Maintenance - Insert missing organisms in
specimen parts
To print a label for your samples you need to specify which of the organisms in the specimen
should be shown on the label. If for any reason the organisms where not included into the
parts as shown in the image below, you may do this belated for all data sets for a selected
project. 

Select the print tab as well as the project and click on the [Check for missing units in
parts] button. The missing entries will be listed as shown below. To insert them click on the
corresponding button. 

 

 

Set storage location to last identification
The image below displays the option to synchronize the storage location with the last
identification. Select the project and Search for differing storage . All parts with differing
storage location will be listed. To check a single dataset, select it in the list and click on the 

Check dataset button. A click on the Update storage locations button writes the new
versions of the storage locations in the database. 
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Maintenance - Images
The sorting of images may be changed for a whole project. Choose Administration ->
Maintenance from the menu. A window will open as shown below. On the tab page Images
select the project for which the images should be sorted. There are 4 options to sort the
images (see image below). Click on the button to list all images that may be sorted. To
write the selected sorting into the database click the button Change sequence of images . 
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Import / Export
There are several import mechanisms: 

An overview of some options for the im- and export of data is shown in the image below. The
export and reimport of tab-separated list allows external editing of the data in e.g. spread
sheet programs. An example for a dataflow from the original source to a webportal is show 
here.
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Import
There are several import mechanisms: 

 Import wizard for tab separated lists: Import data from foreign sources and attach
further data to existing data sets in the database. 

 Replication with a local database. 
 Restoring an Archive . 
 Outdated but kept for compatibility 

o Import of specimen scans (): Import image data, where the accession number is
a part of the file name. Image data can be imported together with default
information to the entire batch. 

o Import and reimport of tab-separated lists (outdated but kept for compatibility):
Import data from foreign sources and reimport after external editing. 
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Import specimen scans
Outdated but kept for compatibility.  

With this import routine you can import new data sets along with new images into the
database. To achieve this the image files should be named corresponding to the accession
numbers of the data sets which should be imported (e.g. M-003145 in the example below) and
an optional trailing identifier (e.g. _20070711_122541 in the example below. The image below
shows an overview of the entire import process.

To import images like scanned labels from specimens choose Data - Import - Specimen
scans... from the menu. A window for the import of images will be opened (see below).

The fields marked with  red  are mandatory. 
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Image source

To select the images you wish to import in the database click on the  button. A dialog will
open where you can select the images you wish to import into your database.

Select the files and close the window to enter the selection of the images in the list in the
form.

 

Import options and security checks

If you wish to replace data sets for images already in the database, check the Overwrite
existing images checkbox. If the images are located in a subfolder which is named according
to the first characters of the accession number, check the Place images in subfolder of
length checkbox and specify the length of the name of the folder. If you wish to check the
URIs of the images, check the corresponding checkbox. The data sets will then only be
imported if the images are available on the web. If the filename next to the accession number
contains a trailing identifier, it must be separated by a unique character. Check the
corresponding box and enter the separating character. If you wish to assess whether the
accession numbers are correct, you can check the start and the length of the accession
number by checking the appropriate checkboxes.   

Image list

The list shows the image files selected for the import. To test if all files passes the specified
checks, click on the Test import button. If the file name passed all checks, the OK field for
the image will be checked after the test. Otherwise an explanation for not passing the checks
will be shown in the  Error column. 

The first column of the list shows the accession number extracted from the file name. The
second column shows the file name of the original image file and the path written in the
database. These paths may differ from the original, if you select the option for setting a
different BaseURL. If a data set for an image already exists in the database and you selected
the Append images option, the checkbox Append at the right end of the table will be
checked.
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Database

You can set several mandatory and optional values to be written in the database for all
imported data. The fields marked with  red  are mandatory. These are the collections in which
the specimens are located: the material categories of the specimens, the project, the content
type of the scans (e.g. label) and the taxonomic group of the main organism in the specimens.
If you wish to refer to a web source for the labels instead of a local file, you need to provide
the base URL as well. Optional fields are a place according to the DiversityGazetteer and the
date of the gathering event, the collector, the accession date, an identification, an exsiccatal
series and the type of the label. For explanation of the buttons see module related entries . 

To test the import and whether the images are present in the database click on the 

 button. If everything is fine click on the button to start the
import. 

Logfile: To log the list of imported images and any errors during the import check the Create
log file checkbox. This will create a log file with your name, the date and time of the import in
the directory where the image files are located.

The program will check whether an accession number is already present in the database. It
will only import the data, if the option Append images if accession number is present is
checked. Otherwise this data will not be imported.

If the images will be provided by a webserver, check the appropriate checkbox and specify
the folder or click on the  button to search for the website.

In the overview below the mandatory fields are marked with red, the optional fields with
yellow.
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Import tab-separated lists
Outdated but kept for compatibility.  

With this import routine you can import data as tab-separated lists (plain text files) into the
database. Choose Data -> Import -> Import list... from the menu to open the window for
import. In the window click on the button to select the file with the data you wish to
import. Use the proper [encoding] to ensure that all special characters will be transferred
correctly. If you change the encoding after opening the file, click on the button to reload
the file with the new encoding. 

The content of the file will be shown in the upper part of the [Column mapping] tab page.
Use [Data start in line] to set the area for the import. Proceeding lines will be ignored and
depicted with a  gray background   as shown below. Every column in your file must be either
ignored or mapped to a column in the database. The lower part of the mapping section shows
your mapping while the upper part contains the first lines of your file. You can either use a
prepared column mapping or create a new one. To import a previous column mapping click on
the   button and choose one of the XML-files. 

Column mapping

For a column which should not be imported choose the  black  color from the group as shown
for the second column in the image below. These columns will be ignored for the analysis and
the import. For all other columns choose the [Table] and the [Column] your data
corresponds to. If you wish to import two different data sets in the same table, you need to
change the [Alias for table] to a unique value for this data set. 

If some columns should be transferred into one field, you have to choose a group for these
columns as shown below for columns 3 to 5, 6 to 9, ... . Simply choose a color from the group
combobox other than white or black to choose a group. To save the current mapping click on
the button. 
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To analyse the data in the file click on the [Analyse] button. During the analysis the program
may ask you to give additional information like the taxonomic groups of the imported
organisms. In the upper part of the window you may add information to be imported together
with your data from the file. The available options depend on the structure of your data. 

The image below shows the tab page where you can define the relations between two
organisms. This might be necessary if e.g. your data contains information on parasites and
hosts. The data tables which are related to an identification are listed with their aliases in the
lists for the identification tables. Use the    and    buttons to move them between the lists.
Use the    buttons to change the sequence within a list. With the [Host] option 
you define the host and the [Main] option defines which organism will be chosen as the first
to be printed e.g. on a label. 

 

 

By default one CollectionEvent will be created for each data set. 
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If the events should be joined following the entries in the file, you can choose the second
option as shown below. The import will create a new event, if there were any changes made
to the data related to the CollectionEvent, like the description of the locality, the altitude, the
coordinates etc.

 

If all the data sets belong to one EventSeries e.g. to one expedition, you can choose the
option as shown below and enter the code and description of the EventSeries in the
corresponding fields.

 

If you wish to use an existing EventSeries, click on the button and select a series from the
form. The code and description of the selected series will be shown as in the image below.

 

After your data was successfully analysed, the window will show you the result as shown in
the image below. During the analysis the program will add missing tables and columns
necessary for the import. The first data set will be shown in the form. If you wish to check
more data sets, set the number of the last position you wish to check and click on the 
[Analyse] button. The data is arranged according to the tables in the database in which they
will be imported. The underlined fields belong to the primary keys of the respective tables and
are red, if missing. These missing values will be generated during the import. If a data set
contains no values and will therefore not be imported into the database, the columns will be
shown in blue. To import these entries anyway choose the [import empty values] option. To
browse through the data sets in the preview use the buttons. 
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To import the data click on the [Start import] button. If you wish to import only part of the
data e.g. for a test, choose the [Import first ... lines] option.   
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Import wizard for tab separated lists
With this import routine, you can import data from text files (as tab-separated lists) into the
database. For an introduction see a short tutorial . Choose Data -> Import ->  Wizard
and then the type of data that should be imported, e.g. import Series ... from the menu.
A window as shown below will open that will lead you through the import of the data. The
window is separated in 3 areas. On the left side, you see a list of possible data related import
steps according to the type of data you choose for the import. On the right side you see the
list of currently selected import steps. In the middle part the details of the selected import
steps are shown. 

 

Choosing the File 

As a first step, choose the File from where the data should be imported. For an introduction
see a short tutorial . The currently supported format is tab-separated text. Then choose
the Encoding of the file, e.g. Unicode. The preferred encoding is UTF8. The Start line and
End line will automatically be set according to your data. You may change these to restrict
the data lines that should be imported. The not imported parts in the file are indicated as
shown below with a gray background. If the First line contains the column definition this
line will not be imported as well. If your data contains e.g. date information where notations
differ between countries (e.g. 31.4.2013 - 4.31.2013), choose the Language / Country to
ensure a correct interpretation of your data. Finally you can select a prepared Schema (see
chapter Schema below) for the import. 
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Choosing the data ranges

In the selection list on the left side of the window (see below) all possible import steps for the
data are listed according to the type of data you want to import.

The import of certain tables can be paralleled. To add parallels click on the button (see
below). To remove parallels, use the button. Only selected ranges will appear in the list of
the steps on the right (see below).

To import information of logging columns like who created and changed the data, click on 
button in the header line. This will include an additional substeps for every step containing the
logging columns (see below). If you do not import these data, they will be automatically filled
by default values like the current time and user.
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Attaching data 

You can either import your data as new data or Attach them to data in the database. For
an introduction see a short tutorial . Select the import step Attachment from the list.
All tables that are selected and contain columns at which you can attach data are listed (see
below). Either choose the first option Import as new data or one of the columns the
attachment columns offered like SeriesCode in the table Series in the example below. 

If you select a column for attachment, this column will be marked with a blue background (see
below and chapter Table data).

 

Merging data 

You can either import your data as new data or Merge them with data in the database. For
an introduction see a short tutorial . Select the import step Merge from the list. For
every table you can choose between Insert, Merge, Update and Attach (see
below). 

The Insert option will import the data from the file independent of existing data in the
database. 

The Merge option will compare the data from the file with those in the database according
to the Key columns (see below). If no matching data are found in the database, the data
from the file will be imported. Otherwise the data will be updated. 

The Update option will compare the data from the file with those in the database according
to the Key columns. Only matching data found in the database will be updated. 

The Attach option will compare the data from the file with those in the database according
to the Key columns. The found data will not be changed, but used as a reference data in
depending tables.  
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Empty content will be ignored e.g. for the Merge or Update option. To remove content
you have to enter the value NULL. As long as the column will allow emty values, the content
will be removed using the NULL value. 

 

Table data 

To set the source for the columns in the file, select the step of a table listed underneath the 
Merge step. All columns available for importing data will be listed in the central part of the

window. In the example shown below, the first column is used to attach the new data to data
in the database.

A reminder in the header line will show you what actions are still needed to import the data
into the table:

 Please select at least one column   = No column has been selected so far. 
 Please select at least one decisive column   = If data will be imported depends on the

content of decisive columns, so at least one must be selected.
 Please select the position in the file   = The position in the file must be given if the

data for a column should be taken from the file. 
 Please select at least one column for comparison   = For all merge types other than

insert columns for comparison with data in the database are needed.
 From file or For all   = For every you have to decide whether the data are taken from

the file or a value is entered for all
 Please select a value from the list   = You have to select a value from the provided

list 
 Please enter a value   = You have to enter a value used for all datasets 

The handling of the columns in described in the chapter columns. 

 

Testing 

To test if all requirements for the import are met use the Testing step. You can use a
certain line in the file for you test and then click on the Test data in line: button. If there are
still unmet requirements, these will be listed in a window as shown below. 

Page 348



If finally all requirements are met, the testing function will try to write the data into the
database and display any errors that occurred as shown below. All datasets marked with a red
background, produced some error.  

To see the list of all errors, double click in the error list window in the header line (see below).
 

If finally no errors are left, your data are ready for import. The colors in the table nodes in the
tree indicate the handling of the datasets: INSERT, MERGE, UPDATE, No difference. Attach,
No data. The colors of the table columns indicate whether a column is decisive , a key
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column or an attachment column .  

If you suspect, that the import file contains data already present in the database, you may
test this and extract only the missing lines in a new file. Choose the attachment column (see
chapter Attaching data) and click on the button Check for already present data. The data
already present in the database will be marked red (see below). Click on the button Save
missing data as text file to store the data not present in the database in a new file for
the import. The import of specimen contains the option Use default duplicate check for
AccessionNumber that is selected by default.  

If you happen to get a file with a content as shown below, you may have seleted the wrong
encoding or the encoding is incompatible. Please try to save the original file as UTF8 and
select this encoding for the import.  
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Import 

With the last step you can finally start to import the data into the database. If you want to
repeat the import with the same settings and data of the same structure, you can save a
schema of the current settings (see below). You optionally can include a description of you
schema and with the button you can generate a file containing only the description. 

Schedule for import of tab-separated text files
into DiversityCollection
Target within DiversityCollection: Specimen

Schedule version: 1 Database version: 02.05.41

Lines: 2 - 3215 First line contains
column definition: ?

Encoding: Unicode Language: de
 

Tables

CollectionSpecimen (CollectionSpecimen) 
Parent: CollectionEvent
Merge handling: Insert
Column in table

? Ke
y

Co
py

Pr
e

Po
st

Fil
e
po
s.

Tr
an
sfo
rm
ati
on
s

Va
lue

So
urc
e

Ta
ble

CollectionSpecimenID Dat
ab
as
e

AccessionNumber ? ? 0 Fil
e

IdentificationUnit_1 (IdentificationUnit) 
Parent: CollectionSpecimen
Merge handling: Merge

Column in table ? Ke
y

Co
py

Pr
e

Po
st

Fil
e
po

Transformations Value Source Table
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s.
CollectionSpecimenID Database
IdentificationUnitID Database
LastIdentificationCach
e

? 2 File

+ 3 File

+ 4 File

+ 5 File

TaxonomicGroup ? fish Interface

IdentificationUnitAnalysis_1_1 (IdentificationUnitAnalysis) 
Parent: IdentificationUnit_1
Merge handling: Update

Column in table ? Ke
y

Co
py

Pr
e

Po
st

Fil
e
po
s.

Transformations Value Source Table

CollectionSpecimenID Database
IdentificationUnitID Database
AnalysisID 94 Interface
AnalysisNumber 1 Interface
AnalysisResult ? ? 39 File

Lines that could not be imported will be marked with a red background while imported lines are
marked green (see below).

If you want to save lines that produce errors during the import in a separate file, use the
Save failed lines option. The protocol of the import will contain all settings according to the
used schema and an overview containing the number of inserted, updated, unchanged and
failed lines (see below).
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Description 

A description of the schema may be included in the schema itself or with a click on the 
button generated as a separate file. This file will be located in a separate directory Description
to avoid confusion with import schemas. An example for a description file is shown below,
containing common settings, the treatment of the file columns and interface settings as
defined in the schema.

Schedule for import of tab-separated text files into DiversityCollection
Target within DiversityCollection: Specimen

Schedule version: 1

Databa
se

version
: 

02.05.
52

Lines:2 - 5

First
line

contai
ns

colum
n

definiti
on: 

?

Encoding:Unicode Langu
age:de

Description: Import Schema fuer Literaturdaten (Bayernflora) aus Dörr &
Lippert mit MTB Daten und max. 4 Sammlern

 

File columns
Merge

handling of
table

Column
usage

Ins
ert

Me
rge

Up
dat
e

Att
ac
h

Dec
isiv
e

Key

Pos. Nam
e

Tabl
e

Column Example Transformed

0 ID
CollectionS

pecimen. 
ExternalI
dentifier

1

1 originalname
Identificatio

n_1_2. 
Taxonom
icName

Ophioglossum vulgatum
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2 nameautor
Identificatio

n_1_1. 
Taxonomi
cName

Ophioglossum vulgatum L.

3 taxnr
Identificatio

n_1_1. 
NameURI 3949

Prefix: http://tnt.diversityw orkbench.de/TaxonNames_Plants/

4 mtb
CollectionE
ventLocalis

ation_6. 

Location
1

8423

5 qu
CollectionE
ventLocalis

ation_6. 

Location
2

2

6 unschärfe
CollectionE
ventLocalis

ation_6. 

Location
Accuracy

7 jahr_von
CollectionE

vent. 
Collectio
nYear

1902

8 jahr_bis
CollectionE

vent. 
Collectio
nDateSu
pplement

Prefix: bis?

9 status
Identificatio

nUnitAnalys
is_1_1. 

Analysis
Result

10

verwa
ltung
seinh
eit

not imported

11 fundo
rt

not imported

12 finder not imported
13 ID_collector1

CollectionA
gent_1. 

Collector
sAgentU
RI

43708

Prefix: http://snsb.diversityw orkbench.de/Agents_BayernFlora/

14 ID_collector2
CollectionA

gent_2. 
Collector
sAgentU
RI

Prefix: http://snsb.diversityw orkbench.de/Agents_BayernFlora/

15 ID_collector3
CollectionA

gent_3. 
Collector
sAgentU
RI

Prefix: http://snsb.diversityw orkbench.de/Agents_BayernFlora/

16 ID_collector4
CollectionA

gent_4. 
Collector
sAgentU
RI

Prefix: http://snsb.diversityw orkbench.de/Agents_BayernFlora/
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17
primä
rquell
e

not imported

18 ID_primärquelle
Annotation_

1. 
Referenc
eURI

Prefix: http://id.snsb.info/references/

19

primä
rquell
e_sei
ten

not imported

20 bestand
Identificatio

nUnitAnalys
is_1_2. 

Analysis
Result

21 sonstiges
CollectionS

pecimen. 
OriginalNo
tes

22 höhe
CollectionE
ventLocalis

ation_7. 

Location
1

23 herba
r1

not imported

24 herba
r2

not imported

25 herba
r3

not imported

26 ID_herbar1
CollectionS
pecimenRel

ation_1. 

RelatedS
pecimen
Collectio
nID

27 ID_he
rbar2

not imported

28 ID_he
rbar3

not imported

29 det not imported

30 ID_de
t

not imported

31 rev not imported

32 ID_re
v

not imported

33 daten
quelle

not imported

34 ID_datenquelle
CollectionS

pecimen. 
Referenc
eURI

135

Prefix: http://id.snsb.info/references/

35 proje
ct1

not imported

36 project2
CollectionS

pecimen. 
Additional
Notes

O Beobachtung

Transform
ations:

Reglar express.: 

O ? Beobachtu
ng

Reglar express.: 
H ? Herbaraus
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w ertung
Reglar express.: 

L ? Literaturau
sw ertung

Interface settings
Table Table alias Column Value

Annotation Annotation_1 AnnotationType Reference

Annotation_1 Annotation Literaturauswertung: nach
Dörr & Lippert (2004)

Annotation_1 ReferenceDisplayText Annotation
CollectionAgent CollectionAgent_1 CollectorsName Collector1

CollectionAgent_2 CollectorsName Collector2
CollectionAgent_3 CollectorsName Collector3
CollectionAgent_4 CollectorsName Collector4

CollectionEvent CountryCache Germany
CollectionProject CollectionProject_1 ProjectID 37

CollectionProject_2 ProjectID 149
CollectionSpecimen ReferenceTitle Reference
CollectionSpecimenRelatio
n

CollectionSpecimenRelatio
n_1 RelatedSpecimenURI

CollectionSpecimenRelatio
n_1

RelatedSpecimenDisplayT
ext

CollectionSpecimenRelatio
n_1 Notes Herbarauswertung: nach

Dörr & Lippert (2004)
Identification Identification_1_1 IdentificationSequence 2

Identification_1_2 IdentificationSequence 1

Identification_1_2 Notes Originalname aus Dörr &
Lippert (2004)

IdentificationUnit IdentificationUnit_1 LastIdentificationCache plant
IdentificationUnit_1 TaxonomicGroup plant

IdentificationUnitAnalysis IdentificationUnitAnalysis_
1_1 AnalysisID 2

IdentificationUnitAnalysis_
1_1 AnalysisNumber 1

IdentificationUnitAnalysis_
1_2 AnalysisID 4

IdentificationUnitAnalysis_
1_2 AnalysisNumber 2
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Import wizard - Columns 

If the content of a file should be imported into a certain column of a table, mark it with the 
checkbox. 

Decisive columns 

The import depends on the data found in the file where certain columns can be selected as
decisive. Only those lines will be imported where data are found in any of these decisive
columns. To mark a column as decisive, click on the icon at the beginning of the line (see
below).

In the example shown below, the file column Organims 2 was marked as decisive. Therefore
only the two lines containing content in this column will be imported. 

 

Key columns 

For the options Merge, Update and Attach the import compares the data from the
file with those already present in the database. This comparison is done via key columns.
To make a column a key column, click on the icon at the beginning of the line. You can
define as many key columns as you need to ensure a valid comparison of the data.

 

Source 

The data imported into the database can either be taken From file or the same value that
you enter into the window or select from a list can be used For all datasets. If you choose
the From file option, a window as shown below will pop up. Just click in the column where the
data for the column should be taken from and click OK (see below).
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If you choose the For all option, you can either enter text, select a value from a list or use
a checkbox for YES or NO.

 

Transformation 

The data imported may be transformed e.g. to adapt them to a format demanded by the
database. For further details please see the chapter Transformation. 

 

Copy 

If data in the source file are missing in subsequent lines as shown below, 

you can use the Copy line option to fill in missing data as shown below where the blue
values are copied into empty fields during the import. Click on the button to ensure that
missing values are filled in from previous lines. 
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Prefix and Postfix 

In addition to the transformation of the values from the file, you may add a pre- and a postfix.
These will be added after the transformation of the text. Double-click in the field to see or
edit the content. The pre- and a postfix values will only be used, if the file contains data for
the current position. 

For the datatype geography the pre- and postfixes will be automatically set to enable the
import. The preset values by default are set for points as geographical units. You may change
this to predefined types like lines or areas. Click on the button at the end of the line to
open the information window. Here you can choose among the types mentioned above (see
below).  

 

Column selection 

If for any reason, a column that should take its content from the imported file misses the
position of the file or you want to change the position click on the button. In case a
position is present, this button will show the number of the column. A window as shown below
will pop up where you can select and change the position in the file. 

 

Multi column 

The content of a column can be composed from the content of several columns in the file. To
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add additional file columns, click on the button. A window as shown below will pop up,
showing you the column selected so far, where the sequence is indicated in the header line.
The first column is marked with a blue background while the added columns are marked with a
green background (see below). 

To remove an added column, use the button (see below). 

 

Information 

The button opens a window displaying the information about the column. For certain
datatypes additional options are included (see Pre- and Postfix). 
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Import wizard - transformation 

The data imported may be transformed e.g. to adapt them to a format demanded by the
database. Click on the button to open a window as shown below. 

Here you can enter 4 types of transformation that should be applied to your data. Cut out
parts,  Translate contents from the file, RegEx apply regular expressions or Replace text
in the data from the file. All transformations will be applied in the sequence they had been
entered. Finally, if a prefix and/or a postfix are defined, these will be added after the
transformation. To remove a transformation, select it and click on the button. 

 

Cut 

With the cut transformation you can restrict the data taken from the file to a part of the
text in the file. This is done by splitters and the position after splitting. In the example below,
the month of a date should be extracted from the information. To achieve this, the splitter '.'
is added and than the position set to 2. You can change the direction of the sequence with
the button Seq starting at the first position and starting at the last position. Click on the
button Test the transformation to see the result of your transformation. 
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Translate 

The translate transformation translates values from the file into values entered by the user.
In the example above, the values of the month cut out from the date string should be
translated from roman into numeric notation. To do this click on the button to add a
translation transformation (see below). To list all different values present in the data, click on
the button. A list as shown below will be created. You may as well use the and 
buttons to add or remove values from the list or the button to clear the list. Then enter the
translations as shown below. Use the save button to save entries and the Test the
transformation button to see the result.  
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To load a predefined list for the transformation use the button. A window as shown below
will open. Choose the encoding of the data in you translation source, if the first line contains
the column definition and click on the  button to open a file. Click OK to use the values
from the file for the translation. 

 

Regular expression 

The transformation using regular expressions will transform the values according to the
entered Regular expression and Replace by vales. For more details please see

Page 363



documentations about regular expressions. 

 

Replacement 

The replacement transformation replaces any text in the data by a text specified by the user.
In the example shown below, the text "." is replaced by "-".  

 

Calculation  

The calculation transformation performs a calculation on numeric value, dependent on an
optional condition. In the example below, 2 calculations were applied to convert 2-digit values
into 4 digit years. 
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Filter  

The filter transformation compares the values from the file with a value entered by the user.
As a result you can either Import content of column in file or Import a fixed value. To
select another column that should be compared, click on the button and choose a column
from the file in the window that will open. If the column that should be compared is not the
column of the transformation, the number of the column will be shown instead of the 
symbol. To add further filter conditions use the button. For the combination of the
conditions you can choose among AND and OR.  
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Export
There are several options to export your data. You can either export data of the entire
database or the content of the data sets listed in the specimen list. 

Export data of the whole database

Export of the content of the entire database is possible either as a backup on the database
server or as export as csv files. See the Backup chapter for more details. 

Export data of selected specimens

There are several export mechanisms: 

 Export of tab-separated lists 
o Export data in a tab separated format for external analysis or editing. 
o Export from Grid-Mode using the export function for Specimens, Organisms,

Parts and CollectionEvents. 
o Export of the content of a single datebase table with the Table editors . 
o Export via Spread sheets . 
o For a flexible export that includes data from linked modules, choose the export

wizard . 
 Export as SQLite database 

o Export via Spread sheets . 
o For a flexible export that includes data from linked modules, choose the export

wizard . 
 XML 

o ABCD: Export data as XML according to ABCD schema 2.06 (see www.tdwg.org
). 

o JSTOR: Export data as XML according to format of JSTOR and the Global
Plant Initiative respectively. 

 Label print 
o Generation of labels. 
o Generation of inventory lists.  

 Replication with a local database.
 Cache database .
 Creating an archive .
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Label
Select the printer in the header menu to switch to the printing mode. If your specimen
contains more than one part, choose the part of the specimen for which the label should be
generated. The sequence is shown in the image below and in a short tutorial .

 

Additional information about a label is entered in the label section (see image below). The data
are stored in the table CollectionSpecimen.

 

The organisms of a specimen are printed on a label according to the display order.

To print a label for a specimen you have to select a schema file. There are default schema
files available in the folder LabelPrinting/Schemas in your application directory (see below).
This is the default place to store schema files. 

Click on the  button to open the directory. You will find several prepared schema files
among which you can choose or change them to your own needs or create new ones
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respectively. The schema file /LabelPrinting/Schemas/Templates/LabelTemplates.xslt
provides templates for the other schema files. If this file is missing the generation of the label
may fail and you will get a warning. You may give a title for the print in the field Title.
From the Collection and MaterialCategory available for the selected specimen choose
one from the list (Coll./Mat.). To generate the label for the current specimen click on the 
 button. To generate labels for all specimens selected in your query click on the  button
(you may use the button to select all specimens). If you need duplicates of your labels

change the number in the duplicates box to the desired value. You can print 1 - 99
duplicates of one label. If there are more than 20 specimens in the list, you receive a warning
whether you really wish to create all these labels as this could be somewhat time consuming.
The labels are generated as XML files with XSLT-schema files, transformed to HTML-files and
depicted in a browser. To print the label click on the  button. 

If you wish to print labels for duplicates which are stored in a different collection, the
duplicate should be a child of the original specimen as shown in the example below.

 

Depending on the schema you use, the label will be marked as duplicate and contain a
reference to the original specimen (see below).
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If you wish to save the generated files for later printing, click on the  button to do so. Note
that the program will by default create a file Label.xml and in case a schema file is specified
a file Label.htm in the LabelPrinting directory which will be overwritten every time you
generate a new label. Thus, you need to save the file under a different name or in a different
directory to prevent the program to erase this data.

If you wish to print labels for all the specimens in the specimen list, you can restrict these to
the collection and the material category of the current specimen part (see image above).

If you do not select a schema file, i.e. the textbox Schema file: is empty, you will see
the generated XML-file as shown in the image below. The XML file is the base for all label
types you wish to generate. To create your own labels simply design your own XSLT-schema
file. See e.g. http://www.w3.org/TR/xslt for further information about schema files.

If you wish to reformat the accession number, you may choose among the options provided by
the program, e.g. conversion of arabic to roman numbers (BSPG-1988-007-00001 ->
BSPG-1988-VII-00001). Select the format from the combobox [Conversion] shown above.

 

Codes

For a short tutorial about the inclusion of codes in the label see a short tutorial .

Code 39 

If you use Code 39 for your labels and wish to print the barcodes on the labels, you need the
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font  , which is included in the DiversityCollection package. Place this font in the
folder where your fonts are stored (e.g.: C:\WINNT\Fonts). If the font is not available, the
barcode will appear as the accession number between two '*' signs. If this font does not do
the job you may try other fonts, e.g. code 39 from logitogo. Download the font, copy it into
your fonts directory and adapt the xslt file according to the line below: 

<xsl:variable name="FontBarcode"> font-size: 10pt; font-family: Code-39-Logitogo
</xsl:variable> 

QR-code 

To include a QR-Code in the label, activate the QR-Code generator and select the source
for the QR code (e.g.: AccessionNumber, CollectorsEventNumber, DepositorsAccessionNumber,
ExternalIdentifier, PartAccessionNumber, StableIdentier or StorageLocation). For certain
sources you can specify the type of the source (see below). Depending on your XSLT-schema
the QR code will appear in your label (see below). The QR-Codes are generated via a
Google-Api, which is only available if you have access to the Internet. The created QR-Code
images will be stored in the folder LabelPrint/img. This folder will be cleared for every printout.
So if you want to keep the label you need to copy the created file Lable.html together with
the folder img.
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Export data as tab-separated lists
Outdated but kept for compatibility.  

You can export the content of the datasets listed in the specimen list into a tab-separated
list. Choose Data - Export - Export list... from the menu. A window as shown below will
open. To change the preset path of the export file use the button. 

To start the export click on the [Start export] button. A file will be created in your
application directory, containing the exported data. A preview of the data is shown in the
lower part of the form. If you check the include columns for reimport option, the header
will contain an additional line for table names which you can use for reimporting the data. If
you check the include the SQL-Query option, the Text of the command for selecting the
datasets will be attached at the end of your report. The form will show the first lines as set in
the Show first ... datasets (range: 1 - 99) as a preview. During the first export, the list for
the fields for sorting the results [Order by:] will be filled. So if you need sorted results just
restart the export after selecting the field after the first export. 

To choose the fields you want to see in the export click on the button. A window
will open as shown below, where you can choose the fields you want to export. 
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Please keep in mind, that only the datasets listed in the specimen list of the main form will
be exported. If for example you set the maximal number for the specimen list to 100, only
these datasets will be exported, even if the number of datasets related to your query will be
more than 100. 

Please be aware, that you will get "cross joins" between the data in your database as in the
example shown below. If for example you start an export containing taxa and collectors and
you have 3 taxa and 2 collectors in a dataset this will result in 6 lines in the export: every
taxon combined with every collector (3 x 2 = 6). To evaluate the data you have to group the
results accordingly. The first line in the file corresponds to the description as shown in the
form above for the selection of the export fields. The second line shows the tables and the
third line the column within the database. The following lines contain the data. If you want to
avoid these cross joins and need only one line for each dataset, please use the export
function of the grid mode. 

Accession number Taxon Collector 
CollectionSpecimen IdentificationUnit CollectionAgent 
AccessionNumber LastIdentificationCache CollectorsName 
M-0013579 Arthrocladiella mougeotii (Lev.) Vassilkov Sandu, C. 
M-0013579 Arthrocladiella mougeotii (Lev.) Vassilkov Savulescu, T.
M-0013579 Blumeria graminis (DC.) Speer Sandu, C. 
M-0013579 Blumeria graminis (DC.) Speer Savulescu, T.
M-0013579 Lycium barbarum Sandu, C. 
M-0013579 Lycium barbarum Savulescu, T.
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Reimport tab-separated lists
Outdated but kept for compatibility.  

With this import routine you are able to reimport data in tab-separated lists which have been
exported from the database. Choose Data -> Import -> Reimport list... from the menu to
open the window for the reimport. To reimport data it must have been exported using the
option [add columns for reimport] to ensure correct header lines in your file. As the client
provides no possibility to change data on the basis of lists, you may export the respective
data to a tab-separated list, change your values and reimport the data.

In the window click on the button to select the file with the data you wish to import. Use
the proper [encoding] to ensure that all special characters will be transferred correctly. If
you change the encoding after opening the file, click on the button to reload the file with
the new encoding. The content of the file will be visible as shown below. For a reimport the
data will always start in line 7, indicated by a  gray background  of the header lines.

To analyse the data in the file click on the [Analyse] button. After a successful analysis, the
window will show you the result as shown in the image below. The first data set will be shown
in the form. If you wish to check more data sets, set the number of the last position you wish
to check and click on the [Analyse] button. The data is presented according to the tables in
the database where they will be inserted. Underlined columns belong to the primary key of the
respective tables and are red, if missing. These missing values will be generated during the
import. If a data set contains no values and will therefore not be imported into the database
or updated, the columns will be shown in blue. To import these entries anyway choose the
[import empty values] option. To browse through the data sets in the preview use the

buttons. 

To import your data click on the [Start import] button. If you wish to import only a part of
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the data, e.g. for a test, choose the [Import first ... lines] option. 
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Export wizard 
The export wizard provides a possibility to export the data selected in the main form. The
data are exported as tab separated text file. The export may include transformations of the
data as well as information provided by linked modules and webservices. Choose Data -
Export - Export wizard from the menu and then select one of the export targets (Event,
Specimen, ...). For a short introduction see the tutorial. 

 

Adding tables 

There are the following ways to add tables: 

 One parallel table
 Several parallel tables according to selected data
 Dependent table

All options will include the depending tables as defined for the default table. The option for
several tables will add as many tables as there are found in the data. 

If you added parallel tables, you should set the sequence of the datasets within these tables:
For the columns that should be used for sorting the data, set the ordering sequence to a
value > 0 and choose if the ordering sequence should be ascending or descending .

 

Adding related values 

Certain columns in the database may provide information linked to another table or a
module resp. webservice . Click on the button to add a linked value. 

 

Adding and editing file columns 

To add columns to the exported file, use the buttons. In the textbox at the top of the file
column, you can change the header for the column. To change the position of a file column
use the resp. button. To fuse a column with the previous column, click in the gray bar on
the left side of the column that will change to for fused columns. To remove a file column,
use the button. Pre- and postfixes for the columns can directly be entered in the
corresponding fields. To apply transformations on the data click on the button.

 

Filter 

To filter the exported data, use the filter function. Click on the button and enter the text for
the filter. Only data matching the filter string will be exported. If a filter is set, the button
will have a red background to remind you of the filter. The filter may be set for any number of
columns you need for the restriction of the exported data.

 

Rowfilter 

This filter in contrast to the filter above strictly applies to the row according to the sequence
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of the data. For an explanation see a short tutorial . 

 

Test 

To test the export choose the Test tab, set the number of lines that should be included in
the test and click on the Test export button. To inspect the result in a separate window,
click on the button.

 

Export 

To export your data to a file, choose the Export tab. If you want to store the file in
different place use the button to choose the directory and edit the name of the file if
necessary. Check the include a schema option if you want to save a schema together
with your export. To start the export, click on the Export data   button. To open the
exported file, use the button.

 

Export to SQLite 

To export your data into a SQLite database, choose the Export to SQLite tab. You may
change the preset name of the database in order to keep previous exports. Otherwise you
overwrite previous exports with the same filename. To start the export, click on the Export
data   button. To view the exported data, use the button.

 

Schema 

To handle the settings of your export, choose the Schema tab. To load a predefined
schema, click on the button. To reset the settings to the default, click on the 
button. To save the current schema click on the button. With the button you can
inspect the schema in a separate window. 
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Export wizard - transformation 

The exported data may be transformed e.g. to adapt them to a format demanded by the user.
Click on the button to open a window as shown below. For an introduction see a short
tutorial . 

Here you can enter 6 types of transformation that should be applied to your data. Cut out
parts,  Translate contents from the file, RegEx apply regular expressions or Replace
text and apply Calculations or Filters on the data from the file. All transformations will be
applied in the sequence they had been entered. Finally, if a prefix and/or a postfix are defined,
these will be added after the transformation. To remove a transformation, select it and click
on the button. 

 

Cut 

With the cut transformation you can restrict the data taken from the file to a part of the
text in the file. This is done by splitters and the position after splitting. In the example below,
the month of a date should be extracted from the information. To achieve this, the splitter '.'
is added and then the position set to 2. You can change the direction of the sequence with
the button Seq starting at the first position and starting at the last position. Click on the
button Test the transformation to see the result of your transformation. 
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With the Start at Pos. option the given splitters will be converted into space (' ') and the
whole string starting with the given position will be used (see below). 

 

Translate 
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The translate transformation translates values from the file into values entered by the user.
In the example above, the values of the month should be translated from roman into numeric
notation. To do this click on the button to add a translation transformation (see below). To
list all different values present in the data, click on the button. A list as shown below will be
created. You may as well use the and buttons to add or remove values from the list or
the button to clear the list. Then enter the translations as shown below. Use the save
button to save entries and the Test the transformation button to see the result.  

To load a predefined list for the transformation use the   button. A window as shown below
will open. Choose the Encoding of the data in your translation source and indicate if the 
First line contains column definition. Click OK to use the values from the file for the
translation. 
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Regular expression 

The transformation using regular expressions will transform the values according to the
entered Regular expression and Replace by v values. For more details please see
documentations about regular expressions. 
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Replacement 

The replacement transformation replaces any text in the data by a text specified by the user.
In the example shown below, the text "." is replaced by "-".  

 

Calculation  

The calculation transformation performs a calculation on numeric value, dependent on an
optional condition. In the example below, 2 calculations were applied to convert 2-digit values
into 4 digit years. 
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Filter  

The filter transformation compares the values from the data with a value entered by the user.
As a result you can either Export content into file or Export fixed value. To select
another column that should be compared, click on the button and choose a column from
the file in the window that will open. If the column that should be compared is not the column
of the transformation, the number of the column will be shown instead of the symbol. To
add further filter conditions use the button. For the combination of the conditions you can
choose among AND and OR.  
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Export wizard - tutorial
This tutorial demonstrates the export of a small sample from the database. For an introduction
see a short tutorial . 

Choosing the data 

 In the main form, select the data that should be exported (only the data displayed in the
query results are exported). 

Exporting the data 

Choose Data -> Export -> Wizard -> Organism ... from the menu. A window as shown
below will open where the available tables for export are listed in the upper left area. To show
the data columns of a table, select this table in the list. 

 

Adding additional tables 

In this example, we want to add as many parallel identification tables as present in the data.
To do this, click on the button of the Identification table. At the end of the list (depending
on your data) the additional tables are added (see below). 
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Setting the sequence for the tables 

To set the sequence of the Identifications, select the first table and for the column
IdentificationSequence set sorting sequence to 1 and the direction for sorting to descending 

.  
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Choosing data from linked modules 

Some columns provide the possibility to add data from linked tables or modules. In this
example we choose the column NameURI linking to the module DiversityTaxonNames (see
below). 
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To provide linked values, click on the button. A window as shown below will open, where
you can choose among the provided services.

After the service is selected, you will be asked for the value provided by the service (see
below).

Now the selected link is added underneath the column as shown below. You can add as many
links as you need for your export.
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For some modules there are values that refer to other modules with a name like Link to ... as
shown in the example below.

If you select one of theses values, you will be asked to select the service or database linked
to this modul (see below)

... and then to select one of the provided columns (see below)

Within the form this linked values will be marked as shown below. If several results are
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retrieved these will be separated with by " | ".

 

Adding columns to the file 

To add columns to the exported file, click on the buttons for the columns resp. linked
values. In this example select all Family values and the TaxonomicName (see below).

 

Fusing columns 

The families should appear as one column and as the sources can exist only once for each
identification we can fuse these columns. To do so, click on the delimiters between these
columns (see below). 
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Setting the headers 

By default the headers for the exported data are set according to the names of the columns
in the database. To change this, edit them as shown below where TaxonomicName has been
changed to Taxon (see below). For fused columns only the header in the first column will be
used. 

 

Testing 

To test the export, click on the Test export button. The result depends on the content in
your data but should look similar as shown below. 

 

Export 

To finally export the data, choose the Export tab. By default the data will be exported into
tab separated file in a directory in the application directory (see below). You can change the
directory (click on the button). You can choose the Include schema option to create a
schema that you may reuse in a later export. 
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Export for the Global Plant Initiative / JSTOR
To export the data of the specimen selected in the specimen list according to the Global Plant
Initiative / JSTOR choose Data -> Export -> XML  -> GPI / JSTOR ... from the menu. A
window will open where you can set some additional options for the export (see below). The
data sets will be exported according to the JSTOR Plant Science Handbook (June 2011). 

If the data does not fulfill the criteria of the Global Plant Initiative / JSTOR, the errors will be
listed as shown below. You have to fix these errors in your data to create a valid export file.
To start the export click on the Start export button. The data will be exported into a file in
your application directory. Click on the button to inspect the exported data (see below). 
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If the data are not restricted to names linked to a thesaurus (see option in image above), the
export will take information like the family from the linked thesaurus if available (e.g.
DiversityTaxonNames). Otherwise information stored in DiversityCollection will be used (if
available). If neither is available the export will insert a message like "not assigned" and the
error report will contain a message like "Family is missing". 
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Export CSV
To export the tables of the database in a tabulator, comma or semicolon separated format,
choose Data -> Export -> Export CSV... from the menu. A window as shown below will open
where you can select the tables to be exported in sections [Selection criteria] and in the
[Tables for export]. 

A prerequisite for this export is that the bcp program is installed on your computer. This has
either been installed together with the installation of SQL-Server or you have to install the
Microsoft Command Line Utilities for SQL Server. 

To start the export click on the Start export button. By default the data will be exported
into a directory ...\Export\<database_name> below your application directory. Click on the 
button to select a different target directory before starting export. 
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After export the tables are marked with green background, if table schema and data were
exported successfully. If only the data were exported, this is marked with yellow background,
if nothing was exported, the background is red. A detailed export report can be viewed by a
click on the export result file name.  
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Export ABCD
In the current version only the main data from DiversityCollection will be exported to ABCD. 

To export the data of the specimen selected in the specimen list following the ABCD schema
2.06 choose Data -> Export -> XML (ABCD Schema)... from the menu. A window will open
where you can set some additional parameters defined in ABCD and BioCASE respectively as
shown below. 

To start the export click on the Start export button. The data will be exported into a file in
your application directory. Click on the button to inspect the exported data (see below). 
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Page 396



Cache database
The cache databases for DiversityCollection are designed as sources for preformatted data for
publication in e.g. public user portals like GBIF. For an introduction see a short tutorial   
. The cache database by default has a name corresponding to the main source database, e.g.
DiversityCollectionCache and is located on the same server and by itself is the source for the
data in Postgres (Version 9.4 or above) cache databases located on any Windows or Linux
server (see image below). An overview for the basic steps is provided in chapter Basic steps
for publication of data via the cache database. 

 

Generating the cache database 

To create a cache database you need to be a system administrator (s. Login administration).
The creation of the cache database is described in the chapter Creation of the cache
database. 

 

Projects 

The publication and transfer of the data is always related to a project. Every project has its
own database schema containing the data tables etc. The metadata are defined via settings
in a DiversityProjects database. The Projects module provides a stable identifier for each
Project. The basic address has to be set in the Project module (choose Administration -
Stable identifier ... in the menu). Please turn to the module DiverisityProjects for further
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information. The metadata will be transferred into a table in the cache database. For further
details see chapter Projects in the cache database. 

 

Scientific terms, agent, taxonomy and other sources 

As well as data from DiversityCollection, data from other modules like DiversityScientificTerms
containing terms, DiversityTaxonNames containing the taxonomy, including accepted names
and synonyms are transferred into the cache database and may be retrieved from the local
server or a linked server. The data of these sources are stored and transferred independent
from the project data. For further details see the chapters about agents, terms and taxonomy
. 
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Import / Export - example for a data flow
In the image below, an expample for a data flow from the original source to the final
GBIF-portal is shown. As a first step the data are imported via the Import wizard are
imported into the database. After the data are given free for publication, they are transferred
into the cache database .  From there they are transferred into a Postgres database 
containing a package for conversion into ABCD. Finally the BioCASE tool for mapping the
data is used to provide the data for GBIF.
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Basic steps for publication of data via the
cache database
1 - Create the cache database 

To create a cache database as shown in a short tutorial and in the chapter Creation of the
cache database you need to be a system administrator (s. Login administration). After this
step the cache database should be available and you can create a Postgres database as final
target of your data. 

2 - Create a Postgres database 

The final formatting of the data e.g. for publication via webservice are performed in a Postgres
database. If no server providing Postgres is available, you may install Postgres on your local
machine (see https://www.postgresql.org/ for further information). The creation and
administration of a Postgres database is described in a short tutorial and in chapter
Administration of the Postgres cache databases. 

3 - Insert sources for taxonomic names, scientific terms, agents etc. 

This step is optional and depends upon the availability of a source for e.g. taxonomic names.
You may either use sources from your local server or the public available sources provided by
tnt.diversityworkbench.de (turn to http://www.snsb.info for further information). For a
introduction see a short tutorial . The needed settings are described in chapter Sources
from other modules.  

4 - Insert a project 

The data published in the cache database are organized according to the projects. Add a
project as shown in a short tutorial and described in chapter Projects in the cache
database. In the source database, make sure that the data within this project are not
withheld from publication (see chapter Availability of data sets for more details) and that the
ranges you want to publish are set properly (see chapter Restrictions for the datatransfer into
the cache database).  

5 - Transfer the data 

The final transfer of the data is described in chapter Sources for other modules and chapter
Transfer of the data. 

6 - Publish or export the data 

To export the data or prepare them for publication according to the specifications of
webservices etc. the data frequently need to be formatted. This is done with packages as
described in chapter Administration of the Packages. 

7 - Map data via BioCASe (only for ABCD consuming publishers like GBIF) 

For publishers using ABCD like GBIF, use the BioCASe provider software and mapping tool to
link the data formatted with the ABCD package.   
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Administration of the Postgres cache
databases
To create a Postgres cache database, you must be
connected with a server running Postgres  (Version 9.4
or above). To connect to a server, click on the button
and enter the connection parameters. If no cache database
has been created so far, connect to the default database 
postgres as shown below.

After connecting to the Postgres server, click on the 
button to create a new cache database (see below). You
will be asked for the name of the database and a short
description.

After the database was created, you have to update the
database to the current version. Click on the Update 
button to open a window listing all needed scripts. To run
these scripts just click on the Start update button.
After the update the database is ready to take your data.
Subsequent updates may become necessary with new
versions of the database. For an introduction see a short
tutorial . To remove the current database from the
server, just click on the button.

In the image on the right you see a screenshot from the
tool pgAdmin III. You may use this tool to inspect your data
and administrate the database independent from
DiversityCollection. Please keep in mind, that any changes
you insert on this level may disable your database from
being used by DiversityCollection as a sink for your cache
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data. The data are organized in schemata, with public
as the default schema. Here you find functions for
marking the database as a module of the Diversity
Workbench and the version of the database. The function
highresolutionimagepath translates local image paths into
paths for high resolution images. To use this function it
must be adapted to your local server settings. The tables in
this schema are TaxonSynonymy where the data derived
from DiversityTaxonNames are stored and ScientificTerm
where the data derived from DiversityScientificTerms are
stored. For every project a separate schema is created
(here Project_BFLsorbusmmcoll). The project schemata
contain 2 functions for the ID of the project and the
version. The data are stored in the tables while the
packages in their greater part are realized as views and

functions extracting and converting the data from the
tables according to their requirements.  
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Creation of the cache database 
To create a cache database you need to be a system administrator (s. Login administration).
To create the cache database, choose Data - Cache database ... from the menu. If so
far no cache database exists, you will be asked if a new one should be generated. After the
generation of the cache database a window as shown below will open. For an introduction see
a short tutorial . 

Click on the Update button to update the database to the latest version. A window as
shown below will open. Click on Start update to execute all the scripts needed for the
latest version of the database.

During the update you may encounter under certain circumstances the message that the test
of the generic functions failed (see below).

The most probable reason for this is that the name of your projects database does not
correspond to the specifications of the update-script. This error can easily be fixed. As an
administrator use the Microsoft SQL Server Management Studio. In the directory of your
cache database select the Scalar-valued Function dbo.ProjectsDatabase ...
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... and use Modify from the context menu. In the Code of the function (see below) change
the last set @DB = ... to the real name of your projects database.

The result may look as shown below. After the change, press F5 to execute the script.

After the function returns the correct name of the ProjectsDatabase, the update script should
proceed without further error messages. 
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Cache database - User administration
There are 2 roles in the cache database with a general access to the data: CacheAdmin (for
the administration and transfer of the data) and CacheUser (with read only access). The data
in the cache databases are organized in projects. Therefore for every project you find 2
additional roles within the data range of every project: CacheAdmin_Project_... and
CacheUser_Project_... with access to the data corresponding to the roles above. You find
these roles in the SQL-Server cache database as well as in the Postgres database.

To administrate the logins in the SQL-Server database, click on the button to open a
window as shown below. To administrate the access for other logins, you have to be a 
System administator. For further details please see the chapter about the login
administration for the main database.

 

Postgres database 

To handle the logins and user groups on the Postgres database server, click on the button.
A window as shown below will open, where you can create and delete logins and groups. For
the logins you can change their membership in groups and their properties (see below). On the
left you find 2 lists, with the upper list containing the logins and the list below with the groups
resp. roles. For the logins you can set the general properties as shown below. The login
postgres is created with the installation of the database and is the login for the administration
of the database including the updates etc. For details about predefined properties like "Is
superuser", please turn to the Postgres documentation. 
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In the Membership in groups area you can define the groups in which the login is a member
(see below). 

For the groups you can change their membership in other groups and their permissions (see
below). 
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Sources from other modules
To provide details from other modules like DiversityTaxonNames, DiversityAgents,
DiversityScientificTerms etc. in the cached data, this information is transferred into the cache
database together with the data from DiversityCollection database. Use the button to add
a source for the data you need. The data for the cache database are provided via views that
will be created for you. With the button you can list the sources used in the projects to get
a hint of what may be needed. The tables and view for the sources are placed in the schema
dbo in the SQL-Server cache database and public in the Postgres cache databases. For
an introduction see a short tutorial . 

Subsets

The sources of some module provide additional subsets to the main data. To select the
subsets that should be transferred to the cache database, click on the button. In the
upcoming dialog (see the example for DiversityTaxonNames below) select those subsets you
want to transfer in addition to the basic name list. 

Transfer

Single manual transfer

To transfer the data of a single source into the   cache database use the button and the
buttons to inspect the content. 

To transfer the data into the Postgres database, you have to connect with a database
first. Use the button to transfer the data from the   cache database into the  Postgres
database. The button will transfer the data of all sources in the list into the cache database
(see below).

Scheduled transfer

To transfer the data of all sources into the   cache database and all available Postgres
databases, use the scheduled transfer as background process. With this transfer all available
Postgres databases will be included in the data transfer. These targets are indicated
underneath the Postgres block (see image below). 

If the target is placed on the current server, the text will appear in black as shown below. 
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Removal 

With the button you can remove the sources together with the views (see above). 
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Anonymous collectors 
If collectors should be published as an anonym string, edit the Anonymous collectors list.
Use the > button to move a collector from the selected project into the list of anonymous
collectors. To remove a collector from this list, just delete it from the table (see below).

In the cache database these collectors will be translated into the selected Anonymisation
and a number, e.g. Anonymus 1. So the data of one collector can still be recognized without
revealing the name of the collector.
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Projects in the cache database
The data transferred into the cache database are always transferred according to a project
they belong to. If no projects were added so far the window will appear like shown below. For
an introduction see a short tutorial .

To add a new project for the transfer into the cache database, click on the Add project 
button. In the area below a new entry as shown below will appear. The area on the right
shows the number of datasets in the project in the source database together with the date of
the last update. To ensure the separation of the data between the projects,
DiversityCollection creates a separate schema for every project named Project_[name of the
project] together with needed roles, tables etc.. 

Before transferring data you have to update the project schema to the latest version,
indicated by the appearance of an update button . Click on the button to open a window
as shown below. Click on the Start update button to update the schema to the latest
version. 
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After the update the database is ready to transfer data into.  

Besides the restrictions in the source database, you can set further restrictions for this
transfer. Click on the button to edit the datawithholding reasons for the data of the
project. Click on the button and choose the ranges of the data that should be transferred
(see below). 
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To transfer the data you have 3 options as described in the Transfer chapter.

Afterwards the number and date of the transferred data are visible as shown below. 

To inspect the transferred data use the View content button. A window as shown below
will open where all tables containing the data of the project are listed. 

Click on the button to filter the content. A window as shown below will open. Choose the
column for the filter, the operator (e.g. = ) and the filter value (see below). 
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Now click on the button to add the filter criteria to the table filter. You may add as many
criteria as needed (see below). With the button you can clear the filter.. 

Before you can transfer the data into the Postgres database, you have to connect to the
Postgres database and click on the button to establish the project and run necessary
updates . After the project is established and up to date, use the button to transfer the
data in the Postgres area (see below).

If a project is exported into another Postgres database on the same server, these
databases will be listed underneath the Postgres block (see image below). For an overview of
all target Postgres databases click on the button. 

If the target is placed on the current server, the text will appear in black (see image below).
Packages will be listed for the other targets as well. 

 

In the Postgres database you can install packages to adapt the data to any needed
format. 
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Restrictions for the data transfer into the
cache database 
The restrictions of the published data are defined in the main database via projects , data
withholding and embargos . 
In the cache database further restrictions can be set for every project and include the
taxonomic groups , the material categories and the localisation systems that are
transferred. The colletors may be anonymized. For the localisation systems it is possible to
restrict the precision of the coordinates. To set these restrictions, click on the  button. A
window as shown below will open. 

Restrict the localisation systems the taxonomic groups , the material categories , the
analysis and by moving the entries between the Not published and Published list. For an
overview see a short tutorial . 
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Transfer of the data
To transfer the data you have 3 options: 

 Single transfer : Transfer data of a single project
 Bulk transfer : Transfer data of all projects and sources selected for the schedule

based transfer

With the resp. button you can decide if the data should be checked for updates. If this
option is active ( ) the program will compare the contents and decide if a transfer is needed.

If a transfer is needed, this will be indicated with a red border of the transfer button . If
you transferred only a part of the data this will be indicated by a thin red border for the

current session . The context menu of the button View differences will show the
accession numbers of the datasets with changes after the last transfer (see below). 

Competing transfer 

If a competing transfer is active for the same step, this will be indicated as shown below.
While this transfer is active, any further transfer for this step will be blocked.

If this competing transfer is due to e.g. a crash and is not active any more, you have to get
rid of the block to preceed with the transfer of the date. To do so you have to reset the
status of the transfer. Check the scheduler as shown below. This will activate the 
button.

Now click on the button to open the window for setting the scheduler options as shown
below.
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To finally remove the block by the Active transfer, click on the button. This will remove the
block and you can preceed with the transfer of the data.

 

Single transfer 

To transfer the data for a certain project, click on the button in the Cache- or Postgres data
range (see below). 

A window as shown below will open, where all data ranges for the transfer will be listed. With
the  button you can set the timeout for the transfer of the data where 0 means infinite and is
recommended for large amounts of data. With the button you can switch on resp. of the
generation of a report. Click on the Start transfer button to start the transfer. 
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After the data are transferred, the number and data are visible as shown below. 
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After the data are transferred successful transfers as indicated by an error by . The
reason for the failure is shown if you click on the button. For the transfer to the Postgres
database the number in the source and the target will be listed as shown below indicating
deviating numbers of the data. For the detection of certain errors it may help to activate the
logging as described in the chapter Transfer Settings. 
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To inspect the first 100 lines of the transferred data click on the button. 

 

Bulk transfer 

To transfer the data for all projects selected for the schedule based transfer, click on the 
button in the cache- or Postgres data range (see below). 

Together with the transfer of the data, reports will be generated and stored in the reports
directory. Click on the button in the Timer area to open this directory. To inspect data in
the default schemas (dbo for SQL-Server and public for Postgres ) outside the project
schemata, use the buttons shown in the image above. 

 

Transfer as background process 

Transfer data from database to cache database and all Postgres databases 

To transfer the data as a background process use the following arguments: 

 CacheTransfer
 Server of the SQL-server database
 Port of SQL-server
 Database with the source data
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 Server for Postgres cache database
 Port for Postgres server
 Name of the Postgres cache database
 Name of Postgres user
 Password of Postgres user

For example: 

C:\DiversityWorkbench\DiversityCollection> DiversityCollection.exe CacheTransfer
snsb.diversityworkbench.de 5432 DiversityCollection 127.0.0.1 5555 DiversityCollectionCache
PostgresUser myPostgresPassword

The application will transfer the data according to the settings, generate a protocol as
described above and quit automatically after the transfer of the data. For an introduction see
a short tutorial . The user starting the process needs a Windows authentication with
access to the SQL-Server database and proper rights to transfer the data. The sources and
projects within DiversityCollection will be transferred according to the settings (inclusion,
filter, days and time). The transfer will be documented in report files. Click on the button to
access these files. For a simulation of this transfer click on the Transfer all data according to
the settings  button at the top of the form. This will ignore the time restrictions as defined
in the settings and will start an immediate transfer of all selected data. 

To generate transfer reports and document every step performed by the software during the
transfer of the data use a different first argument: 

 CacheTransferWithLogging
 ...

C:\DiversityWorkbench\DiversityCollection> DiversityCollection.exe CacheTransferWithLogging
snsb.diversityworkbench.de 5432 DiversityCollection 127.0.0.1 5555 DiversityCollectionCache
PostgresUser myPostgresPassword

To transfer only the data from the main database into the cache database use a different first
argument: 

 CacheTransferCacheDB
 ...

To transfer only the data from the cache database into the postgres database use a different
first argument: 

 CacheTransferPostgres
 ...

The remaining arguments correspond to the list above. The generated report files are located
in the directory .../ReportsCacheDB and the single steps are witten into the file
DiversityCollectionError.log. 

History 

For every transfer of the data along the pipeline, the settings (e.g. version of the databases)
the number of transferred data and additional information are stored. Click on the  button in
the respective part to get a list of all previous transfers together with these data (see
below). 
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Administration of the Packages
The formatting of the data according to the specifications of webservices etc. is done with
packages. There is a growing list of packages provided with the software. For new packages
either turn to the developers or create a package of your own. The packages are realised as
view, functions etc. reading the data in the tables without any changes to the data. They
therefore can be inserted and removed without any effects on the original data. The naming
of the objects within a package follow the schema [Name of the package]_... as shown in the
images below. For an introduction see a short tutorial .  

To administrate the packages installed within one project, click on the button. A window as
shown below will open listing all available packages. 

Click on the button to establish the selected package. To ensure the current version of the
package, click on the Update to vers. ... button (see below). 

A window will open where all the needed scripts will be listed. For packages keeping the data
in their own tables like ABCD it may be necessary to adapt the timeout for database
commands. Click on the button and enter an appropriate value. For large amounts of data
the value 0 is recommended, which means infinite. To remove a package use the button and
the button to get information about the package. To inspect the data provided by the
package, click on the button. A window as shown below will open listing all package related
objects. In the case of ABCD BioCASe is depending on the schema public (see  below). For
every object (table, view, column, ... ) the description is shown in the lower part of the
window. With a click no the  button you can generate a description of all objects in the
package.
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With a click no the button you can generate a description of all objects in the package (see
below). 

The package ABCD creates additional views in the schema public as BioCASE is unable to
handle schemata. Therefore the package ABCD can only be installed for one project (=
schema) in a database. Some packages provide add-ons to adapt them to special
specifications. 

To export the content of a package, click on the button. A window as shown below will
open listing the main views of the package. You can export the data as XML (creating a
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directory with one xml file for every view) or as SQLite database (creating a SQLite
database containing the tables). 

A package (e.g. ABCD) may contain e.g. materialized views. These need an update after
the data have been transferred to the Postgres database. Click on the Transfer data
button to update these views or perform other necessary steps after the data have been
transferred. A window as shown below will open, listing the transfer steps for the package. 

Choose the steps that should be transferred and click on the Start transfer button to
transfer the data resp. update the materialized views. 
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Administration of the Add-Ons for Packages
For certain packages there are add-ons available to adapt a package to the special
specifications of e.g. a project. To add an add-on, click on the button as shown below. A
window as shown below will open listing all available add-ons. 

After the add-on has been added, you need to update it to the current version of the add on
with a click on the Update to vers. ... button (see below). A window will open where all
the needed scripts will be listed. Some add-ons are exclusive, meaning that no further
add-ons can be added and further updates of the package are organized via the add-on as
shown below. To remove an add-on you have to remove the package with a click on the 
button. With a click on the button to get information about the add-on. 

An Add-on defines a version of the package it is compatible with. Add-ons can not be
removed as they perform canges in the package. To remove an Add-on, remove the package
and reinstall it. If a package containing an Add-on needs an update you have to remove the
package as well and reinstall it.  
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Infrastructure within the cache database
For the administration of the data that are published via the cache database, certain tables
as shown below are used. These are either placed in the schema dbo or a schema named
according to the published project, e.g. Project_Test for a project with the name Test.  

Central tables

There are a number of tables placed in the schema dbo that are accessible by all projects.  

Project tables

The central project tables contain the information about the projects that are published
together with the target (Postgres) databases and the packages including optional add-ons
into which they had been transferred. This information is used to ensure a recovery in case of
a loss of the targets.

 

 

 ProjectPublished

 ProjectTarget

 ProjectTargetPackage

 ProjectTransfer

 Target

 

Source tables

To access sources from other modules (e.g. DiversityAgents) there are tables for the storage
of the principal access to the modules and a number of tables containing the data (depending
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on the module).

Access tables

These tables contain the principal access like the name of the view defined to access the
data. The example below lists the tables defined for the module DiversityAgents, but there are
corresponding tables for every module accessed by the cache database. 

 AgentSource

 AgentSourceTarget

Data tables

These tables contain the data provided by the module and therefore depend on the module.
The example below lists the tables defined for the module DiversityAgents, but there are
corresponding tables for every module accessed by the cache database. 

 Agent

 AgentContactInformation

To access the data in the module there are views generated by the client. The name of these
views are composed according to the name of the database, the server and the project to
ensure a unique name. These are stored in the table AgentSource and are used by the client
for a transfer of the data from the module database into the tables in the cache database.
The example below lists the views for the module DiversityAgents. 

 Agents_BSMcollectors

 Agents_BSMcollectors_C

Project tables

These tables contain the data of the projects with every project having its own schema.
These tables correspond to the tables in the main database of the module with certain
limitations (no logging columns, internal notes etc.) 

 CacheAnalysis

 CacheAnnotation

 CacheCollection

 CacheCollectionAgent

 CacheCollectionEvent

 CacheCollectionEventLocalisation

 CacheCollectionEventProperty

 CacheCollectionExternalDatasource

 CacheCollectionSpecimen
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 CacheCollectionSpecimenImage

 CacheCollectionSpecimenPart

 CacheCollectionSpecimenProcessing

 CacheCollectionSpecimenReference

 CacheCollectionSpecimenRelation

 CacheExternalIdentifier

 CacheIdentification

 CacheIdentificationUnit

 CacheIdentificationUnitAnalysis

 CacheIdentificationUnitGeoAnalysis

 CacheIdentificationUnitInPart

 CacheLocalisationSystem

 CacheMetadata

 CacheProcessing

 CacheProjectAgent

 CacheProjectAgentRole

 CacheProjectReference

 ProjectAnalysis

 ProjectMaterialCategory

 ProjectTaxonomicGroup

Project procedures for the data transfer into the project
tables

For every project table there is a procedure that transfers the data from the main database
into the cache table. The names of these procedures are procPublish + the name of the table
in the main database e.g. procPublishAnalysis for the transfer from the table Analysis into
the table CacheAnalysis. 

 

List of tables mentioned above
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Table ProjectPublished
The projects published via the cache database (Details about the projects are defined in
DiversityProjects)

Column Data type Description Nullable Relation

ProjectID int

ID of the project
to which the
specimen belongs
(Projects are
defined in
DiversityProjects)

NO -

Project nvarchar (50)

The name or title
of the project as
shown in a user
interface
(Projects are
defined in
DiversityProjects)

YES -

CoordinatePrecisio
n tinyint

Optional reduction
of the precision of
the coordinates
within the project

YES -

ProjectURI varchar (255)

The URI of the
project, e.g. as
provided by the
module
DiversityProjects.

YES -

LastUpdatedWhen datetime
The date of the
last update of the
project data

YES -

LastUpdatedBy nvarchar (50)
The user
reponsible for the
last update.

YES -

TransferProtocol nvarchar (MAX)

The protocol
created during
the transfer of
the data

YES -

IncludeInTransfer bit

If the project
should be
included in a
schedule based
data transfer

YES -

CompareLogDate bit

If the log dates of
the transferred
data should be
compared to
decide if data are
transferred
Default value: (0)

YES -

TransferDays varchar (7)

The days the
transfer should be
done, coded as
integer values
with Sunday = 0
up to Saturday =
6

YES -
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Default value: '0'

TransferTime time

The time when
the transfer
should be
executed
Default value:
'00:00:00.00'

YES -

TransferIsExecute
dBy

nvarchar (500) If any transfer of
the data is active

YES -

TransferErrors nvarchar (MAX)
Errors that
occurred during
the data transfers

YES -

LastCheckedWhen datetime

The date and
time when the
last check for the
need of an
update of the
content occurred

YES -

Table ProjectTarget
The targets of the projects, i.e. the Postgres databases

Column Data type Description Nullable Relation

ProjectID int

ID of the project
to which the
specimen belongs
(Projects are
defined in
DiversityProjects)

NO Refers to table
ProjectPublished

LastUpdatedWhen datetime
The date of the
last update of the
project data

YES -

TransferProtocol nvarchar (MAX)

The protocol
created during
the transfer of
the data

YES -

IncludeInTransfer bit

If the project
should be
included in a
schedule based
data transfer
Default value: (1)

YES -

CompareLogDate bit

If the log dates of
the transferred
data should be
compared to
decide if data are
transferred
Default value: (0)

YES -

TransferDays varchar (7)

The days the
transfer should be
done, coded as
integer values
with Sunday = 0
up to Saturday =

YES -
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6
Default value: (0)

TransferTime time

The time when
the transfer
should be
executed
Default value:
'00:00:00.00'

YES -

TransferIsExecute
dBy

nvarchar (500) If any transfer of
the data is active

YES -

TransferErrors nvarchar (MAX)
Errors that
occurred during
the data transfers

YES -

TargetID int
The ID of the
server, relates to
table Target

NO Refers to table
Target

LastCheckedWhen datetime

The date and
time when the
last check for the
need of an
update of the
content occurred

YES -

Table ProjectTargetPackage
Packages for projects as documented in the table Package in the Postgres database

Column Data type Description Nullable Relation

ProjectID int
Refers to
ProjectID in table
ProjectTarget

NO Refers to table
ProjectTarget

TargetID int
Referes to
TargetID in table
ProjectTarget

NO Refers to table
ProjectTarget

Package nvarchar (50)
Package installed
for this project
target

NO -

Table ProjectTransfer
The transfers of data of a project

Column Data type Description Nullable Relation
ProjectID int ID of the project,

part of PK
NO Refers to table

ProjectPublished

TransferDate datetime

Date of the
transfer. Part of
PK
Default value:
getdate()

NO -

ResponsibleUserID int
The ID of the
user as stored in
table UserProxy of

YES -
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the source
database,
responsible for
the transfer
Default value:
(-1)

TargetID int

If the transfer
regards a
postgres
database, the ID
of the target (=
Postgres
database) as
stored in table
Target

YES Refers to table
Target

Package nvarchar (50)

If the transfer
regards a
package, the
name of the
package,
otherwise empty

YES -

Settings nvarchar (MAX)

The versions,
number of
transfered data
etc. of the
objects
concerned by the
transfer [format:
JSON]

YES -

Table Target
The postgres databases as targets for the data

Column Data type Description Nullable Relation

TargetID int
ID of the target
on a postgres
server, PK

NO -

Server nvarchar (255) Name or IP of the
Server NO -

Port smallint Port for accessing
the server NO -

DatabaseName nvarchar (255) The name of the
database NO -

Table AgentSource
The sources for the data from a module database accessed via a view
defined in the cache database

Column Data type Description Nullable Relation

SourceView nvarchar (200)

the name of the
view retrieving
the data from the
database

NO -
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Source nvarchar (500)

The name of the
source, e.g. the
name of the
project as defined
in the source
module

YES -

SourceID int

The ID of the
source, e.g. the
ID of the project
as defined in the
source module

YES -

LinkedServerName nvarchar (500)

If the source is
located on a
linked server, the
name of the
linked server

YES -

DatabaseName nvarchar (50)

The name of the
database where
the data are
taken from

YES -

Subsets nvarchar (500)

Subsets of a
source: The
names of the
tables included in
the transfer
separted by "|"

YES -

TransferProtocol nvarchar (MAX)

The protocol
created during
the transfer of
the data

YES -

IncludeInTransfer bit

If the source
should be
included in a
schedule based
data transfer

YES -

LastUpdatedWhen datetime
The date of the
last update of the
data

YES -

CompareLogDate bit

If the log dates of
the transferred
data should be
compared to
decide if data are
transferred
Default value: (0)

YES -

TransferDays varchar (7)

The days the
transfer should be
done, coded as
integer values
with Sunday = 0
up to Saturday =
6
Default value: '0'

YES -

TransferTime time

The time when
the transfer
should be
executed

YES -
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Default value:
'00:00:00.00'

TransferIsExecute
dBy

nvarchar (500) If any transfer of
the data is active

YES -

TransferErrors nvarchar (MAX)
Errors that
occurred during
the data transfers

YES -

LastCheckedWhen datetime

The date and
time when the
last check for the
need of an
update of the
content occurred

YES -

Table AgentSourceTarget
The targets of the projects, i.e. the Postgres databases

Column Data type Description Nullable Relation

SourceView nvarchar (200)
SourceView as
defined in table
AgentSource

NO Refers to table
AgentSource

Target nvarchar (200)

The targets of
the projects, i.e.
the Postgres
databases where
the data should
be transferred to

NO -

LastUpdatedWhen datetime
The date of the
last update of the
project data

YES -

TransferProtocol nvarchar (MAX)

The protocol
created during
the transfer of
the data

YES -

IncludeInTransfer bit

If the project
should be
included in a
schedule based
data transfer
Default value: (1)

YES -

CompareLogDate bit

If the log dates of
the transferred
data should be
compared to
decide if data are
transferred
Default value: (0)

YES -

TransferDays varchar (7)

The days the
transfer should be
done, coded as
integer values
with Sunday = 0
up to Saturday =
6

YES -
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Default value: (0)

TransferTime time

The time when
the transfer
should be
executed
Default value:
'00:00:00.00'

YES -

TransferIsExecute
dBy

nvarchar (500) If any transfer of
the data is active

YES -

TransferErrors nvarchar (MAX)
Errors that
occurred during
the data transfers

YES -

LastCheckedWhen datetime

The date and
time when the
last check for the
need of an
update of the
content occurred

YES -

Table Agent
The main table with the data of the agent

Column Data type Description Nullable Relation

BaseURL varchar (500)
The basic URL as
defined in the
module database

NO -

AgentID int
Unique ID for the
Agent (= Primary
key)

NO -

AgentURI varchar (255)

The link to the
dataset, i. e. the
BaseURL + the
AgentID

YES -

AgentParentID int

The AgentID of
the superior
agent if agents
are organized
within a hierarchy

YES -

AgentName nvarchar (200)

The whole name
of the agent as
shown e.g. for
selection in an
user interface.
For persons this
entry will be
generated as
follows:
LastName,
FirstNames,
AgentTitle

NO -

AgentTitle nvarchar (50)
The title of the
agent, e.g. Dr.,
Prof.

YES -

GivenName nvarchar (255) The first names of YES -
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the agent (if a
person) or the
name of e.g. an
institution

GivenNamePostfix nvarchar (50)

Variable part of
name, correctly
placed at end of
given names

YES -

InheritedNamePref
ix nvarchar (50)

Variable part of
name, correctly
placed at the
beginning of the
inherited names

YES -

InheritedName nvarchar (255)
The last names of
the agent (if a
person)

YES -

InheritedNamePos
tfix nvarchar (50)

Additions after
inherited name,
like generation
(Jr., III.) or
names of religious
orders

YES -

Abbreviation nvarchar (50) Abbreviation of
the agent

YES -

AgentType nvarchar (50)
The type of the
agent, e.g.
person, company

YES -

AgentRole nvarchar (255)

The role of an
agent esp. a
person within an
organization. e.g.
"Database
Administrator" or
"Curator"

YES -

AgentGender nvarchar (50) The gender resp.
sex of the agent

YES -

Description nvarchar (1000) A description of
the agent

YES -

OriginalSpelling nvarchar (200)

Name as originally
written in e.g.
chinese or cyrillic
letters

YES -

Notes nvarchar (MAX) Notes about the
agent

YES -

ValidFromDate datetime

The date of the
begin of the
exsistence of the
agent, e.g. the
birthday of a
person or the
founding of an
institution,
calculated from
ValidFromDay, -
Month and -Year

YES -

ValidUntilDate datetime The date of the
end of the YES -
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exsistence of the
agent, e.g. death
of a person or
closing of an
institute,
calculated from
ValidUntilDay, -
Month and -Year

SynonymToAgentI
D int

The AgentID of
the agent which
was selected as a
replacement for
the current
agent, e.g. if to
equal datasets
were imported
from different
sources

YES -

ProjectID int

The ID of the
project in the
module database
containing the
data

NO -

LogInsertedWhen smalldatetime

Date and time
when record was
first entered
(typed or
imported) into
this system.
Default value:
getdate()

YES -

SourceView nvarchar (200)
The name of the
source view of
the data

NO -

Table AgentContactInformation
The contact information resp. addresses of the agents

Column Data type Description Nullable Relation

AgentID int

Refers to the ID
of Agent (=
Foreign key and
part of primary
key)

NO -

DisplayOrder tinyint

Display order of
records in user
interface.
DisplayOrder 1
corresponds to
the preferred
address (= part of
primary key)

NO -

AddressType nvarchar (50)
Type of the
adress, e.g.
private

YES -
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Country nvarchar (255) Country of the
address

YES -

City nvarchar (255) City of the
address

YES -

PostalCode nvarchar (50)

ZIP or postcode
of the address
(usually output
before or after
the city)

YES -

Streetaddress nvarchar (255)

Usually street
name and
number, but may
also contain post
office box

YES -

Address nvarchar (255)
Free text postal
address of the
agent

YES -

Telephone nvarchar (50)
Phone number,
including area
code

YES -

CellularPhone nvarchar (50)

The number of a
mobile telephone
device of the
agent

YES -

Telefax nvarchar (50)
Fax number,
including area
code

YES -

Email nvarchar (255) E-mail address of
the agent

YES -

URI nvarchar (255)

URI pointing to a
homepage
containing further
information

YES -

Notes nvarchar (MAX) Notes about this
address

YES -

ValidFrom datetime

The date when
this address
became valid as
date according to
ISO 8601

YES -

ValidUntil datetime

The date of the
expiration of the
validity of this
address as date
according to ISO
8601

YES -

SourceView nvarchar (200)
The name of the
source view of
the data

NO -

View Agents_BSMcollectors

Column Data type
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BaseURL varchar (255)
AgentID int
AgentParentID int
AgentName nvarchar (200)
AgentTitle nvarchar (50)
GivenName nvarchar (255)
GivenNamePostfix nvarchar (50)
InheritedNamePrefix nvarchar (50)
InheritedName nvarchar (255)
InheritedNamePostfix nvarchar (50)
Abbreviation nvarchar (50)
AgentType nvarchar (50)
AgentRole nvarchar (255)
AgentGender nvarchar (50)
Description nvarchar (1000)
OriginalSpelling nvarchar (200)
Notes nvarchar (MAX)
ValidFromDate datetime
ValidUntilDate datetime
SynonymToAgentID int
ProjectID int
LogUpdatedWhen smalldatetime

View Agents_BSMcollectors_C

Column Data type
AgentID int
DisplayOrder tinyint
AddressType nvarchar (50)
Country nvarchar (255)
City nvarchar (255)
PostalCode nvarchar (50)
Streetaddress nvarchar (255)
Address nvarchar (255)
Telephone nvarchar (50)
CellularPhone nvarchar (50)
Telefax nvarchar (50)
Email nvarchar (255)
URI nvarchar (255)
Notes nvarchar (MAX)
ValidFrom datetime
ValidUntil datetime
LogUpdatedWhen smalldatetime
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Table CacheAnalysis

Column Data type Nullable
AnalysisID int NO
AnalysisParentID int YES
DisplayText nvarchar (50) YES
Description nvarchar (MAX) YES
MeasurementUnit nvarchar (50) YES
Notes nvarchar (MAX) YES
AnalysisURI varchar (255) YES

Table CacheAnnotation

Column Data type Nullable
AnnotationID int NO
ReferencedAnnotationID int YES
AnnotationType nvarchar (50) NO
Title nvarchar (50) YES
Annotation nvarchar (MAX) NO
URI varchar (255) YES
ReferenceDisplayText nvarchar (500) YES
ReferenceURI varchar (255) YES
SourceDisplayText nvarchar (500) YES
SourceURI varchar (255) YES
ReferencedID int NO
ReferencedTable nvarchar (500) NO

Table CacheCollection

Column Data type Nullable
CollectionID int NO
CollectionParentID int YES
CollectionName nvarchar (255) NO
CollectionAcronym nvarchar (10) YES
AdministrativeContactName nvarchar (500) YES
AdministrativeContactAgentUR
I

varchar (255) YES

Description nvarchar (MAX) YES
Location nvarchar (255) YES
CollectionOwner nvarchar (255) YES
DisplayOrder smallint YES
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Table CacheCollectionAgent

Column Data type Nullable
CollectionSpecimenID int NO
CollectorsName nvarchar (255) NO
CollectorsSequence datetime2 YES
CollectorsNumber nvarchar (50) YES
CollectorsAgentURI nvarchar (500) YES

Table CacheCollectionEvent

Column Data type Nullable
CollectionEventID int NO
Version int NO
CollectorsEventNumber nvarchar (50) YES
CollectionDate datetime YES
CollectionDay tinyint YES
CollectionMonth tinyint YES
CollectionYear smallint YES
CollectionDateSupplement nvarchar (100) YES
CollectionTime varchar (50) YES
CollectionTimeSpan varchar (50) YES
LocalityDescription nvarchar (MAX) YES
HabitatDescription nvarchar (MAX) YES
ReferenceTitle nvarchar (255) YES
CollectingMethod nvarchar (MAX) YES
Notes nvarchar (MAX) YES
CountryCache nvarchar (50) YES
ReferenceDetails nvarchar (50) YES
LocalityVerbatim nvarchar (MAX) YES
CollectionEndDay tinyint YES
CollectionEndMonth tinyint YES
CollectionEndYear smallint YES

Table CacheCollectionEventLocalisation

Column Data type Nullable
CollectionEventID int NO
LocalisationSystemID int NO
Location1 nvarchar (255) YES
Location2 nvarchar (255) YES
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LocationAccuracy nvarchar (50) YES
LocationNotes nvarchar (MAX) YES
DeterminationDate smalldatetime YES
DistanceToLocation varchar (50) YES
DirectionToLocation varchar (50) YES
ResponsibleName nvarchar (255) YES
ResponsibleAgentURI varchar (255) YES
AverageAltitudeCache float YES
AverageLatitudeCache float YES
AverageLongitudeCache float YES
RecordingMethod nvarchar (500) YES
Geography nvarchar (MAX) YES

Table CacheCollectionEventProperty

Column Data type Nullable
CollectionEventID int NO
PropertyID int NO
DisplayText nvarchar (255) YES
PropertyURI varchar (255) YES
PropertyHierarchyCache nvarchar (MAX) YES
PropertyValue nvarchar (255) YES
ResponsibleName nvarchar (255) YES
ResponsibleAgentURI varchar (255) YES
Notes nvarchar (MAX) YES
AverageValueCache float YES

Table CacheCollectionExternalDatasource

Column Data type Nullable
ExternalDatasourceID int NO
ExternalDatasourceName nvarchar (255) YES
ExternalDatasourceVersion nvarchar (255) YES
Rights nvarchar (500) YES
ExternalDatasourceAuthors nvarchar (200) YES
ExternalDatasourceURI nvarchar (300) YES
ExternalDatasourceInstitution nvarchar (300) YES

Table CacheCollectionSpecimen

Column Data type Nullable
CollectionSpecimenID int NO
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LabelTranscriptionNotes nvarchar (255) YES
OriginalNotes nvarchar (MAX) YES
LogUpdatedWhen datetime YES
CollectionEventID int YES
AccessionNumber nvarchar (50) YES
AccessionDate datetime YES
AccessionDay tinyint YES
AccessionMonth tinyint YES
AccessionYear smallint YES
DepositorsName nvarchar (255) YES
DepositorsAccessionNumber nvarchar (50) YES
ExsiccataURI varchar (255) YES
ExsiccataAbbreviation nvarchar (255) YES
AdditionalNotes nvarchar (MAX) YES
ReferenceTitle nvarchar (255) YES
ReferenceURI varchar (255) YES
ExternalDatasourceID int YES

Table CacheCollectionSpecimenImage

Column Data type Nullable
CollectionSpecimenID int NO
URI varchar (255) NO
ResourceURI varchar (255) YES
SpecimenPartID int YES
IdentificationUnitID int YES
ImageType nvarchar (50) YES
Notes nvarchar (MAX) YES
LicenseURI varchar (500) YES
LicenseNotes nvarchar (500) YES
DisplayOrder int YES
LicenseYear nvarchar (50) YES
LicenseHolderAgentURI nvarchar (500) YES
LicenseHolder nvarchar (500) YES
LicenseType nvarchar (500) YES
CopyrightStatement nvarchar (500) YES
CreatorAgentURI varchar (255) YES
CreatorAgent nvarchar (500) YES
IPR nvarchar (500) YES
Title nvarchar (500) YES

Table CacheCollectionSpecimenPart

Column Data type Nullable
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CollectionSpecimenID int NO
SpecimenPartID int NO
DerivedFromSpecimenPartID int YES
PreparationMethod nvarchar (MAX) YES
PreparationDate datetime YES
PartSublabel nvarchar (50) YES
CollectionID int NO
MaterialCategory nvarchar (50) NO
StorageLocation nvarchar (255) YES
Stock float YES
Notes nvarchar (MAX) YES
AccessionNumber nvarchar (50) YES
StorageContainer nvarchar (500) YES
StockUnit nvarchar (50) YES
ResponsibleName nvarchar (255) YES

Table CacheCollectionSpecimenProcessing

Column Data type Nullable
CollectionSpecimenID int NO
SpecimenProcessingID int NO
ProcessingDate datetime YES
ProcessingID int YES
Protocoll nvarchar (100) YES
SpecimenPartID int YES
ProcessingDuration varchar (50) YES
ResponsibleName nvarchar (255) YES
ResponsibleAgentURI varchar (255) YES
Notes nvarchar (MAX) YES

Table CacheCollectionSpecimenReference

Column Data type Nullable
CollectionSpecimenID int NO
ReferenceID int NO
ReferenceTitle nvarchar (400) NO
ReferenceURI varchar (500) YES
IdentificationUnitID int YES
SpecimenPartID int YES
ReferenceDetails nvarchar (500) YES
Notes nvarchar (MAX) YES
ResponsibleName nvarchar (255) YES
ResponsibleAgentURI varchar (255) YES
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Table CacheCollectionSpecimenRelation

Column Data type Nullable
CollectionSpecimenID int NO
RelatedSpecimenURI varchar (255) NO
RelatedSpecimenDisplayTex
t varchar (255) NO

RelationType nvarchar (50) YES
RelatedSpecimenCollectionID int YES
RelatedSpecimenDescription nvarchar (MAX) YES
Notes nvarchar (MAX) YES
IdentificationUnitID int YES
SpecimenPartID int YES

Table CacheExternalIdentifier

Column Data type Nullable
ID int NO
ReferencedTable nvarchar (128) NO
ReferencedID int NO
Type nvarchar (50) YES
Identifier nvarchar (500) YES
URL varchar (500) YES
Notes nvarchar (MAX) YES

Table CacheIdentification

Column Data type Nullable
CollectionSpecimenID int NO
IdentificationUnitID int NO
IdentificationSequence smallint NO
IdentificationDate datetime YES
IdentificationDay tinyint YES
IdentificationMonth tinyint YES
IdentificationYear smallint YES
IdentificationDateSupplement nvarchar (255) YES
IdentificationDateCategory nvarchar (50) YES
VernacularTerm nvarchar (255) YES
TaxonomicName nvarchar (255) YES
NameURI varchar (255) YES
IdentificationCategory nvarchar (50) YES
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IdentificationQualifier nvarchar (50) YES
TypeStatus nvarchar (50) YES
TypeNotes nvarchar (MAX) YES
ReferenceTitle nvarchar (255) YES
ReferenceURI varchar (255) YES
ReferenceDetails nvarchar (50) YES
Notes nvarchar (MAX) YES
ResponsibleName nvarchar (255) YES
ResponsibleAgentURI varchar (255) YES
NameID int YES
BaseURL varchar (255) YES
TermURI nvarchar (500) YES

Table CacheIdentificationUnit

Column Data type Nullable
CollectionSpecimenID int NO
IdentificationUnitID int NO
LastIdentificationCache nvarchar (255) NO
TaxonomicGroup nvarchar (50) NO
RelatedUnitID int YES
RelationType nvarchar (50) YES
ExsiccataNumber nvarchar (50) YES
DisplayOrder smallint NO
ColonisedSubstratePart nvarchar (255) YES
FamilyCache nvarchar (255) YES
OrderCache nvarchar (255) YES
LifeStage nvarchar (255) YES
Gender nvarchar (50) YES
HierarchyCache nvarchar (500) YES
UnitIdentifier nvarchar (50) YES
UnitDescription nvarchar (50) YES
Circumstances nvarchar (50) YES
Notes nvarchar (MAX) YES
NumberOfUnits smallint YES
OnlyObserved bit YES
RetrievalType nvarchar (50) YES
StableIdentifier nvarchar (500) YES

Table CacheIdentificationUnitAnalysis

Column Data type Nullable
CollectionSpecimenID int NO
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IdentificationUnitID int NO
AnalysisID int NO
AnalysisNumber nvarchar (50) NO
AnalysisResult nvarchar (MAX) YES
ExternalAnalysisURI varchar (255) YES
ResponsibleName nvarchar (255) YES
ResponsibleAgentURI varchar (255) YES
AnalysisDate nvarchar (50) YES
SpecimenPartID int YES
Notes nvarchar (MAX) YES

Table CacheIdentificationUnitGeoAnalysis

Column Data type Nullable
CollectionSpecimenID int NO
IdentificationUnitID int NO
AnalysisDate datetime NO
Geography nvarchar (MAX) YES
Geometry nvarchar (MAX) YES
ResponsibleName nvarchar (255) YES
ResponsibleAgentURI varchar (255) YES
Notes nvarchar (MAX) YES

Table CacheIdentificationUnitInPart

Column Data type Nullable
CollectionSpecimenID int NO
IdentificationUnitID int NO
SpecimenPartID int NO
DisplayOrder smallint NO
Description nvarchar (500) YES
StableIdentifier nvarchar (500) YES

Table CacheLocalisationSystem

Column Data type Nullable
LocalisationSystemID int NO
DisplayText nvarchar (500) YES
Sequence int NO
ParsingMethodName nvarchar (50) YES
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Table CacheMetadata

Column Data type Nullable
ProjectID int NO
ProjectTitleCode nvarchar (254) YES
TaxonomicGroup nvarchar (254) YES
DatasetGUID nvarchar (254) YES
TechnicalContactName nvarchar (254) YES
TechnicalContactEmail nvarchar (254) YES
TechnicalContactPhone nvarchar (254) YES
TechnicalContactAddress nvarchar (254) YES
ContentContactName nvarchar (254) YES
ContentContactEmail nvarchar (254) YES
ContentContactPhone nvarchar (254) YES
ContentContactAddress nvarchar (254) YES
OtherProviderUDDI nvarchar (254) YES
DatasetTitle nvarchar (254) YES
DatasetDetails nvarchar (254) YES
DatasetCoverage nvarchar (254) YES
DatasetURI nvarchar (254) YES
DatasetIconURI nvarchar (254) YES
DatasetVersionMajor nvarchar (254) YES
DatasetCreators nvarchar (254) YES
DatasetContributors nvarchar (254) YES
DateCreated nvarchar (254) YES
DateModified nvarchar (254) YES
SourceID nvarchar (254) YES
SourceInstitutionID nvarchar (254) YES
OwnerOrganizationName nvarchar (254) YES
OwnerOrganizationAbbrev nvarchar (254) YES
OwnerContactPerson nvarchar (254) YES
OwnerContactRole nvarchar (254) YES
OwnerAddress nvarchar (254) YES
OwnerTelephone nvarchar (254) YES
OwnerEmail nvarchar (254) YES
OwnerURI nvarchar (254) YES
OwnerLogoURI nvarchar (254) YES
IPRText nvarchar (254) YES
IPRDetails nvarchar (254) YES
IPRURI nvarchar (254) YES
CopyrightText nvarchar (500) YES
CopyrightDetails nvarchar (254) YES
CopyrightURI nvarchar (254) YES
TermsOfUseText nvarchar (254) YES
TermsOfUseDetails nvarchar (254) YES
TermsOfUseURI nvarchar (254) YES
DisclaimersText nvarchar (254) YES
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DisclaimersDetails nvarchar (254) YES
DisclaimersURI nvarchar (254) YES
LicenseText nvarchar (254) YES
LicensesDetails nvarchar (254) YES
LicenseURI nvarchar (254) YES
AcknowledgementsText nvarchar (254) YES
AcknowledgementsDetails nvarchar (254) YES
AcknowledgementsURI nvarchar (254) YES
CitationsText nvarchar (254) YES
CitationsDetails nvarchar (254) YES
CitationsURI nvarchar (254) YES
RecordBasis nvarchar (254) YES
KindOfUnit nvarchar (254) YES
HigherTaxonRank nvarchar (254) YES
RecordURI nvarchar (500) YES
BaseURL varchar (255) YES
StableIdentifier nvarchar (500) YES
ProjectTitle nvarchar (400) YES

Table CacheProcessing

Column Data type Nullable
ProcessingID int NO
ProcessingParentID int YES
DisplayText nvarchar (50) YES
Description nvarchar (MAX) YES
Notes nvarchar (MAX) YES
ProcessingURI varchar (255) YES
OnlyHierarchy bit YES

Table CacheProjectAgent

Column Data type Nullable
ProjectID int NO
AgentName nvarchar (255) NO
AgentURI varchar (255) NO
AgentRole nvarchar (50) YES
AgentType nvarchar (50) YES
Notes nvarchar (MAX) YES
AgentSequence int YES

Table CacheProjectAgentRole
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Column Data type Nullable
ProjectID int NO
AgentName nvarchar (255) NO
AgentURI varchar (255) NO
AgentRole nvarchar (50) NO

Table CacheProjectReference

Column Data type Nullable
ProjectID int NO
ReferenceTitle nvarchar (255) NO
ReferenceURI varchar (255) YES
ReferenceDetails nvarchar (50) YES
ReferenceType nvarchar (255) YES
Notes nvarchar (MAX) YES
URI nvarchar (500) YES

Table ProjectAnalysis

Column Data type Nullable
AnalysisID int NO

Table ProjectMaterialCategory

Column Data type Nullable
MaterialCategory nvarchar (50) NO

Table ProjectTaxonomicGroup

Column Data type Nullable
TaxonomicGroup nvarchar (50) NO
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BioCASe 
To publish your data on portals like GBIF data can be provided in the ABCD standard using
BioCASe for mapping your data (see below). Use the ABCD package to convert the data
into a format prepared for BioCASe. Configure the database and map the fields according to
the examples. 

For details about the BioCASe software please see the provided documentation.
DiversityCollection transfers the data for every project in a separate schema. As BioCASe so
far is unable to handle schemata in Postgres additional views for the package ABCD are
created in the schema public and you need to provide a single database for every project. 

 

Step by Step

To provide the data for BioCASe you need to transfer the data from DiversityCollection
together with all auxiliary sources (Taxa, References, Gazetteer) depending on your data from
the SQL-Server database to the SQL-Server cache database and from there to the 
Postgres cache database. In the Postgres database you need the package ABCD for
mapping your data to BioCASe. 

 

Metadata

The metadata for ABCD are taken from the project data in the module DiversityProjects to
which the data in DiversityCollection are linked to. These metadata are defined as Settings
as shown below as children of the setting ABCD. The following ABCD topics are taken from the
settings in DiversityProjects: 

 TaxonomicGroup
 Dataset including GUID, Coverage, Version, Creators, Icon, Dates etc.
 TechnicalContact
 ContentContact
 OtherProvider
 Source
 Owner
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 IPR
 Copyright
 TermsOfUse
 Disclaimers
 Acknowledgements
 Citations (if Reference is missing - see below)
 RecordBasis
 RecordURI
 KindOfUnit
 HigherTaxonRank

For further information about the configuration of the settings in DiversityProjects, please see
the manual for this module.

 

Metadata - Stable identifier = DatasetGUID 

The DatasetGUID in ABCD is taken from the stable identifier defined in the module
DiversityProjects for the database in combination with the ID of the project. To set the stable
identifier choose Administration - Stable identifier from the menu in DiversityProjects and
enter the basic path (e.g. see below). This stable identifier can only be set once. After it is
set you will get a message as shown below. 
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Metadata - License 

The license information for ABCD are taken from the first entry in the IPR & Licenses section
in DiversityProjects (see below) where the first entry is the one entered first. 

Metadata - Citation text

The citation for the project follows the form <Authors> (<Publication_year>). <Title>.
[Dataset]. Data Publisher: <Data_center_name>. <URI>. 

The <Authors> are taken from the Agents section (see below) where all agents with the
role Author are included according to their sequence in the list and separated by ";". 
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The <Publication_year> is the year of the publication i.e. the current year. The <Title>
corresponds to the Title of the project. The <Data_center_name> is taken from the 
Agents section. Here the first agent with the role Publisher is used. The <URI> is taken from
the field URI of the citation with the type  BioCASe (GFBio) in the Citations & References
section (see below). 
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Gathering - IsoCode

The IsoType for a country is taken from corresponding information in the module
DiversityGazetteer. To ensure these information is available in the cache database, insert a
source for a gazetteer project containing this information (see below). 

 

Identification

The ABCD schema provided with this software is NOT including information from the module
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DiversityTaxonNames, so sources for Taxa are not needed by default. If for your own needs
you decide to add additional data for the identifications from the module DivesityTaxonNames,
ensure that the data corresponding to the names in your identifications are transferred from
DiversityTaxonNames (see below). 

 

Postgres database

The package ABCD providing the objects for mapping your data for BioCASE contains objects
in the schema public. Therefore you need one database for every project you want to provide
for BioCASE and the sources mentioned above have to be transferred in each of these
databases. 

 

Transfer

To provide the data for BioCASE you need to transfer all auxiliary sources as described above
(Taxa, References, Gazetteer) depending on your data and the project data themselves from
the SQL-Server databases to the SQL-Server cache database and from there to the
Postgres cache database . The package itself needs a further transfer step if data have
been changed after the creation of the package as the parts of the data in the Postgres
database are imported into tables or materialized views according to the specifications of
ABCD. 
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BioCASe Configuration Tool - demo 
Home | Overview | Settings | DB connection | DB structure | Archive | QueryForms | Help | Report
a Bug 

Database Structure

Use this tool to describe your database structure, so that the software knows how to query you database.

DB Connection status: OK 

Formularbeginn

t1

Table/View Alias Primary Key Attribute(s) Foreign Key(s)
Delet
e
alias

ABCD_Content

ABCD_ContentContact

ContentContac

ContentContact

ProjectID ProjectID

ProjectID
integer --none--

New Primary Key 
--new-- --new-- integer Add

FK to alias
Metadata   

         
ProjectID integer

--none--

        New Attribute 

         
--new-- --new-- integer Add

new FK to alias
--none--

Add

  

Delet
e
alias

ABCD_Measur

ABCD_MeasurementOrFact

MeasurementO

MeasurementOrFa

ID ID

ID
text --none--

New Primary Key 
--new--

--new--
integer Add

FK to alias
Unit   

         
ID text

--none--

        New Attribute 

         
--new-- --new--

integer Add

new FK to alias
--none--

Add

  

Delet
e
alias

ABCD_Metada

ABCD_Metadata

Metadata

Metadata

ProjectID

ProjectID ProjectID
integer --none--

New Primary Key 
--new--

--new--
integer Add

new FK to alias
--none--

Add

  

Delet
e
alias

ABCD_MultiMe

ABCD_MultiMediaObject

MultiMediaObje

MultiMediaObject

ID ID

ID
text --none--

fileURI fileURI

fileURI
text --none--

New Primary Key 

FK to alias
Unit   

         
ID text --none--

        New Attribute 
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--new--

--new--
integer Add          

--new-- --new--
integer Add

new FK to alias
--none--

Add

  

Delet
e
alias

ABCD_Technic

ABCD_TechnicalContact

TechnicalConta

TechnicalContact

ProjectID ProjectID

ProjectID
integer --none--

New Primary Key 
--new-- --new-- integer Add

FK to alias
Metadata   

         
ProjectID integer

--none--

        New Attribute 

         
--new-- --new-- integer Add

new FK to alias
--none--

Add

  

Delet
e
alias

ABCD_Unit

ABCD_Unit

Unit

Unit

ID

ID ID
text --none--

New Primary Key 
--new--

--new--
integer Add

new FK to alias
--none--

Add

  

Delet
e
alias

ABCD_Unit_As

ABCD_Unit_Associations_UnitAssociation

Unit_Associatio

Unit_Associations

ID ID

ID
text --none--

New Primary Key 
--new--

--new--
integer Add

FK to alias
Unit   

         
ID text

--none--

        New Attribute 

         
--new-- --new--

integer Add

new FK to alias
--none--

Add

  

Delet
e
alias

ABCD_Unit_Ga

ABCD_Unit_Gathering

Unit_Gathering

Unit_Gathering

ID

ID ID
text --none--

New Primary Key 
--new--

--new--
integer Add

FK to alias
Unit   

         
ID text --none--

        New Attribute 

         
--new--

--new--
integer

Add

new FK to alias
--none--

Add
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Delet
e
alias

ABCD_Unit_Ga

ABCD_Unit_Gathering_Agents

Unit_Gathering

Unit_Gathering_A

ID ID

ID
text --none--

New Primary Key 
--new--

--new--
integer Add

FK to alias
Unit   

         
ID text

--none--

        New Attribute 

         
--new-- --new--

integer Add

new FK to alias
--none--

Add

  

Delet
e
alias

ABCD_Unit_Ga

ABCD_Unit_Gathering_Stratigraphy_ChronostratigraphicTerm

Unit_Gathering

Unit_Gathering_S

ID ID ID text --none--

New Primary Key 
--new-- --new-- integer Add

FK to alias
Unit   

         
ID text

--none--

        New Attribute 

         
--new-- --new-- integer Add

new FK to alias
--none--

Add

  

Delet
e
alias

ABCD_Unit_Ga

ABCD_Unit_Gathering_Stratigraphy_LithostratigraphicTerm

Unit_Gathering

Unit_Gathering_S

ID ID ID text --none--

New Primary Key 
--new-- --new-- integer Add

FK to alias
Unit   

         
ID text

--none--

        New Attribute 

         
--new-- --new-- integer Add

new FK to alias
--none--

Add

  

Delet
e
alias

ABCD_Unit_Sp

ABCD_Unit_SpecimenUnit

Unit_Specimen

Unit_SpecimenUn

ID

ID ID
text --none--

New Primary Key 
--new--

--new--
integer Add

FK to alias
Unit   

         
ID text

--none--

        New Attribute 

         
--new--

--new--
integer

Add

new FK to alias

--none-- Add   

New
alias

Add

--select--

--select--

--new--  
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Save

         
Revert

Formularende
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BioCASe Configuration Tool - demo 
Home | Overview | Settings | DB connection | DB structure | Archive | QueryForms | Help | Report
a Bug 

Formularbeginn

cmf_ABCD_2.1.xm t1

FormularendeMapping - ABCD_2.1.xml
http://www.tdwg.org/schemas/abcd/2.1 

Formularbeginn

t1 cmf_ABCD_2.1.xm

Generated 2015-12-02 13:53:24.132975 by Configtool lib $Revision: 1416 $
Modified 2017-01-25 17:15:01
Record definition /DataSets/DataSet/Units/Unit

Root table alias Unit

Static table aliases Metadata

 Refresh Save Revert

Show all concepts or add new concepts by xpath identifier:

- Collapse all   |   + Expand all   |   Collapse unmapped 
 

- DataSets
 DataSet 
  - ContentContacts
   ContentContact 
    Email 
     Mapping1: ContentContact.Email(text)    
    Name 
     Mapping1: ContentContact.Name(text)    
  - Metadata
   - Description
    Representation 
     @language 
      Mapping1: "en"    
     Details 
      Mapping1: Metadata.Description_Representation_Details(text)    
     Title 
      Mapping1: Metadata.Description_Representation_Title(text)    
     URI 
      Mapping1: Metadata.Description_Representation_URI(text)    
   - IPRStatements
    - Acknowledgements
     - Acknowledgement
      @language 
       Mapping1: "en"    
      Details 
       Mapping1: Metadata.IPRStatements_Acknowledgement_Details(text)    
      Text 
       Mapping1: Metadata.IPRStatements_Acknowledgement_Text(text)    
      URI 
       Mapping1: Metadata.IPRStatements_Acknowledgement_URI(text)    
    - C itations
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     - C itation
      @language 
       Mapping1: "en"    
      Details 
       Mapping1: Metadata.IPRStatements_C itation_Details(text)    
      Text 
       Mapping1: Metadata.IPRStatements_C itation_Text(text)    
      URI 
       Mapping1: Metadata.IPRStatements_C itation_URI(text)    
    - Copyrights
     - Copyright
      @language 
       Mapping1: "en"    
      Details 
       Mapping1: Metadata.IPRStatements_Copyright_Details(text)    
      Text 
       Mapping1: Metadata.IPRStatements_Copyright_Text(text)    
      URI 
       Mapping1: Metadata.IPRStatements_Copyright_URI(text)    
    - Disclaimers
     - Disclaimer
      @language 
       Mapping1: "en"    
      Details 
       Mapping1: Metadata.IPRStatements_Disclaimer_Details(text)    
      Text 
       Mapping1: Metadata.IPRStatements_Disclaimer_Text(text)    
      URI 
       Mapping1: Metadata.IPRStatements_Disclaimer_URI(text)    
    - IPRDeclarations
     - IPRDeclaration
      @language 
       Mapping1: "en"    
      Details 
       Mapping1: Metadata.IPRStatements_IPRDeclaration_Details(text)    
      Text 
       Mapping1: Metadata.IPRStatements_IPRDeclaration_Text(text)    
      URI 
       Mapping1: Metadata.IPRStatements_IPRDeclaration_URI(text)    
    - Licenses
     - License
      @language 
       Mapping1: "en"    
      Details 
       Mapping1: Metadata.IPRStatements_License_Details(text)    
      Text 
       Mapping1: Metadata.IPRStatements_License_Text(text)    
      URI 
       Mapping1: Metadata.IPRStatements_License_URI(text)    
    - TermsOfUseStatements
     - TermsOfUse
      @language 
       Mapping1: "en"    
      Details 
       Mapping1: Metadata.IPRStatements_TermsOfUse_Details(text)    
      Text 
       Mapping1: Metadata.IPRStatements_TermsOfUse_Text(text)    
      URI 
       Mapping1: Metadata.IPRStatements_TermsOfUse_URI(text)    
   - Owners
    - Owner
     - Addresses
      Address 
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       Mapping1: Metadata.Owner_Address(text)    
     - EmailAddresses
      EmailAddress 
       Mapping1: Metadata.Owner_EmailAddress(text)    
     LogoURI 
      Mapping1: Metadata.Owner_LogoURI(text)    
     - Organisation
      - Name
       - Representation
        @language 
         Mapping1: "en"    
        Abbreviation 
         Mapping1: Metadata.Owner_Organisation_Name_Abbreviation(text)    
        Text 
         Mapping1: Metadata.Owner_Organisation_Name_Text(text)    
     - Person
      FullName 
       Mapping1: Metadata.Owner_Person_FullName(text)    
     - Roles
      Role 
       Mapping1: Metadata.Owner_Role(text)    
     - TelephoneNumbers
      - TelephoneNumber
       Number 
        Mapping1: Metadata.Owner_Telephone_Number(text)    
     - URIs
      URL 
       Mapping1: Metadata.Owner_URL(text)    
   - RevisionData
    DateModified 
     Mapping1: Metadata.RevisionData_DateModified(text)    
  - TechnicalContacts
   TechnicalContact 
    Address 
     Mapping1: TechnicalContact.Address(text)    
    Email 
     Mapping1: TechnicalContact.Email(text)    
    Name 
     Mapping1: TechnicalContact.Name(text)    
    Phone 
     Mapping1: TechnicalContact.Phone(text)    
  - Units
   Unit 
    - Associations
     UnitAssociation 
      AssociationType 
       Mapping1: Unit_Associations_UnitAssociation.AssociationType(text)    
       @language 
        Mapping1: "en"    
      Comment 
       Mapping1: Unit_Associations_UnitAssociation.Comment(text)    
       @language 
        Mapping1: "en"    
      KindOfUnit 
       Mapping1: Unit_Associations_UnitAssociation.KindOfUnit(text)    
       @language 
        Mapping1: "en"    
      SourceInstitutionCode 
       Mapping1: Unit_Associations_UnitAssociation.SourceInstitutionCode(text)    
      SourceName 
       Mapping1: Unit_Associations_UnitAssociation.SourceName(text)    
      UnitGUID 
       Mapping1: Unit_Associations_UnitAssociation.UnitGUID(text)    
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      UnitID 
       Mapping1: Unit_Associations_UnitAssociation.UnitID(text)    
    DateLastEdited 
     Mapping1: Unit.DateLastEdited(text)    
    - Gathering
     - Agents
      GatheringAgent 
       AgentText 
        Mapping1: Unit_Gathering_Agents.GatheringAgent_AgentText(text)    
     - Country
      ISO3166Code 
       Mapping1: Unit_Gathering.ISO3166Code(text)    
      Name 
       Mapping1: Unit_Gathering.Country_Name(text)    
       @language 
        Mapping1: "en"    
     - DateTime
      ISODateTimeBegin 
       Mapping1: Unit_Gathering.DateTime_ISODateTimeBegin(text)    
     LocalityText 
      Mapping1: Unit_Gathering.LocalityText(text)    
      @language 
       Mapping1: "de"    
     - SiteCoordinateSets
      - SiteCoordinates
       - CoordinatesLatLong
        LatitudeDecimal 
         Mapping1: Unit_Gathering.SiteCoordinateSets_CoordinatesLatLong_LatitudeDecimal(text)    
        LongitudeDecimal 
         Mapping1: Unit_Gathering.SiteCoordinateSets_CoordinatesLatLong_LongitudeDecimal(text)    
        SpatialDatum 
         Mapping1: Unit_Gathering.SiteCoordinateSets_CoordinatesLatLong_SpatialDatum(text)    
     - Stratigraphy
      - ChronostratigraphicTerms
       ChronostratigraphicTerm 
        Term 
         Mapping1: Unit_Gathering_Stratigraphy_ChronostratigraphicTerm.Term(text)    
      - LithostratigraphicTerms
       LithostratigraphicTerm 
        Term 
         Mapping1: Unit_Gathering_Stratigraphy_LithostratigraphicTerm.Term(text)    
    - HerbariumUnit
     Exsiccatum 
      Mapping1: Unit.HerbariumUnit_Exsiccatum(text)    
    - Identifications
     - Identification
      - Result
       - TaxonIdentified
        - HigherTaxa
         - HigherTaxon
          HigherTaxonName 
           Mapping1: Unit.Identification_Taxon_HigherTaxonName(text)    
          HigherTaxonRank 
           Mapping1: "regnum"    
        - ScientificName
         FullScientificNameString 
          Mapping1: Unit.Identification_Taxon_ScientificName_FullScientificName(text)    
         IdentificationQualifier 
          Mapping1: Unit.Identification_Taxon_ScientificName_Qualifier(text)    
    KindOfUnit 
     Mapping1: Unit.KindOfUnit(text)    
     @language 
      Mapping1: Unit.KindOfUnit_Language(text)    
    - MeasurementsOrFacts
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     MeasurementOrFact 
      - MeasurementOrFactAtomised
       LowerValue 
        Mapping1: MeasurementOrFact.LowerValue(text)    
       MeasuredBy 
        Mapping1: MeasurementOrFact.MeasuredBy(text)    
       MeasurementDateTime 
        Mapping1: MeasurementOrFact.MeasurementDateTime(text)    
       Parameter 
        Mapping1: MeasurementOrFact.Parameter(text)    
       UnitOfMeasurement 
        Mapping1: MeasurementOrFact.UnitOfMeasurement(text)    
    - MultiMediaObjects
     MultiMediaObject 
      - Creators
       creator 
        Mapping1: MultiMediaObject.CreatorAgent(text)    
      - IPR
       - Copyrights
        - Copyright
         @language 
          Mapping1: "en"    
         Text 
          Mapping1: MultiMediaObject.IPR_Copyright_Text(text)    
       - Licenses
        - License
         @language 
          Mapping1: "en"    
         Details 
          Mapping1: MultiMediaObject.IPR_License_Details(text)    
         Text 
          Mapping1: MultiMediaObject.IPR_License_Text(text)    
       - TermsOfUseStatements
        - TermsOfUse
         @language 
          Mapping1: "en"    
         Text 
          Mapping1: Metadata.IPRStatements_TermsOfUse_Text(text)    
      fileFormat 
       Mapping1: MultiMediaObject.FileFormat(text)    
      fileURI 
       Mapping1: MultiMediaObject.fileURI(text)    
      productURI 
       Mapping1: MultiMediaObject.ProductURI(text)    
    RecordBasis 
     Mapping1: Unit.RecordBasis(text)    
    RecordURI 
     Mapping1: Unit.RecordURI(text)    
    SourceID 
     Mapping1: Unit.SourceID(text)    
    SourceInstitutionID 
     Mapping1: Unit.SourceInstitutionID(text)    
    - SpecimenUnit
     - NomenclaturalTypeDesignations
      NomenclaturalTypeDesignation 
       TypeStatus 
        Mapping1: Unit_SpecimenUnit.NomenclaturalTypeDesignation_TypeStatus(text)    
       - TypifiedName
        FullScientificNameString 
         Mapping1: Unit_SpecimenUnit.NomenclaturalTypeDesignation_TypifiedName_FullScientificName(text)    

     - Preparations
      preparation 
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       preparationType 
        Mapping1: Unit_SpecimenUnit.Preparation_PreparationType(text)    
        @language 
         Mapping1: "en"    
    UnitGUID 
     Mapping1: Unit.UnitGUID(text)    
    UnitID 
     Mapping1: Unit.UnitID(text)    

  

Formularende

Save
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Archive 
Create archive 

The data related to a project can be exported into an archive. Choose Data - Archive - 
Create archive... from the menu. A window as shown below will open. 

Select the project you want to create an archive of and click on the Find the data button.
The data related with the project will be imported into temporary tables to allow you to
inspect them in advance of the creation of the archive (use the buttons to see the data).
To create the archive, click on the Create the archive button. A directory will be created
containing a XML file for every table.  

 

Reset database 

Before you restore an archive, please make sure that the data from the archive do not
interfere with the data in the database. In order to avoid problems you should clean the
database from any user data. To clear the database from any user data, choose  Data - 
Archive - Reset database... from the menu. A window as shown below will open listing all
tables and the number of data within these tables. Click on the Reset database  button to
remove any of these data including any data in the log tables. 
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Restore archive 

To restore an archive choose Data - Archive - Restore archive... from the menu. A
window as shown below will open listing the tables in the database. To restore an archive
click on the Choose archive directory button and select the directory containing the
archive files. Next click on the Read data button to import the data from the XML files into
temporary tables.

With a click on the buttons you can inspect the content of the temporary tables. Finally
click on the Restore the archiv button.
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Plan schedule based archive creation 

To administrate the schedule based creation of archives choose Data - Archive - 
Administrate archives... from the menu. A window as shown below will open listing the
projects in the database. Select the project that should be included in the schedule based
creation of archives. To create an archive for all selected projects, click on the Create
archives button. The protocol of a previous archiving is shown as in the image below.
Successful runs are indicated with a green color while failures have a red background (see
below).

 

Creation of archives as a backgroud process 

To archive the data in a scheduler based background process, you can start the application
with the following arguments: 

 Archive
 Server of the SQL-server database
 Port of SQL-server
 Database with the source data
 Optional: Directory where the archive directories should be created

C:\DiversityWorkbench\DiversityCollection> DiversityCollection.exe Archive
snsb.diversityworkbench.de 5432 DiversityCollection
C:\DiversityWorkbench\DiversityCollection\Archive

The application will create the archives, generate the protocols as described above and quit
automatically after the job is done. The user starting the process needs a Windows
authentication with access to the SQL-Server database and proper rights to archive the data.
If the last argument is not given the default directory [...\Application directory\Archive] will
be used. 
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Replication
If you wish to work with your data on a local database (called subscriber), e.g. on your
laptop, not linked to a database on a central server (called publisher) and these data should
be synchronized with the data in the database on the server, you may use the replication
function of DiversityCollection. To install the database on your local computer see the 
installation section. 

To use the replication function you require the roles Replicator or Administrator. 

Add Publisher 

To define a publishing database choose Data -> Replication -> Add Publisher from the
menu. A window will open where you choose the publisher. After the publisher is set, you may
transfer data between your local database (subscriber) and the publisher. This function is
only available for administrators.

Remove Publisher 

To remove a publisher from the list choose Data -> Replication -> [Publisher] -> 
Remove from the menu (where [Publisher] is the name of the publishing database on the
publishing server). This function is only available for administrators.

 

Clean database 

Initially you may wish to remove all previous data from your local database (subscriber).
Choose Data -> Replication -> Clean database ... from the menu. A window will open
as shown below where you may choose the ranges which should be cleared: 

 Definitions = the basic definitions within the database, e.g. the available taxonomic
groups. 

 Descriptions = the descriptions and their translations of the tables and columns of the
database. 
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 Project, User = the available projects and users. 
 Basic data = basic data like the collection. 
 Data = the specimen, organisms etc. 

Choose the data ranges you wish to clear and click on the button. All tables which contain
data will be listed as shown below.

 

Choose the tables which should be cleared and click on the Clean database button. Please
keep in mind that you can not delete data from a table as long as there is data in a related
table depending on the data you wish to delete. The sequence of the tables is organized to
avoid these problems.

 

Download 

To download data from the publisher choose Data -> Replication -> [Publisher] -> 
Download from the menu (where [Publisher] is the name of the publishing database on the
publishing server). A form will open as shown below. Choose the project of the data and the
data ranges (see above) which you wish to download. Click on the button to list the tables
containing data. To start the download click on the Start download button. With the 
Force download, ignore conflicts option you can decide whether or not the data in your
local database (= Subscriber) should be checked for changes before you download the data
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from the publisher. 

If not all data should be included in the replication, you have the option to set a filter. Click
on the button for the table where the data should be filtered to set this filter. A window as
shown below will open. 
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All columns of the table will be listed and allow you to set the filter. To inspect the filtered
data, click on the button. Click on the button to see the current filter. If a filter is set

this will be indicated with a blue background .

 

Merge 

To merge data from your local subscriber database with the publisher you must first choose a
project. Choose Data -> Replication -> [Publisher] -> Merge from the menu
([Publisher] is the name of the publishing database on the publishing server). As described for
the download, choose the data ranges and click on the button. To start the upload click on
the Start merge button.

 

Upload 

To transfer data from your local subscriber database to the publisher you must first choose a
project. Choose Data -> Replication -> [Publisher] -> Upload from the menu
([Publisher] is the name of the publishing database on the publishing server). As described for
the download, choose the data ranges and click on the button. To start the upload click on
the Start upload button. With the Force upload, ignore conflicts option you can
decide whether or not the data in server (= Publisher) should be checked for changes before
you upload the data from your local database (= Subscriber).

As described for the download, data may be filtered with a click on the button (see
above). 
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Tools 

To fix problems that may interfere with the replication you find some tools under the menu 
Data -> Replication -> [Publisher] -> Tools... from the menu ([Publisher] is the
name of the publishing database on the publishing server). A window will open as shown
below.

You may synchronize the RowGUIDs between basic subscriber and publisher tables if for any
reason these are differing, e.g. due to manual insert. Choose the table that should be
synchronized. The tables will be compared for both publisher and subscriber. The datasets
with identical key but different RowGUID will be listed (see above). Click on the Start
update button to synchronize the RowGUIDs. 

 

Conflict 

If the transfer of data was successful, the numbers of the transferred data will be shown as
below.

During the download or upload a conflict may occur, if the data has been edited in both
databases. This will be indicated as shown below.

Click on the button to open a window as shown below where you can choose between the
two versions of the data as found in the publisher and the subscriber database. 
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The conflicting columns are marked red. For text values the program will create a combination
of both values (see above) in a merged version of the data. Choose the preferred version of
the data and click Solve conflict button. If you can not solve a conflict, use the Ignore
conflict or Stop conflict resolution buttons respectively.

 

Report 

At the end of each transfer a report will be created with a summary for every table which has
been included.
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Stable identifier 
Stable identifiers are generated from a basic URL and the IDs from the database. To set the
basic URL select Administration - Stable identifier ... from the menu. A window as shown
below will open, where you can set the basic URL for the stable identifier either for the whole
database or for every project. With the button you can copy the current URL to all projects
in the list. 

The Test button creates a QR code for the URL as shown above using a google api
(http://chart.apis.google.com). The stable identifier consits of the basis address as set
above, followed by the part that identifies the object in the database as shown in the
examples below. For an introduction see a short tutorial . 

Table Stable identifier

Specim
en:

http://id.snsb.info/snsb/Collection
_SNSB/312

= [Server]/[Instance]/[Alias for
database]/[CollectionSpecimenID]

Unit: http://id.snsb.info/snsb/Collection
_SNSB/312/789

= [Server]/[Instance]/[Alias for
database]/[CollectionSpecimenID]/[Identificati
onUnitID]

Part: http://id.snsb.info/snsb/Collection
_SNSB/312/789/283

= [Server]/[Instance]/[Alias for
database]/[CollectionSpecimenID]/[Identificati
onUnitID]/[SpecimenPartID]

Collecti
on:

http://id.snsb.info/snsb/Collection
_SNSB/Collection/23

= [Server]/[Instance]/[Alias for
database]/[Table]/[CollectionID]

Transac
tion:

http://id.snsb.info/snsb/Collection
_SNSB/Transaction/4

= [Server]/[Instance]/[Alias for
database]/[Table]/[TransactionID]

In the examples above http://id.snsb.info is the server, snsb is the instance on the server
that may correspond to an organization etc. like ZSM or SMNK. Collection_SNSB is an alias for
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the database corresponding to the name of the database without the leading string Diversity.
The following numbers point on the keys of the datasets in the main tables. The last two
examples point to separate tables within the database and the following number correspond to
the key for these tables.

An additional id service is necessary to make direct use of the stable identifiers. This id
service redirect a given stable identifier to another web-page which shows data about the
identifier. This can be HTML or xml-rdf according to the CETAF recommendations. The id
service needs further information to redirect to those websites. For the redirection to a
BioCase-Provider installation or a xml-rdf-service, the information can be retrieved from the
main database. The necessary roles and logins for this id service can be generated by
pressing the button at the buttom of the window. This buttom will not be visible if the
corresponding roles etc. already do exist.
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Customization of the application
DiversityCollection provides several ways to adapt the forms to your needs. There are special
adaptations for the main window and for the grid view. General adaptations are performed
with the context.
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Entities, contexts, usage and
languages
DiversityCollection may be used in diverse contexts like collection management, observations
or field mapping. To ensure that a user working in a certain area will see the descriptions
corresponding to his domain the DiversityWorkbench provides the possibility to define
corresponding contexts. 

To set the context and the language for the program choose Administration - Customize
display ... from the menu. A window will open as shown below where you may select the
language and the context which should be used. By default the language will be set according
to the settings of your operating system, however, you may change it here. The default
language within DiversityCollection is English. If you select a certain context, the tables in the
lower part of the form will show you the special setting within this context. These settings are
edited as described below.   

 

For the documentation of the tables used for the storage of the entity related data please
see the section Entity tables. 

To edit the entities choose Administration - Application description ... from the menu. A
window will open as shown below where you may edit the entities defined for the program.
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Group for the display of the entity

If in a user interface certain entities should be displayed in a group, enter the name of the
group here. 

Usage

If nothing is defined for the usage of an entity, it will be handled according to the rights of
the user. In certain context an entity may be set to e.g. read only, inapplicable or not used.
In case of the later two possibilities the entity will not appear in the interface of the program.
For example, transaction management (e.g. loan) will not be handled with a mobile device,
thus the corresponding entities will be set to "not used". Use the [Insert new usage] button
to insert a new usage for an entity. To edit the possible usages choose Administration -
Usage ... from the menu. 

 inapplicable: An entity which may not be applied in a certain context will not be shown
in a user interface, e.g. the depositors accession number in the context observation.  

 preset: An entity will have a preset value, e.g. 'determination' for the identification
category in the context observation.

 read only: An entity may not be changed.
 hidden: An entity should be hidden from the user interface.   

Context 

The default context is General. Thus, in the beginning you will find all representations within
this context. Within the representation, when a certain context is missing, the program will
search for a representation in the parent context until a representation is found. To edit the
context choose Administration - Context ... from the menu. A window will open as shown
below where you may edit the context.
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Representation 

An entity may have differing representations in different contexts. For example a
CollectionEvent may correspond to an observation or gathering in other contexts. Use the
Entity and Representation menu to fill in missing entries. If an only if entity should receive a
different title or description in the user interface, enter the values in the table. If nothing is
defined in a certain context, the program will walk up the tree defined with the parent code
(see the image above) to find available values for the title or description of the entity. The
highest entry in the hierarchy is the context General with the language English. If you define
deviating values for the display text, the abbreviation or the description, you must at least
enter values in the highest entry (General, English) as a default value for all other entities.  

Language /font> 

TThe default language used in DiversityCollection is English. Thus, in the beginning you will
find all descriptions etc. in English. All representations may be defined for any language. Use
the Representation menu to automatically fill in missing entries of a language. If there are
changes in the original description of tables or columns in the database, choose 
Representation - Update descriptions according to database/strong> from the menu
to import the updated descriptions for the English version and context "General". 

Entity /font>

To insert missing entities use the Entity menu. To insert all missing tables of a
database choose Entity - Insert all missing tables ... from the menu. A window will
open listing the missing tables. Use the [Exclude: ... ] field and [Requery] button to
remove certain tables from the list, e.g. if you do not wish to define entities for log
tables, enter *_log and then click [Requery]. You may repeat this until the list contains
only tables you wish to use. 
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You find corresponding functions for single tables and for entries in a table. The later
function is restricted to tables with a primary key with one column. A window will open
where you map the columns, provided for the entity documentation to columns in the
table, of which you wish to import the entries (see image below).

 

This may be necessary, if e.g. certain entries in a table should not be used in a certain
context or if you wish to translate the contents into another language. 
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Customize the main form
The main window can be customised in several parts. To change the visible parts in the main
window select Administration - Customize display ... from the menu. A window (see below)
will open where you can select the groups which should be displayed. In the first tab you can
change the visibility for the taxonomic groups and material categories.

In the second tab (see below) you can set 

 visibility of the localisation systems displayed in a distribution map
 the localisation systems available for the selection in the drop down menus
 the collection site properties available for the selection in the drop down menus
 the source for the country list from a gazetteer
 the direction of the hierarchy derived from a gazetteer and written into the cached

value representing the gazetteer entry 
 the separator in the hierarchy derived from a gazetteer and written into the cached

value representing the gazetteer entry
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Defaults and miscellaneous

In the third tab (see below) you can add the name of the responsible person or choose the
current user for several entries and show/hide the controls for the exsiccata.
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Timeout

The timeout for web resources and databases either added manually or via linked server can
be set to adapt to the velocity of the available net. If you set the Timeout for web response
to 0, the application will ignore any resources retrieved from the web. By default these values
are set to 30 seconds. This is demonstrated in a short tutorial .   

 

Responsible

You can choose to either use the current user or a specified user as a responsible for new
datasets for various tables (see image above). 

Storage location

The source for the list for the storage location can be set as shown below: 

 Taxonomic names from identifications within the selected specimen
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 Storage locations already entered for the parts within the collection where the part is
stored

 Storage locations already entered for the parts within the whole database

 

Template copy mode

 

There are 3 possibilities: 

 Copy values from the template only if there are no entries in the data
 Ask the user if there are differing contents in data and template whether the template

values should be copied into the data
 Copy the values from the template irrespective of any content in the data

 

Subcollection content

The display text for the content of the subcollection can be composed of the fields listed
below: 

 Accession number of the specimen
 Accession number of the part
 First identification of the first organism
 Storage location of the first part
 Locality of the collection event
 Collection date

The default collection for new parts can set here as well. 

 

Miscellaneous

Show exsiccata: If the data fields for the exsiccatal series should be displayed.

Show accepted names: With this option the names linked to DiversityTaxonNames will be
checked for the synonymy status. Accepted names will be shown with a green color and for
synonyms the accepted name will be displayed above the current name (see below).

Scan DiversityDescriptions: If accessible DiversityDescriptions databases should be scanned
for links to the current dataset.

Use autocompletion for all textboxes: Available in upcoming version - If this option is
choosen, textboxes will autocomplete starting with the specified text length.
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Resources directory

The directory for the resource can be set with as shown in the area below. Here parameters
for example the spreadsheets are stored. See chapter Resources for details. 

Transaction

Transaction display sequence

To customize the sequence and format of the transactions shown in the tree, choose 
Administration -> Customize display ... from the menu and then select the part
Transaction (see below). If you want to change the default sequence and/or display type,
click on the button. Use the and buttons to change the position of a certain type of
transaction and choose one of the display types. To reset these settings to the database
default, use the button. If your transactions are organized within a hierarchy, you can
include the titles of the superior hierarchies with the Include superior transaction in title
option.  

Transaction standard comments
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As an administrator you can add entries to the Standard comments for transactions (see
above) that are used to enter standard phrases into the comment field of a transaction. 

Default currency

The default currency for all transaction payments in the database is Euro. To change the
default currency click on the Currency button.  

 

Settings

The tab Settings shows an overview of all settings set by the user e.g. when linking the
sources for identification to a certain database or webservice via the button (see
below). Relations to Diversityworkbench modules include the database and the project as
shown below. With the Reset button, you can clear the whole settings. These settings can
not be defined here, but are set in the main form in the corresponding parts e.g. the
identification. These settings are stored in the database for every user (UserProxy ->
Settings).  
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Database
The database for DiversityCollection is based on Microsoft SQL-Server 2005.

Organisation of the data

The main tables of the database are CollectionEvent corresponding to the event of the
collection and CollectionSpecimen holding the specimens collected. Connected to these tables
you find tables for additional information. 

The image below shows the main tables of the database.

 

The diagram shows the tables of the database marked according to their logical groups. In the
center the table CollectionSpecimen holds specimen data e.g. the accession number. On the
left you find the tables containing collection event data and on the right tables related to the
organisms and their identifications. Further logical groups are collectors, projects, storage
and transaction.

Further details: tables , application tables, access.
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Installation of the database
DiversityCollection uses Microsoft SQL-Server 2008 or later as database engine. If you do not
have a database server with DiversityCollection already available, you need to install the
database engine first. Download the free version of Microsoft SQL Server Express 2008 or later
(e.g. SQLEXPRADV_x86_DEU.exe  ) from http://www.microsoft.com/downloads/. Start the
program and follow the instructions for the installation. 

Download the database files DiversityCollection_Data.MDF  and DiversityCollection_log.LDF
 from http://www.diversityworkbench.net/Portal/ provided as a zip archive

(DiversitCollection.zip) and copy them into your database directory. 

If you plan to use the database on your local computer (SQL Server Express), start the
program DiversityCollection.exe and in the main window click on the button or choose
Connection -> Database ... from the menu. A window will open as shown below. Here
choose the option Local database and select the database file in your directory. 

 

Server configuration 

To configure your server for remote access launch the SQL Server Configuration Manager
(see image below). 

Then click on the "Protocols for SQLEXPRESS" node. Right click on "TCP/IP" in the list of
Protocols and choose "enable" for TCP/IP.
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Right click on the TCP/IP node and select "Properties" to open a window as shown below. 

In the part IPALL clear out the value for "TCP Dynamic Ports". Give a TCP-Port number to
use when making remote connections e.g. "4321" as shown above. You have to restart the
SQL Server Express service before you can connect to your database. 

If you use a database on a server, make sure that the firewall of the server allows access via
the port you set for the connection (see below). 
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Start the Microsoft SQL Server Managment Studio and attach the database as shown below.
Choose the node "databases" and right-click on it to open the context menu (see below).
Then choose "attach" from the context menu. A window will open where you can choose the
file DiversityCollection_Data.MDF from your database directory and attach it to the database
engine.
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After the installation make sure to get the latest updates from 
http://windowsupdate.microsoft.co m/.

 

Database configuration 

To configure your database use the client as described in Database configuration.
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Configuration of the database
To configure your database choose Administration -> Database -> Rename
database to change the name of the database according to your requirements. During this
renaming all processes in the database will be terminated (you will get a warning if processes
from other hosts are active). 

Afterwards you should adapt the address that is published by the database for access by
other modules. Choose Administration -> Database -> Set published address from
the menu. This will change the published address to the name of the server where your
database is located and provide an identifier for your database, e.g. http://xy.diversityworkbe
nch.de/Collection/ .  

Renaming of the database and adapting of the published address should be done before you
start to use the database and name and address should not be changed afterwards as
data sets from other modules linked to data in the database would otherwise point to
outdated addresses. 
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Connections to the databases and services
The program will automatically try to connect to all the modules within the Diversity
Workbench. To edit these connections choose Connection -> Module connections ...
from the menu. A form (see below) will open where you can edit the connections. 

To requery the connections use the button. If you want to add a connection to a different
server click on the  button and connect to the database you want to add to the list. Added
databases will be displayed in green. To remove a connection from the list select it and click
on the button. If an added connection misses a password, this will be indicated by a red
backcolor. Click on the button to enter the missing password. 

Webservices like Index Fungorum will be displayed in blue. 
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Linked server
Databases not available on the local server may be accessible via a linked server. To
administrate the linked servers, choose Administration - Linked servers ... from the
menu. A form (see below) will open where you can add linked servers and inspect the content
of the available databases. 

Use the  resp. buttons to add or remove a linked server. To add a linked server, you need
the name of the server and the port, e.g. tnt.diversityworkbench.de, 5432, the login
associated with the connection of the linked server e.g. TNT and the password for this login.
The available databases will be listed as shown above. To inspect the content, select
among the tables or views listed in the right part as shown above. Linked servers have certain
restrictions for the availability of data, e.g. XML and geography data are not available via a
linked server. For a table or view containing incompatible content you may encounter a
corresponding error mentioning the reason for the incompatibility. 
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Database - access
The database engine for DiversityCollection is Microsoft SQL-Server 2008 or later.

When you are connected to a database it is indicated by the icon of the connection button 
in the upper left corner. When you are not connected the following icon will be shown .

To access any database you must specify the server where the database is located. For the
configuration of this connection choose Connection, Database... from the menu or click on
the button as demonstrated in a short tutorial . 

If you want to use a database on a central server or remote computer, start the program 
DiversityCollection.exe. In the main window click on the button or choose Connection ->
Database ... from the menu. A window will open as shown below. Here choose the option
Remote database and set the connection parameters as described below. 

Database name, IP-address and Port

A dialog will open to specify the name or IP-address and port number of the server as well as
to select the authentication mode. You can either choose Windows authentication (see left
image below) or SQL-Server authentication (see middle image below).
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The standard port number for SQL-Server is 1433 and will be set as a default. If the database
server is configured using a different port, you must enter its number in the field Port. Click on

the button to connect to the server. If the connection information is valid,
you can choose a database from the server in the combo box at the base of the window (see

right image above). To restart the connecting process click on the button. 

If you access a database for the first time you will be asked to consent to the storage and
processing of your personal data (see below) according to the General Data Protection
Regulation. Without your consent the access is not possible.

 

Password

If you are logged in with a SQL-Server account and are not restricted to the group User,
you can change your password. Choose Administration - Change password... from the
menu. In the window that will open, enter your current password and the new password (see
below). The password must match the restrictions set by the database server. 
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Encryption

The connection to the databases by default is encrypted, symbolized by the icon. To

change to an not encrypted connection, click on the icon which will change to accordingly,
indicating a not encrypted connection. 

 

Module connections

The program will automatically try to establish a connection to Diversity Workbench databases
and webservices. For further details see the Connections section. 
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Database documentation
These are the tools to describe the parts of the database and create documentations of the
structure. To use these tools, choose Administation -> Database -> Documentation
... from the menu. A window will open as shown below. 

Select the tables that should be included in the documentation, choose among the provided
options and click on the button Create ... documentation to create a documentation in one of
the available formats (HTML, MediaWiki, JSP-Wiki).  
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Database description
These are the tools to describe the parts of the database and create documentations of the
structure. To use these tools, choose Administration -> Database -> Description ...
from the menu. A window will open as shown below. 

Description

The structure of the database is documented as Entities of the structure 
[Table].[Column].[Content] e.g. Analysis for the table Analysis or
CollTransactionType_Enum.Code.loan for the entry loan in the table
CollTransactionType_Enum. The descriptions are defined for contexts if e.g. a certain group of
users need differing descriptions or translations of the database structures. In the Usage
section you can define the Accessibility of tables and columns if e.g. for a mobile application
like DiversityMobile certain parts of the database e.g. should not be used. With the 
Determination you can define if the contents are set by e.g. a program or by the user. With
the Visibility you can define if certain parts should be visible of hidden. If for a certain
context a preset value should be used, this value can be set here. In the Representation
section you can enter a Display text, an Abbreviation and a Description for all contexts in any
language.  

Entity

To insert missing tables choose Entity - Insert all missing tables from the menu. A window
as shown below will open where you can select among the missing tables which of these
should be added. Missing columns can be added with the menu Entity - Insert missing
columns for ... either all tables or a selected table. If you want to insert descriptions for the
content of a table, choose Insert PK for selected table. This is option is provided to enable
the translation of enumerations contained in the database.
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Representation

To insert entries for a language that is missing, choose Representation - Insert all
language ... from the menu. In the window that will open, choose the language and click OK.
Any missing language entry will be inserted to prepare the entry of the translations by a user.
The database contains default descriptions of all tables and columns. These can either be
used as a base for the description. Select a table and choose Representation - Update
descriptions ... from the menu. To change the descriptions in the database according to the
entries you made choose Representation - Update database ... from the menu.

 

Usage

With the Usage menu you can add a Usage for a table or for the columns of a table.

 

Context

To edit the context choose Administration - Context from the menu. A window as shown
below will open with all contexts available in the database.
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To enter a new context, just enter the values in the last line. As ParentCode enter General or
one of the existing codes. The values of this parent context will be used if values for the new
context are missing. As next step insert the parameters for the new context into the table for
the representation. To do so select the table EntityContext_Enum and choose Insert PK for
selected table (see below). This will add the value for the new context so far missing in the
table Entity and EntityRepresentation.

In the upcoming dialog set the mapping as shown below.

Now the new context is available for selection in the main menu.
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Index
 Analysis

 AnalysisResult

 AnalysisTaxonomicGroup

 Collection

 CollectionAgent

 CollectionEvent

 CollectionEventImage

 CollectionEventLocalisation

 CollectionEventMethod

 CollectionEventParameterValue

 CollectionEventProperty

 CollectionEventRegulation

 CollectionEventSeries

 CollectionEventSeriesImage

 CollectionExternalDatasource

 CollectionImage

 CollectionProject

 CollectionSpecimen

 CollectionSpecimenImage

 CollectionSpecimenImageProperty

 CollectionSpecimenPart

 CollectionSpecimenPartDescription

 CollectionSpecimenPartRegulation

 CollectionSpecimenProcessing

 CollectionSpecimenProcessingMethod
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 CollectionSpecimenProcessingMethodParameter

 CollectionSpecimenReference

 CollectionSpecimenRelation

 CollectionSpecimenTransaction

 Identification

 IdentificationUnit

 IdentificationUnitAnalysis

 IdentificationUnitAnalysisMethod

 IdentificationUnitAnalysisMethodParameter

 IdentificationUnitGeoAnalysis

 IdentificationUnitInPart

 LocalisationSystem

 Method

 MethodForAnalysis

 MethodForProcessing

 Parameter

 Processing

 ProcessingMaterialCategory

 ProjectAnalysis

 ProjectProcessing

 Property

 Transaction

 TransactionAgent

 TransactionDocument

 TransactionPayment
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Table Analysis
Analysis types used within the database

Column Data type Description Nullable Relation
AnalysisID int ID of the analysis

(primary key)
NO -

AnalysisParentID int

Analysis ID of the
parent analysis, if
it belongs to a
certain type
documented in
this table

YES Refers to table
Analysis

DisplayText nvarchar (50)

Name of the
analysis as e.g.
shown in user
interface

YES -

Description nvarchar (MAX) Description of the
analysis

YES -

MeasurementUnit nvarchar (50)

The measurement
unit used for the
analysis, e.g. mm,
µmol, kg

YES -

Notes nvarchar (MAX) Notes on this
analysis

YES -

AnalysisURI varchar (255)

URI referring to
an external
documentation of
the analysis

YES -

OnlyHierarchy bit

If the entry is
only used for the
hierarchical
arrangement of
the entries
Default value: (0)

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -
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RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Table AnalysisResult
Value lists for analysis types with predefined values, e.g. "0, 1, 2, 3, ..." for
Red list category. Includes description etc. for the values in the list.

Column Data type Description Nullable Relation
AnalysisID int ID of the analysis

(primary key)
NO Refers to table

Analysis

AnalysisResult nvarchar (255)
The categorized
value of the
analysis

NO -

Description nvarchar (500)

Description of
enumerated
object displayed
in the user
interface

YES -

DisplayText nvarchar (50)

Short abbreviated
description of the
object displayed
in the user
interface

YES -

DisplayOrder smallint

The order in
which the entries
are displayed.
The order may be
changed at any
time, but all
values must be
unique.

YES -

Notes nvarchar (500)

Internal
development
notes on usage,
definition, etc. of
an enumerated
object

YES -

LogInsertedBy nvarchar (50)

Name of user to
first enter (typ or
import) the data.
Default value:
suser_sname()

YES -

LogInsertedWhen smalldatetime

Point in time
when the data
was first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)
Name of the
person to update
this data last.

YES -
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Default value:
suser_sname()

LogUpdatedWhen smalldatetime

Point in time
when this data
was updated last.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 Analysis

Table AnalysisTaxonomicGroup
The types of analysis which are available for a taxonomic group

Column Data type Description Nullable Relation

AnalysisID int
Analysis ID,
foreign key of
table Analysis.

NO Refers to table
Analysis

TaxonomicGrou
p nvarchar (50)

Taxonomic group
the organism,
identified by this
unit, belongs to.
Groups listed in
table
CollTaxonomicGro
up_Enum (=
foreign key)

NO -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 Analysis

Table Collection
The collections where the specimen are stored
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Column Data type Description Nullable Relation

CollectionID int

Unique reference
ID for the
collection (=
primary key)

NO -

CollectionParentID int

For a
subcollection
within another
collection:
CollectionID of
the collection to
which the
subcollection
belongs. Empty
for an
independent
collection

YES Refers to table
Collection

CollectionName nvarchar (255)

Name of the
collection (e.g.
'Herbarium Kew')
or subcollection
(e.g. 'cone
collection',
'alcohol
preservations').
This text should
be kept relatively
short. You may
use Description
for additional
information

NO -

CollectionAcronym nvarchar (10)

A unique code for
the collection,
e.g. the
herbarium code
from Index
Herbariorum

YES -

AdministrativeCon
tactName nvarchar (500)

The name of the
person or
organisation
responsible for
this collection

YES -

AdministrativeCon
tactAgentURI varchar (255)

The URI of the
person or
organisation
responsible for
the collection e.g.
as provided by
the module
DiversityAgents

YES -

Description nvarchar (MAX)
A short
description of the
collection

YES -

Location nvarchar (255)

Optional location
of the collection,
e.g. the number
within a file
system or a

YES -
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description of the
room(s) housing
the
(sub)collection

CollectionOwner nvarchar (255)

The owner of the
collection as e.g.
printed on a label.
Should be given if
CollectionParentID
is null

YES -

DisplayOrder smallint

The order in
which the entries
are displayed.
The order may be
changed at any
time, but all
values must be
unique.

YES -

Type nvarchar (50)

Type of the
collection, e.g.
cupboard, drawer
etc.

YES
Refers to table
CollCollectionType
_Enum

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 CollCollectionType_Enum

Table CollectionAgent
The collector(s) of CollectionSpecimens

Column Data type Description Nullable Relation
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CollectionSpeci
menID int

Refers to ID of
CollectionEvent
(= foreign key
and part of
primary key)

NO
Refers to table
CollectionSpecime
n

CollectorsName nvarchar (255) Name of the
Collector

NO -

CollectorsAgentUR
I varchar (255)

The URI of the
Agent, e.g. as
stored within the
module
DiversityAgents

YES -

CollectorsSequen
ce datetime2

The order of
collectors in a
team.
Automatically set
by the database
system
Default value:
sysdatetime()

YES -

CollectorsNumber nvarchar (50)

Number assigned
to a specimen or
a batch of
specimens by the
collector during
the collection
event (= 'field
number')

YES -

Notes nvarchar (MAX)

Notes on the
collector, e.g. if
the name is
uncertain

YES -

DataWithholdingR
eason nvarchar (255)

If the data set is
withhold, the
reason for
withholding the
data, otherwise
null

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)
Name of the
person to update
this data set last

YES -
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Default value:
suser_sname()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 CollectionSpecimen

Table CollectionEvent
The event where and when the specimen were collected

Column Data type Description Nullable Relation

CollectionEventI
D int

Unique ID for the
table
CollectionEvent
(= primary key)

NO -

Version int

The version of
the data set.
Automatically set
by the system.
Default value: (1)

NO -

SeriesID int

The ID of the
related
expedition.
Relates to the PK
of the table
CollectionExpediti
on (foreign key). 

YES
Refers to table
CollectionEventSe
ries

CollectorsEventNu
mber nvarchar (50)

Number assigned
to a collection
event by the
collector (= 'field
number')

YES -

CollectionDate datetime

The cached date
of the collection
event calulated
from the entries
in CollectionDay,
-Month and
-Year.

YES -

CollectionDay tinyint

The day of the
date of the event
or when the
collection event
started

YES -

CollectionMonth tinyint

The month of the
date of the event
or when the
collection event
started

YES -

CollectionYear smallint
The year of the
date of the event
or when the

YES -
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collection event
started

CollectionEndDay tinyint

The day of the
date of the event
or when the
collection event
ended

YES -

CollectionEndMont
h tinyint

The month of the
date of the event
or when the
collection event
ended

YES -

CollectionEndYear smallint

The year of the
date of the event
or when the
collection event
ended

YES -

CollectionDateSup
plement nvarchar (100)

Verbal or
additional
collection date
information, e.g.
'end of summer
1985', 'first
quarter',
'1888-1892'. The
end date, if the
collection event
comprises a
period. The time
of the event, if
necessary.

YES -

CollectionDateCat
egory nvarchar (50)

Category of the
date of the
identification e.g.
"system",
"estimated" (=
foreign key, see
in table
CollEventDateCat
egory_Enum)

YES
Refers to table
CollEventDateCat
egory_Enum

CollectionTime varchar (50)

The time of the
event or when
the collection
event started

YES -

CollectionTimeSpa
n varchar (50)

The time span
e.g. in seconds of
the collection
event

YES -

LocalityDescriptio
n nvarchar (MAX)

Locality
description of the
locality exactly as
written on the
original label (i.e.
without
corrections during
data entry)

YES -

LocalityVerbatim nvarchar (MAX) Locality as given
in historical YES -
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context,
documents and
labels

HabitatDescription nvarchar (MAX)

Geo-ecological
description of the
locality exactly as
written on the
original label (i.e.
without
corrections during
data entry)

YES -

ReferenceTitle nvarchar (255)

The title of the
publication where
the collection
event was
published. Note
that this is only a
cached value
where
ReferenceURI is
present

YES -

ReferenceURI varchar (255)

URI (e.g. LSID) of
the source
publication where
the collection
event is
published, may
e.g. refer to the
module
DiversityReferenc
es

YES -

ReferenceDetails nvarchar (50)

The exact
location within
the reference,
e.g. pages, plates

YES -

CollectingMethod nvarchar (MAX)

Description of the
method used for
collecting the
samples, e.g.
traps, moist
chambers, drag
net

YES -

Notes nvarchar (MAX) Notes on the
collection event

YES -

CountryCache nvarchar (50)

The country
where the
collection event
took place.
Cached value
derived from an
entry in
CollectionEventLo
calisation

YES -

DataWithholdingR
eason nvarchar (255)

If the data set is
withhold, the
reason for
withholding the
data, otherwise

YES -
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null

DataWithholdingR
easonDate nvarchar (50)

The reason for
withholding the
collection date

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 CollectionEventSeries
 CollEventDateCategory_Enum

Table CollectionEventImage
The images showing the collection site resp. place of the observations

Column Data type Description Nullable Relation

CollectionEventI
D int

Part of primay
key, refers to
unique ID for the
table
CollectionEvent
(= foreign key)

NO Refers to table
CollectionEvent

URI varchar (255)

The complete URI
address of the
image. This is
only a cached
value, if
ResourceID is
available and
referring to the
module
DiversityResource
s

NO -
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ResourceURI varchar (255)

The URI of the
resource (e.g.
see module
DiversityResource
s)

YES -

ImageType nvarchar (50) Type of the
image, e.g. map YES

Refers to table
CollEventImageTy
pe_Enum

Notes nvarchar (MAX)

Notes to this
image concerning
the
CollectionEvent

YES -

Description xml (MAX) Description of the
image

YES -

Title nvarchar (500) Title of the
resource

YES -

IPR nvarchar (500)

Intellectual
Property Rights;
the rights given
to persons for
their intellectual
property

YES -

CreatorAgent nvarchar (500)

Person or
organization
originally creating
the resource

YES -

CreatorAgentURI varchar (255)
Link to the
module
DiversityAgents

YES -

CopyrightStateme
nt nvarchar (500)

Notice on rights
held in and for
the resource

YES -

LicenseType nvarchar (500)

Type of an official
or legal permission
to do or own a
specified thing, e.
g. Creative
Common Licenses

YES -

InternalNotes nvarchar (500)

Internal notes
which should not
be published e.g.
on websites

YES -

LicenseHolder nvarchar (500)
The person or
institution holding
the license

YES -

LicenseHolderAge
ntURI nvarchar (500)

The link to a
module containing
futher information
on the person or
institution holding
the license

YES -

LicenseYear nvarchar (50)
The year of
license
declaration

YES -

DataWithholdingR
eason nvarchar (255) If the data set is

withhold, the YES -
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reason for
withholding the
data, otherwise
null

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 CollectionEvent
 CollEventImageType_Enum

Table CollectionEventLocalisation
The geographic localisation of a CollectionEvent

Column Data type Description Nullable Relation

CollectionEventI
D int

Refers to the ID
of CollectionEvent
(= foreign key
and part of
primary key)

NO Refers to table
CollectionEvent

LocalisationSyst
emID int

Refers to the ID
of
LocalisationSyste
m (= foreign key
and part of
primary key)

NO
Refers to table
LocalisationSyste
m

Location1 nvarchar (255)

Either a named
location selected
from a thesaurus
(e.g. 'Germany,
Bavaria,
Kleindingharting')
or altitude range

YES -
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or other values
(e. g. 100-200 m)

Location2 nvarchar (255)

Corresponding
value to
Location1 e.g. ID
or URI of
gazetteer or
thesaurus

YES -

LocationAccuracy nvarchar (50)
The accuracy of
the determination
of this locality

YES -

LocationNotes nvarchar (MAX) Notes on the
location

YES -

DeterminationDat
e smalldatetime

Date of the
determination of
the geographical
localisation

YES -

DistanceToLocati
on varchar (50)

Distance from the
specified place to
the real location
of the collection
site (m)

YES -

DirectionToLocati
on varchar (50)

Direction from the
specified place to
the real location
of the collection
site (Degrees rel.
to north)

YES -

ResponsibleName nvarchar (255)

The name of the
agent (person or
organization)
responsible for
this entry.

YES -

ResponsibleAgent
URI varchar (255)

URI of the person
or organisation
responsible for
the data (see
e.g. module
DiversityAgents)

YES -

Geography geography The geography of
the localisation

YES -

RecordingMethod nvarchar (500)

The method or
device used for
the recording of
the localisation

YES -

AverageAltitudeC
ache float

Calculated
altitude as parsed
from the location
fields

YES -

AverageLatitudeC
ache float

Calculated
latitude as parsed
from the location
fields

YES -

AverageLongitude
Cache float

Calculated
longitude as
parsed from the
location fields

YES -
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LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 CollectionEvent
 LocalisationSystem

Table CollectionEventMethod
The methods used during a collection event

Column Data type Description Nullable Relation

CollectionEventI
D int

Refers to ID of
CollectionSpecime
n (= foreign key
and part of
primary key)

NO Refers to table
CollectionEvent

MethodID int
ID of the setting,
part of primary
key

NO Refers to table
Method

MethodMarker nvarchar (50)

A marker for the
method, part of
primary key
Default value: '1'

NO -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:

YES -
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suser_sname()

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 CollectionEvent
 Method

Table CollectionEventParameterValue
The values of the parameter of the methods used within a collection event

Column Data type Description Nullable Relation

CollectionEventI
D int

Unique ID for the
table
CollectionEvent
(= foreign key
and part of
primary key)

NO
Refers to table
CollectionEventMe
thod

MethodID int

ID of the method
tool. Referes to
table Method (=
foreign key and
part of primary
key)

NO

Refers to table
CollectionEventMe
thod and table
Parameter

MethodMarker nvarchar (50)

A marker for the
method, part of
primary key
Default value: '1'

NO
Refers to table
CollectionEventMe
thod

ParameterID int

ID of the
parameter tool.
Referes to table
Parameter (=
foreign key and
part of primary
key)

NO Refers to table
Parameter

Value nvarchar (MAX)

The value of the
parameter, if
different of the
default value as
documented in
the table
Parameter

YES -
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Notes nvarchar (MAX)
Notes concerning
the value of the
parameter 

YES -

LogInsertedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogInsertedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Depending on:
 CollectionEventMethod
 Parameter

Table CollectionEventProperty
A property of a collection site, e.g. exposition, slope, vegetation. May refer
to Diversity Workbench module DiversityScientificTerms

Column Data type Description Nullable Relation

CollectionEventI
D int

Refers to the ID
of CollectionEvent
(= foreign key
and part of
primary key)

NO Refers to table
CollectionEvent

PropertyID int

The ID of the
property of the
collection site,
foreign key, see
table Property

NO Refers to table
Property

DisplayText nvarchar (255)

The text for the
property as
shown e.g. in a
user interface

YES -

PropertyURI varchar (255)
URI referring to
an external data
source e.g.

YES -
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DiversityTerminolo
gy

PropertyHierarchy
Cache nvarchar (MAX)

A cached text of
the complete
name of the
descriptor
including superior
categories, if
present

YES -

PropertyValue nvarchar (255)

The value of a
captured feature,
e.g. temperature,
pH, vegetation
etc. If there is a
range, this is the
lower or first
value

YES -

ResponsibleName nvarchar (255)

The name of the
agent (person or
organization)
responsible for
this entry.

YES -

ResponsibleAgent
URI varchar (255)

URI of the person
or organisation
responsible for
the data (see
e.g. module
DiversityAgents)

YES -

Notes nvarchar (MAX)
Notes on the
property of the
colletion site.

YES -

AverageValueCac
he float

For numeric
values - a cached
average value
according to the

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier - NO -
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Default value:
newsequentialid()

Depending on:
 CollectionEvent
 Property

Table CollectionEventRegulation
Regulation applied to a collection event

Column Data type Description Nullable Relation

CollectionEventI
D int

Part of primay
key, refers to
unique ID for the
table
CollectionEvent
(= foreign key)

NO Refers to table
CollectionEvent

Regulation nvarchar (400)

Regulation as
defined in the
table Regulation.
Used to ensure,
that user checked
correct entry with
authorized stuff

NO -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 CollectionEvent
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Table CollectionEventSeries
The series whithin which collection events take place

Column Data type Description Nullable Relation

SeriesID int

Primary key. The
ID for this series
of collection
events (= primary
key)

NO -

SeriesParentID int
The ID of the
superior series of
collection events

YES
Refers to table
CollectionEventSe
ries

Description nvarchar (MAX)

The description of
the series of
collection events
as it will be
printed on e.g.
the label

NO -

SeriesCode nvarchar (50)

The user defined
code for a series
of collection
events

YES -

Notes nvarchar (MAX)
Notes on this
series of
collection events

YES -

Geography geography
The geography of
the series of
collection events

YES -

DateStart datetime

Point in time
when the series
of collection
events started

YES -

DateEnd datetime

Point in time
when the series
of collection
events ended

YES -

DateCache datetime

The first date of
the depending
events, used for
sorting the
expeditions
[controlled by the
database]

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime Point in time
when this data YES -
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set was updated
last
Default value:
getdate()

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Table CollectionEventSeriesImage
The images showing the sites of a series of collection events, e.g. an
expedition

Column Data type Description Nullable Relation

SeriesID int

Unique ID for the
table
CollectionEventSe
ries (= foreign key
and part of
primary key)

NO
Refers to table
CollectionEventSe
ries

URI varchar (255)

The complete URI
address of the
image. This is
only a cached
value, if
ResourceID is
available and
referring to the
module
DiversityResource
s

NO -

ResourceURI varchar (255)

The URI of the
resource (e.g.
see module
DiversityResource
s)

YES -

ImageType nvarchar (50) Type of the
image, e.g. map YES

Refers to table
CollEventSeriesIm
ageType_Enum

Notes nvarchar (MAX)
Notes to this
image of the
collection site

YES -

Description xml (MAX) Description of the
image

YES -

Title nvarchar (500) Title of the
resource

YES -

IPR nvarchar (500)

Intellectual
Property Rights;
the rights given
to persons for

YES -
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their intellectual
property

CreatorAgent nvarchar (500)

Person or
organization
originally creating
the resource

YES -

CreatorAgentURI varchar (255)
Link to the
module
DiversityAgents

YES -

CopyrightStateme
nt nvarchar (500)

Notice on rights
held in and for
the resource

YES -

LicenseType nvarchar (500)

Type of an official
or legal permission
to do or own a
specified thing,
e.g. Creative
Common licenses

YES -

InternalNotes nvarchar (500)

Internal notes
which should not
be published e.g.
on websites

YES -

LicenseHolder nvarchar (500)
The person or
institution holding
the license

YES -

LicenseHolderAge
ntURI nvarchar (500)

The link to a
module containing
futher information
on the person or
institution holding
the license

YES -

LicenseYear nvarchar (50)
The year of
license
declaration

YES -

DataWithholdingR
eason nvarchar (255)

If the data set is
withhold, the
reason for
withholding the
data, otherwise
null

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50) Name of the YES -
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person to update
this data set last
Default value:
suser_sname()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 CollectionEventSeries
 CollEventSeriesImageType_Enum

Table CollectionExternalDatasource
CollectionExternalDatasource document the sources of the names.

Column Data type Description Nullable Relation

ExternalDatasou
rceID int

An ID to identify
an external data
collection of the
collected
specimen (primary
key, the ID has
no meaning
outside of the
DiversityWorkben
ch system)

NO -

ExternalDatasourc
eName nvarchar (255)

The name of the
data collection
which has been
integrated or can
be linked to for
further analysis

YES -

ExternalDatasourc
eVersion nvarchar (255)

The version of
this data
collection (either
official version
number or dates
when the
collection was
integrated)

YES -

Rights nvarchar (500)

A description of
copyright
agreements or
permission to use
data from the
external database

YES -

ExternalDatasourc
eAuthors nvarchar (200)

The persons or
institutions
responsible for
the external
database

YES -

ExternalDatasourc
eURI nvarchar (300)

The URI of the
database provider
or the external
database

YES -
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ExternalDatasourc
eInstitution nvarchar (300)

The institution
responsible for
the external
database

YES -

InternalNotes nvarchar (1500)
Additional notes
on this data
collection

YES -

ExternalAttribute_
NameID nvarchar (255)

The table and
field name in the
external data
collection to
which
CollectionExternal
ID refers

YES -

PreferredSequenc
e tinyint

For selection in
e.g. picklists: of
several equal
names only the
name from the
source with the
lowest preferred
sequence will be
provided.

YES -

Disabled bit

If this source
should be disabled
for selection of
names e.g. in
picklists

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Table CollectionImage
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The images showing the collection

Column Data type Description Nullable Relation

CollectionID int

Refers to the ID
of Collection (=
foreign key and
part of primary
key)

NO Refers to table
Collection

URI varchar (255)
The complete URI
address of the
image. 

NO -

ImageType nvarchar (50) Type of the
image, e.g. label

YES -

Notes nvarchar (MAX) Notes on the
collection image

YES -

Description xml (MAX) Description of the
image

YES -

Title nvarchar (500) Title of the
resource

YES -

IPR nvarchar (500)

Intellectual
Property Rights;
the rights given
to persons for
their intellectual
property

YES -

CreatorAgent nvarchar (500)

Person or
organization
originally creating
the resource

YES -

CreatorAgentURI varchar (255)
Link to the
module
DiversityAgents

YES -

CopyrightStateme
nt nvarchar (500)

Notice on rights
held in and for
the resource

YES -

LicenseType nvarchar (500)

Type of an official
or legal permission
to do or own a
specified thing,
e.g. Creative
Common licenses

YES -

InternalNotes nvarchar (500)

Internal notes
which should not
be published e.g.
on websites

YES -

LicenseHolder nvarchar (500)
The person or
institution holding
the license

YES -

LicenseHolderAge
ntURI nvarchar (500)

The link to a
module containing
futher information
on the person or
institution holding
the license

YES -

LicenseYear nvarchar (50) The year of
license YES -
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declaration

DataWithholdingR
eason nvarchar (255)

If the data set is
withhold, the
reason for
withholding the
data, otherwise
null

YES -

LogInsertedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogInsertedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 Collection

Table CollectionProject
The projects within which the collection specimen were placed

Column Data type Description Nullable Relation

CollectionSpeci
menID int

Refers to the ID
of
CollectionSpecime
n (= foreign key
and part of
primary key)

NO
Refers to table
CollectionSpecime
n

ProjectID int

ID of the project
to which the
specimen belongs
(Projects are
defined in
DiversityProjects)

NO Refers to table
ProjectProxy

LogCreatedWhen datetime
Point in time
when this data
set was created

YES -
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Default value:
getdate()

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 CollectionSpecimen
 ProjectProxy

Table CollectionSpecimen
The data directly attributed to the collected specimen

Column Data type Description Nullable Relation

CollectionSpeci
menID int

Unique ID for the
table
CollectionSpecime
n (primary key)

NO -

Version int
The version of
the data set
Default value: (1)

NO -

CollectionEventID int

Refers to the ID
of table
CollectionEvent
(= foreign key
and part of
primary key)

YES Refers to table
CollectionEvent

CollectionID int

ID of the
collection as
stored in table
Collection (=
foreign key, see
table Collection)

YES Refers to table
Collection

AccessionNumber nvarchar (50)

Accession number
of the specimen
within the
collection, e.g.
"M-29834752"

YES -
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AccessionDate datetime

The date of the
accession
calculated from
the entries in
AccessionDay,
-Month and -Year

YES -

AccessionDay tinyint

The day of the
date when the
specimen was
acquired in the
collection

YES -

AccessionMonth tinyint

The month of the
date when the
specimen was
acquired in the
collection

YES -

AccessionYear smallint

The year of the
date when the
specimen was
acquired in the
collection

YES -

AccessionDateSu
pplement nvarchar (255)

Verbal or
additional
accession date
information, e.g.
'end of summer
1985', 'first
quarter',
'1888-1892'

YES -

AccessionDateCat
egory nvarchar (50)

Category of the
date of the
accession e.g.
"system",
"estimated" (=
foreign key, see
in table
CollDateCategory
_Enum)

YES
Refers to table
CollDateCategory
_Enum

DepositorsName nvarchar (255)

The name of the
depositor(s)
(person or
organization
responsible for
deposition).
Where entire
collections are
deposited, this
should also
contain the
collection name
(e.g. 'Herbarium
P. Döbbler')

YES -

DepositorsAgentU
RI varchar (255)

The URI of the
depositor(s)
(person or
organization
responsible for
deposition)

YES -
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DepositorsAccessi
onNumber nvarchar (50)

Accession number
of the specimen
within the
previous or
original collection,
e.g. 'D-23948'

YES -

LabelTitle nvarchar (MAX)
The title of the
label e.g. for
printing labels.

YES -

LabelType nvarchar (50)

Printed,
typewritten,
typewritten with
handwriting
added, entirely in
handwriting, etc.

YES
Refers to table
CollLabelType_En
um

LabelTranscription
State nvarchar (50)

The state of the
transcription of a
label into the
database: 'Not
started',
'incomplete',
'complete'

YES
Refers to table
CollLabelTranscrip
tionState_Enum

LabelTranscription
Notes nvarchar (255)

User defined
notes on the
transcription of
the label into the
database

YES -

ExsiccataURI varchar (255)

If specimen is an
exsiccata: The
URI of the
exsiccata series,
e.g. as stored
within the
DiversityExsiccata
module

YES -

ExsiccataAbbrevia
tion nvarchar (255)

If specimen is an
exsiccata:
Standard
abbreviation of
the exsiccata
(not necessarily a
unique identifier;
editors or
publication places
may change over
time)

YES -

OriginalNotes nvarchar (MAX)

Notes found on
the label of the
specimen by the
original collector
or from a later
revision

YES -

AdditionalNotes nvarchar (MAX)

Additional notes
made by the
editor of the
specimen record,
e.g. 'doubtful
identification/local

YES -
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ity'

ReferenceTitle nvarchar (255)

The title of the
publication where
the specimen was
published. Note
that this is only a
cached value
where
ReferenceURI is
present

YES -

ReferenceURI varchar (255)

URI (e.g. LSID) of
reference where
specimen is
published, e.g.
referring to the
module
DiversityReferenc
es

YES -

ReferenceDetails nvarchar (50)

The exact
location within
the reference,
e.g. pages, plates

YES -

Problems nvarchar (255)

Description of a
problem which
occurred during
data editing.
Typically these
entries should be
deleted after help
has been
obtained. Do not
enter scientific
problems here;
use
AdditionalNotes
for such
permanent
problems!

YES -

DataWithholdingR
eason nvarchar (255)

If the data set is
withhold, the
reason for
withholding the
data, otherwise
null
Default value:
N'Withhold by
default'

YES -

InternalNotes nvarchar (MAX)

Internal notes
which should not
be published e.g.
on websites

YES -

ExternalDatasourc
eID int

An ID to identify
an external data
collection of the
collected
specimen (primary
key, the ID has
no meaning

YES
Refers to table
CollectionExternal
Datasource
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outside of the
DiversityWorkben
ch system)

ExternalIdentifier nvarchar (100)

The identifier of
the external
specimen as
defined in the
external data
source

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 CollDateCategory_Enum
 Collection
 CollectionEvent
 CollectionExternalDatasource
 CollLabelTranscriptionState_Enum
 CollLabelType_Enum

Table CollectionSpecimenImage
The images of a collection specimen or of an organism (stored in table
IdentificationUnit) within this specimen

Column Data type Description Nullable Relation

CollectionSpeci
menID int

Refers to the ID
of
CollectionSpecime
n (= foreign key
and part of
primary key)

NO

Refers to table
CollectionSpecime
n and table
IdentificationUnit

URI varchar (255) The complete URI NO -

Page 540



address of the
image. This is
only a cached
value, if
ResourceID is
available and
referring to the
module
DiversityResource
s

ResourceURI varchar (255)

The URI of the
image, e.g. as
stored in the
module
DiversityResource
s. 

YES -

SpecimenPartID int

Optional: If the
data set is not
related to a part
of a specimen,
the ID of a
related part (=
foreign key)

YES
Refers to table
CollectionSpecime
nPart

IdentificationUnitI
D int

If image refers to
only one out of
several
IdentificationUnits
for a specimen,
refers to the ID of
an
IdentificationUnit
for a collection
specimen (=
foreign key)

YES Refers to table
IdentificationUnit

ImageType nvarchar (50)
Type of the
image, e.g.
photograph

YES
Refers to table
CollSpecimenImag
eType_Enum

Notes nvarchar (MAX) Notes on the
specimen image

YES -

Description xml (MAX) Description of the
image

YES -

Title nvarchar (500) Title of the
resource

YES -

IPR nvarchar (500)

Intellectual
Property Rights;
the rights given
to persons for
their intellectual
property

YES -

CreatorAgent nvarchar (500)

Person or
organization
originally creating
the resource

YES -

CreatorAgentURI varchar (255)
Link to the
module
DiversityAgents

YES -

CopyrightStateme nvarchar (500) Notice on rights YES -
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nt held in and for
the resource

LicenseType nvarchar (500)

Type of an official
or legal permission
to do or own a
specified thing, e.
g. Creative
Common Licenses

YES -

LicenseURI varchar (500)
The URI of the
license for the
resource

YES -

LicenseHolder nvarchar (500)
The person or
institution holding
the license

YES -

LicenseHolderAge
ntURI nvarchar (500)

The link to a
module containing
futher information
on the person or
institution holding
the license

YES -

LicenseYear nvarchar (50)
The year of
license
declaration

YES -

LicenseNotes nvarchar (500) Notice on license
for the resource

YES -

DataWithholdingR
eason nvarchar (255)

If the data set is
withhold, the
reason for
withholding the
data, otherwise
null

YES -

DisplayOrder int

The order in
which the images
should be shown
in a interface

YES -

InternalNotes nvarchar (500)

Internal notes
which should not
be published e.g.
on websites

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50) Name of the
person to update YES -
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this data set last
Default value:
suser_sname()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 CollectionSpecimen
 CollectionSpecimenPart
 CollSpecimenImageType_Enum
 IdentificationUnit

Table CollectionSpecimenImageProperty
The properties of images of a collection specimen

Column Data type Description Nullable Relation

CollectionSpeci
menID int

Refers to the ID
of
CollectionSpecime
n (= foreign key
and part of
primary key)

NO
Refers to table
CollectionSpecime
nImage

URI varchar (255)

The complete URI
address of the
image. This is
only a cached
value, if
ResourceID is
available and
referring to the
module
DiversityResource
s

NO
Refers to table
CollectionSpecime
nImage

Property varchar (255) The property of
the image

NO -

Description nvarchar (MAX)
If description of
the property of
the image

YES -

ImageArea geometry (MAX)
The area in the
image the
property refers to

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime Point in time
when this data YES -
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set was updated
last
Default value:
getdate()

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 CollectionSpecimenImage

Table CollectionSpecimenPart
Parts of a collected specimen. Includes a possible hierarchy of the parts

Column Data type Description Nullable Relation

CollectionSpeci
menID int

Refers to the ID
of
CollectionSpecime
n (= foreign key
and part of
primary key)

NO

Refers to table
CollectionSpecime
n and table
CollectionSpecime
nPart

SpecimenPartID int

Unique ID of the
part of the
collection
specimen (= part
of primary key). 

NO -

DerivedFromSpeci
menPartID int

SpecimenPartID
of the specimen
from which the
current specimen
is derived from

YES
Refers to table
CollectionSpecime
nPart

PreparationMetho
d nvarchar (MAX)

The method used
for the
preparation of the
part of the
specimen, e.g.
the inoculation
method for
cultures

YES -

PreparationDate datetime

Point in time
when the part
was preparated
e.g when it was
separated from
the source object

YES -

AccessionNumber nvarchar (50)

Accession number
of the part of the
specimen within
the collection, if
it is different from

YES -
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the accession
number of the
specimen as
stored in the
table
CollectionSpecime
n, e.g.
"M-29834752"

PartSublabel nvarchar (50)

The label for a
part of a
specimen, e.g.
"cone", or a
number attached
to a duplicate of
a specimen

YES -

CollectionID int

ID of the
collection as
stored in table
Collection (=
foreign key, see
table Collection)

NO Refers to table
Collection

MaterialCategory nvarchar (50)

Material category
of specimen.
Examples:
'herbarium
sheets',
'drawings',
'microscopic
slides' etc. (=
foreign key, see
table
CollMaterialCateg
ory_Enum)
Default value:
N'specimen'

NO
Refers to table
CollMaterialCateg
ory_Enum

StorageLocation nvarchar (255)

A code identifying
the place where
the specimen is
stored within the
collection.
Frequently the
accepted
scientific name is
used as storage
location code.

YES -

Stock float

Number of stock
units, if the
specimen is
stored in
separated units
e.g. several boxes
or vessels (max.
255)

YES -

StockUnit nvarchar (50)

If empty, the
stock is given as
a count, else it
contains the unit
in which stock is

YES -
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expressed, e.g.
µl, ml, kg etc.

StorageContainer nvarchar (500)
The container in
which the part is
stored

YES -

ResponsibleName nvarchar (255)

Name of the
person or
institution
responsible for
the preparation

YES -

ResponsibleAgent
URI varchar (255)

URI of the person
or institution
responsible for
the preparation
(= foreign key) as
stored in the
module
DiversityAgents

YES -

Notes nvarchar (MAX)
Notes on the
storage of the
sample

YES -

DataWithholdingR
eason nvarchar (255)

If the specimen
part is withhold,
the reason for
withholding the
data, otherwise
null.

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 Collection
 CollectionSpecimen
 CollMaterialCategory_Enum
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Table CollectionSpecimenPartDescription
Description of the specimen part with a standardized vocabulary as defined
in the module DiversityScientificTerms

Column Data type Description Nullable Relation

CollectionSpeci
menID int

Refers to the ID
of
CollectionSpecime
n (= foreign key
and part of
primary key)

NO
Refers to table
CollectionSpecime
nPart

SpecimenPartID int

Unique ID of the
part of the
collection
specimen (= part
of primary key). 

NO
Refers to table
CollectionSpecime
nPart

PartDescriptionI
D int

ID of the
description (Part
of primary key)

NO -

Description nvarchar (MAX)

The descrition of
the part. Cached
value if
DescriptionTermU
RI is used

YES -

DescriptionTermU
RI varchar (500)

Link to a external
datasource like a
webservice or the
module
DiversityScientific
Terms where the
description is
documented

YES -

Notes nvarchar (MAX) Notes about this
description

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:

YES -
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suser_sname()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 CollectionSpecimenPart

Table CollectionSpecimenPartRegulation
Regulation applied to a collection specimen part

Column Data type Description Nullable Relation

CollectionEventI
D int

The ID of the
collection event
during which the
objects where
collected, refers
to table
CollectionEvent

NO
Refers to table
CollectionEventRe
gulation

CollectionSpeci
menID int

Part of primay
key, refers to
unique ID for the
table
CollectionSpecime
n (= foreign key)

NO
Refers to table
CollectionSpecime
nPart

SpecimenPartID int

Part of primay
key, refers to
unique ID for the
table
CollectionSpecime
nPart (= foreign
key)

NO
Refers to table
CollectionSpecime
nPart

Regulation nvarchar (400)

The name of the
regulation, refers
to table
Regulation

NO
Refers to table
CollectionEventRe
gulation

RegulationID int

Part of primay
key, refers to
unique ID for the
table Regulation
(= foreign key)

YES -

ResponsibleName nvarchar (500) - YES -
ResponsibleAgent
URI

nvarchar (500) - YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

ID of the creator
of this data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime Point in time YES -
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when this data
set was updated
last
Default value:
getdate()

LogUpdatedBy nvarchar (50)

ID of the person
to update this
data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 CollectionEventRegulation
 CollectionSpecimenPart

Table CollectionSpecimenProcessing
The processing which was applied to a collected specimen

Column Data type Description Nullable Relation

CollectionSpeci
menID int

Refers to ID of
CollectionSpecime
n (= foreign key
and part of
primary key)

NO

Refers to table
CollectionSpecime
n and table
CollectionSpecime
nPart

SpecimenProces
singID int

Unique ID of the
processing of a
specimen or part
of a specimen,
part of primary
key

NO -

ProcessingDate datetime
Point in time of
the start of the
processing

YES -

ProcessingID int

ID of the
processing
method. Refers to
ProcessingID in
table Processing
(foreign key)
Default value: (1)

NO Refers to table
Processing

Protocoll nvarchar (100)
The label of the
processing
protocol

YES -

SpecimenPartID int

Optional: If the
data set is
related to a part
of a specimen,
the ID of a
related part (=
foreign key, see
table
CollectionSpecime

YES
Refers to table
CollectionSpecime
nPart
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nPart)

ProcessingDuratio
n varchar (50)

The duration of
the processing
including the unit
(e.g. 5 min) or
the end of the
processing
starting at the
processing date
(e.g. 23.05.2008)

YES -

ResponsibleName nvarchar (255)

Name of the
person or
institution
responsible for
the determination

YES -

ResponsibleAgent
URI varchar (255)

URI of the person
or institution
responsible for
the determination
(= foreign key) as
stored in the
module
DiversityAgents.

YES -

Notes nvarchar (MAX) Notes on the
processing

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

ToolUsage xml (MAX)

The tools used for
the processing
and their usage or
settings.

YES -

Depending on:
 CollectionSpecimen
 CollectionSpecimenPart
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 Processing

Table CollectionSpecimenProcessingMethod
The methods used for a processing of a specimen

Column Data type Description Nullable Relation

CollectionSpeci
menID int

Refers to ID of
CollectionSpecime
n (= Foreign key
and part of
primary key)

NO
Refers to table
CollectionSpecime
nProcessing

SpecimenProces
singID int

Refers to the ID
of the specimen
processing (=
foreign key and
part of primary
key)

NO
Refers to table
CollectionSpecime
nProcessing

MethodID int
ID of the method,
part of primary
key

NO
Refers to table
MethodForProcess
ing

MethodMarker nvarchar (50)

A marker for the
method, part of
primary key
Default value: '1'

NO -

ProcessingID int

ID of the
processing. Refers
to ProcessingID in
table Processing
(foreign key)
Default value: (1)

NO
Refers to table
MethodForProcess
ing

LogCreatedWhen datetime

The time when
this dataset was
created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Who created this
dataset
Default value:
user_name()

YES -

LogUpdatedWhen datetime

The last time
when this dataset
was updated
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Who was the last
to update this
dataset
Default value:
user_name()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
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 CollectionSpecimenProcessing
 MethodForProcessing

Table CollectionSpecimenProcessingMethodParameter
The parameter values of a method used for the processing of a specimen

Column Data type Description Nullable Relation

CollectionSpeci
menID int

Refers to ID of
CollectionSpecime
n (= Foreign key
and part of
primary key)

NO

Refers to table
CollectionSpecime
nProcessingMetho
d

SpecimenProces
singID int

Refers to ID of
CollectionSpecime
nProcessing (=
Foreign key and
part of primary
key)

NO

Refers to table
CollectionSpecime
nProcessingMetho
d

ProcessingID int

ID of the
processing. Refers
to ProcessingID in
table Processing
(= Foreign key
and part of
primary key)
Default value: (1)

NO

Refers to table
CollectionSpecime
nProcessingMetho
d

MethodID int

ID of the method
(= Foreign key
and part of
primary key)

NO

Refers to table
CollectionSpecime
nProcessingMetho
d and table
Parameter

MethodMarker nvarchar (50)

A marker for the
method, part of
primary key
Default value: '1'

NO

Refers to table
CollectionSpecime
nProcessingMetho
d

ParameterID int

ID of the
parameter.
Referes to table
Parameter (=
Foreign key and
part of primary
key)

NO Refers to table
Parameter

Value nvarchar (MAX)

The value of the
parameter if
different of the
default value as
documented in
the table
Parameter

NO -

LogCreatedWhen datetime

The time when
this dataset was
created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50) Who created this YES -
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dataset
Default value:
user_name()

LogUpdatedWhen datetime

The last time
when this dataset
was updated
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Who was the last
to update this
dataset
Default value:
user_name()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 CollectionSpecimenProcessingMethod
 Parameter

Table CollectionSpecimenReference
A reference related to the collection specimen

Column Data type Description Nullable Relation

CollectionSpeci
menID int

Refers to unique
ID of collection
specimen record
(part of primary
key)

NO

Refers to table
CollectionSpecime
n and table
IdentificationUnit

ReferenceID int

Unique reference
ID for the
reference record
(part of primary
key)

NO -

ReferenceTitle nvarchar (400)

The title of the
publication
related to the
specimen or parts
of it. Note that
this is only a
cached value
where
ReferenceURI is
present

NO -

ReferenceURI varchar (500)

URI of the
reference, e.g. a
connection to the
module
DiversityReferenc
es

YES -

IdentificationUnitI
D int

If relation refers
to a certain
organism within a
specimen, the ID

YES Refers to table
IdentificationUnit
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of an
IdentificationUnit
(= foreign key)

SpecimenPartID int

If the relation
refers to a part of
a specimen, the
ID of a related
part (= foreign
key)

YES
Refers to table
CollectionSpecime
nPart

ReferenceDetails nvarchar (500)

The exact
location within
the reference,
e.g. pages, plates

YES -

Notes nvarchar (MAX) Notes about the
reference

YES -

ResponsibleName nvarchar (255)

The name of the
agent (person or
organization)
responsible for
this entry.

YES -

ResponsibleAgent
URI varchar (255)

URI of the person
or organisation
responsible for
the data (see
e.g. module
DiversityAgents)

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 CollectionSpecimen
 CollectionSpecimenPart
 IdentificationUnit

Page 554



Table CollectionSpecimenRelation
The relations of a collection specimen to other collection specimen

Column Data type Description Nullable Relation

CollectionSpeci
menID int

Unique reference
ID for the
collection
specimen record
(primary key)

NO

Refers to table
CollectionSpecime
n and table
IdentificationUnit

RelatedSpecime
nURI

varchar (255) URI of the related
specimen

NO -

RelatedSpecimenD
isplayText varchar (255)

The name of a
related specimen
as shown e.g. in
a user interface

NO -

RelationType nvarchar (50)

Type of the
relation between
the specimen (=
foreign key, see
table
CollRelationType_
Enum)

YES
Refers to table
CollSpecimenRelat
ionType_Enum

RelatedSpecimenC
ollectionID int

ID of the
Collection as
stored in table
Collection (=
foreign key, see
table Collection)

YES Refers to table
Collection

RelatedSpecimenD
escription

nvarchar (MAX) Description of the
related specimen

YES -

IdentificationUnitI
D int

If relation refers
to a certain
organism within a
specimen, the ID
of an
IdentificationUnit
(= foreign key)

YES Refers to table
IdentificationUnit

SpecimenPartID int

If the relation
refers to a part of
a specimen, the
ID of a related
part (= foreign
key)

YES
Refers to table
CollectionSpecime
nPart

Notes nvarchar (MAX)
Notes on the
relation to the
specimen

YES -

IsInternalRelation
Cache bit

If the relation
represents a
connection
between
specimen in this
database
Default value: (1)

NO -

LogCreatedWhen datetime
Point in time
when this data
set was created

YES -
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Default value:
getdate()

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 Collection
 CollectionSpecimen
 CollectionSpecimenPart
 CollSpecimenRelationType_Enum
 IdentificationUnit

Table CollectionSpecimenTransaction
The transactions in which a specimen was involved

Column Data type Description Nullable Relation

CollectionSpeci
menID int

Refers to ID of
CollectionSpecime
n (= foreign key
and part of
primary key)

NO
Refers to table
CollectionSpecime
nPart

TransactionID int

Unique ID for the
table Transaction
(= foreign key
and part of
primary key)

NO Refers to table
Transaction

SpecimenPartID int

Optional: If the
data set is
related to a part
of a specimen,
the ID of a
related part (=
foreign key, see
table
CollectionSpecime
nPart)

NO
Refers to table
CollectionSpecime
nPart

AccessionNumber nvarchar (255) Accession number YES -
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which has been
assigen to the
part of the
specimen, e.g. in
connection with a
former inventory.

TransactionReturn
ID int

Unique ID for the
table Transaction
(= foreign key)
for the return of a
part that has
been on loan

YES -

TransactionTitle nvarchar (200)

Title as in related
table Transaction.
Used for
validation of
correct entry of
transaction with
type regulation
(see insert
trigger)

YES -

LogInsertedBy nvarchar (50)

Name of user to
first enter (typ or
import) the data.
Default value:
suser_sname()

YES -

LogInsertedWhen smalldatetime

Point in time
when the data
was first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last.
Default value:
suser_sname()

YES -

LogUpdatedWhen smalldatetime

Point in time
when this data
set was updated
last.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

IsOnLoan bit
True, if a
specimen is on
loan

YES -

Depending on:
 CollectionSpecimenPart
 Transaction
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Table Identification
The identifications of the organisms within a specimen

Column Data type Description Nullable Relation

CollectionSpeci
menID int

Refers to the ID
of
CollectionSpecime
n (= foreign key
and part of
primary key)

NO Refers to table
IdentificationUnit

IdentificationUni
tID int

Refers to the ID
of
IdentficationUnit
(= foreign key
and part of
primary key)

NO Refers to table
IdentificationUnit

IdentificationSe
quence smallint

The sequence of
the
identifications.
The last
identification
(having the
highest
sequence) is
regarded as valid
Default value: (1)

NO -

IdentificationDate datetime

The date of the
identification
calculated from
the entries in
IdentificationDay,
-Month and -Year

YES -

IdentificationDay tinyint The day of the
identification

YES -

IdentificationMont
h

tinyint The month of the
identification

YES -

IdentificationYear smallint

The year of the
identification. The
year may be
empty if only the
day or month are
known.

YES -

IdentificationDate
Supplement nvarchar (255)

Verbal or
additional
identification date
information, e.g.
'end of summer
1985', 'first
quarter',
'1888-1892'

YES -

IdentificationDate
Category nvarchar (50)

Category of the
date of the
identification e.g.
"system",
"estimated" (=
foreign key, see

YES

Refers to table
CollIdentificationD
ateCategory_Enu
m
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in table
CollDateCategory
_Enum)

VernacularTerm nvarchar (255)

Name or term
other than a
taxonomic (=
scientific) name,
e.g. 'pine',
'limestone',
'conifer',
'hardwood'

YES -

TermURI varchar (500)

The URI of the
term, e.g. as
provided by the
module
DiversityScientific
Terms.

YES -

TaxonomicName nvarchar (255)

Valid name of the
species (including
the taxonomic
author where
available).
Example: 'Rosa
canina L.'

YES -

NameURI varchar (255)

The URI of the
taxonomic name,
e.g. as provided
by the module
DiversityTaxonNa
mes.

YES -

IdentificationCate
gory nvarchar (50)

Category of the
identification e.g.
'determination',
'confirmation',
'absence' (=
foreign key, see
table
CollIdentificationC
ategory_Enum)

YES
Refers to table
CollIdentificationC
ategory_Enum

IdentificationQuali
fier nvarchar (50)

Qualification of
the identification
e.g. "cf."," aff.",
"sp. nov." (=
foreign key, see
table
CollIdentificationQ
ualifier_Enum)

YES
Refers to table
CollIdentificationQ
ualifier_Enum

TypeStatus nvarchar (50)

If identification
unit is type of a
taxonomic name:
holotype,
syntype, etc. (=
foreign key, see
table
CollTypeStatus_E
num)

YES
Refers to table
CollTypeStatus_E
num

TypeNotes nvarchar (MAX) Notes on the
typification of this YES -
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specimen

ReferenceTitle nvarchar (255)

Publications or
authoritative
opinions of
scientist used
during the
identification
process. Example:
enter
'Schmeil-Fitschen
1995', if this field
flora was used.

YES -

ReferenceURI varchar (255)

The URI of the
reference e.g. as
provided by the
module
DiversityReferenc
es

YES -

ReferenceDetails nvarchar (50)

The exact
location within
the reference,
e.g. pages, plates

YES -

Notes nvarchar (MAX)

User defined
notes, e.g. the
reason for a
re-determination /
change of the
name, etc.

YES -

ResponsibleName nvarchar (255)

Name of the
person or
institution
responsible for
the determination

YES -

ResponsibleAgent
URI varchar (255)

URI of the person
or institution
responsible for
the determination
(= foreign key) as
stored in the
module
DiversityAgents.

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -
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LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 CollIdentificationCategory_Enum
 CollIdentificationDateCategory_Enum
 CollIdentificationQualifier_Enum
 CollTypeStatus_Enum
 IdentificationUnit

Table IdentificationUnit
Organism which is present in or on a collectied specimen

Column Data type Description Nullable Relation

CollectionSpeci
menID int

Refers to the ID
of
CollectionSpecime
n (= foreign key
and part of
primary key)

NO

Refers to table
CollectionSpecime
n and table
IdentificationUnit

IdentificationUni
tID int

ID of the
IdentificationUnit
(= part of primary
key). Usually one
of possibly
several organisms
present on the
collected
specimen.
Example: parasite
with
hyperparasite on
plant leaf = 3
units,

NO -

LastIdentification
Cache nvarchar (255)

The last
identification as
entered in table
Identification

NO -

FamilyCache nvarchar (255)

A cached value of
the family of the
taxon of the last
identification. Can
be set by the
editor, if NameURI
in table
Identification is
NULL, otherwise
set by the
system.

YES -
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OrderCache nvarchar (255)

A cached value of
the order of the
taxon of the last
identification. Can
be set by the
editor, if NameURI
in table
Identification is
NULL, otherwise
set by the
system.

YES -

HierarchyCache nvarchar (500)

A cached value fo
the superior
taxonomy of the
last identification
as derived from a
taxonomic data
provider

YES -

TaxonomicGroup nvarchar (50)

Taxonomic group
the organism,
identified by this
unit, belongs to.
Groups listed in
table
CollTaxonomicGro
up_Enum (=
foreign key)

NO
Refers to table
CollTaxonomicGro
up_Enum

OnlyObserved bit

True, if the
organism was only
observed rather
than collected. It
is therefore not
present on the
preserved
specimen.
Example: Tree
under which the
collected
mycorrhizal
fungus grew.
Default value: (0)

YES -

RelatedUnitID int

The
IdentificationUnitI
D of the organism
or substrate on
which this
organism is
growing (= foreign
key)

YES Refers to table
IdentificationUnit

RelationType nvarchar (50)

The relation of a
unit to its
substrate, e.g.
parasitism,
symbiosis etc. as
stored in
CollRelationType_
Enum (= foreign
key)

YES
Refers to table
CollUnitRelationTy
pe_Enum
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ParentUnitID int

The
IdentificationUnitI
D of a parent
organism of which
this organism is a
child of (= foreign
key).

YES Refers to table
IdentificationUnit

ColonisedSubstrat
ePart nvarchar (255)

If a substrate
association
exists: part of the
substrate which is
affected in the
interaction (e.g.
'leaves', if a
fungus is growing
on the leaves of
an infected plant)

YES -

LifeStage nvarchar (255)

Examples: 'II, III'
for spore
generations of
rusts or 'seed',
'seedling' etc. for
higher plants

YES -

Gender nvarchar (50)
The sex of the
organism, e.g.
'female'

YES -

NumberOfUnits smallint

The number of
units of this
organism, e.g.
400 beetles in a
bottle

YES -

NumberOfUnitsMo
difier nvarchar (100)

A modifier for the
number of units of
this organism,
e.g. ca. 400
beetles in a bottle

YES -

ExsiccataNumber nvarchar (50)

If specimen is an
exsiccata:
Number of current
specimen within
the exsiccata
series

YES -

ExsiccataIdentific
ation smallint

Refers to the
IdentificationSequ
ence in
Identification (=
foreign key). The
name under which
the collectied
specimen or this
organism is
published within
an exsiccata.

YES -

UnitIdentifier nvarchar (50)

An identifier for
the identification
of the unit, e.g. a
number painted
on a tree within

YES -
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an experimental
plot

UnitDescription nvarchar (50)

Description of the
unit, especially if
not an organism
but parts or
remnants of it
were present or
observed, e.g. a
nest of an insect
or a song of a
bird

YES -

Circumstances nvarchar (50)
Circumstances of
the occurence of
the organism

YES
Refers to table
CollCircumstances
_Enum

RetrievalType nvarchar (50)

The way the data
about the unit
were retrieved,
e.g. observation,
literature

YES
Refers to table
CollRetrievalType_
Enum

DisplayOrder smallint

The sequence in
which the units
within this
specimen will
appear on e.g. a
label where the
first unit may be
printed in the
header and others
in the text below.
0 means the unit
should not appear
on a label.
Default value: (1)

NO -

DataWithholdingR
eason nvarchar (255)

If the data set is
withhold, the
reason for
withholding the
data, otherwise
null

YES -

Notes nvarchar (MAX)

Further
information on the
organism or
interaction, e.g.
infection
symptoms like
'producing galls'

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime Point in time YES -
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when this data
set was updated
last
Default value:
getdate()

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 CollCircumstances_Enum
 CollectionSpecimen
 CollRetrievalType_Enum
 CollTaxonomicGroup_Enum
 CollUnitRelationType_Enum

Table IdentificationUnitAnalysis
The analysis values taken from an organism resp. object

Column Data type Description Nullable Relation

CollectionSpeci
menID int

Refers to the ID
of
CollectionSpecime
n (= foreign key
and part of
primary key)

NO

Refers to table
IdentificationUnit
and table
IdentificationUnitI
nPart

IdentificationUni
tID int

Refers to the ID
of
IdentficationUnit
(= foreign key
and part of
primary key)

NO

Refers to table
IdentificationUnit
and table
IdentificationUnitI
nPart

AnalysisID int
Analysis ID,
foreign key of
table Analysis.

NO Refers to table
Analysis

AnalysisNumber nvarchar (50) Number of the
analysis

NO -

AnalysisResult nvarchar (MAX) The result of the
analysis

YES -

ExternalAnalysisU
RI varchar (255)

An URI for an
analysis as
defined in an
external
datasoure

YES -

ResponsibleName nvarchar (255)

Name of the
person or
institution
responsible for
the determination

YES -
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ResponsibleAgent
URI varchar (255)

URI of the person
or institution
responsible for
the determination
(= foreign key) as
stored in the
module
DiversityAgents.

YES -

AnalysisDate nvarchar (50) The date of the
analysis

YES -

SpecimenPartID int

ID of the part of
a specimen
(optional, foreign
key) if the
analysis was done
with a part of the
specimen (see
table
CollectionSpecime
nPart).

YES
Refers to table
IdentificationUnitI
nPart

Notes nvarchar (MAX) Notes on this
analysis

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

ToolUsage xml (MAX)

The tools used for
the analysis and
their usage or
settings.

YES -

Depending on:
 Analysis
 IdentificationUnit
 IdentificationUnitInPart
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Table IdentificationUnitAnalysisMethod
The methods used for an analysis

Column Data type Description Nullable Relation

CollectionSpeci
menID int

Refers to ID of
CollectionSpecime
n (= Foreign key
and part of
primary key)

NO
Refers to table
IdentificationUnit
Analysis

IdentificationUni
tID int

Refers to the ID
of
IdentficationUnit
(= foreign key
and part of
primary key)

NO
Refers to table
IdentificationUnit
Analysis

MethodID int
ID of the method,
part of primary
key

NO
Refers to table
MethodForAnalysi
s

MethodMarker nvarchar (50)

A marker for the
method, part of
primary key
Default value: '1'

NO -

AnalysisID int

ID of the
processing. Refers
to AnalysisID in
table Processing
(foreign key)
Default value: (1)

NO

Refers to table
IdentificationUnit
Analysis and table
MethodForAnalysi
s

AnalysisNumber nvarchar (50) Number of the
analysis NO

Refers to table
IdentificationUnit
Analysis

LogCreatedWhen datetime

The time when
this dataset was
created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Who created this
dataset
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

The last time
when this dataset
was updated
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Who was the last
to update this
dataset
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
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 IdentificationUnitAnalysis
 MethodForAnalysis

Table IdentificationUnitAnalysisMethodParameter
The parameter values of a method used for an analysis

Column Data type Description Nullable Relation

CollectionSpeci
menID int

Refers to ID of
CollectionSpecime
n (= Foreign key
and part of
primary key)

NO
Refers to table
IdentificationUnit
AnalysisMethod

IdentificationUni
tID int

ID of the
identification unit
(= Foreign key
and part of
primary key)

NO
Refers to table
IdentificationUnit
AnalysisMethod

AnalysisID int

ID of the analysis.
Refers to
AnalysisID in table
Analysis (=
Foreign key and
part of primary
key)
Default value: (1)

NO
Refers to table
IdentificationUnit
AnalysisMethod

AnalysisNumber nvarchar (50)

Number of the
analysis (=
Foreign key and
part of primary
key)

NO
Refers to table
IdentificationUnit
AnalysisMethod

MethodID int

ID of the method
(= Foreign key
and part of
primary key)

NO

Refers to table
IdentificationUnit
AnalysisMethod
and table
Parameter

MethodMarker nvarchar (50)

A marker for the
method, part of
primary key
Default value: '1'

NO
Refers to table
IdentificationUnit
AnalysisMethod

ParameterID int

ID of the
parameter tool.
Referes to table
Parameter (=
Foreign key and
part of primary
key)

NO Refers to table
Parameter

Value nvarchar (MAX)

The value of the
parameter if
different of the
default value as
documented in
the table
Parameter

YES -

LogCreatedWhen datetime The time when
this dataset was YES -
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created
Default value:
getdate()

LogCreatedBy nvarchar (50)

Who created this
dataset
Default value:
user_name()

YES -

LogUpdatedWhen datetime

The last time
when this dataset
was updated
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Who was the last
to update this
dataset
Default value:
user_name()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 IdentificationUnitAnalysisMethod
 Parameter

Table IdentificationUnitGeoAnalysis
The geographical position or region of an organism at a certain time

Column Data type Description Nullable Relation

CollectionSpeci
menID int

Refers to the ID
of
CollectionSpecime
n (= foreign key
and part of
primary key)

NO Refers to table
IdentificationUnit

IdentificationUni
tID int

Refers to the ID
of
IdentficationUnit
(= foreign key
and part of
primary key)

NO Refers to table
IdentificationUnit

AnalysisDate datetime The date of the
analysis

NO -

Geography geography

The geography
where the
organism resp.
object was
located according
to WGS84, e.g. a
point (latitide,
longitude and
altitude)

YES -

Geometry geometry (MAX) The geometry of
the place the YES -
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organism resp.
object was
observed, e.g. an
area

ResponsibleName nvarchar (255)

Name of the
person or
institution
responsible for
the determination

YES -

ResponsibleAgent
URI varchar (255)

URI of the person
or institution
responsible for
the determination
(= foreign key) as
stored in the
module
DiversityAgents.

YES -

Notes nvarchar (MAX) Notes on this
analysis

YES -

LogCreatedWhen datetime
Point in time
when this data
set was created

YES -

LogCreatedBy nvarchar (50)
Name of the
creator of this
data set

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last

YES -

LogUpdatedBy nvarchar (50)
Name of the
person to update
this data set last

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 IdentificationUnit

Table IdentificationUnitInPart
The list of the organisms which are found in a part of the specimen

Column Data type Description Nullable Relation

CollectionSpeci
menID int

Refers to the ID
of
CollectionSpecime
n (= foreign key
and part of
primary key)

NO

Refers to table
CollectionSpecime
nPart and table
IdentificationUnit

IdentificationUni
tID int

ID of the
identification unit
in table
IdentificationUnit
(= part of primary

NO Refers to table
IdentificationUnit
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key). Usually one
of possibly
several organisms
present on the
collection
specimen.
Example: parasite
with
hyperparasite on
plant leaf = 3
units,

SpecimenPartID int

ID of the part of
a specimen
(optional, foreign
key), if the
identification unit
is located on a
part of the
specimen (see
table
CollectionSpecime
nPart).

NO
Refers to table
CollectionSpecime
nPart

DisplayOrder smallint

The sequence in
which the units
within this part
will appear on
e.g. a label where
the first unit may
be printed in the
header and others
in the text below.
0 means the unit
should not appear
on a label.
Default value: (1)

NO -

Description nvarchar (500)

A description of
the unit,
especially if not
an entire unit but
e.g. parts of it
are stored in the
collection, e.g. a
nest of a bird

YES -

LogInsertedBy nvarchar (50)

Name of the user
to first enter (typ
or import) the
data.
Default value:
suser_sname()

YES -

LogInsertedWhen smalldatetime

Point in time
when the data
was first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50) Name of the YES -
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person to update
this data last.
Default value:
suser_sname()

LogUpdatedWhen smalldatetime

Point in time
when this data
was updated last.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 CollectionSpecimenPart
 IdentificationUnit

Table LocalisationSystem
The geographic localisation systems, e.g. coordinates

Column Data type Description Nullable Relation

LocalisationSyst
emID int

Unique ID for the
localisation
system (= Primary
key)

NO -

LocalisationSyste
mParentID int

LocalisationSyste
mID of the
superior
LocalisationSyste
m

YES
Refers to table
LocalisationSyste
m

LocalisationSyste
mName nvarchar (100)

Name of the
system used for
the determination
of the place of
the collection, e.
g. Gauss-Krüger,
MTB, GIS

NO -

DefaultAccuracyO
fLocalisation nvarchar (50)

The default for
the accuracy of
values which can
be reached with
this method

YES -

DefaultMeasureme
ntUnit nvarchar (50)

The default
measurement unit
for the
localisation
system, e.g. m,
geograpic
coordinates

YES -

ParsingMethodNa
me nvarchar (50)

Internal value,
specifying a
programming
method used for
parsing text in
fields

YES -
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Location1/Locatio
n2 in table
CollectionLocalisa
tion

DisplayText nvarchar (50)

Short abbreviated
description of the
localisation
system as
displayed in the
user interface

YES -

DisplayEnable bit

Specifies, if this
item is enabled to
be used within
the database.
Localisation
systems can be
disabled to avoid
seeing them, but
keep the
definition for the
future.

YES -

DisplayOrder smallint

The order in
which the entries
are displayed.
The order may be
changed at any
time, but all
values must be
unique.

YES -

Description nvarchar (255)
Description of the
localisation
method

YES -

DisplayTextLocati
on1 nvarchar (50)

Short abbreviated
description of the
attribute
Location1 in the
table
CollectionGeograp
hy as displayed in
the user interface

YES -

DescriptionLocatio
n1 nvarchar (255)

Description of the
attribute
Location1 in the
table
CollectionGeograp
hy as displayed in
the user interface

YES -

DisplayTextLocati
on2 nvarchar (50)

Short abbreviated
description of the
attribute
Location2 in the
table
CollectionGeograp
hy as displayed in
the user interface

YES -

DescriptionLocatio
n2 nvarchar (255)

Description of the
attribute
Location2 in the

YES -
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table
CollectionGeograp
hy as displayed in
the user interface

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Table Method
Methods used within the database

Column Data type Description Nullable Relation
MethodID int ID of the Method

(Primary key)
NO -

MethodParentID int

MethodID of the
parent Method, if
it belongs to a
certain type
documented in
this table

YES Refers to table
Method

OnlyHierarchy bit

If the entry is
only used for the
hierarchical
arrangement of
the entries
Default value: (0)

YES -

DisplayText nvarchar (50)

Name of the
Method as e.g.
shown in user
interface

YES -

Description nvarchar (MAX) Description of the
Method

YES -

MethodURI varchar (255)

URI referring to
an external
documentation of
the Method

YES -

ForCollectionEven
t bit

If a method may
be used during a
collection event

YES -

Notes nvarchar (MAX) Notes on this
method

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime
Point in time
when this data
set was updated

YES -
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last
Default value:
getdate()

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Table MethodForAnalysis
Methods available for a Analysis

Column Data type Description Nullable Relation

AnalysisID int

ID of the table
Analysis (foreign
key and part of
primary key)

NO Refers to table
Analysis

MethodID int

ID of the table
Method (foreign
key and part of
primary key)

NO Refers to table
Method

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 Analysis
 Method
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Table MethodForProcessing
Methods available for a processing

Column Data type Description Nullable Relation

ProcessingID int

ID of the table
Processing
(foreign key and
part of primary
key)

NO Refers to table
Processing

MethodID int

ID of the table
Method (foreign
key and part of
primary key)

NO Refers to table
Method

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 Method
 Processing

Table Parameter
The variable parameters within a method

Column Data type Description Nullable Relation

MethodID int

ID of the Method
(foreign key and
part of primary
key)

NO Refers to table
Method

ParameterID int ID of the
Parameter (part NO -
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of primary key)

DisplayText nvarchar (50)

Name of the
parameter as e.g.
shown in user
interface

YES -

Description nvarchar (MAX) Description of the
parameter

YES -

ParameterURI varchar (255)

URI referring to
an external
documentation of
the Parameter

YES -

DefaultValue nvarchar (MAX) The default value
of the parameter

YES -

Notes nvarchar (MAX) Notes on this
parameter

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 Method

Table Processing
The processings of the specimen

Column Data type Description Nullable Relation

ProcessingID int
ID of the
processing
(primary key)

NO -

ProcessingParentI
D int

The ID of the
superior type of
the processing

YES Refers to table
Processing
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DisplayText nvarchar (50)

The display text
of the processing
as shown e.g. in
a user interface

YES -

Description nvarchar (MAX) Description of the
processing

YES -

Notes nvarchar (MAX) Notes on the
processing

YES -

ProcessingURI varchar (255)

A URI for a
processing as
defined in an
external data
source

YES -

OnlyHierarchy bit

If the entry is
only used for the
hierarchical
arrangement of
the entries
Default value: (0)

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Table ProcessingMaterialCategory
The processings which are possible for a certain material category

Column Data type Description Nullable Relation

ProcessingID int

ID of the
processing. Refers
to ProcessingID in
table Processing
(foreign key)
Default value: (1)

NO Refers to table
Processing
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MaterialCategor
y nvarchar (50)

Material category
of specimen.
Examples:
'herbarium
sheets',
'drawings',
'microscopic
slides' etc.
Default value:
N'specimen'

NO -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 Processing

Table ProjectAnalysis
The types of the analysis which are available for a project

Column Data type Description Nullable Relation
AnalysisID int ID of the analysis

(primary key)
NO Refers to table

Analysis

ProjectID int

ID of the project
to which the
specimen belongs
(Projects are
defined in
DiversityProjects)

NO Refers to table
ProjectProxy

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:

YES -
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getdate()

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 Analysis
 ProjectProxy

Table ProjectProcessing
The types of processing available within a project

Column Data type Description Nullable Relation

ProcessingID int

ID of the table
Processing
(foreign key and
part of primary
key)

NO Refers to table
Processing

ProjectID int

ID of the project
to which the
specimen belongs
(Projects are
defined in
DiversityProjects)

NO Refers to table
ProjectProxy

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -
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Depending on:
 Processing
 ProjectProxy

Table Property
The list of the properties that can be specified for the collection site

Column Data type Description Nullable Relation

PropertyID int

Unique ID for the
localisation
system (= primary
key)

NO -

PropertyParentID int

LocalisationSyste
mID of the
superior
LocalisationSyste
m

YES Refers to table
Property

PropertyName nvarchar (100)

Name of the
system used for
the determination
of the place of
the collection, e.
g. Gauss-Krüger,
MTB, GIS

NO -

DefaultAccuracyO
fProperty nvarchar (50)

The default for
the accuracy of
values which can
be reached with
this method

YES -

DefaultMeasureme
ntUnit nvarchar (50)

The default
measurement unit
for the
characterisation
system, e.g. pH

YES -

ParsingMethodNa
me nvarchar (50)

Internal value,
specifying a
programming
method used for
parsing text in
fields
Location1/Locatio
n2 in table
CollectionLocalisa
tion

NO -

DisplayText nvarchar (50)

Short abbreviated
description of the
localisation
system as
displayed in the
user interface

YES -

DisplayEnabled bit

Specifies, if this
item is enabled to
be used within
the database.

YES -
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Localisation
systems can be
disabled to avoid
seeing them, but
keep the
definition for the
future.
Default value: (1)

DisplayOrder smallint

The order in
which the entries
are displayed.
The order may be
changed at any
time, but all
values must be
unique.

YES -

Description nvarchar (MAX)
Description of the
localisation
method

YES -

PropertyURI varchar (1000)

The URI of the
property, e.g. as
provided by the
module
DiversityScientific
Terms.

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Table Transaction
Transactions like loan, borrow, gift, exchange etc. of specimen, if they are
e.g. permanently or temporary transfered from one collection to another

Column Data type Description Nullable Relation

TransactionID int
Unique ID for the
transaction (=
primary key)

NO -

ParentTransaction
ID int

The ID of a
preceeding
transaction of a
superior
transaction, if
transactions are
organized in a
hierarchy

YES Refers to table
Transaction

TransactionType nvarchar (50)

Type of the
transaction, e.g.
gift in or out,
exchange in or
out, purchase in
or out
Default value:
N'exchange'

NO
Refers to table
CollTransactionTy
pe_Enum

TransactionTitle nvarchar (200) The title of the
transaction as NO -
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e.g. shown in an
user interface

ReportingCategor
y nvarchar (50)

A group defined
for the
transaction, e.g.
a taxonomic
group as used for
exchange
balancing

YES -

AdministratingColl
ectionID int

ID of the
collection which is
responsible for
the administration
of the
transaction.

NO Refers to table
Collection

MaterialDescriptio
n nvarchar (MAX)

Description of the
material of this
transaction
Default value: ''

YES -

MaterialCategory nvarchar (50)

Material category
of specimen.
Examples:
'herbarium
sheets',
'drawings',
'microscopic
slides' etc.
Default value:
N'specimen'

YES -

MaterialCollectors nvarchar (MAX) The collectors of
the material

YES -

MaterialSource nvarchar (500)

The source of the
material within a
transaction, e.g.
a excavation

YES -

FromCollectionID int

The ID of the
collection from
which the
specimen were
transfered, e.g.
the donating
collection of a gift

YES Refers to table
Collection

FromTransactionP
artnerName nvarchar (255)

Name of the
person or
institution from
which the
specimen were
transfered, e.g.
the donator of a
gift

YES -

FromTransactionP
artnerAgentURI varchar (255)

The URI of the
transaction
partner (see e.g.
module
DiversityAgents)

YES -

FromTransactionN
umber nvarchar (50) Number or code

by which a YES -
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transaction may
be recorded by
the administration
of the source of
the specimen,
e.g. the donating
collection of a gift

ToCollectionID int

The ID of the
collection to
which the
specimen were
transfered, e.g.
the receiver of a
gift

YES Refers to table
Collection

ToTransactionPar
tnerName nvarchar (255)

Name of the
person or
institution to
which the
specimen were
transfered, e.g.
the receiver of a
gift

YES -

ToTransactionPar
tnerAgentURI varchar (255)

The URI of the
transaction
partner (see e.g.
module
DiversityAgents)

YES -

ToTransactionNu
mber nvarchar (50)

Number or code
by which a
transaction may
be recorded by
the administration
of the destination
of the specimen,
e.g. the receiving
collection of a gift

YES -

NumberOfUnits int

The number of
units which were
(initially) included
in the transaction

YES -

Investigator nvarchar (200)

The investigator
for whose study a
transacted
material was sent

YES -

TransactionComm
ent nvarchar (MAX)

Comments on the
exchanged
material
addressed to the
transaction
partner

YES -

BeginDate datetime
Date when the
transaction
started

YES -

AgreedEndDate datetime

End of the
transaction
period, e.g. if the
time for borrowing
the specimen is

YES -
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restricted

ActualEndDate datetime

Actual end of the
transaction after
a prolonation
when e.g. the
date of return for
a loan was
prolonged by the
owner

YES -

DateSupplement nvarchar (100)

Verbal or
additional date
information, e.g.
'end of summer
1985', 'first
quarter',
'1888-1892'.

YES -

InternalNotes nvarchar (MAX)

Internal notes on
this transaction
not to be
published e.g. on
a web page

YES -

ToRecipient nvarchar (255)

The recipient
receiving the
transaction e.g. if
not derived from
the link to
DiversityAgents

YES -

ResponsibleName nvarchar (255)
The person
responsible for
this transaction

YES -

ResponsibleAgent
URI varchar (255)

The URI of the
person, team or
organisation
responsible for
the data (see
e.g. module
DiversityAgents)

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
user_name()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:

YES -
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user_name()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 Collection
 CollTransactionType_Enum

Table TransactionAgent
Agents involved in the transaction

Column Data type Description Nullable Relation

TransactionID int

Unique ID for the
transaction,
refers to table
Transaction (=
part of primary
key and foreign
key)

NO Refers to table
Transaction

TransactionAge
ntID int

Unique ID for the
Agent within the
transaction (=
part of primary
key)

NO -

AgentName nvarchar (500)
Name of the
person or
institution

YES -

AgentURI varchar (500)

Link to the source
for further
informations
about the agent,
e.g in the module
DiversityAgents

YES -

AgentRole nvarchar (500)
Role of the agent
within the
transaction

YES -

Notes nvarchar (MAX) Notes about the
agent

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:

YES -
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getdate()

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 Transaction

Table TransactionDocument
The history of transactions or the documents connected to the transactions

Column Data type Description Nullable Relation

TransactionID int

Unique ID for the
transaction,
refers to table
Transaction (=
part of primary
key and foreign
key)

NO Refers to table
Transaction

Date datetime
The date of the
event of a
transaction

NO -

TransactionText nvarchar (MAX)
The text of a
transaction
document

YES -

TransactionDocu
ment

image
(2147483647)

A scanned
document
connected to this
transaction

YES -

DisplayText nvarchar (255)

A display text as
shown e.g. in a
user interface to
characterize the
document

YES -

DocumentURI varchar (1000)

A link to a web
resource of the
document the
document

YES -

DocumentType nvarchar (255) The type of the
document

YES -

InternalNotes nvarchar (MAX) Internal notes on
this transaction

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50) Name of the
creator of this YES -
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data set
Default value:
suser_sname()

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 Transaction

Table TransactionPayment
The payments within a transaction

Column Data type Description Nullable Relation

TransactionID int

Unique ID for the
transaction,
refers to table
Transaction (=
part of primary
key and foreign
key)

NO Refers to table
Transaction

PaymentID int
Unique ID for the
payment (= part
of primary key)

NO -

Identifier nvarchar (500)

An identifer for
the payment like
a booking number
or invoice number

YES -

Amount float

Amount of the
payment in the
default currency
as defined in
TransactionCurren
cy

YES -

ForeignAmount float

If the payment
was not in the
default curreny as
defined in
TransactionCurren
cy, the amount of
the payment in
foreign curreny

YES -

ForeignCurrency nvarchar (50) If the payment YES -
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was not in the
default curreny as
defined in
TransactionCurren
cy, the foreign
currency of the
payment

PayerName nvarchar (500)

Name of the
person or
institution paying
the amount

YES -

PayerAgentURI varchar (500)

Link to the source
for further
infomations about
the payer, e.g in
the module
DiversityAgents

YES -

RecipientName nvarchar (500) Agent receiving
the payment

YES -

RecipientAgentURI varchar (500)

Link to the source
for further
infomations about
the recipient of
the payment, e.g
in the module
DiversityAgents

YES -

PaymentDate datetime Date of the
payment

YES -

PaymentDateSupp
lement nvarchar (50)

Supplement to
the date of the
payment, e.g. if
the original date
is not a real date
like 'summer 1920'
or '1910 - 1912'

YES -

PaymentURI varchar (500)

A link to an
external
administration
system for the
payment

YES -

Notes nvarchar (MAX) Notes about the
payment

YES -

LogCreatedWhen datetime

Point in time
when this data
set was created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Name of the
creator of this
data set
Default value:
suser_sname()

YES -

LogUpdatedWhen datetime

Point in time
when this data
set was updated
last
Default value:

YES -
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getdate()

LogUpdatedBy nvarchar (50)

Name of the
person to update
this data set last
Default value:
suser_sname()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

NO -

Depending on:
 Transaction
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Database - Project related tables
Information concerning the projects and related tables are stored in the tables shown in the
diagram below.

 

 

Index
 CollectionProject

 ProjectAnalysis

 ProjectProcessing

 ProjectProxy

 ProjectUser

 UserProxy

Table CollectionProject
The projects which the collection specimen were placed in

Column Data type Description
CollectionSpecimenID int ID of the CollectionSpecimen (= Foreign key and

part of primary key)

ProjectID int ID of the project to which the specimen belongs
(Projects are defined in DiversityProjects)
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LogCreatedWhen datetime Point in time when this data set was created
Default value: getdate()

LogCreatedBy nvarchar (50) Name of the creator of this data set
Default value: user_name()

LogUpdatedWhen datetime
Point in time when this data set was updated
last
Default value: getdate()

LogUpdatedBy nvarchar (50) Name of the person to update this data set last
Default value: user_name()

RowGUID uniqueidentifier -
Default value: newsequentialid()

Table ProjectAnalysis
The types of the analysis that are available for a project

Column Data type Description
AnalysisID int ID of the analysis (Primary key)

ProjectID int ID of the project to which the specimen belongs
(Projects are defined in DiversityProjects)

LogCreatedWhen datetime Point in time when this data set was created
Default value: getdate()

LogCreatedBy nvarchar (50) Name of the creator of this data set
Default value: user_name()

LogUpdatedWhen datetime Point in time when this data set was updated last
Default value: getdate()

LogUpdatedBy nvarchar (50) Name of the person to update this data set last
Default value: user_name()

RowGUID uniqueidentifier -
Default value: newsequentialid()

Table ProjectProcessing
The types of processing available within a project

Column Data type Description
ProcessingID int ID of the processing (Primary key)

ProjectID int ID of the project to which the specimen belongs
(Projects are defined in DiversityProjects)

LogCreatedWhen datetime Point in time when this data set was created
Default value: getdate()

LogCreatedBy nvarchar (50) Name of the creator of this data set
Default value: user_name()

LogUpdatedWhen datetime Point in time when this data set was updated last
Default value: getdate()

LogUpdatedBy nvarchar (50) Name of the person to update this data set last
Default value: user_name()

RowGUID uniqueidentifier -
Default value: newsequentialid()
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Table ProjectProxy
The projects as stored in the module DiversityProjects

Column Data type Description

ProjectID int

ID of the project to which the
specimen belongs (Projects
are defined in
DiversityProjects)

Project nvarchar (50)

Name or title of the project as
shown in a user interface
(Projects are defined in
DiversityProjects)

ImageDescriptionTemplate xml (MAX) Template for the description
of images

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table ProjectUser
The projects a user can access

Column Data type Description

LoginName nvarchar (50)
Login name of the user to
access DivesityWorkbench,
Microsoft domains, etc..

ProjectID int

ID of the project to which the
specimen belongs (Projects
are defined in
DiversityProjects)

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

Table UserProxy
The user as stored in the module DiversityUsers

Column Data type Description

LoginName nvarchar (50)
Login name of the user to
access DivesityWorkbench,
Microsoft domains, etc..

CombinedNameCache nvarchar (255)
Short name of the user, e.g.
P. Smith
Default value: NULL

UserURI varchar (255)

URI of the user in a remote
module, e.g. refering to
UserInfo.UserID in database
DiversityUsers
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AgentURI varchar (255) AgentURI - UserProxy
Queries xml (MAX) Queries created by the user

RowGUID uniqueidentifier
-
Default value:
newsequentialid()
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Database - Entity tables
Information concerning the entities are stored in the tables shown in the diagram below. 

Table Entity
The entities in an application e.g. the tables and columns in a database

Column Data type Description

Entity varchar (500)

Name of the entity, e.g. Table.Column.Content within
the database or a unique string for e.g. a message
within the DiversityWorkbench (e.g.
"DiversityWorkbench.Message.Connection.NoAccess"),
primary key

DisplayGroup nvarchar (50) Name of the group, if DiversityWorkbench entities should
be displayed in a group.

Notes nvarchar (MAX) Notes about the entity

Obsolete bit True if an entity is obsolete. Obsolete entities may be
kept to ensure compatibility with older modules
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LogCreatedWhen datetime Point in time when this data set was created
Default value: getdate()

LogCreatedBy nvarchar (50) Name of the creator of this data set
Default value: user_name()

LogUpdatedWhen datetime Point in time when this data set was updated last
Default value: getdate()

LogUpdatedBy nvarchar (50) Name of the person to update this data set last
Default value: user_name()

RowGUID uniqueidentifier -
Default value: newsequentialid()

Table EntityRepresentation
The description of the entity in a certain context in different languages

Column Data type Description
Entity varchar (500) Name of the entity. Foreign key, relates to table Entity
LanguageCode nvarchar (50) ISO 639: 2-letter codes for the language of the content

EntityContext nvarchar (50)
Context for the representation, e.g. "Exchange with
ABCD", "collection management" or "observation" as
defined in table EntityContext_Enum

DisplayText nvarchar (50) Text for the entity as shown e.g. in a user interface

Abbreviation nvarchar (20) Abbreviation for the entity as shown e.g. in a user
interface

Description nvarchar (MAX) Description of the entity
Notes nvarchar (MAX) Notes about the representation of the entity

LogCreatedWhen datetime Point in time when this data set was created
Default value: getdate()

LogCreatedBy nvarchar (50) Name of the creator of this data set
Default value: user_name()

LogUpdatedWhen datetime Point in time when this data set was updated last
Default value: getdate()

LogUpdatedBy nvarchar (50) Name of the person to update this data set last
Default value: user_name()

RowGUID uniqueidentifier -
Default value: newsequentialid()

Table EntityUsage
The usage of an entity in a certain context, e.g. hidden, read only

Column Data type Description
Entity varchar (500) Name of the entity. Foreign key, relates to table Entity

EntityContext nvarchar (50)
Context for the representation, e.g. "Exchange with
ABCD", "collection management" or "observation" as
defined in table EntityContext_Enum

Accessibility nvarchar (50) Whether the access to an entity is resticted to e.g.
read only or can be edited without restrictions

Determination nvarchar (50) Whether a value is determined e.g. by the system or
the user
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Visibility nvarchar (50) Whether the entity is visible or hidden from e.g. a user
interface

PresetValue nvarchar (500)
Whether a value resp. SQL statement for the value is
preset, e.g. 'determination' for identifications when
using a mobile device during an expedition

Notes nvarchar (MAX) Notes about the usage of the entity

LogCreatedWhen datetime Point in time when this data set was created
Default value: getdate()

LogCreatedBy nvarchar (50) Name of the creator of this data set
Default value: user_name()

LogUpdatedWhen datetime Point in time when this data set was updated last
Default value: getdate()

LogUpdatedBy nvarchar (50) Name of the person to update this data set last
Default value: user_name()

RowGUID uniqueidentifier -
Default value: newsequentialid()
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History
To inspect the history of a data set click on the button. A window will open showing all
former states of the data in tables with the current data set at the top. The database
DiversityCollection handles 2 different histories - one for the CollectionSpecimen and one for
the CollectionEvent. The version shown in the header of the main window refers to these

histories . The first number refers to the version of the specimen. If an
event was defined a second number is shown, referring to the version of the CollectionEvent
e.g. 5  3 means version 5 of the specimen and version 3 of the CollectionEvent. 

If you want to restore an old version of a data set, choose the corresponding line in the table
and click on the Restore data as in selected line button. The process is demonstrated in a
short tutorial .

  

The version will be set automatically. If a data set is changed the version will be increased if
the last changes were done by a different user or the last change is more than 24 hours ago
(for further details see topic Logging).

If a part of the logged data has been transferred into a separate database (see chapter Save
logging tables) a button Include saved log will appear that allows you to include these
data. Click on the button to retrieve the transferred data.

If you want to restore a whole data set for a specimen including all dependent data, click on
the Restore deleted button. This function is as well available from the menu Data - 
Restore from log ... . In the upcoming dialogs choose the basic table to start for the search.
Depending on your data you have to choose the correct table. There are 3 main possibilities
as shown in the image below: CollectionEventSeries, CollectionEvent, CollectionSpecimen. If
e.g. only the specimen have been deleted an the data of the collection events are still
present, choose CollectionSpecimen as starting table. In the upcoming dialogs enter the date
where the query should start and end, an optional filter for a column and the number of lines
from the log table that should be displayed. Finally select the datarow(s) of the root table
that should be restored. After that the program will try to recover the data with all depending
information. The precondition is Version 2.6.11 of the database before the data were deleted,
otherwise only a partial recovery is possible. The process is demonstrated in a short tutorial 

.
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Logging
Changes within the database will be documented for each data set together with the time and
the responsible user in the columns shown in the image below.

All main tables have a corresponding logging table. If you change or delete a data set, the
original data set will be stored in this logging table together with information about by whom
and when changes were made last.

 

Transfer logging table content 

If space for the logging tables is limited esp. if included in regular backups, you may want to
transfer a part of the content of the logging tables into a separate database, not included
into regular backups. If for the first time you time you list the log tables in the corresponding
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form and the logging database is missing to far, you will be asked if this database should be
created for you. Click yes to let the program create the database for you. As next step you
will be asked if you want to change the storage position of the log database. By default the
log database will be created in the same location as the main database. If you choose a
different directory, make sure this directory exists and you have access to. This database will
contain the content transferred from the logging tables (see image below) and get the same
name as the main database extended with ..._Log. 

To transfer contents of the logging tables choose Administration - Database - Transfer
log from the menu. A window as shown below will open, where you can transfer parts of the
content of the logging tables into the separate log database. Choose the date starting at
which the data should be kept into the database. Older data will be transferred into the
logging database. Then click on the   List tables  button. The logging tables together with the
numbers that will be transferred resp. kept will be listed as shown below. 

To transfer the content click on the  Transfer content of tables   button. A schema with
the name Log_ extended with the current date will be created where the tables for the
transfer of the data will be created as shown below. 
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The previous transfers of logging content will be listed according the created schemata as
shown below. Click on the  List tables  button to see the list of tables and than a table in the
list to display the content as shown below. 

If data transferred into the log database must be restored, click on the   Include saved log 
 button. This will include all data from the Log database in the list for the restore (see
below). 

To provide the users that had been added to the main database after the creation of the log
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database access to the transferred log data, click on the  Copy user   button. This will
replenish the user list in the log database. With the  Logins   button you can open the
administration for the logins in the log database. 
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Backup
If you want to create a backup of your database, there are 2 options. You may either export
the data as csv files to your local computer or you may create a backup on the server.

Export data as csv

To export your data as csv files to your local computer, choose Data -> Export -> 
CSV(bcp) ... from the menu. A window will open as shown below, where you can select the
tables that should be exported. Click on the Start Export button to export your data. If you
choose the option as shown below 2 files will be created for every table. The first file (*.csv)
contains the data while the second file (*.xml) contains the structure of the table.

Create backup on the server

To create a backup of your database on the server, choose Data -> Backup database
from the menu. This will create a SQL-Server backup on the server where the database is
located. Ensure that there is enough space on the server. 

Another option is to create a direct copy of the database files on the server. For this you
have to use the functions provided by SQL-Server. However, you need administration rights
for the database you want to create a backup of. Open the Enterprise Manager for
SQL-Server, choose the database and detach it from the server as shown in the image below.
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After detaching the database, you can save a copy of the ..._Data.MDF file to keep it as a
backup.

After storing the backup you have to reattach the database.

A dialog will appear where you have to select the original database file in your directory.
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Database tools
These are the tools to handle the basic parts of the database. These tools are only available
for the owner of the database and should be handled with care as any changes in the
database may disable the connection of your client to the database. Before changing any
parts of the database it is recommended to backup the current state of the database. To
use these tools, choose Administation -> Database -> Database tools ... from the
menu. A window will open as shown below. 

Description

The Description section (see above) shows the basic definitions of the objects in the
database and enables you to enter a description for these objects including tables and their
columns, functions and their parameter etc. With the buttons SQL for adding, update and
both you can generate SQL statements for the creation of the descriptions in your database.
Use the button both if you are not sure if a description is already present as it will generate a
SQL statement working with existing and missing descriptions (see below). 

 

Log table and trigger

In the Log table and trigger section (see below) click on the List tables button to see all
tables within the database. The Table section shows the basic definitions of a selected table.
If columns for logging the date and responsible user for inserting and updating the data are
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missing, you can use the Attach ... button to attach these columns to the table. Furthermore
you may add a RowGUID to the table as e.g. a preparation for a replication.

In the Log table section (see below) you can create a logging table for the selected table in
a format as used within the Diversity Workbench. Click on the Show SQL ... button to show
the SQL-statement that will create the logging table. If an old logging table should be kept,
choose the Keep old log table option. If your table should support the version setting from a
main table, choose the Add the column LogVersion option. To finally create the logging
table click on the Create LogTable ... button. 

The triggers for insert, update and delete are created in the according sections (see
below). If an old trigger exists, its definition will be shown in the upper part of the window.
Click on the Show SQL button to see the definition of the trigger according to the current
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definition of the table in a format as used in the Diversity Workbench. If a trigger should set
the version in a main table, which the current table is related to, choose the Add version
setting to trigger option. To enable this option you must select the version table first. To
finally create the trigger click on the Create trigger button. The update and delete triggers
will transfer the original version of the data into the logging tables as defined above, where
you can inspect the history of the data sets. 

If so far no procedure for setting the version in a main table is defined, you can create this
procedure in the last section. Click on the Show SQL button to see the definition and on the
Create Procedure button to create the procedure (see below).
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Preparation for replication

If you want to use replication within you module, the tables need certain columns and a log
table. These preparations can be performed by a script, generated in the section Replication
(see below). Select the tables you want to include in the process and create the script. This
script can than be included in an update of the database. Please ensure that these changes
are only be done by expert staff.

 

Clear logtables

If for any reason you want to clear the log tables of the database, this can be done in the 
Clear log tab as shown below. Click on the List tables button to list the log tables. Then
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select those that should be cleared and click on the Clear log of selected tables button
(see below). Please keep in mind that any restoration of data from the log is only possible as
long as the data can be retrieved from the log.

 

Data protection 

To implement the General Data Protection Regulation of the European Union several steps
have to be performed in a database: 

 Generate a skript using this tool (see below) to convert all tables and insert objects
according to the requirements: 

o Add columns ID, PrivacyConsent and PrivacyConsentDate in table UserProxy
o Grant update to PrivacyConsent and PrivacyConsentDate in table UserProxy
o Create update trigger for UserProxy setting the PrivacyConsentDate
o Create the function providing the ID of the user from UserProxy
o Create the function providing the name of the user from UserProxy
o Create the function PrivacyConsentInfo providing common information
o For every table: 

 Insert users from a table into UserProxy (if missing so far)
 Insert users from the corresponding log table into UserProxy (if missing

so far)
 Change the constraints for the logging columns (User_Name() →

UserID())
 Replace user name with ID in logging columns
 Replace user name with ID in logging columns of the log table
 Adapt description of the logging columns

 Include the skript in an update of the database 
 Check the database for update triggers, functions using e.g. CURRENT_USER,

USER_NAME, SUSER_SNAME etc. where user names must be replaced with their IDs.
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Create a script performing these tasks and include it into an update for the database
 Adapt the client to the now changed informations (e.g. query for responsible etc.)

After these changes the only place where the name of a user is stored is the table UserProxy
together with the ID. Removing the name (see below) will remove any information about the
user leaving only a number linked to the information within depending data. 

To generate a script for the objects and changes needed to implement the General Data
Protection Regulation use the Data protection tab as shown below. The generated script will
handle the standard objects (logging columns) but not any additional circumstances within the
database. For these you need to inspect the database in detail and create a script to handle
them on your own.

To set the website where detailed information about the handling of the General Data
Protection Regulation within the DiversityWorkbench resp. the current database is provided,
click on the button on the Info site tab. If unchanged, the default site for the
DiversityWorkbench is set (see below). 
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If for any reason a user wants his name to be removed from the database, select the users
name from the list as shown below and click on the  button (see below).
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Version of data sets
The Version of a data set consists of two parts, e.g. 3 / 1 as shown in the header of the
specimen in the main form. The first number refers to the version of the data set as stored in
table CollectionSpecimen. The second number refers to the version as stored in table
CollectionEvent. Both versions will be set to a higher number if the data in the tables
themselves or in dependent tables are changed. Thus, if a new identification is inserted in the
table Identification the specimen number of the version will increase from 3 to 4 resulting in a
version 4 / 1 for the whole data set. The changes in the version will only occur if the last
changes in the data were more than 24 hours ago or a different user is changing the data.
This ensures that a user can change several parts in a data set within 24 hours and the
version will only be increased by 1.

The data is stored in the tables CollectionSpecimen and CollectionEvent.
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Database - Application tables
Information concerning the predefined queries for users is stored in the table shown in the
diagram below. 

Table ApplicationSearchSelectionStrings
Selection strings for customized queries for users

Column Data type Description

UserName varchar (50) Name of the user who created this SQL string
Default value: user_name()

SQLStringIdentifier varchar (50) Identifier for the selection string as shown in a user
interface

ItemTable varchar (50)
Main table from which the data sets should be
selected
Default value: 'TaxonName'

SQLString varchar (MAX) SQL string for selecting data sets from the
database

Description nvarchar (MAX) Description of the results set and the purpose of
the query

LogCreatedWhen datetime Point in time when this data set was created
Default value: getdate()

LogCreatedBy nvarchar (50) Name of the creator of this data set
Default value: user_name()

LogUpdatedWhen datetime Point in time when this data set was updated last
Default value: getdate()

LogUpdatedBy nvarchar (50) Name of the person to update this data set last
Default value: user_name()
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Diversity Workbench
The Diversity Workbench is composed of components for building and managing biodiversity
information, each of which focuses on a particular domain. Each component can provide
services to the other components. DiversityCollection can link data to the
modules DiversityExsiccatae, DiversityGazetteer, DiversityScientificTerms,
DiversityTaxonNames, DiversityAgents and DiversityReferences as illustrated in the image
below.

The modules communicate with each other to provide their services for the other modules.
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Modules
The DiversityWorkbench is a set of components for building and managing biodiversity
information, each of which focuses on a particular domain.

Dive
rsity
Age
nts

Administration of the agents, i.e. people and institutions which should be documented with e.g. their addresses

Dive
rsity
Coll
ecti
on

Administration of the scientific collections and specimens within these collections

Dive
rsity
Exsi
ccat
ae

Administration of exsiccatal series

Dive
rsity
Gaze
tteer

A data collection to enable the linking of geographical records with the Getty Thesaurus of Geographical Names (TGN), the German GN250 database and other sources of
geographical names

Dive
rsity
Proj
ects

Administration of projects. 

Dive
rsity
Refe
renc
es

Administration of references

Dive
rsity
Sam
plin
gPlo
ts

Administration of sampling plots

Dive
rsity
Scie
ntifi
cTer
ms

Data collections of scientific terms from foreign sources like vegetation, stratigraphy, soil science etc. and for the description of parts of the specimen like bones etc.. 

Dive
rsity
Tax
onN
ame
s

Administration of taxonomic names, their synonyms and hierarchical position

Each module provides services for the other modules. To use the service of a module you
require access to the database of the module and optionally the module application placed in
your application directory. 

In the figure shown below the connections to other modules within DiversityCollection are
indicated.
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Module related entry
The DiversityWorkbench is a set of components for building and managing biodiversity
information. Each of which focuses on a particular domain and provides services for the other 
modules. For an introduction see a short tutorial . To use the service of a module you need
access to the database of the module and optionally the module application placed in your
application directory. Entries related to an external module have a standard interface in the
main form. There are 3 states of this interface:

1 - the value is only set in the local database with no connection to the remote module

In this state you may either type the value or select it from the values which are already
available in the database. To get a list of the available values type the beginning of the value

(you may use wildcards) and click on the button. 

 

2 - the value is related to the remote module

If you wish to set a relation to the remote module you have 2 options: 

Option 1: Click on the button to select the source in the window that will open where you
can select among the available sources. If you select a DiversityWorkbench database as a
source, you can choose among the available projects. 

After the source is set, the pin and drop-down box will change their colors as shown below
to indicate that the values are not longer derived from the content in DiversityCollection but
from the selected source database. To activate the dropdown via keyboard, enter the search
string in the text box (in the image below "Erysiphe a"), move to the combobox with the key
combination shift+tab and press the space key. 

To remove the link to the remote database, click on the  button and than select Cancel in
the window where you select the database. The pin will change to and the data will again be
derived from the local values in DiversityCollection. An overview for all settings can be found
under Administration - Customize display - Settings. 

Option 2: click on the button. A window will open where you may select an entry from the
foreign database. With this option you have the full range of query options as shown in the
image below as well as access to additional webservices. 

Page 618

http://media.snsb.info/Tutorials/DiversityCollection/Editing/ModulVerbindung.wmv


 

If the value has a relation to the remote module, the interface will appear as shown above. To
release the connection to the remote module click on the button. If you require further
information on the value, click on the button. This will open a form showing an overview of
the related value. 
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If the client application of the module is available, you may inspect the details of the entry.
To start the client application of the remote module click on the button.  

 

3 - relation to a webservice

Some modules provide the possibility to link your data to an external webservice. For example,
DiversityTaxonNames gives you access to the taxonomic names of IndexFungorum. To
establish a connection to an external webservice click on the button. As with the link to
modules within the DiversityWorkbench, a window will open where you are able to choose from
either DiversityWorkbench modules or external Webservices. See Webservice for further
details
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Description - links from DiversityDescriptions
In the module DiversityDescriptions you can link data to DiversityCollection. To detect these
links and list them in DiversityCollection, select the specimen in the tree and activate the
checkbox Scan module DiversityDescriptions at the bottom of the details section. If there
are links found in the available DiversityDescriptions databases, these will be listed as shown
below. Select one of the items in the list to show some basic data stored in
DiversityDescriptions (see below).  

To show the details in the module DiversityDescriptions set the path to the application (click
on the button) and click on the button. The module DiversityDescriptions will start,
showing the dataset with the link to DiversityCollection (see below).
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Reference
Details about References are stored in the module DiversityReferences. You may choose one
of the entries in this module from the picklist. To access the data stored in
DiversityReferences click on the  button. 

For access to the references from other modules you require the application 
DiversityReferences.exe in your application directory. To use the application
DiversityReferences.exe you require access to the database DiversityReferences. For more
information see the DiversityWorkbench Portal. 
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Webservice - foreign sources
Some modules within the DiversityWorkbench provide the possibility to link your data to an
external webservice. For example DiversityTaxonNames gives you access to the taxonomic
names of Index Fungorum. To establish a connection to an external webservice click on the 

button. A window will open where you may choose from either DiversityWorkbench modules
or external Webservices. For an overview see a short tutorial . The currently provided
webservices are:

 DiversyityReferences 
o Recent Literature on Lichens 

 DiversityTaxonNames 
o Index Fungorum 
o Mycobank 
o The Catalogue of Life 
o The Palaeontology Database 
o The Pan-European Species directories Infrastructure 
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Recent Literature on Lichens - webservice
The module DiversityReferenes gives you access to the webservice Recent Literature on
Lichens. To access this service click on the button. A window will open where you can
search for entries in the database (see below).  

Enter the query restriction for the Authors, the Year and the Title in the query conditions.
Click on the search button to start the query. In the list in the left upper part the results of
the query will be listed. On the right part of the window additional information is shown as
provided by the webservice. To include the link from the webservice into your database
choose one of the entries and click OK. The entry will change as shown below.

If you double-click on the link area , a window will open providing you with the retrieval
information of the webservice. 

To receive the entire information related to this entry as provided by the webservice click on
the button. A window will open as shown below where information on the webservice is
listed. 
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If you wish to remove the link to the webservice, click on the button. This will only remove
the relation to the webservice, not the cached name. 
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Index Fungorum - webservice
Some modules within the DiversityWorkbench provide the possibility to link your data to an
external webservice. For example DiversityTaxonNames gives you access to the taxonomic
names of Index Fungorum. To establish a connection to this webservice, click on the 
button. A window will open where you may choose Index Fungorum from the database list
(see below).  

Enter the query restriction for the name in the Name field in Query conditions. The maximum

number of records you receive may be set in the max. results field (choose a
low number, if you have a slow connection to the internet). Click on the search button to
start the query. In the list in the left upper part the results of the query will be listed. In the
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right part of the window additional information is shown as provided by the webservice. For
certain entries buttons will appear, as e.g. shown above for the basionym and the current
name of a scientific name. Click on these buttons, if you wish to change to one of these
related data sets from the webservice. If available, the information provided on the
corresponding website is shown in the lower part. To include the link from the webservice into
your database choose one of the entries and click OK. The entry will change as shown below.

If you double-click on the link area , a window will open providing you with the retrieval
information of the webservice. 

To receive the entire information related to this entry as provided by the webservice click on
the button. A window will open as shown below where information on the webservice is
listed. If available, the lower part will show the corresponding information of a website.

If you wish to remove the link to the webservice, click on the button. This will only remove
the relation to the webservice, not the cached name. 
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Mycobank - webservice
Some modules within the DiversityWorkbench provide the possibility to link your data to an
external webservice. For example DiversityTaxonNames gives you access to the taxonomic
names of Mycobank. To establish a connection to this webservice, click on the button. A
window will open where you may choose Mycobank from the database list (see below).  

Enter the query restriction for the name in the Name field in Query conditions. Click on the
search button to start the query. In the list in the left upper part the results of the query
will be listed. In the right part of the window additional information is shown as provided by
the webservice. To include the link from the webservice into your database choose one of the
entries and click OK. The entry will change as shown below.

If you double-click on the link area , a window will open providing you with the retrieval
information of the webservice. 

To receive the entire information related to this entry as provided by the webservice click on
the button. A window will open as shown below where information on the webservice is
listed.

Page 628



If you wish to remove the link to the webservice, click on the button. This will only remove
the relation to the webservice, not the cached name. 

Page 629



Pan-European Species directories
Infrastructure - webservice
Some modules within the DiversityWorkbench provide the possibility to link your data to an
external webservice. For example DiversityTaxonNames gives you access to the taxonomic
names of the Pan-European Species directories Infrastructure (PESI). To establish a
connection to this webservice, click on the button. A window will open where you can
choose PESI from the database list (see below).  

Enter the query restriction for the name in the Name field in Query conditions. Click on the
search button to start the query. In the list in the left upper part the results of the query
will be listed. On the right part of the window additional information is shown as provided by
the webservice. If available, the information provided on the corresponding website is shown
in the lower part. To include the link from the webservice into your database choose one of
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the entries and click OK. The entry will change as shown below.

If you double-click on the link area , a window will open providing you with the retrieval
information of the webservice. 

To receive the entire information related to this entry as provided by the webservice click on
the button. A window will open as shown below where information on the webservice is
listed. If available, the lower part will show the corresponding information of a website.

If you wish to remove the link to the webservice, click on the button. This will only remove
the relation to the webservice, not the cached name. 
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Catalogue of Life - webservice 
DiversityWorkbench provides the possibility to link your data to an external webservice. The
webservice provided by the Catalogue of Life is possible through the module
DiversityTaxonNames. To establish a connection to this external webservice click on the 
button. A window will open where you may choose this webservice (see below). The
webservices of Catalogue of Life are changing on a regular basis. An old version is provided
under the item CatalogueOfLife (e.g.
http://webservice.catalogueoflife.org/annual-checklist/2014/webservice?id=12363960), a new
version under the item CatalogueOfLife_2 including higher taxa (e.g.
http://www.catalogueoflife.org/col/webservice?id=100462e62ffa1ccd31709a968e115cf9). 

In the field Name in Query conditions enter your search string and click on the button to
start the query. In the list of the left upper part the results of the query will be listed. In the
right part of the window additional information is shown as provided by the webservice. If
available, the lower part of the window will show the webpage of the related information. 

Page 632

http://www.catalogueoflife.org/search.php
http://webservice.catalogueoflife.org/annual-checklist/2014/webservice?id=12363960),
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For higher taxa and synonyms the accepted name will be shown as e.g. shown above. To
inspect one of these entries click on the linked entry of the ID - in the example above ID: 695
. To include the link from the webservice into your database choose one of the entries in the
list and click OK. The entry will change as shown below.

If you double-click on the link area , a window will open providing you with the retrieval
information of the webservice. The content depends on the version of the webservice you
used (e.g.: 
http://www.catalogueoflife.org/col/webservice?id=100462e62ffa1ccd31709a968e115cf9 or
http://webservice.catalogueoflife.org/annual-checklist/2014/webservice?id=12363960). 

To receive the information related to an entry as provided by the webservice click on the 
button. A window will open as shown below where information on the webservice is listed in
the upper part. If available, additional information provided on a corresponding website will be
shown in the lower part.
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If you wish to remove the link to the webservice, click on the button. This will only remove
the relation to the webservice, not the cached name. 
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The Palaeontolgy Database - webservice 
DiversityWorkbench provides the possibility to link your data to an external webservice. The
webservice provided by the Palaeontology Database is possible through the module
DiversityTaxonNames. To establish a connection to this external webservice click on the 
button. A window will open where you may choose this webservice (see below). 

In the field Name in Query conditions enter you search string and click on the button to
start the query. In the list of the left upper part the results of the query will be listed. In the
right part of the window additional information is shown as provided by the webservice. The
lower part of the window will show the webpage of the related information. 
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For synonyms the accepted name will be shown as well as shown above. To change to the
accepted name click on the linked entry of the ID - in the example above ID: 57254. To
include the link from the webservice into your database choose one of the entries in the list
and click OK. The entry will change as shown below.

If you double-click on the link area , a window will open providing you with the retrieval
information of the webservice. 

To receive the information related to an entry as provided by the webservice click on the 
button. A window will open as shown below where information on the webservice is listed in
the upper part. If available, additional information provided on a corresponding website will be
shown in the lower part.
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If you wish to remove the link to the webservice, click on the button. This will only remove
the relation to the webservice, not the cached name. 
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